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1.1 Overview 

This manual introduces the AS Series CPU functions, devices, module tables, troubleshooting, and so forth. 

1.1.1 Related Manuals 

The related manuals for AS Series programmable logic controllers are listed below. 
 AS Series Quick Start 
 This guides you in how to use the system before reading the related manuals. 
 AS Series Programming Manual AS Series Programming Manual 

 This introduces programming for the AS Series programmable logic controllers, basic instructions, and 
applied instructions. 

 ISPSoft User Manual 
 This introduces the use of the ISPSoft software, programming language (Ladder, IL, SFC, FBD, and ST), 
POUs, and tasks. 

 AS Series Hardware Manual 
 This introduces electrical specifications, appearances, dimensions, and so forth. 
 AS Series Operation Manual 
 This introduces CPU functions, devices, module tables, troubleshooting, and so forth. 
 AS Series Module Manual 

 This introduces special I/O modules such as network modules, analog I/O modules, temperature 
measurement modules, motion control modules, and so forth. 

1.1.2 Models Descriptions  

Classification Model Name Description 

Power supply 

module 

AS-PS02 
Input: 100-240 VAC, 50/60 Hz  

Output: 24VDC/2A, 48W (for PLC internal use) 

AS-PS02A 

Input: 100-240 VAC, 50/60 Hz  

Output: 24VDC/1.5A, 36W (for PLC internal use) 

Output: 24VDC/0.5A, 12W (for external use) 

AS300 Series 

CPU module 

AS332P-A 

CPU module, PNP output, 1x Ethernet port, 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, 2x function cards 

(optional), supporting 32 I/Os (16DI+16DO) and up to 1024 

I/Os. Program capacity:128K steps, high-density terminal 

blocks 

AS332T-A 

CPU module, NPN output, 1x Ethernet port, 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, 2x function cards 

(optional), supporting 32 I/Os (16DI+16DO) and up to 1024 

I/Os. Program capacity:128K steps, high-density terminal 

blocks 

AS324MT-A 

CPU module, NPN differential output, 1x Ethernet port, 2x 

RS-485 ports, 1x USB port, 1x Micro SD interface, 2x 

function cards (optional), supporting 24 I/Os (12DI+12DO) 
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Classification Model Name Description 

and up to 1016 I/Os. Program capacity:128K steps, 

high-density terminal blocks 

AS320P-B 

CPU module, PNP output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, 2x function cards 

(optional), supporting 20 I/Os (8DI+12DO) and up to 1024 

I/Os. Program capacity:128K steps, removable terminal 

blocks 

AS320T-B 

CPU module, NPN output, 1x Ethernet port, 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, 2x function cards 

(optional), supporting 20 I/Os (8DI+12DO) and up to 1024 

I/Os. Program capacity:128K steps, removable terminal 

blocks 

AS300N-A 

CPU module, no I/Os, 1x Ethernet port, 2x RS-485 ports, 1x 

USB port, 1x Micro SD interface, 2x function cards 

(optional), and supporting up to 1024 I/Os. Program 

capacity:128K steps 

AS200 Series 

CPU module 

AS228P-A 

CPU module, PNP output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 28 I/Os (16DI+12DO) and 

up to 1024 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

AS228T-A 

CPU module, NPN output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 28 I/Os (16DI+12DO) and 

up to 1024 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

AS228R-A 

CPU module, Relay output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 28 I/Os (16DI+12DO) and 

up to 1024 I/Os. Program capacity: 64K steps, removable 

terminal blocks 

AS218PX-A 

CPU module, PNP output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 
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AS218TX-A 

CPU module, NPN output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

AS218RX-A 

CPU module, Relay output, 1x Ethernet port , 2x RS-485 

ports, 1x USB port, 1x Micro SD interface, CAN 

communication port, supporting 18 I/Os 

(8DI+6DO+2AI+2AO) and up to 1024 I/Os. Program 

capacity: 64K steps, removable terminal blocks 

Digital 

input/output 

module 

AS08AM10N-A 

24VDC  

5mA  

8 inputs 

Spring-clamp terminal block 

AS08AN01P-A 

5 - 30VDC 

0.5A 

8 outputs 

Sourcing output 

Spring-clamp terminal block 

AS08AN01R-A 

240VAC/24VDC 

2A 

8 outputs 

Relay 

Spring-clamp terminal block 

AS08AN01T-A 

5 - 30VDC 

0.5A 

8 outputs 

Sinking output 

Spring-clamp terminal block 

AS16AM10N-A 

24VDC 

5mA 

16 inputs 

Spring-clamp terminal block 

AS16AN01P-A 

5 - 30VDC 

0.5A 

16 outputs 
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Sourcing output 

Spring-clamp terminal block 

AS16AN01R-A 

240VAC/24VDC 

2A 

16 outputs 

Relay 

Spring-clamp terminal block 

AS16AN01T-A 

5 - 30VDC 

0.5A 

16 outputs 

Sinking output 

Spring-clamp terminal block 

AS16AP11P-A 

24VDC 

5mA 

8 inputs 

5 - 30VDC 

0.5A 

8 outputs 

Sourcing output 

Spring-clamp terminal block 

AS16AP11R-A 

24VDC 

5mA 

8 inputs 

240VAC/24VDC 

2A 

8 outputs 

Relay 

Spring-clamp terminal block 

AS16AP11T-A 

24VDC 

5mA 

8 inputs 

5 - 30VDC 

0.5A 

8 outputs 

Sinking output 

Spring-clamp terminal block 
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AS32AM10N-A 

24VDC 

3.2mA 

32 inputs 

MIL connector 

AS32AN02T-A 

5 - 30VDC 

0.1A 

32 outputs 

Sinking output 

MIL connector 

AS64AM10N-A 

24VDC 

3.2mA 

64 inputs 

MIL connector 

AS64AN02T-A 

5 - 30VDC 

0.1A 

64 outputs 

Sinking output 

MIL connector 

Analog 

input/output 

module 

AS04AD-A 

4-channel analog input module 

Hardware resolution: 16 bits 

0–10V, 0/1–5V, -5 to +5V, -10 to +10V, 0/4–20mA, 

-20–+20mA 

Conversion time: 2 ms/channel 

AS08AD-B 

8-channel analog input module 

Hardware resolution: 16 bits 

0 to +10V, 0/1–5V, -5V to +5V, -10V to +10V 

Conversion time: 2 ms/channel 

AS08AD-C 

8-channel analog input module 

Hardware resolution: 16 bits 

0/4–20mA, -20mA–+20mA 

Conversion time: 2 ms/channel 

AS04DA-A 

4-channel analog input module 

Hardware resolution: 12 bits 

-10 to +10V, 0–20mA, 4–20mA 

Conversion time: 2 ms/channel 

AS06XA-A 4-channel analog input module 
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Hardware resolution: 16 bits 

0–10V, 0/1–5V, -5 to +5V, -10 to +10V, 0/4–20mA, -20 to 

+20mA 

Conversion time: 2 ms/channel 

2-channel analog input module 

Hardware resolution: 12 bits 

-10 to +10V, 0–20mA, 4–20mA 

Conversion time: 2 ms/channel 

Temperature 

measurement 

module 

AS04RTD-A 

4-channe, 2-wire/3-wire RTD  

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 / 

LG-Ni1000 / Cu50 / Cu100 / 0-300Ω / 0-3000Ω input 

impedance 

Resolution: 0.1°C/0.1°F (16 bits) 

Conversion time: 200ms/channel 

AS06RTD-A 

6-channe, 2-wire/3-wire RTD  

Sensor type: Pt100 / Ni100 / Pt1000 / Ni1000 / JPt100 / 

LG-Ni1000 / Cu50 / Cu100 / 0-300Ω / 0-3000Ω input 

impedance, Resolution: 0.1°C/0.1°F (16 bits) 

Conversion time: 200ms/channel 

AS04TC-A 

4-channel thermocouple 

Sensor type: J, K, R, S, T, E, N, B and -100 to +100 mV  

Resolution: 0.1°C/0.1°F (24 bits) 

Conversion time: 200ms/channel 

AS08TC-A 

8-channel thermocouple 

Sensor type: J, K, R, S, T, E, N, B and -100 to +100 mV  

Resolution: 0.1°C/0.1°F (24 bits) 

Conversion time: 200ms/channel 

Load cell 

module 
AS02LC-A 

2-channel, 4-wire/6-wire load cell sensor 

Eigenvalues for a load cell: 1, 2, 4, 6, 20, 40, 80 mV/V 

Highest precision 1/10000 @ 50ms of conversion time 

ADC Resolution : 4 bits 

Conversion time: 2.5–400ms (nine options to choose from) 

Positioning 

module 
AS02PU-A 

2-axis motion control,  

5-24 VDC, 1 differential input,  

maximum high-speed frequency at 200 k Hz 

24 VDC, 5 mA, 5 inputs 
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5 VDC, 2-axis, 4 differential outputs,  

maximum high-speed frequency at 200 k Hz 

AS04PU-A 

4-axis motion control 

24 VDC, 5mA, 6 outputs 

5-30 VDC, 0.1A, 4-axis, 8 outputs, maximum high-speed 

frequency at 100 kHz 

Network 

module 

AS00SCM-A 
Serial communication module, 2x communication ports for 

communication cards, supporting MODBUS protocols 

AS01DNET-A 
DeviceNet communication port, functioning as master or 

slave  

Remote I/O 

module 

AS00SCM-A 

+ 

AS-FCOPM 

For AS-FCOPM function cards 

AS00SCM-A 

+ 

AS-FEN02 

For AS-FEN02 function cards 

AS01DNET-A (RTU) 

DeviceNet remote IO slave, its right side connectswith AS 

Series extension modules, including digital modules, analog 

modules, temperature modules, etc.  

Function cards 

AS-F232 
Serial communication port, RS232, functioning as master or 

slave 

AS-F422 
Serial communication port, RS422, functioning as master or 

slave 

AS-F485 
Serial communication port, RS485, functioning as master or 

slave 

AS-FCOPM 
CANopen communication port, supporting DS301, AS 

series remote modules and Delta servo systems 

AS-F2AD 

2-channel analog input  

0-10V (12 bits), 4-20mA (11 bits) 

Conversion time: 3ms/channel 

AS-F2DA 

2-channel analog input  

0-10V, 4-20mA (12 bits) 

Conversion time: 2ms/channel 

AS-FEN02 
2x Ethernet ports, supporting MODBUS TCP, EtherNet/IP 

Adapter, AS Series remote control, and DLR function 

Programming UC-PRG015-01A Used for the connection between a PLC and a PC via a mini 
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cable (1.5M) USB port, use for AS332T-A, AS332P-A, and AS324MT-A 

UC-PRG030-01A (3M) 
Use for the connection between a PLC and a PC with a mini 

USB port, use for AS332T-A, AS332P-A, and AS324MT-A 

UC-PRG030-20A (3M) 
Use for the connection between a PLC and a PC with a 

RJ45 port, use for AS332T-A, AS332P-A and AS324MT-A 

I/O extension  

cable 

UC-ET010-24B (1M) 

UC-ET020-24B (2M) 

UC-ET030-24B (3M) 

MIL connector, 40Pin  40Pin, shielded, use for  

AS32AM10N-A, AS32AN02T-A, AS64AM10N-A and 

AS64AN02T-A 

UC-ET010-24D (1M) 

UC-ET020-24D (2M) 

UC-ET030-24D (3M) 

MIL connector, 40Pin 2x 20Pin, shielded, use for 

AS332T-A, AS332P-A, AS324MT-A, AS32AM10N-A, 

AS32AN02T-A, AS64AM10N-A, and AS64AN02T-A 

External 

terminal 

module 

UB-10-ID16A 

16 inputs/outputs, 20-Pin MIL connector, use for AS332T-A, 

AS332P-A, AS324MT-A, AS32AM10N-A, AS32AN02T-A, 

AS64AM10N-A and AS64AN02T-A 

UB-10-ID32A 
32 inputs, 40-Pin MIL connector, use for AS32AM10N-A and 

AS64AM10N-A 

UB-10-IO32D 

Terminal block (spring clamp/MIL connector), MIL connector 

to 40-Pin spring clamp terminal block, use for AS332T-A, 

AS332P-A, AS324MT-A, AS32AM10N-A, AS32AN02T-A 

UB-10-OR16A 
16 relay outputs, 20-Pin MIL connector, NPN, use for 

AS332T-A, AS32AN02T-A and AS64AN02T-A 

UB-10-OR16B 
16 relay outputs, 20-Pin MIL connector, PNP, use for 

AS332P-A 

UB-10-OT32A 
32 transistor outputs, 40-Pin MIL connector, NPN, use for 

AS32AN02T-A and AS64AN02T-A 

Network cables 

UC-CMC003-01A (0.3M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC005-01A (0.5M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC010-01A (1M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC015-01A (1.5M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC020-01A (2M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC030-01A (3M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC050-01A (5M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC100-01A (10M) CANopen communication cable, use for AS-FCOPM series 

UC-CMC200-01A (20M) CANopen communication cable, use for AS-FCOPM series 
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UC-EMC003-02A (0.3M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  

UC-EMC005-02A (0.5M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series. 

UC-EMC010-02A (1M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  

UC-EMC020-02A (2M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  

UC-EMC050-02A (5M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  

UC-EMC100-02A (10M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  

UC-EMC200-02A (20M) 
Ethernet communication cable, use for AS Series, CPU and 

AS-FEN02 Series.  
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1.2 Overview 

An AS series CPU module is an advanced controller with built-in 6 high speed counters for inputs, up to 6-axis 

(pulse), and can optionally work with a total of 8-axis (CANopen) position outputs. It provides a strong network 

function for users, and users can create connection among devices on the network through software. An AS 

series CPU module also provides structured programming. Users can assign programs to different tasks, and 

write a program which is frequently executed in a function block. Besides, users can choose different 

programming languages ladder diagrams (LD), structured texts (ST), sequential function charts (SFC), and 

continuous function chart (CFC) dealt with by IEC 61131-3 according to their needs when writing programs. 

They can create the AS series hardware configuration by means of hardware configuration software. They can 

also restore or back up a system rapidly through the built-in SD interface in an AS series series CPU module. 

This manual introduces the basic operation of an AS series system, and help users familiarize themselves with 

the AS series system. 

 

1.3 Characteristics 

Characteristics of the AS series CPU module: 

(1) High efficiency 

 The AS Series CPU module uses a 32-bit high-speed processor. The module executes basic 

instructions at 25 ns each and moving instructions at 150ns each. The module executes instructions 

at a speed of 40k steps/ms (40% of the instructions are basic instructions, and 60% of the instructions 

are applied instructions).  

 The CPU of the AS Series uses the Soc architecture, built with six (or 3) high speed counters. The 

maximum frequency is 200 kHz for each counter (differential output models can reach 4 MHz); 

six-axis high speed position output at 200 kHz (differential output models can reach 4 MHz). 

(2) Supporting more inputs and outputs 

 The AS series CPU module supports up to 1024 digital I/Os or 32 I/O modules (any type) or 16 analog 

I/O modules.  

 The AS series works with SCM/DNETcommunication modules (AS-FCOPM, and AS-FEN02 included) 

to create a remote connection, and you can connect up to 15 remote modules.  

Note: For the connections between the CPU modules and the remote modules, the I/O points cannot 

exceed 1024 I/Os, 32 I/O modules (any type), or 16 analog I/O modules.  

(3) Multiple I/O modules 

 The AS series CPU module supports the following I/O modules: digital input/output modules, analog 
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input/output modules, temperature measurement modules, network modules, and function cards. 

Module Description 

Digital 

input/output 

module 

AS08AM10N-A, AS08AN01T-A, AS08AN01P-A, AS08AN01R-A, 

AS16AM10N-A, AS16AN01T-A, AS16AN01P-A, AS16AN01R-A, 

AS16AP11T-A, AS16AP11P-A, AS16AP11R-A, AS32AM10N-A, 

AS32AN02T-A, AS64AM10N-A, AS64AN02T-A 

Analog 

input/output 

module 

(Temperature 

measurement 

module) 

AS04AD-A, AS08AD-B, AS08AD-C, AS04DA-A, AS06XA-A, AS04RTD-A,
AS06RTD-A, AS04TC-A, AS08TC-A 

Positioning 

module 
AS02PU-A, AS04PU-A 

Network module AS00SCM-A, AS01DNET-A 

Communication 

card 
AS-F232, AS-F422, AS-F485, AS-FCOPM, AS-FEN02 

Function card AS-F2AD, AS-F2DA 

 
(4) Larger program capacity and memory 

 The AS300 Series advanced CPU modules have 128k steps of program capacity. 60000 general 
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that 
can be used for storing parameters).  

 The AS200 Series advanced CPU modules have 64k steps of program capacity. 60000 general 
registers (30000 for specific use and 30000 for programming editing), and 64k words of memory (that 
can be used for storing parameters).  

(5) Supporting IEC 61131-3 

 The AS series CPU module supports IEC 61131-3. 

 Supported programming languages are ladder diagrams (LD), sequential function chart (SFC), 
structured text (ST), and continuous function chart (CFC). 
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 You can select a programming language according to your preference. Programming languages 

support one another so that programs written by different users are compatible. 

(6) Strong function block 

 Both standard IEC61131-3 function blocks and convenient functions blocks provided by Delta 

Electronics, Inc. are supported. You can use function blocks for frequently used programs for greater 

structure and convenience. 

 The symbol for a function block in a ladder diagram is similar to an integrated circuit (IC) in a circuit 

diagram. Because the ladder diagram is based on the traditional circuit diagram, the operation of a 

function block is similar to the function of an integrated circuit. You only need to send the signal to the 

corresponding input of the function block.  You do not need to consider the processing procedure 

inside the function block. 

 

 A function block is a program element equipped with the operation function. It is similar to a subroutine, 

and is a type of POU (Program Organization Unit). It cannot operate by itself, and must be called 

through the main program POU. The function defined by the function block is executed after being 

called with the related parameters. The final result can be sent to the device or variable in the superior 

POU after the function block completes.  

 You can set passwords in ISPSoft to provide function block security. The program inside a function 

block cannot be read, and business patents cannot be compromised. 
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(7) Task 

 

 You can assign 283 tasks at most to a program. Among these tasks, 32 are cyclic, 32 are I/O 

interrupts, 4 are timer interrupts, two are communication interrupts, one is an external 24 V 

low-voltage interrupt, and 212 are user-defined tasks.  

 You can enable and disable a task when running a program by using the TKON and TKOFF 

instructions. 

(8) Increasing hardware configuration efficiency through a USB cable and ISPSoft 

 The AS Series CPU module provides a standard USB 2.0 interface. USB 2.0 increases the data 

transfer rate and decreases the time it takes to download the program, monitor the program, and 

configure the hardware. You do not need to buy a special communication cable for the CPU module. 

You can use a general USB cable to connect to the AS Series CPU module. 

(9) Serial control interface with multiple functions 

 AS Series CPU modules provide two RS-485 serial control interfaces, COM1 and COM2, which can 

be set as a either master or slave. 

 You use the communication cards to work with two extension serial communication ports and to set 

the port as a master or slave.  

(10) High-speed Ethernet communication interface 

 AS Series CPU modules are equipped with a 10/100 M Ethernet communication interface and support 

email, web, and socket services.  

 System error messages can be sent to your email immediately. You do not need to be on location to 

understand the problem.  
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(11) Memory card 

 The memory card has the following functions. 

System backup: user program, CPU parameters, module table, and the device setting values 

System recovery: user program, CPU parameters, module table, and device setting values 

Parameter storage: device value 

Log storage: system error log and system status log 

(12) I/O module installation 

 The AS Series PLC supports slide-and-lock installation on I/O modules when the power is off. After the 

PLC is powered off, you can remove the defective module and replace it with a new one without 

removing other modules. 

 

 

(13) Supporting on-line debugging mode 

 You can use the on-line debugging mode in the AS series CPU module after a single instruction step 

completes, or after a breakpoint is specified, to find bugs in the program.  

 The CPU module must be running to enter the debugging mode. After enabling the on-line monitoring 

function, click . The debugging screen varies from programming language to programming 

language, but the same operation applies to these programming languages. For the AS series PLC, 

structured text does not support debugging mode, and sequential function charts supports debugging 

mode during the action and the transition. 
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Step 1: Set the PLC to RUN 

 

 

 

 

 

 

 

Step 2: Entering the on-line mode 
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Step 3: Enter debugging mode 

 

(14) On-line editing mode 

 You can use the on-line editing mode when the system is running to update the program without 

affecting the system operation. 

 When the system is in the on-line monitoring mode, enter the on-line editing mode by clicking . 
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 After the program is modified and compiled, you can update the program in the CPU module by 

clicking  to download it to the CPU. 
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2.1 General Specifications 

Item Specifications 
Operating temperature -20 to 60°C 
Storage temperature -40 to 80°C 

Operating humidity 
5–95% 
No condensation 

Storage humidity 
5–95% 
No condensation 

Work environment No corrosive gas exists. 
Installation location In a control box 
Pollution degree 2 
EMC (electromagnetic 
compatibility) Refer to Chapter 7 for more information. 

Vibration resistance 

Tested with: 
5 Hz ≦ f ≦ 8.4 Hz, constant amplitude 3.5 mm;  

8.4 Hz ≦ f ≦ 150 Hz, constant acceleration 1g 

Duration of oscillation: 10 sweep cycles  
per axis on each direction of the three mutually perpendicular axes 
International Standard IEC 61131-2 & IEC 60068-2-6 (TEST Fc) 

Shock resistance 

Tested with: 
Half-sine wave: 
Strength of shock 15 g peak value, 11 ms duration; 
Shock direction: The shocks in each in direction per axis, on three mutually 
perpendicular axes (total of 18 shocks) 
International Standard IEC 61131-2 & IEC 60068-2-27 (TEST Ea) 

Safety  Conforms to IEC 61131-2, UL508 
  

2.2 CPU Module Specifications 
2.2.1 Functional specifications 

Item 
AS324MT-A / AS332T-A 
AS332P-A / AS320T-B 

 AS320P-B / AS300N-A 

AS228T-A / AS228P-A 
AS228R-A / AS218TX-A 

AS218PX-A / AS218RX-A 
Remark 

Execution The program is executed cyclically.  

Input/Output control 
Regenerated inputs/outputs  
Direct inputs/outputs 

The inputs and 
outputs can be 
controlled through the 
direct inputs and 
direct outputs. 

Programming language 
IEC 61131-3   

Ladder diagrams, continuous function charts, 
structured text, and sequential function charts 

 

Instruction execution speed 40K steps/ms  
Number of instructions Approximately 666 instructions  

Constant scan cycle (ms) 
1-32000  
(The scan cycle can be increased by one 
millisecond.) 

Setting the parameter 
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Item 
AS324MT-A / AS332T-A 
AS332P-A / AS320T-B 

 AS320P-B / AS300N-A 

AS228T-A / AS228P-A 
AS228R-A / AS218TX-A 

AS218PX-A / AS218RX-A 
Remark 

Program capacity (step) 128K steps  64K steps  

Installation DIN rails or screws  
Installation of a module No backplane installation; only module after module   
Maximum number of 
modules which can be 
installed 

32 modules  

Number of tasks 283 tasks (32 cyclic tasks; 16 I/O interrupts; four 
timed interrupts, etc.)  

Refer to the AS Series 
Operation manual for 
more information. 

Number of inputs/outputs Maximum 1024 

Number of 
inputs/outputs 
accessible to an actual 
input/output module 

Input relays [X] 1024  
Output relays [Y] 1024  
Internal relays [M] 8192 (M0–M8191)  
Timers [T] 512 (T0–T511)  
Counters [C] 512 (C0–C511)  
32-bit counter [HC] 256 (HC0–HC255)  
Data register [D] 30000 (D0–D29999)  
Data register [W] 30000 (W0–W29999)  
Stepping relay [S] 2048 (S0–S2047)  
Index register [E] 10 (E0–E9)  
Special auxiliary relay [SM] 2048 (SM0–SM2047)  
Special data register [SR] 2048 (SR0–SR2047)  
Serial communication port 2x RS-485   
Ethernet port 10/100 M  
USB port Mini USB  
Storage interface SD Card (Micro SD); maximum storage: 32G  

Real-time clock Years, months, days, hours, minutes, seconds, and 
weeks  

*Batteries (CR1620) are 
not included. 

Function card interface 

2x function cards, 
supporting 
communication card, 
AD/DA analog function 
cards 

None  

CANopen DS301 (Master) Maximum node: 64; maximum bytes: 2000 *A function card 
AS-FCOPM is required 
for AS300 Series.  CANopen DS301 (Slave) Maximum PDO: 8; maximum bytes: 8 
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2.2.2 Electrical specifications 

          Model 
 
 

Item 

AS332T-A/ 
AS332P-A/ 
AS324MT-A 

AS320T-B/ 
AS320P-B AS300N-A AS228T-A/ 

AS228P-A 
AS218TX-A/ 
AS218PX-A 

AS228R-A/ 
AS218RX-A 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Power 
consumption (W) 3.6 3.6 3 3.4 4.9 4.3 / 5.3 

Weight (g) 260 285 235 285 290 325 / 310 

 
 Electrical specifications for the inputs on digital input/output module. The signals passing through 

the inputs are 24 VDC signals. 

Model 
Item 

AS332T-A 
AS332P-A 

AS320T-B 
AS320P-B AS324MT-A 

Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7) 12 (X0.0-X0.11) 

Connector type MIL connector Removable terminal blocks MIL connector 
Input type Digital input 

Input form Direct current (sinking or sourcing) 

X0.0+–X0.3+/X0.0- to 
X0.3-: differential input 
X0.4–X0.11: Direct current 
(sinking or sourcing) 

Input voltage/ 
current 

24 VDC 
5 mA 

X0.0+–X0.3+/X0.0- to X0.3-: 
5 VDC, 5 mA 
X0.4–X0.11: 24 VDC, 5 mA 

Action 
level 

OFF→ON >15 VDC 
X0.0+–X0.3+/X0.0- to X0.3-: 
>0.2VDC 
X0.4–X0.11: >15VDC 

ON→OFF <5 VDC 
X0.0+–X0.3+/X0.0- to 
X0.3-: <-0.2VDC 
X0.4–X0.11: <5VDC 

Response 
time 

OFF→ON 
X0.0~X0.11：< 2.5μs 

X0.12~X0.15：< 50μs 

X0.0+–X0.3+/X0.0- to 
X0.3-： < 0.125 μs 

X0.4–X0.11: < 2.5μs 

ON→OFF 
X0.0~X0.11：< 2.5μs 

X0.12~X0.15：< 50μs 

X0.0+–X0.3+/X0.0- to 
X0.3-： < 0.125 μs 

X0.4–X0.11: < 2.5μs 

Maximum input 
frequency 

X0.0~X0.11：200KHz 

X0.12~X0.15：10KHz 

X0.0+–X0.3+/X0.0- to 
X0.3-: < 4 MHz 
X0.4–X0.11: < 200 kHz 

Input impedance 5.6 kΩ 

Input signal 
Voltage input 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open collectors. 

Electrical isolation Optocoupler 
Input display When the optocoupler is driven, the input LED indicator is ON. 

Note: AS300N-A does not come with inputs/outputs. 
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 Electrical specifications for the outputs on AS300 Series.  

Model 
Item 

AS332T-A 
AS332P-A 

AS320T-B 
AS320P-B AS324MT-A 

Number of inputs 16 (Y0.0-Y0.15) 12 (Y0.0-Y0.11) 12 (Y0.0-Y0.11) 

Connector type MIL connector 
Removable 

terminal blocks 
MIL connector 

Output form  
Transistor-T (sinking)  

Transistor-P (sourcing) 

Y0.0+–Y0.3+/Y0.0- to Y0.3-: differential 
input 
Y0.4–Y0.11: Transistor-T (sinking) 

Output current 5-30 VDC, 0.1A 
Y0.0+–Y0.3+/Y0.0- to Y0.3- : 5 VDC, 
20 mA 
Y0.4–Y0.11: 5-30VDC, 0.1A 

Maximum 
load 

Resistance 0.1A 
Y0.0+-Y0.3+/Y0.0-Y0.3- : 20mA 

Y0.4-Y0.11: 0.1A 
Inductance N/A 
Bulb N/A 

Maximum 
output 
frequency*1 

Resistance 
Y0.0-Y0.11: 200 KHz 
Y0.12-Y0.15: 100 Hz 

Y0.0+–Y0.3+/Y0.0- to Y0.3- : 4 MHz 
Y0.4–Y0.11: 200 KHz 

Inductance N/A 

Bulb N/A 

Maximum 
Response 
time 

OFF→ON 
Y0.0~Y0.11: 2.5μs 

Y0.12~Y0.15: 0.5ms 
Y0.0+–Y0.3+/Y0.0- to Y0.3-: 0.125 μs 
Y0.4–Y0.11: 2.5 μs 

 
 Electrical specifications for the inputs on AS200 Series. The signals passing through the inputs are 

24 VDC signals. 

Model 
Item 

AS228P-A / AS228R-A / AS228T-A AS218PX-A / AS218RX-A / 
AS218TX-A 

Number of inputs 16 (X0.0-X0.15) 8 (X0.0-X0.7) 

Connector type Removable terminal blocks 
Input type Digital input 
Input form Direct current (sinking or sourcing) 

Input voltage/ current 
24 VDC 

5 mA 

Action level 
OFF→ON >15 VDC 

ON→OFF <5 VDC 

Response time 
OFF→ON 

X0.0–X0.7: < 2.5μs 
X0.8–X0.15: < 50μs 

ON→OFF 
X0.0–X0.7: < 2.5μs 
X0.8–X0.15: < 50μs 

Maximum input frequency 
X0.0–X0.7: 200 KHz 
X0.8–X0.15: 10 KHz 

Input impedance 3.9 kΩ 

Input signal 

Voltage direct input 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open   

  collectors. 
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Model 
Item 

AS228P-A / AS228R-A / AS228T-A AS218PX-A / AS218RX-A / 
AS218TX-A 

Electrical isolation Optocoupler 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Analog inputs N/A 2 
Analog input resolution N/A 12bits 

Analog input mode N/A 
-10V~10V (voltage mode) or 
20mA~20mA (currentmode) 

Analog linearity error N/A ±1% (full scale) 

Analog input impedance N/A 
≧1 MΩ (Voltage mode) 

250 Ω (Current mode) 
 
 Electrical specifications for the outputs on AS200 Series.  

Model 
Item 

AS228R-A 
AS218RX-A 

AS228T-A 
AS218TX-A 

AS228P-A 
AS218PX-A 

Number of outputs 
AS228 Series: 12 outputs (Y0.0-Y0.11) 

AS218 Series 6 outputs (Y0.0-Y0.5) 
Connector type Removable terminal blocks 
Output form Relay Transistor-T (sinking) Transistor-P (sourcing) 

Input voltage/ current 240 VAC / 24 VDC 5-30 VDC 5-30 VDC 

Maximum 
load 

Resistance 2A/output, 8A/COM 0.5A 0.5A 
Inductance Life cycle curve*1 N/A N/A 

Bulb 
20W (24VDC) 

100W (230VAC) N/A N/A 

Maximum 
output 
frequency 

Resistance 1Hz 200kHz 200kHz 

Inductance 0.5Hz N/A N/A 

Bulb 1Hz N/A N/A 

Maximum 
Response 
time 

OFF→ON 
10 ms 2.5 μs 2.5 μs 

ON→OFF 

Analog outputs AS218 Series: 2 outputs 
Analog output resolution AS218 Series: 12bits 
Analog output mode AS218 Series: -10V~10V (voltage mode) or 0mA~20mA (currentmode) 
*1: Life cycle curve 
 

Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300

500

100

1000
2000

3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)
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2.2.3 Ethernet Specifications   

Item AS300 Series AS200 Series Remarks 

Communication Protocol MODBUS TCP, EtherNet/IP, SMTP, 
HTTP 

Protocols can 
be used 
simultaneously 

MODBUS 
TCP 

Server connection number 32 16  
Client connection number 32 16  

RTU-EN01 Mapping number 4 4  

Socket 
TCP connection number 4 2  
UDP connection number 4 2  

SMTP Email number 4 2  

EtherNet/IP 

Type Scanner, Adapter  

CIP Network 
I/O 

Connection 

CIP 
connection 

number 

32 
(Clients+Servers) 

16 
(Clients+Servers) 

I/O 
connections 

shared 
TCP 

connection 
number 

16 
(Clients+Servers) 

8 
(Clients+Servers) 

I/O 
connections 

shared 
Requested 

Packet 
Interval (RPI) 

5 ms–1000 ms Default: 20 ms 

Max. 
Transmission 

Speed 

 
3000 pps 

 
 

 

Max. Data 
Length/per 

transmission 
500 bytes   

CIP Network 
Explicit 

Message 

Class 3 
(Connected 

Type) 

Total 32 
(Servers), 

including the 
ones from the 
UCMM type 

Total 16 
(Servers), 

including the 
ones from the 
UCMM type 

I/O 
connections 

shared 

UCMM  
(Non- 

Connected 
Type) 

Total 32 (Clients 
+ Servers) , 
including the 
ones from the 

Class 3 

Total 16 (Clients 
+ Servers) , 
including the 
ones from the 

Class 3 

I/O 
connections 

shared 

CIP Objects 

Identity, Message Router, Assembly, 
Connection Manager, Port, TCP/IP 

interface, Ethernet link, Vendor 
specific 

 

CIP Network 
Produced 

Tag 

Max. CIP 
connection 

number 
32 (Servers) 16 (Servers) 

I/O 
connections 

shared 
Max. Data 

Length 400 bytes  

Requested 
Packet 

Interval (RPI) 
5 ms–1000 ms  

CIP Network Max. CIP 32  16  I/O 
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Item AS300 Series AS200 Series Remarks 
Consumed 

Tag 
Connection 

Number 
(Clients+Servers) (Clients+Servers) connections 

shared 
Max. Data 

Length 400 bytes   

Requested 
Packet 

Interval (RPI) 
5 ms–1000 ms  

 AS00SCM (RTU) + AS-FEN02 
conneciton number 15 8 AS Remote 

 
2.2.4 CPU Module Profiles 

 AS324MT-A/AS332T-A/AS332P-A/AS300N-A 

 
8

75

92

98
.3

88

80

1

2
COM1

COM2

5

0

OUT
4

1
2
3

8

9

11
10

2

102

7

5

6

4
IN

3 11

AS324MT

0
1

8
9

40

1

BAT. LOW

ERROR

RUN

POWER

Ethernet

6
7

3

10

11 12

7

4

5

6

9 13

 
Unit: mm 

 
 AS320T-B/AS320P-B 

10

11 12

80
75

95.5

13

98
.3

88

8 1 4

1

2

4

3

5

7
6

 
Unit: mm 
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Number Name Description 

1 

Power LED indicator Indicates the power status of the CPU module 

Run LED indicator 
Operating status of the module 
ON: the module is running. 
OFF: the module is stopped.  

Error LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

BAT.LOW LED 
indicator 

Indicates the battery status of the CPU module. 
(Enable/Disable this display in HWCONFIG in ISPSoft) 

COM1 LED 
COM2 LED 

Indicates the communication status of the COM port. 
OFF: no communication over the COM port 
Blinking: communication over the COM port 

2 Model name Shows the model name of the CPU module. 

3 

Run/Stop 
RUN: execute the programs 
STOP: stop the programs 

USB port Mini USB communication port 
SD card slot Provides an interface for an SD card  

VR0/VR1 
VR0: use the flag SM166 to activate the values in SR166 
VR1: use the flag SM167 to activate the values in SR167 

4 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

5 Ethernet port Provides an interface for a n Ethernet communication  
6 COM1/COM2  Provides an interface for RS-485 communication 
7 DIN rail clip Secures the DIN rail 
8 Extension card slot Provides an interface for an extension card 

9 MIL connector Connects the module and the wiring module 
Note: AS300N-A does not come with inputs/outputs; no connector for AS300N-A.  

10 Grounding clip For grounding  
11 Power supply For power supply 
12 Label Nameplate 
13 External module port Connects the modules 

14 
Removable terminal 
blocks 

Connects the module and the wiring module 
Note: AS300N-A does not come with inputs/outputs; no connector 
for AS300N-A.  
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 AS200 Series (AS218PX-A/AS218RX-A/AS218TX-A/AS228R-A/AS228T-A/AS228P-A) 

10

11 12

88

75
95.5

13

98
.3

88

8

 9

1

2

4

3

5

7
6

 
Unit: mm 

 
Number Name Description 

1 

Power LED indicator Indicates the power status of the CPU module 

Run LED indicator 

Operating status of the module 
ON: the module is running. 
OFF: the module is stopped.  
Blinking: the module is detecting an error. 

Error LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

BAT.LOW LED 
indicator 

Indicates the battery status of the CPU module. 
(Enable/Disable this display in HWCONFIG in ISPSoft) 

COM1 LED 
COM2 LED 
CAN LED 

Indicates the communication status of the COM/CAN port. 
OFF: no communication over the COM/CAN port 
Blinking: communication over the COM/CAN port 

2 Model name Shows the model name of the CPU module. 

3 

Run/Stop 
RUN: execute the programs 
STOP: stop the programs 

USB port Mini USB communication port 
SD card slot Provides an interface for an SD card  

VR0/VR1 
VR0: use the flag SM166 to activate the values in SR166 
VR1: use the flag SM167 to activate the values in SR167 

4 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

5 Ethernet port Provides an interface for a n Ethernet communication  
6 COM1/COM2  Provides an interface for RS-485 communication 
7 DIN rail clip Secures the DIN rail 
8 CAN port Provides an interface for CAN communication 

9 
Removable terminal 
blocks 

Connects the module and the wiring module 

10 Grounding clip For grounding  
11 Power supply For power supply 
12 Label Nameplate 
13 External module port Connects the modules 
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7

6

113

87
55.3

1
3
4
5

2

 MIL connector, extension cable, and wiring modules (for AS332T-A/AS332P-A/AS324MT-A) 

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M) 

 

39 40

1 2
500+10m m-

39 40

21 22
19 20

1 2

O U T
  #1

IN
# 2

Len gth

 
Unit: mm 

 
 

Number Name Description 

1 IDC 40-pin terminal  
Connects a digital input/output module and an external terminal 
module. 

2 IDC 20-pin terminal 
Connects the external terminal modules 
UB-10-ID16A/UB-10-OR16A/UB-10-OR16B 

 

2. AS332T-A/AS332P-A/AS324MT-A and the external terminal module UB-10-ID16A 
67.0

87.0

53.62

1

3

4

 
Unit: mm 

Number Name Description 
1 20-pin MIL connector Connects the external terminal module and a wiring module 
2 Terminals Input/Output terminals for wiring 
3 Clip Hangs the external terminal module on a DIN rail 
4 Set screw Fixes the base 

 
3. AS332T-A and the external terminal module UB-10-OR16A/AS332P-A, and UB-10-OR16B 

 

 
 
 
 
 
 
 



Chapter  2  Spec i f ica t ions and System Conf igurat ion 

2-13  

2_  

 
 

Unit: mm 

 
Number Name Description 

1 20-pin MIL connector Connects the external terminal module and a wiring module 
2 Terminals Input/Output terminals for wiring 
3 2-pin power input terminal Power input terminal for wiring 
4 Output LED indicator If there is an output signal, the output LED indicator is ON. 
5 Relay output Relay output 
6 Clip Hangs the external terminal module on a DIN rail 
7 Set screw Fixes the base 

 
 Spring clamp/MIL connector terminal block UB-10-IO32D for AS332T-A/AS332P-A/AS324MT-A 

 

23 6.
24 35.

26.9
33.7

10
1

1

2

 Unit: mm 
 

Number Name Description 
1 Terminal block for output Terminal block 
2 40-pin MIL connector Connects the module and the wiring module 
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2.2.5 CPU Module Input/Output Terminals 

AS332P-A AS332T-A 

COM1

COM2

135

0

OUT
4

1

2

3

8

12

9

11

10

2

102

7

5

6

4
IN

3

15

12

13

14

11

AS332P

0

1

8

9

40

1

BAT. LOW

ERROR

RUN

POWER

Ethernet

6

7

14

15

 

- - 

POWER

BAT. LOW

RUN

ERROR

COM2

COM1

146

7 15

113
IN

3

2

1

5

4
OUT

10

11

9

13

12

4

6

5

0

7

14

13

12

8

15

2

AS332T

1

0

2

9

8

10

40

1

Ethernet

 

- - 
S/S S/S S/S S/S 

X0.15 X0.14 X0.15 X0.14 
X0.13 X0.12 X0.13 X0.12 
X0.11 X0.10 X0.11 X0.10 
X0.9 X0.8 X0.9 X0.8 
X0.7 X0.6 X0.7 X0.6 
X0.5 X0.4 X0.5 X0.4 
X0.3 X0.2 X0.3 X0.2 
X0.1 X0.0 X0.1 X0.0 
C0 C0 - - 
- - C0 C0 

Y0.15 Y0.14 Y0.15 Y0.14 
Y0.13 Y0.12 Y0.13 Y0.12 
Y0.11 Y0.10 Y0.11 Y0.10 
Y0.9 Y0.8 Y0.9 Y0.8 
Y0.7 Y0.6 Y0.7 Y0.6 
Y0.5 Y0.4 Y0.5 Y0.4 
Y0.3 Y0.2 Y0.3 Y0.2 
Y0.1 Y0.0 Y0.1 Y0.0 

AS324MT-A AS320T-B/AS320P-B 

COM1

5

6

7

3

2

1

4
OUT

0

10

11

9

8

AS324MT

2

3
IN

4

6

5

7

COM2

1

0

10

11

9

8

2 1

40

BAT. LOW

POWER

RUN

ERROR

Ethernet

 

S/S S/S 

X1

Y10OUT
4

5

7

6

IN

6

0

3

4

5

2

1

Ethernet

0

2

3

1

7

C0

Y0

Y2

X6

X4

Y8

Y6

Y4

10

11

9

8

AS320T

RUN

POWER

COM2

BAT. LOW

COM1

ERROR

X2

X0

Y11

X7

Y3

Y1

X5

C0

Y9

Y7

Y5

X3

 

S/S S/S 
X0.11 X0.10 X0 X1 
X0.9 X0.8 X2 X3 
X0.7 X0.6 X4 X5 
X0.5 X0.4 X6 X7 
SG0 SG0 C0 C0 
X0.3- X0.3+ Y0 Y1 
X0.2- X0.2+ Y2 Y3 
X0.1- X0.1+ Y4 Y5 
X0.0- X0.0+ Y6 Y7 

C0 C0 Y8 Y9 
Y0.11 Y0.10 Y10 Y11 
Y0.9 Y0.8   
Y0.7 Y0.6   
Y0.5 Y0.4   
SG1 SG1   
Y0.3- Y0.3+   
Y0.2- Y0.2+   
Y0.1- Y0.1+   
Y0.0- Y0.0+   
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AS218RX-A/AS218TX-A/AS218PX-A 

6

5

4

C1

OUT

11

9

C2

7

RUN

146 376

10

8

12

14

0

Et hernet

5

6

7

1

4

3

2

8

9

11

10

157

OUT

●

11

1 3

1 5

●

●

8

10

9

IN

2

4

0

COM2

COM1

80

91

12

13

11

5

4

3
IN

102

BAT. LOW

ERROR

2

1

0

3

1

5

OUT

C0

IN

POWER

 

AIO DIO 

V1+ V2+ S/S C0 

I1+ I2+ X0.0 Y0.0 

VI1- VI2- X0.1 Y0.1 

- - X0.2 Y0.2 

VO1 VO2 X0.3 - 

IO1 IO2 X0.4 C1 

AG AG X0.5 Y0.3 

- - X0.6 Y0.4 

-  X0.7 Y0.5 

AS228R-A/AS228T-A/AS228P-A 

6

5

4

C1

OUT

11

9

C2

7

RUN

146 376

10

8

12

14

0

Et hernet

5

6

7

1

4

3

2

8

9

11

10

157

OUT

●

11

1 3

1 5

●

●

8

10

9

IN

2

4

0

COM2

COM1

80

91

12

13

11

5

4

3
IN

102

BAT. LOW

ERROR

2

1

0

3

1

5

OUT

C0

IN

POWER

 

IN OUT 

S/S S/S C0 C1 

X0.0 X0.1 Y0.0 Y0.4 

X0.2 X0.3 Y0.1 Y0.5 

X0.4 X0.5 Y0.2 Y0.6 

X0.6 X0.7 Y0.3 Y0.7 

X0.8 X0.9 - - 

X0.10 X0.11 - C2 

X0.12 X0.13 Y0.8 Y0.9 

X0.14 X0.15 Y0.10 Y0.11 
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 MIL connector and the external terminal module UB-10-ID16A for AS332T-A / AS332P-A / 
AS324MT-A 

TB1
TB2

 
 

#1

#2
 

AS332T-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

AS332P-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 - C0 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 - C0 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

AS324MT-A 

#1 
TB1 Y0.0+ Y0.1+ Y0.2+ Y0.3+ SG1 Y0.4 Y0.6 Y0.8 Y0.10 C0 

TB2 Y0.0- Y0.1- Y0.2- Y0.3- SG1 Y0.5 Y0.7 Y0.9 Y0.11 C0 

#2 
TB1 X0.0+ X0.1+ X0.2+ X0.3+ SG0 X0.4 X0.6 X0.8 X0.10 S/S 

TB2 X0.0- X0.1- X0.2- X0.3- SG0 X0.5 X0.7 X0.9 X0.11 S/S 
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 Spring clamp/MIL connector terminal block UB-10-IO32D for AS332T-A/AS332P-A/AS324MT-A 

40 

 

39 

38 37 

36 35 

34 33 

32 31 

30 29 

28 27 

26 25 

24 23 

22 21 

20 19 

18 17 

16 15 

14 13 

12 11 

10 9 

8 7 

6 5 

4 3 
2 1 

 

2.3 Digital Input/Output Module Specifications 
2.3.1 General Specifications 

 Electrical specifications for the inputs on digital input/output modules  
(The signals passing through the inputs are 24 VDC signals.) 

Module name 08AM10N 
-A 

16AM10N 
-A 

32AM10N 
-A 

64AM10N 
-A 

16AP11R 
A 

16AP11T 
-A 

16AP11P 
-A 

Number of inputs 8 16 32 64 8 8 8 

Connector type Removable terminal 
block 

MIL connector Removable terminal block 

Input type Digital input 
Input form Direct current (sinking or sourcing) 

Input voltage/ current 24 VDC，5 mA 24 VDC 
3.2 mA 

24 VDC，5 mA 

Action level 
OFF→ON >15 VDC 
ON→OFF <5 VDC 

Response 
time 

OFF→ON 10 ms±10% 
ON→OFF 15 ms±10% 

Maximum input 
frequency 50 Hz 

Input impedance 4.7 kΩ 7.5kΩ 4.7 kΩ 

Input signal Voltage input 
Sinking: The inputs are NPN transistors whose collectors are open 
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collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open 

collectors. 
Electrical isolation Optocoupler 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight 100 g 117 g 100 g 140 g 138 g 120 g 120 g 

 

 Electrical specifications for the outputs on a digital input/output module  

Model 
Item 

08AN01
R-A 

16AN01
R-A 

16AP11
R-A 

08AN01 
T-A 

16AN01 
T-A 

16AP11 
T-A 

08AN01
P-A 

16AN01
P-A 

16AP11 
P-A 

Number of inputs 8 16 8 8 16 8 8 16 8 
Connector type Removable terminal block 
Output type Digital output 
Output form  Relay-R Transistor-T (sinking) Transistor-P (sourcing) 
Output voltage/ current 240 VAC/24 VDC 5–30 VDC *2 5–30 VDC *2 

Maximum 
load 

Resistance 2A/output, 8A/COM 0.5A 0.5A 

Inductance Life cycle curve*2 12 W (24 VDC) 12 W (24 VDC) 

Bulb 
20 W (24 VDC) 

10 0W (230 VAC) 
2 W (24 VDC) 2 W (24 VDC) 

Maximum 
output 
frequency*1 

Resistance 1 Hz 100 Hz 100 Hz 

Inductance 0.5 Hz 0.5 Hz 0.5 Hz 

Bulb 1 Hz 10 Hz 10 Hz 

Maximum 
Response 
time 

OFF→ON 
10 ms 0.5 ms 0.5 ms 

ON→OFF 

Weight 120 g 158 g 138 g 100 g 122 g 120 g 100 g 123 g 120 g 

 
Model 

Item 
32AN02T-A 64AN02T-A 

Number of inputs 32 64 
Connector type MIL connector 
Output type Digital output 
Output form  Transistor-T (sinking) 
Output voltage/ current 5–30 VDC 

Maximum 
load 

0.1 A 0.1A 
Inductance N/A 
Bulb N/A 

Maximum 
output 
frequency*1 

Resistance 100 Hz 

Inductance N/A 

Bulb N/A 

Maximum 
Response 
time 

OFF→ON 
0.5 ms 

ON→OFF 

Weight 100 g  142 g 

*1: The scan cycle affects the frequency.  

*2: The life cycle curve is shown below. 
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Contact Current(A)

20

0.50.1 0.2

30
50

0.3 0.7 1 2

200
300

500

100

1000
2000

3000

O
pe

ra
tio

n(
X

10
)3

120VAC Resistive
30VDC Inductive(t=7ms)

240VAC Inductive(cos 0.4)ψ=
120VAC Inductive(cos =0.4)ψ

30VDC 
Inductive
    (t=40ms)

 
 

 
2.3.2 Digital Input/Output Module Profiles 

 AS08AM10N-A/AS08AN01P-A/AS08AN01R-A/AS08AN01T-A 
28.2

25

8898
.3

1

4

5

3

6

7

8

89

75

7

08AM

5

6

7

2

3 6
5
4
3

4 7

PWR

0

1 2
1
0
IN

IN

S/S

S/S

5

6

7

2

3

4

0

1

IN

S/S

S/S

2

08AN

6
5
4
3

7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

08AN

6
5
4
3

7

PWR

OUT
0

2
1

C0

C0

OUT

4

5

6

7

1

2

3

0

08AN

3
4
5
6
7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

Unit: mm 
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Number Name Description 
1 Model name Model name of the module 

2 
Input/output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output 
terminals 

Arrangement of the terminals 

5 Terminal block clip Secures the terminal block 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
 
 AS16AM10N-A/AS16AN01P-A/AS16AN01R-A/AS16AN01T-A/AS16AP11P-A/AS16AP11R-A/ 

AS16AP11T-A 
38.2 95

75

8898
.3

1

4

5

2

3

6

7

8

7

6

9
10
11

7

8

13

15
14

12

PWR

3
4
5

1
0

2

IN

16AM

12

14

6

8

10

0

4

2

IN IN

15

7

13

11

9

5

1

3

S/S

S/S

S/S

S/S

35

6

12
13

15
14

10
11

9

7

8

OUT

3
4
5

1
0

2

PWR

16AN

OUTOUT

C1

C0

12

14

0

C1

10

8

2

4

6

C0

15

13

11

9

7

5

3

1

6

12
13

15
14

9
10
11

7

8

OUT

3
4
5

0
1
2

PWR

16AN

OUTOUT

12

14

10

8

6

4

2

0

C0 C0

C0 C0

15

13

9

11

7

5

3

1

6

12
13

15
14

9
10
11

7

8

C1

C0

OUT

C1

3
4
5

0
1
2

C0
PWR

16AN

6

4

2

0

8

10

12

14

7

5

3

1

15

11

13

9

OUTOUT

16AP

6

4
5

7
6

1
2
3

7

0
OUT

IN

3
4
5

0
1
2

PWR
C0

OUT

C0

6

7

5

4

3

1

2

0

IN

4

5

6

7

0

1

2

3 6

7

6

4

5

4
5

7
6

1
2
3

7

0
OUT

16AP

3

2

0

1

IN

3
4
5

0
1
2

PWR

OUT

C0

C0

0

4

5

6

7

1

2

3

IN

6

4
5

7
6

OUT

1
2
3

7

0

16AP

IN

3
4
5

1
0

2

PWR
C0

OUT

C0

6

5

4

3

1

2

0

IN

7

6

5

4

3

2

1

0

 
Unit: mm 
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Number Name Description 
1 Model name Model name of the module 

2 
Input/Output LED 
indicator 

If there is an input signal, the input LED indicator is ON. 
If there is an output signal, the output LED indicator is ON. 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output 
terminals 

Arrangement of the terminals 

5 Terminal block clip Secures the terminal block 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
 
 

 AS32AM10N-A 

PWR

39

2

13

15
14

8

10
9

121

11

4
5

3

7
6

IN

1
0

X1 LED
X0 LED

32AM

88
98

.3

1

4

5

2
3

6

28.2

25

7

8

92

75

7

 
Unit: mm 

 
Number Name Description 

1 Model name Model name of the module 

2 
X0/X1 LED 
Indicator switch 

Switches the LED indicators to their represented inputs. 

3 MIL connector 
For the external I/O connecting cables UC-ET010-24B, UC-ET020-24B, 
UC-ET030-24B 

4 
Power LED 
indicator 

Indicates the power status of the module 

5 Input LED indicator LED indicator is ON during input. 
6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
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 AS32AN02T-A 

PWR

2

13

15
14

8

10
9

12

39

1

11

4
5

3

7
6

OUT

1
0

Y1 LED
Y0 LED

32AN

88
98

.3

1

4

5

2
3

6

28.2

25

7

8

92

75

7

Unit: mm 

 

Number Name Description 
1 Model name Model name of the module 

2 
Y0/Y1 LED 
indicator switch 

Switches the LED indicators to their represented outputs. 

3 MIL connector 
For the external I/O connecting cables UC-ET010-24D, UC-ET020-24D,  
UC-ET030-24D 

4 
Power LED 
indicator 

Indicates the power status of the module 

5 
Output LED 
indicator 

LED indicator is ON during output. 

6 DIN rail clip Secures the DIN rail 

7 
External module 
port 

Connects the modules 

8 Label Nameplate 
 

 

 AS64AM10N-A 

8

9

92

75

8

88
98

.3

1

4
5

2
3

6

2

X0

64AM

40

X1

10

0

9
8

4
5
6
7

3

15
14

2

10

12
11

13
40

X3

2

PWR

IN
0
1

X2

0 1

1

7

38.2

35
 

Unit: mm 
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Number Name Description 
1 Model name Model name of the module 

2 
LED indicator 
switch 1 

Switches the LED indicators to their represented inputs. 

3 
LED indicator  
switch 2 

Switches the LED indicators to their represented inputs. 

4 MIL connector 
For the external I/O connecting cables UC-ET010-24B, UC-ET020-24B,  
UC-ET030-24B 

5 
Power LED 
indicator 

Indicates the power status of the module 

6 Input LED indicator If there is an input signal, the input LED indicator is ON. 
7 DIN rail clip Secures the DIN rail 

8 
External module 
port 

Connects the modules 

9 Label Nameplate 
 
 

 AS64AN02T-A 

8

9

92

75

8

2

Y0

40

3

7
6
5
4

13

11
12

10

8
9

Y3

14
15

2

64AN

40

Y1

0 1

2

1
0

Y2

PWR

OUT

10

10

88
98

.3

1

4
5

2
3

6

7

38.2

35  

Unit: mm 
Number Name Description 

1 Model name Model name of the module 

2 
LED indicator 
switch 1 

Switches the LED indicators to their represented outputs. 

3 
LED indicator  
switch 2 

Switches the LED indicators to their represented outputs. 

4 MIL connector 
For the external I/O connecting cables UC-ET010-24D, UC-ET020-24D, 
UC-ET030-24D 

5 
Power LED 
indicator 

Indicates the power status of the module 

6 
Output LED 
indicator 

If there is an output signal, the output LED indicator is ON. 

7 DIN rail clip Secures the DIN rail 

8 
External module 
port 

Connects the modules 

9 Label Nameplate 
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 MIL connector, extension cable, and wiring modules  

1. Extension Cable UC-ET010-24D (1M) / UC-ET020-24D (2M) / UC-ET030-24D (3M) 

 

39 40

1 2
500+10m m-

39 40

21 22
19 20

1 2

O U T
  #1

IN
# 2

Len gth

 
Unit: mm 

 
Number Name Description 

1 IDC 40-pin terminal  
Connects a digital input/output module and an external terminal 
module. 

2 IDC 20-pin terminal 
Connects the external terminal modules 
UB-10-ID16A/UB-10-OR16A/UB-10-OR16B 

 
2. I/O connecting cables UC-ET010-24B (1M) / UC-ET020-24B (2M) / UC-ET030-24B (3M) 

Length

39 40 39 40

1 2 1 2  
 

Number Name Description 

1 IDC 40-pin terminal  
Connects an external terminal module and a wiring module 
UB-10-ID32A, and UB-10-OT32A 

 
3. AS32AM10N-A/AS64AM10N-A and the external terminal modules UB-10-ID16A, UB-10-ID32A 

 UB-10-ID16A 

67.0

87.0

53.62

1

3

4

 
Unit: mm 
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 UB-10-ID32A 

 
113

87

53.6

3

2

1

4

 
Unit: mm 

Number Name Description 

1 
UB-10-ID16A: 20-pin MIL connector 
UB-10-ID32A: 40-pin MIL connector 

Connects the external terminal module and a wiring 
module 

2 Terminals Input/Output terminals for wiring 
3 Clip Hangs the external terminal module on a DIN rail 
4 Set screw Fixes the base 

 
4. AS332T-A/AS64AN02T-A and the external terminal modules UB-10-ID16A, UB-10-OR16A, and 

UB-10-OT32A. 

  
 UB-10-ID16A 

67.0

87.0

53.62

1

7

6

 
Unit: mm 

 
 UB-10-OR16A 

7

6

113

87
55.3

1
3
4
5

2

 
Unit: mm 

 



AS Ser ies  Operat ion Manual   

2-26  

_2 

 UB-10-OT32A 
113

87

53.6

6

2

1

7

 
Unit: mm 

 
Number Name Description 

1 

UB-10- ID16A /OR16A: 
20-pin MIL connector 
UB-10-OT32A: 40-pin MIL 
connector 

Connects the external terminal module and a wiring 
module 

2 Terminals Input/Output terminals for wiring 
3 2-pin power input terminal Power input terminal for wiring 
4 Output LED indicator LED indicator is ON during output. 
5 Relay output Relay output 
6 Clip Hangs the external terminal module on a DIN rail 
7 Set screw Fixes the base 

 
 Spring clamp/MIL connector terminal block UB-10-IO32D for AS32AM10N-A/AS32AN02T-A 

 

23 6.
24 35.

26.9
33.7

10
1

1

2

 Unit: mm 
 

Number Name Description 
1 Terminal block for output Terminal block 
2 40-pin MIL connector Connects the module and the wiring module 
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2.3.3 Digital Input/Output Module Terminals 

AS08AM10N-A AS08AN01P-A 

08AM

5

6

7

2

3
6
5
4
3

4 7

PWR

0

1 2
1
0
IN

IN

 

08AN

6
5
4
3

7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0

 

AS08AN01R-A AS08AN01T-A 

 

08AN

6
5
4
3

7

PWR

OUT
0

2
1

C0

C0

OUT

4

5

6

7

1

2

3

0

 

 

08AN

3
4
5
6
7

PWR

OUT
0

2
1

OUT

4

7

6

5

3

2

1

0

C0

C0
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AS16AM10N-A AS16AN01P-A 

6

9
10
11

7

8

13

15
14

12

PWR

3
4
5

1
0

2

IN

16AM

12

14

6

8

10

0

4

2

IN IN

15

7

13

11

9

5

1

3

 

6

12
13

15
14

10
11

9

7

8

OUT

3
4
5

1
0

2

PWR

16AN

OUTOUT

C1

C0

12

14

0

C1

10

8

2

4

6

C0

15

13

11

9

7

5

3

1

 

AS16AN01R-A AS16AN01T-A 

 

6

12
13

15
14

9
10
11

7

8

OUT

3
4
5

0
1
2

PWR

16AN

OUTOUT

12

14

10

8

6

4

2

0

C0 C0

C0 C0

15

13

9

11

7

5

3

1

 

 

6

12
13

15
14

9
10
11

7

8

C1

C0

OUT

C1

3
4
5

0
1
2

C0
PWR

16AN

6

4

2

0

8

10

12

14

7

5

3

1

15

11

13

9

OUTOUT
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AS16AP11P-A AS16AP11R-A 

16AP

6

4
5

7
6

1
2
3

7

0
OUT

IN

3
4
5

0
1
2

PWR
C0

OUT

C0

6

7

5

4

3

1

2

0

IN

4

5

6

7

0

1

2

3

 

6

7

6

4

5

4
5

7
6

1
2
3

7

0
OUT

16AP

3

2

0

1

IN

3
4
5

0
1
2

PWR

OUT

C0

C0

0

4

5

6

7

1

2

3

IN

 

AS16AP11T-A AS32AM10N-A 

 

6

4
5

7
6

OUT

1
2
3

7

0

16AP

IN

3
4
5

1
0

2

PWR
C0

OUT

C0

6

5

4

3

1

2

0

IN

7

6

5

4

3

2

1

0

 

PWR

39

2

13
14
15

11
12

10

8
9

1

3

7
6
5
4

IN

1
0

32AM
X1 LED
X0 LED

 

- - 
S/S S/S 
1.15 1.14 
1.13 1.12 
1.11 1.10 
1.9 1.8 
1.7 1.6 
1.5 1.4 
1.3 1.2 
1.1 1.0 
- - 

S/S S/S 
0.15 0.14 
0.13 0.12 
0.11 0.10 
0.9 0.8 
0.7 0.6 
0.5 0.4 
0.3 0.2 

0.1 0.0 
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AS32AN02T-A AS64AM10N-A 

 

PWR

39

2

13

15
14

8

10
9

121

11

4
5

3

7
6

OUT

1
0

Y1 LED
Y0 LED

32AN

  

- - 

2

X0

64AM

40

X1

10

0

9
8

4
5
6
7

3

15
14

2

10

12
11

13
40

X3

2

PWR

IN
0
1

X2

0 1

1

 

- - 2.0 2.1 
C0 C0 S/S S/S 2.2 2.3 

1.15 1.14 1.15 1.14 2.4 2.5 
1.13 1.12 1.13 1.12 2.6 2.7 
1.11 1.10 1.11 1.10 2.8 2.9 
1.9 1.8 1.9 1.8 2.10 2.11 
1.7 1.6 1.7 1.6 2.12 2.13 
1.5 1.4 1.5 1.4 2.14 2.15 
1.3 1.2 1.3 1.2 S/S S/S 
1.1 1.0 1.1 1.0 - - 
- - - - 3.0 3.1 

C0 C0 S/S S/S 3.2 3.3 
0.15 0.14 0.15 0.14 3.4 3.5 
0.13 0.12 0.13 0.12 3.6 3.7 
0.11 0.10 0.11 0.10 3.8 3.9 
0.9 0.8 0.9 0.8 3.10 3.11 
0.7 0.6 0.7 0.6 3.12 3.13 
0.5 0.4 0.5 0.4 3.14 3.15 
0.3 0.2 0.3 0.2 S/S S/S 
0.1 0.0 0.1 0.0 - - 

AS64AN02T-A  

2

Y0

40

3

7
6
5
4

13

11
12

10

8
9

Y3

14
15

2

64AN

40

Y1

0 1

2

1
0

Y2

PWR

OUT

10

10

 

- - 2.0 2.1      
C0 C0 2.2 2.3     

1.15 1.14 2.4 2.5     
1.13 1.12 2.6 2.7     
1.11 1.10 2.8 2.9     
1.9 1.8 2.10 2.11     
1.7 1.6 2.12 2.13     
1.5 1.4 2.14 2.15     
1.3 1.2 C1 C1     
1.1 1.0 - -     
- - 3.0 3.1     

C0 C0 3.2 3.3     
0.15 0.14 3.4 3.5     
0.13 0.12 3.6 3.7     
0.11 0.10 3.8 3.9     
0.9 0.8 3.10 3.11     
0.7 0.6 3.12 3.13     
0.5 0.4 3.14 3.15     
0.3 0.2 C1 C1     
0.1 0.0 - -     
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#1

#2

 MIL connector and the wiring module 

1. AS32AM10N-A/AS64AM10N-A  

 The wiring module: UB-10-ID16A 

TB1
TB2

 
 

 
AS32AM10N-A/ AS64AM10N-A 

#2 
TB1 X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 S/S - 

TB2 X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 S/S - 
 

 The wiring module: UB-10-ID32A 

 
 
AS series terminals: 
Upper 

row 
X0.0 X0.2 X0.4 X0.6 X0.8 X0.10 X0.12 X0.14 X1.0 X1.2 X1.4 X1.6 X1.8 X1.10 X1.12 X1.14 S/S S/S 

Lower 
row 

X0.1 X0.3 X0.5 X0.7 X0.9 X0.11 X0.13 X0.15 X1.1 X1.3 X1.5 X1.7 X1.9 X1.11 X1.13 X1.15 S/S S/S 
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2. AS32AN02T-A/AS64AN02T-A and the wiring modules: 

 UB-10-ID16A 

TB1
TB2

 

#1

#2
 

AS332T-A 

#1 
TB1 Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 C0 - 

TB2 Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 C0 - 

 

 UB-10-OT32A 

 
 
AS series terminals: 
Upper 

row Y0.0 Y0.2 Y0.4 Y0.6 Y0.8 Y0.10 Y0.12 Y0.14 Y1.0 Y1.2 Y1.4 Y1.6 Y1.8 Y1.10 Y1.12 Y1.14   

Lower 
row Y0.1 Y0.3 Y0.5 Y0.7 Y0.9 Y0.11 Y0.13 Y0.15 Y1.1 Y1.3 Y1.5 Y1.7 Y1.9 Y1.11 Y1.13 Y1.15 C0 C0 

 UB-10-OR16A 

 
 
AS series terminals: 

 GND +24V 
C0 Y0.0 Y0.1 Y0.2 Y0.3 C1 Y0.4 Y0.5 Y0.6 Y0.7 C2 Y0.8 Y0.9 Y0.10 Y0.11 C3 Y0.12 Y0.13 Y0.14 Y0.15 
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3. AS32AM10N-A/AS32AN02T-A and the wiring modules: 

 UB-10-IO32D 

 

 

2.4 Analog Input/Output Module Specifications  
2.4.1 General Specifications 

 AS04AD-A 

Electrical specifications 

Module name AS04AD-A 
Number of inputs Four 
Analog-to-digital 
conversion Voltage input/Current input 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 
Conversion time 2 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 
Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight 145 g 
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Functional specifications 

Analog-to-digital 
conversion 

Voltage input 

Rated input range -10 V to +10 V 0 V–10 V ±5 V 0 V–5 V 1 V–5 V 
Hardware input 
range 

-10.1 V to  
+10.1 V 

-0.1 V to  
+10.1 V 

-5.05 V to  
+5.05 V 

-0.05 V to  
+5.05 V 

0.95 V–5.05 V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0. 5% 

Linearity error 
(Room 
temperature) 

±0.02% 

Linearity error 
(Full temperature 
range) 

±0.06% 

Hardware 
resolution 16 bits 

Input impedance 1 MΩ 
Absolute input 
range ±15 V 

 
Analog-to-digital 

conversion 
Current input 

Rated input range ±20 mA 0 mA–20 mA 4 mA–20 mA 
Hardware input 
range -20.2 mA to +20.2 mA -0.2 mA to +20.2 mA 3.8 mA–20.2 mA 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0.5% 

Linearity error 
(Room 
temperature) (Full 
temperature 
range) 

±0.04% 

Linearity error ±0.10% 
Hardware 
resolution 16 bits 

Input impedance 250 Ω 
Absolute input 
range ±32 mA 
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 AS08AD-B 

Electrical specifications 

Module name AS08AD-B 
Number of inputs Eight  
Analog-to-digital 
conversion Voltage input 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 
Conversion time 2 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 
Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight 145 g 
 

Functional specifications 

Analog-to-digital 
conversion Voltage input 

Rated input range -10 V to +10 V 0 V–10 V ±5 V 0 V–5 V 1 V–5 V 

Hardware input 
range 

-10.1 V to  
+10.1 V 

-0.1 V to  
+10.1 V 

-5.05 V to  
+5.05 V 

-0.05 V to  
+5.05 V 

0.95 V–5.05 V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0. 5% 

Linearity error 
(Room 
temperature) 

±0.02% 

Linearity error 
(Full temperature 
range) 

±0.06% 

Hardware 
resolution 16 bits 

Input impedance 1 MΩ 
Absolute input 
range ±15 V 
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 AS08AD-C 

Electrical specifications 

Module name AS08AD-C 
Number of inputs Eight 
Analog-to-digital 
conversion Current input 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 
Conversion time 2 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 
Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 
Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight 145 g 
 

Functional specifications 

Analog-to-digital 
conversion 

Current input 

Rated input range ±20 mA 0 mA–20 mA 4 mA–20 mA 
Hardware input 
range -20.2 mA to +20.2 mA -0.2 mA to +20.2 mA 3.8 mA–20.2 mA 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0.5% 

Linearity error 
(Room 
temperature) (Full 
temperature 
range) 

±0.04% 

Linearity error ±0.10% 
Hardware 
resolution 16 bits 

Input impedance 250 Ω 
Absolute input 
range ±32 mA 
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 AS04DA-A 

Electrical specifications 

Module name AS04DA-A 
Number of outputs Four 
Analog-to-digital 
conversion Voltage output/Current output 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15%–+20%) 
Connector type Removable terminal block 
Conversion time 2 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 

Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 

Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight  145 g 
 

Functional specifications 

Analog-to-digital 
conversion 

Voltage output 

Rated output 
range ±10 V 0 V–10 V ±5 V 0 V–5 V 1 V–5 V 

Hardware output 
range 

-10.1V to 
+10.1V 

-0.1V to +10.1V 
-5.05V to 
+5.05V 

-0.05V to 
+5.05V 

0.95V–5.05V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature 
range)  

±0. 5% 

Linearity error 
(Room 
temperature) 

±0.05% 

Linearity error 
(Full temperature 
range) 

±0.05% 

Hardware 
resolution 12 bits 

Input impedance 1 kΩ–2 MΩ at ±10 V and 0 V–10 V 
Absolute output 
range ≧500 Ω at 1 V–5 V 

 
Analog-to-digital 

conversion 
Current output 

Rated output 
range 0 mA–20 mA 4 mA–20 mA 

Hardware output 
range -0.2 mA to +20.2 mA 3.8 mA–20.2 mA 

Error rate (Room 
temperature)  ±0.2% 
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Analog-to-digital 
conversion 

Current output 

Error rate (Full 
temperature 
range)  

±0.5% 

Linearity error 
(Room 
temperature) (Full 
temperature 
range) 

±0.03% 

Linearity error ±0.03% 
Hardware 
resolution 12 bits 

Input impedance ≦550 Ω 

 
 AS06XA-A 

Electrical specifications 

Module name AS06XA-A 
Number of 
inputs/outputs Inputs: four; Outputs: two 

Analog-to-digital 
conversion Voltage input/Current input; Voltage output/Current output; 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 
Conversion time 2ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, but the analog channels are not isolated from one another. 

Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 

Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight  145 g 
 

A/D Functional specifications 

Analog-to-digital 
conversion 

Voltage input 

Rated input range -10V to +10V 0V–10V ±5V 0V–5V 1V–5V 
Hardware input 
range 

-10.1V to 
+10.1V 

-0.1V to  
+10.1V 

-5.05V to 
+5.05V 

-0.05 V to  
+5.05 V 

0.95V–5.05V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature range)  ±0. 5% 

Linearity error 
(Room temperature) ±0.02% 

Linearity error (Full 
temperature range) ±0.06% 

Hardware resolution 16 bits 



Chapter  2  Spec i f ica t ions and System Conf igurat ion 

2-39  

2_  

Analog-to-digital 
conversion 

Voltage input 

Input impedance 1 MΩ 
Absolute input 
range ±15 V 

 
Analog-to-digital 

conversion 
Current input 

Rated input range ±20 mA 0 mA–20 mA 4 mA–20 mA 
Hardware input 
range -20.2 mA–20.2 mA -0.2 mA–20.2 mA 3.8 mA–20.2 mA 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature range)  ±0.5% 

Linearity error 
(Room temperature) 
(Full temperature 
range) 

±0.04% 

Linearity error ±0.10% 
Hardware resolution 16 bits 
Input impedance 250 Ω 
Absolute input 
range ±32 mA 

 
D/A Functional specifications 

Digital-to-analog 
conversion 

Voltage output 

Rated output range ±10V 0V–10V ±5V 0V–5V 1V–5V 
Hardware output 
range 

-10.1V to 
+10.1V 

-0.1V to 
 +10.1V 

-5.05V to 
+5.05V 

-0.05 V to  
+5.05 V 

0.95V–5.05V 

Error rate (Room 
temperature)  ±0.2% 

Error rate (Full 
temperature range)  ±0. 5% 

Linearity error 
(Room temperature) ±0.05% 

Linearity error (Full 
temperature range) ±0.05% 

Hardware resolution 12 bits 
Input impedance 1 kΩ–2 MΩ at ±10 V and 0 V–10 V 
Absolute output 
range ≧500 Ω at 1 V–5 V 

 
Analog-to-digital 

conversion 
Current output 

Rated output 
range 0 mA–20 mA 4 mA–20 mA 

Hardware output -0.2 mA to +20.2 mA 3.8 mA–20.2 mA 
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Analog-to-digital 
conversion 

Current output 

range 
Error rate (Room 
temperature) ±0.2% 

Error rate (Full 
temperature 
range) 

±0.5% 

Linearity error 
(Room 
temperature) (Full 
temperature 
range) 

±0.03% 

Linearity error ±0.10% 
Hardware 
resolution 12 bits 

Output 
impedance ≦550 Ω 

 

2.4.2 Analog Input/Output Module Profiles 

 AS04AD-A/AS08AD-B/AS08AD-C/AS04DA-A/AS06XA-A 

38.2 95

75
35

8898
.3

-

-

1

4

5

2

3

6

7

8

9

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 Removable terminal The inputs are connected to sensors. 
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Number Name Description 
block The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 

6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 

 
 
2.4.3 Analog Input/Output Terminals 

AS04AD-A AS08AD-B AS08AD-C 

04AD

V1+

AG

SLD

●

I3+

VI3-

VI1-

V3+

I1+

V2+

0V

24V

SLD

●

I4+

VI4-

VI2-

V4+

I2+
PWR

ERR
A    D

 

24V

0V

AG

A    D
ERR

PWR
V2+V1+

08AD

V1- V2-

V3-

V3+

V4-

V4+

V5-

V5+

V6-

V6+

V7-

V7+

V8-

V8+

 
 

AG

0V

24V

PWR

ERR
A    D

08AD

I1+ I2+

I1- I2-

I4+

I4-

I3+

I3-

  I5-

I5+

I6-

I6+

  I7-

I7+ I8+

I8-
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AS04DA-A AS06XA-A  

VO1 VO2

AG

SLD

AG

VO4

0V

24V

SLDSLD

●

AG

VO3

IO3

AG

SLD

IO1

IO4

PWR

ERR
D    A

IO2

04DA

 

V1+ V2+

IO1 IO2

AG

0V

24V

VO1

I3+

VI3-

VO2

I4+

VI4-

VI1-

V3+

I1+

VI2-

V4+

I2+

06XA

PWR

A     D
ERR

 

 

 
2.4.4 Analog Input/Output Device Settings 

(1)  AS04AD-A 
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(2)  AS08AD-B 

 
 
 
(3)  AS08AD-C 
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(4)  AS04DA-A 

 
 
 

(5)  AS06XA-A 

 
 
Refer to the AS Series Module Manual for further information on device settings. 
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2.5 Temperature Measurement Modules Specifications 
2.5.1 General Specifications 

 AS04RTD-A / AS06RTD-A 

Electrical specifications 

Number of analog 
inputs AS04RTD-A: four ; AS06RTD-A: six 

Applicable sensor 

2-WIRE & 3-WIRE Pt100/Ni100/Pt1000/Ni1000/ 
JPt100/LG-Ni1000/Cu50/Cu100/0–300 Ω/0–3000 Ω 

Pt100：DIN 43760-1980 JIS C1604-1989；100 Ω 3850 PPM/°C 

Pt1000：DIN EN60751；1 kΩ 3850 PPM/°C 

Ni100/Ni1000：DIN 43760 

JPt100：JIS C1604-1989 

LG-Ni1000 
Cu50/Cu100 

Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 

Connector type Removable terminal block 

Overall accuracy 

Pt100/Ni100/Pt1000/Ni1000/JPt100 

25°C/77°F: The error is ±0.1% of the 
input within the range. 
-20 to +60°C/-4 to +140°F: The error is 
±0.5% of the input within the range. 

LG-Ni1000 
25°C/77°F: The error is ±0.2% of the 
input within the range. 

Cu50 
25°C/77°F: The error is 4°C of the 
input within the range. 

Cu100 
25°C/77°F: The error is 2°C of the 
input within the range. 

Conversion time Two-wire/three-wire configuration: 200 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit/an 
optocoupler, and the analog channels are isolated from one another by 
optocouplers. 
Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 
Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 

Weight AS04RTD-A: 115g ; AS06RTD-A: 125g 
 

Functional specifications 

Analog-to-digital 
conversion Centigrade (°C) Fahrenheit (°F) Input impedance 

Rated input range 

Pt100: -180°C to +800°C 
Ni100: -80°C to +170°C 
Pt1000: -180°C to +800°C 
Ni1000: -80°C to +170°C 
JPt100: -180°C to +500°C 
LG-Ni1000: -50°C to +180°C 
Cu50: -50°C to +150°C 
Cu100: -50°C to +150°C 

Pt100: -292°F to +1,472°F 
Ni100: -112°F to +338°F 
Pt1000: -292°F to +1,472°F 
Ni1000: -112°F to +338°F 
JPt100: -112°F to +338°F 
LG-Ni1000: -58°F to +356°F 
Cu50: -58°F to +302°F 
Cu100: -58°F to +302°F 

0–300 Ω 
0–3000 Ω 
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Average function Range: 1–100 

Self-diagnosis Disconnection detection 

 
 AS04TC-A / AS08TC-A 

Electrical specifications 

Number of analog 
inputs AS04TC-A: four ; AS08TC-A: eight 

Applicable sensor Type J, K, R, S, T, E, N and B thermocouple; input impedance: ±100mV 
Supply voltage 24 VDC (20.4 VDC–28.8 VDC) (-15% to +20%) 
Connector type Removable terminal block 

Overall accuracy 25°C/77°F: The error is ±0.5% of the input within the range. 
-20 to +60°C/-4 to +140°F: The error is ±1% of the input within the range. 

Conversion time 200 ms/channel 

Isolation 

An analog circuit is isolated from a digital circuit by a digital integrated circuit, 
and the analog channels are isolated from one another by optocouplers. 
Isolation between a digital circuit and a ground: 500 VDC 
Isolation between an analog circuit and a ground: 500 VDC 
Isolation between an analog circuit and a digital circuit: 500 VDC 
Isolation between two group circuits: 500 VDC 
Isolation between the 24 VDC and a ground: 500 VDC 
Isolation between the analog channels: 120VAC 

Weight AS04TC-A: 115g ; AS08TC-A: 125g 

 

Functional specifications 

Analog-to-digital 
conversion Centigrade (°C) Fahrenheit (°F) Input impedance 

Rated input range 

Type J: -100°C~1200°C 
Type K: -100°C~1,350°C 
Type R: 0°C~1,750°C 
Type S: 0°C~1,750°C 
Type T: -150°C~400°C 
Type E: -150°C~980°C 
Type N: -150°C~1,300°C 
Type B: 200°C~1,800°C 

Type J: -148°F~2,192°F 
Type K: -148°F~2,462°F 
Type R: 32°F~3,182°F 
Type S: 32°F~3,182°F 
Type T: -238°F~752°F 
Type E: -238°F~1,796°F 
Type N: -238°F~2,372°F 
Type B: 32°F~3,182°F 

±100mV 

Average function Range: 1~100 
Self-diagnosis Disconnection detection 
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2.5.2 Temperature Measurement Module Profiles 

 AS04RTD-A / AS06RTD-A 

38.2

35
8898

.3

1

4

5

2

3

6

04RT D

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 
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 AS04TC-A / AS08TC-A 

38.2

35
8898

.3

1

4

5

2

3

6

04TC

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  

9 Label Nameplate 
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2.5.3 Temperature Measurement Module Dimensions 

AS04RTD-A AS04TC-A 

L1+ L1-

SLD I4-

0V

24V

L2+

SLD

SLD

L4+

L3+

SLD I3-

L4-

L3-

I2-

I1-

L2-

0 4RTD

PWR

ERR
A    D

 

I1 +

SLD I4-

0V

2 4V

SLD

SLD

SLD

I4 +

I3 +

I3-

I2 +

I2-

I1-

04TC

PWR

ERR
A    D

 
AS06RTD-A AS08TC-A 

PWR

A    D
ERR

06RTD

SLD

  I 56-

L6+

L5+

L4+

L3+

SLD

L2+

L1+

L6-

L5-

I34-

L4-

0V

24V

L3-

I12 -

L2-

L1-

 

08TC

A    D

PWR

ERR

SLD

I8+

I7+

I6+

I5+

I4+

I3+

I2+

I1+

I8-

I7-

I6-

I5-

24V

0V

I4-

I2-

I3-

I1-

 
Unit: mm 
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2.5.4 Temperature Measurement Module Device Setting 

(1) AS04RTD-A 

  
 

(2) AS06RTD-A 
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(3) AS04TC-A 

 
 

(4) AS08TC-A 
 

 
 
 

Refer to the AS Series Module Manual for further information on device settings. 
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2.6 Positioning Module Specifications 
2.6.1 General Specifications 

Electrical specifications for the inputs  

 AS02PU-A 

Model 
Item 

Differential inputs on both ends 24VDC COM on one end 

Number of inputs 3  (A+/B+/Z+/A-/B-/Z-) 5 (X0.0-X0.4) 

Connector type Removable terminal blocks 
Input type Digital input 
Input form Connected by an independent terminal Direct current (sinking or sourcing) 
Input current 5-24 VDC, 5 mA 24 VDC, 5 mA 

Action 
level 

OFF→ON - >15 VDC 

ON→OFF - <5 VDC 

Response time 2.5 μs < 0.5 ms 

Maximum input 
frequency 200 KHz 1 KHz 

Input impedance 4.7 kΩ 

Input signal - 

Voltage input 
Sinking: The inputs are NPN transistors 

whose collectors are open 
collectors.  

Sourcing: The inputs are PNP transistors 
whose collectors are open 
collectors. 

Electrical isolation Optocoupler 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight  120 g 

 
 
 AS04PU-A 

Model 
Item 

AS04PU-A 

Number of inputs Six 

Connector type Removable terminal blocks 
Input type Digital input 
Input form Direct current (sinking or sourcing) 
Input current 24 VDC, 5 mA 

Action 
level 

OFF→ON >15 VDC 

ON→OFF <5 VDC 

Response time < 0.5 ms 

Maximum input 
frequency 1 KHz 

Input impedance 4.7 kΩ 
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Model 
Item 

AS04PU-A 

Input signal 
Voltage input 
Sinking: The inputs are NPN transistors whose collectors are open collectors.  
Sourcing: The inputs are PNP transistors whose collectors are open collectors. 

Electrical isolation Optocoupler 
Input display When the optocoupler is driven, the input LED indicator is ON. 
Weight  120 g 

 
Electrical specifications for the outputs  

Model 
Item 

AS02PU-A AS04PU-A 

Number of inputs Four Eight 
Connector type Removable terminal blocks 
Output form  differential output Transistor-T (sinking) (NPN) 
Output current 5 VDC, 20 mA 5-30 VDC, 0.1A 

Maximum 
load 

Resistance 20 mA 0.1A 
Inductance N/A 
Bulb N/A 

Maximum 
output 
frequency*1 

Resistance 200 KHz 100 KHz 

Inductance N/A 

Bulb N/A 

Maximum 
Response 
time 

OFF→ON 2.5 μs 5 μs 

Weight 120 g 

 

2.6.2 Positioning Module Profiles 

 AS02PU-A / AS04PU-A 

2

38.2 95

75
35

8898
.3

1

4

5

2

3

6

77

8

9
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Number Name Description 

1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

Run LED indicator 

Operating status of the module 
ON: the module is running. 
OFF: the module is stopped.  
Blinking: the module is detecting an error. 

Error LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 

 

2.6.3 Positioning Module Terminals  

AS02PU-A AS04PU-A 

3+

0+

1+

2+

02PU

2

3
4

2
3

1
0

A

0
Z
B

1

PWR

RUN
ERR

B+

A+

Z+

A-

B-

Z-

0-

1-

2-

3-

OUT OUT
IN

OUT

IN

1

3

0

2

4

IN

 

5

7

6

5

4

0

3
2
1

6
7

5
4

5

4

IN

3

2

1

0

C0

OUT

0

3
2
1

1

0

2

3
4

04PU

RUN
ERR

PWR

C1
IN

●

●
OUT
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2.7 Network Module Specifications  
2.7.1 General Specifications 

 RS-485/RS-422/RS-232 communication interface 

Item Specifications 
Connector type European-style terminal block, spring-clamp terminal block 

Transmission speed 
300, 600, 1,200, 2,400, 4,800, 9,600, 19,200, 38,400, 57,600, 76,800, 
115,200, 230,400bps 

Communication 
format 

Stop bit: 1 stop bit or 2 stop bits 
Parity bit: none, an odd parity bit, or an even parity bit 
Data bit: 7 data bits or 8 data bits 

Communication 
protocol 

Modbus ASCII/RTU 
UD Link 

 
 CAN communication interface 

Item Specifications 
Connector type RJ-45 
Transmission speed 10K, 20K, 50K, 125K, 250K, 500K, 1000 Kbps 

Communication 
protocol 

AS special remote mode (for RTU mode)  
CANopen (available for models with firmware V2.0 or later) 

 

 Ethernet communication interface 

Item Specifications 
Connector type RJ-45 
Transmission speed 10M, 100 Mbps 
Communication 
protocol MODBUS TCP, EtherNet/IP (available for models with firmware V2.02 or later) 

 

 Electrical specifications 

Item Specifications 
Supply voltage 24 VDC 
Electric energy 
consumption 0.6 W 

Weight Approximately 169 g 
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2.7.2 Network Module Profiles 

 AS00SCM-A 

1

4

5

2

6 75

98
.3

88

56

3

7

8

9

7

10

SCM
PO WER

CA RD 1

CA RD 2

ER RO R

F OR MA T 2

C OM . RTU

ID 2

FOR M AT 1

ID 1

 
Unit: mm 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power or the power is low 

ERROR LED indicator 

Error status of the module 
OFF: The module is normal. 
Blinking:  
 Module setting or communication error (blinks every 1 second) 
 Hardware or low power error (blinks every 0.2 second) 

Extension card 1 indicator 
(orange) 

Blinking: communication is taking place in card 1 
OFF: No communication in card 1 

Extension card 2 indicator 
(orange) 

Blinking: communication is taking place in card 2 
OFF: No communication in card 2 

3 
Address and function 
setting knobs 

2 sets for setting up the address and function in card 1 and 2 

4 
Slot for function card 1  Available for AS-F232/AS-F422/AS-F485/AS-FEN02  

Slot for function card 2 
Available for AS-F232/AS-F422/AS-F485/AS-FCOPM 
AS-FEN02 (only for RTU mode) 

5 Mode switch  COM: communication mode ; RTU: remote control mode 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  

9 Label Nameplate 

10 
Input for supplying power 
to remote modules  

Power supply for the remote module  
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 AS01DNET-A 

 
Unit: mm 

 
Number Name Description 

1 Model name Model name of the module 

2 
State LED indicator 

Master/slave mode: 
 NS LED 
OFF: no power or duplicate ID check has not been completed. 
Green light blinking every 0.5 seconds: the connection  

 to the DeviceNet network failed. 
Green light ON: online; the connection to the DeviceNet  

 network is normal. 
Red light blinking every 0.5 seconds: communication  

 error 
Red light ON: Network trouble, duplicate node ID, no  

 network power or Bus-OFF.   
 
 MS LED 
OFF: no power  
Green light blinking every 0.5 seconds: no module is  
configured. 
Green light ON: input and output data are normal. 
Red light blinking every 0.5 seconds: when AS01DNET 

 works as the master, the slave in Scan List can not work  
 normally. When AS01DNET works as the slave, an error  
 occurs in the configuration. 
Red light ON: hardware error 
 
 Combination of NS LED and MS LED 
NS LED OFF & MS LED OFF: no power  
NS LED OFF & MS LED green light ON: duplicate ID  

 check has not been completed.  
NS LED red light ON & MS LED green light ON: duplicate  

 ID check failed or Bus-OFF. 
 NS LED red light ON & MS LED red light blinking every  
 0.5 seconds: no network power 
 NS LED red light ON & MS LED red light ON: hardware  
 error  

 RTU mode: 
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Number Name Description 
 NS LED 
OFF: no power or duplicate ID check has not been  

 completed. 
Green light blinking every 0.5 seconds: the connection  

 to the DeviceNet network failed. 
Green light ON: online; the connection to the DeviceNet  

 network is normal. 
Red light blinking every 0.5 seconds: I/O connection  

 timeout between AS01DNET (RTU) and DeviceNet master 
Red light ON: Network trouble, duplicate node ID, no  

 network power or Bus-OFF.   
 
 MS LED 
OFF: no power  

 Green light blinking every 0.5 seconds:  
 - AS01DNET (RTU) is waiting for the I/O data from   
  DeviceNet master.  
 - No I/O data transmission between AS01DNET(RTU) and   
  DeviceNet master 
- The PLC connected to DeviceNet master is in STOP state. 
Green light ON: normal transmission of I/O data between  

 AS01DNET (RTU) and DeviceNet master  
Red light blinking every 0.5 seconds: no network power  

 supply; configuration error; module alarms.  
Red light ON: hardware error 

3 Address switch  Setting up the address  

4 Function switch 
Setting up the funcitons, including the work mode and baud rate of   

 DeviceNet network 

5 
DeviceNet communication 
port 

Connects the modules via DeviceNet communication.  
Use AS01DNET-A connector for wiring. 

6 
Mode switch  
(RTU/DNET; 
Master/Slave) 

Master/Slave mode: the port does not need an external  
 24VDC power supply connected 
RTU mode: the power input port of the network module is  

 required to connect an external 24VDC power supply only.  
 You can connect 

7 Left-side extension port Connects the modules 
8 Label Nameplate 
9 Right-side extension port Connects the modules 

10 
Input for supplying power 
to remote modules  

Power supply for the remote module  
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2.7.3 Network Module Device Setting 

 AS00SCM-A 

 
 

Refer to the AS Series Module Manual for further information on device settings. 
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2.8 Load Cell Module Specifications  
2.8.1 General Specifications 

 AS02LC-A 

Load cell module Voltage output 
Rated supply voltage/Power 
consumption 24 VDC (-15 to +20%) / 5W 

Minimum/maximum voltage 18~31.2VDC 
Maximum current consumption 150 mA 
Input signal range ±40mVDC 
Sensibility +5 VDC +/-10% 
ADC resolution 24 bits 
Highest precision 0.04% 
Applicable sensor type Four-wire or six-wire load cell 
Expanding a temperature 
coefficient ≤ ± 50 ppm/K v. E   

Reducing a temperature 
coefficient to zero  ≤ ± 0.4 μV/K 

Linearity error ≤ 0.02% 
Response time 2.5, 10, 16, 20, 50, 60, 100, 200, and 400ms 
Eigenvalue applicable to a load 
cell 0–1, 0–2, 0–4, 0–6, 0–20, 0–40 and 0–80 mV/V 

Maximum distance for 
connecting a load cell 100 meters 

Maximum output current 5 VDC * 160 mA 
Allowable load 40–4,010 Ω   
Averaging weights 100 
Common-mode rejection ratio 
(CMRR @50/60 Hz) ≥100 dB  

Dynamic range K1–K5 
Averaging weights K1–K100 

Isolation 
Between a digital circuit and the ground: 500 VAC  
Between an analog circuit and the ground: 500 VAC  
Between an analog circuit and a digital circuit: 500 VAC 

Weight 140 g 
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2.8.2 Load Cell Module Profiles 

 AS02LC-A 

38.2

35
8898

.3

1

4

5

2
3

6

7

8

9

95

75

7

Unit: mm 
 

Number Name Description 
1 Model name Model name of the module 

2 

POWER LED indicator  
Indicates the status of the power supply 
ON: the power is on 
OFF: no power 

ERROR LED indicator 

Error status of the module 
ON: a serious error occurs in the module. 
OFF: the module is normal. 
Blinking: a minor error occurs in the module. 

Analog to digital 
conversion indicator 

Indicates the analog to digital conversion status  
Blinking: conversion is taking place 
OFF: stop conversion 

3 
Removable terminal 
block 

The inputs are connected to sensors. 
The outputs are connected to loads to be driven. 

4 
Arrangement of the 
input/output terminals 

Arrangement of the terminals 

5 Terminal block clip Removal of the terminal block 
6 DIN rail clip Secures the module onto the DIN rail 
7 Module connecting set Connects the modules 
8 Ground clip  
9 Label Nameplate 
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2.8.3 Load Cell Module Dimensions 

 AS02LC-A 

EX C-EX C+

SL D

0 V

2 4V

SE N+

EX C+

SI G+

SE N+

SL D

SI G+

CH2
SE N-

EX C-

SI G-

CH1
SE N-

SI G-

02LC

 
Unit: mm 

 

2.8.4 Load Cell Module Device Setting 

(1) AS02LC-A 

  
 

Refer to the AS Series Module Manual for further information on device settings. 
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2.9 Extension Card Specifications  
2.9.1 General Specifications 

 AS-F2AD 

Two analog signal input channels:  

Item Voltage Input Current input 

Analog Signal  DC 0–10 V DC 4–20 mA 

Resolution 12-bit 11-bit 

Input impedance ≧1 MΩ 250 Ω 

Conversion time 3 ms / CH 

Characteristic 
curve 

10V

4000

0
Voltage inputD

ig
ita

l V
al

ue
 O

ut
pu

t

 
Current input

D
ig

ita
l V

al
ue

 O
ut

pu
t

20mA

2000

4
 

Digital value 
output 

Card1 SR168 (CH1) SR169 (CH2) 
Card2 SR170 (CH1) SR171 (CH2) 

You can use the program to read the values in SR to obtain the corresponding A/D conversion value for the 
channel. 

 AS-F2DA 

Two analog signal output channels: 

Item Voltage output Current output 

Analog Signal  DC 0–10 V DC 4–20 mA 

Resolution 12-bit 12-bit 

Input impedance ≥1 kΩ ≤500 Ω 

Conversion time 2ms / CH 

Digital value output 
Card1 SR172 (CH1) SR173 (CH2) 

Card2 SR174 (CH1) SR175 (CH2) 

Characteristic 
curve 

Di gital Value Input

Vo
lta

ge
  O

ut
pu

t 10V

40000
 

Digital Value Input

C
ur

re
nt

 O
ut

pu
t 20mA

40004
 

You can use the instruction MOV to move the value to the SR to obtain the corresponding voltage output value.  
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 AS-F232 

The AS series PLC is built with COM1 (RS-485), and COM2 (RS-485). You can use this extension card for 
communication with different interfaces such as RS-232 and a PC. The Communication functions are the same 
as the built-in ones. You can set the communication port as a slave or a master node. After installing the 
extension card, go to the HWCONFIG in the ISPSoft for communication setup.  

 
 Wiring example 

DB9 male to DB9 female (standard cable)

    AS-F232
(DB9 female) + + Superior

machine

 

 AS-FCOPM 

With its own standalone communication port, the module can work independently and can be set as a slave or 
a master node. After installing the extension card, go to the HWCONFIG in ISPSoft to set up the 
communication.  

 

 Wiring example 

 
 

GNDCAN_HCAN_L

Master node Slave node Slave node

Terminal 
 resistor
(120 ohm)

Shielded  
    c ab le

GNDCAN_HCAN_L GND CAN_HCAN_L

Terminal 
 resistor
(120 ohm)

1 20
ON

OFF

 

 

 AS-F422 

You can use this extension card for communication with Delta HMI series or other devices through the RS-422 
communication port.  The Communication functions are the same as the built-in ones. You can set the 
communication port as a slave or a master node. After installing the extension card, go to the HWCONFIG in 
ISPSoft to set up communication. 

 

 Wiring example of the communication with Delta HMI DOPA series via COM2 

 

3
4

1
2

6
7
8
9

COM2/DB-9

AS-F422 Delta HMI  ser iesDOPA

2
1

3
4

T+
T-

R+
R-

Rx+
Rx-

Tx+
Tx-

RTS-
RTS+

CTS+
CTS-
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 AS-F485 

With its own standalone communication port, the module can work independently and can be set as a slave or 
a master node. After installing the extension card, go to the HWCONFIG in ISPSoft to set up communication.  

 
 Wiring example 

D+ D- SG D+ D- SG SG D+ D-

Master node Slave node Slave node

Shielded  
    cable

Shielded  
    cable

Terminal 
 resistor
(120 ohm)

Terminal 
 resistor
(120 ohm)

 
 

 AS-FEN02 

With its own standalone communication port, the module can work independently and can be set as a 
MODBUS TCP server, Client or EtherNet/IP Adapter. After installing the extension card, go to the HWCONFIG 
in ISPSoft to set up the communication.  

 
 Wiring example 

 Linear Topology 

 
 Star Topology 

 
 Ring Topology 

A DLR function is required to create a ring topology.  

 

When a switch is needed for topology, the switch 
should support the DLR function. If not, the 
connection might fail. 
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2.9.2 Extension Card Profiles 

 AS-F2AD/AS-F2DA/AS-F422/AS-F485 

37 23.9
59

.3
60

.8

1 5

  
Unit: mm 

Pin no. AS-F2AD AS-F2DA AS-F422 AS-F485 

1 V1+ VO1 R+ - 
2 I1+ IO1 R- - 
3 V2+ VO2 T+ D+ 
4 I2+ IO2 T- D- 
5 COM COM SG SG 

 AS-F232/AS-FCOPM 

AS-F232 AS-FCOPM 

37 23.9

59
.3

66
.3

1 5

6 9

 

61
.3

37

59
.3

23.9

12345678

18

 
Unit: mm 

Pin no. AS-F232 AS-FCOPM 

1 - CAN_H 

2 TX CAN_L 
3 RX GND 
4 - - 
5 GND - 

6-9 - - 
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 AS-FEN02 

1

88

42

61.5

25.2

2

3
4

5

6
 

Number Name Description 

1 MS indicator 

Indicates if the module has been set 
ON: the setting is complete 
Blinking: the setting is not complete 
OFF: no power 

2 NS indicator 

Indicates the status of Ethernet connection 
Green lignt ON: a CIP connection is established 
Green lignt BLINKING: a CIP connection is not established 
Red light ON: duplicated IP address 
Red light BLINKING: communication timeout / DLR conection  

 lost / IP address change 
OFF: no power / network cable is not connected 

3 RJ-45 port X1/X2 Use for network connections  

4 LINK indicator X1/X2 
Indicate the status of Ethernet connection 
Green light ON: a network connection is established 
OFF: a network connection is not established 

5 ACT indicator X1/X2 
Indicate the status of Ethernet communication 
Orange BLINKING: data transmission  
OFF: no data transmission  

6 Clip ring Secures AS series 

 
 
RJ-45 Pin Definition  

1 TX+ 2 TX- 3 RX+ 4 N/C 

 
5 N/C 6 RX- 7 N/C 8 N/C 

 
 

2.9.3 Function Card Weights 

 AS-F2AD AS-F2DA AS-F422 AS-F485 AS-F232 AS-FCOPM AS-FEN02 
Weight 30g 30g 22g 29g 26g 29g 51g 
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2.10 Power Supply Module Specifications  
2.10.1 General Specifications 

 AS-PS02/AS-PS02A 

Item Specifications 

Supply voltage 
100–240 VAC (-15% to +10%) 
50/60 Hz±5% 

Action 
specifications 

If the input power supply is larger than 85 VAC, the power supply module can 
function normally. 

Allowable 
instantaneous 
power failure time 

If the instantaneous power failure time is less than 10 milliseconds, the power 
supply module keeps running. 

Fuse 2.5A/250 VAC 

Inrush current ＜70A@115 VAC 

24 VDC output 
AS-PS02: 2 A for internal use: the CPU and the modules.  
AS-PS02A: 1.5 A for internal use: the CPU and the modules;  
           0.5 A for external use. 

Power protection The 24 VDC output is equipped with the short circuit protection and the 
overcurrent protection. 

Surge voltage 
withstand level 

1,500 VAC (Primary-secondary), 1,500 VAC (Primary-PE), 500 VAC 
(Secondary-PE) 

Insulation voltage 
Above 5 MΩ  
The voltage between all inputs/outputs and the ground is 500 VDC. 

Ground The diameter of the ground should not be less than the diameters of the cables 
connected to the terminals L and N. 

Weight 
AS-PS02 270 g 
AS-PS02A 310 g 

 

2.10.2 Power Supply Module Profiles 
 AS-PS02 

70

8898
.3

1

4

2

3

INPUT

Wait 5 seconds after removing

LG WARNING

Risk of electrical shock.

power before servic ing.

N

L

PS02

POWER

74.2
77.9

75
91.5

5
5
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 AS-PS02A 

70

8898
.3

1

4

2

3

74.2
77.9

75
91.5

5
5

OUTPUT

INPUT

PS02A

POWER

LG WARNING
Risk of electrical shock.
Wait 5 seconds after removing
power before servicing.

N
L

24G
+24V

OUTPUT

INPUT

+24V
24G

Risk of electrical shock.

LG

L
N

WARNING

POWER

PS02A

power before servicing.

 
 

Number Name Description 

1 
POWER LED 
indicator (green) 

Indicates the status of the power supply 

2 Model name Model name of the power supply module 

3 Terminal Terminal for wiring 

4 
Arrangement of the 
terminals 

+24V: connecting external 24VDC + 
24G: connecting external 24G 
LG: Line ground 
L/N: AC power input 

5 Power output Connected with AS series 
 

2.10.3 Power Supply Module Terminals 
 AS-PS02 
 

POWER

PS02

INPUT

WARNING

INPUT

power before servicing.
Wait 5 seconds after removing
Risk of electrical shock.

L
N
LGLG WARNING

Risk of electrical shock.

power before servicing.

N
L

PS02

POWER

 

 L/N: AC power input 
 LG: Line ground 
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 AS-PS02A 
 

OUTPUT

INPUT

PS02A

POWER

LG WARNING
Risk of electrical shock.
Wait 5 seconds after removing
power before servicing.

N
L

24G
+24V

OUTPUT

INPUT

+24V
24G

Risk of electrical shock.

LG

L
N

WARNING

POWER

PS02A

power before servicing.

 

 +24V: connecting external 24VDC + 
 24G: connecting external 24G 
 L/N: AC power input 
 LG: Line ground 
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Before developing an AS Series system, install ISPSoft and COMMGR. ISPSoft is a software platform for integrating 

the hardware, network configuration, and program development for a system. COMMGR functions as middleware 

between a computer and devices. It functions as a communication management interface between ISPSoft and AS 

Series hardware. 

3.1 Installing and Uninstalling ISPSoft 

 System requirements 

Item System requirement 

Operating system Windows XP / VISTA / 7 / 8 / 10 

CPU Pentium 1.5 G or above 

Memory 256 MB or above (512 MB or above is recommended.) 

Hard disk drive Capacity : 500 MB or above 

CD-ROM drive This is optional for installing ISPSoft. 

Monitor 
Resolution: 800×600 or above  

(suggested setting: 1024x768/96 dpi) 

Keyboard/Mouse A general keyboard/mouse or devices compatible with Windows 

Printer A printer with a driver for Windows. This is needed to print projects. 

RS-232 port For connecting to a PLC 
One of them is used, but a PLC that is 

connected must have a corresponding port. (*1) 
USB port For connecting to a PLC 

Ethernet port For connecting to a PLC 

Communication 

software 
COMMGR, a communication manager, must be installed. (*2) 

Supported Models  
AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series PLCs)/ AS series, AC 

motor drives: VFD with PLC built-in series, and Text panel HMI with PLC built-in series. 

*1. ISPSoft supports several ways to connect a computer to a PLC.  Make sure the port and the mode supported by 

the PLC are correct before you connect a computer to the PLC. 

*2. Please refer to section 3.2 for more information about COMMGR. 

*3. The functions and specifications mentioned above are only applicable to ISPSoft version 3.00 or above. The older 

versions are not equipped with complete functions. 
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3.1.1 Installing ISPSoft 

If an older version of ISPSoft has been installed on a computer, uninstall it before you install ISPSoft. Refer to section 

3.1.2 for more information about uninstalling ISPSoft. The following are the steps to install ISPSoft. 

(1) Start the Windows operating system and then install ISPSoft. You may need administrative privileges to install the 

software. 

(2) Put the ISPSoft CD in the CD-ROM drive, or download the installation program from 

http://www.delta.com.tw/ch/index.asp. Before you install the installation program downloaded from the website, 

you must decompress the file. 

(3) Click Start, and then click Run… to open the Run window. Specify the path to the file called setup.exe in the 

Open box, and then click OK. You can also double-click the setup icon to execute the installation program. 

 

 

(4) After the ISPSoft x.xx – Install Shield Wizard window appears, click Next. 

 
 

 

 

 

 

http://www.delta.com.tw/ch/index.asp


AS Ser ies Operat ion Manual  

3-4 

_3 

(5) Type the necessary information in the User Name and Organization boxes, and then click Next. 

 
 

(6) Leave the default path unchanged, or click Change… to change the path. Click Next. 

 
 

(7) Check the installation information, and then click Install. 
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(8) After ISPSoft is installed, the install program creates shortcuts on the desktop and the Start menu. Click Finish to 

complete the installation. 
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3.1.2 Uninstalling ISPSoft 

(1) There are two methods to uninstall ISPSoft. 

 Method 1: Open the Control Panel window, and click Add or Remove Programs.  In the Currently 

installed programs dialog box, click ISPSoft x.xx, and then click Remove. 

 

 

 Method 2: Start>Programs>Delta Industrial Automation>PLC>ISPSoft x.xx>Uninstall 

 

 

(2) Click Yes to remove ISPSoft.  
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3.2 Installing and Uninstalling COMMGR 

3.2.1 Installing COMMGR 

If an older version of COMMGR has been installed on a computer, uninstall it before you install COMMGR. Refer to 

section 3.2.2 for more information about uninstalling COMMGR. The following are the steps to install COMMGR. 

(1) Start the Windows operating system and then install ISPSoft. You may need administrative privileges to install the 

software. 

(2) Put a COMMGR CD in the CD-ROM drive, or download the installation program from 

http://www.delta.com.tw/ch/index.asp. Before you install the program downloaded from the website, you must 

decompress the file. 

(3) Click Start, and then click Run… to open the Run window. Specify the path to the file called setupComm.exe in 

the Open box, and then click OK. You can also double-click the setup Comm icon to execute the installation 

program. 

 

 
(4) After the COMMGR x.xx – Install Shield Wizard window appears, click Next. 

 

http://www.delta.com.tw/ch/index.asp
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(5) Type the necessary information in the User Name and Organization boxes, and then click Next. 

 
 

(6) Check the installation information, and then click Install. 

 
 

(7) After you install COMMGR, the installation program creates a shortcut to the program on the Start menu. Click 

Finish to complete the installation. 
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3.2.2 Uninstalling COMMGR 

(1) There are two methods to uninstall COMMGR. 

 Method 1: Open the Control Panel window, and click Add or Remove Programs. In the Currently installed 

programs box, click COMMGR x.xx, and then click Remove. 

 

 

 Method 2: Start>Programs>Delta Industrial Automation>Communication>COMMGR>Uninstall 

 

 

(2) Click Yes to remove COMMGR. 
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4.1 Installation 

4.1.1 Installing a Module 

1. Press the clip rings if they are out as the image 1 shown. Push the module to the desire position 
until you hear a click to finish installation.  

2. Link the I/O modules on the right side of the PLC and make sure they are hooked together. Push the 
modules into the DIN rail until you hear a click.  

3. After you installed the module, fasten the screws on the modules to secure the module on the DIN rail. 

1

1

     

2

 

 

 
If there is a vibration source near the installation site, install anti-vibration baffles on the sides of the AS Series 
modules for better stabilization, such as the gray baffles show below. 
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 Install the baffles: 

 Hook the baffle onto the DIN rail and press it down as the directional arrow shows below.  

 

 

 

 Use screws to secure the baffle.  
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 The completed baffle installation is shown below. 

 

4.1.2 Installing a Removable Terminal Block 

Install the removable terminal block on the module as shown below. 

 Installation 

1. Align the terminal block at the printed circuit board, and press it into the module. 

 

 Removal 

1. Pull the clips down in the direction shown by the arrow, and then pull the terminal block up 

as shown below. 
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4.2 Wiring 

4.2.1 Wiring a Power Supply Module 

A power supply module supplies direct current to a CPU module and I/O modules.  

 Connecting an AC power cable 

+24V
24G

LG

L
N

PS02A AS Series 06XA

24V
0V

Control Box

     100~240V

 

 The alternating-current input voltage is either 100 VAC or 240 VAC. Connect the power supply to the 

terminals L and N. If the 110 VAC or the 220 VAC power supply is connected to the input terminals +24V 

and 24G, the PLC will be damaged. 

 If power is interrupted for less than 10 milliseconds, the PLC keeps running without being affected. If a 

power interruption lasts for longer, or if the voltage of the power supply decreases, the PLC stops running, 

and there is no output. When the power supply returns to normal, the PLC resumes. Notice that there are 

latched auxiliary relays and registers in the PLC when you write the program. 

 Use single-wire cables or two-wire cables in a diameter of 22 AWG~18 AWG and with less than 2 mm 

pin-typed terminals. Only use copper conducting wires with a temperature of 60/75°C. 

 
 
 
 

4.2.2 Wiring I/O Modules 

The I/O modules include digital input/output, analog input/output, and network modules. Follow the directions 
for the wiring of I/O modules in Chapter 5 of the AS Series Hardware Manual. 
 

22-18AWG< 2mm 8-10mm
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5.1 Introduction of Devices 

This section describes the values and strings processed by the PLC. It also describes the functions of devices 

that include input, output, and auxiliary relays, as well as timers, counters, and data registers. The PLC 

simulates external devices in the PLC’s internal memory, so the word “device” is a generic name that refers to 

all the internal memory locations in the PLC. A device can be a bit device or a word device. Bit devices simulate 

coils, contacts and flags, while word devices simulate registers.  

5.1.1 Device Table 

Type Device name Number of devices Range 

Bit device 

Input relay X 1024 X0.0–X63.15 

Output relay Y 1024 Y0.0–Y63.15 

Data register 
D 48,0000 D0.0–D29999.15 

W 48,0000 W0.0–W29999.15 *4 

Auxiliary relay M 8192 M0–M8191 

Special auxiliary relay SM 4096 SM0–SM4095 

Stepping relay S 2048 S0–S2047 

Timer T 512 T0–T511 

Counter C 512 C0–C511 

32-bit counter HC 256 HC0–HC255 

Word device 

Input relay X 64 X0–X63 

Output relay Y 64 Y0–Y63 

Data register 
D 30000 D0–D29999 

W 30000 W0–W29999 *4 

Special auxiliary relay SR 2048 SR0–SR2047 

File register FR 65536 FR0–FR65535 

Timer T 512 T0–T511 

Counter C 512 C0–C511 

32-bit counter HC 256（512 words） HC0–HC255 

Index register E 
10 E0–E9 

5 E10–E14 *4 

Constant*1 Decimal system K 
16 bits: -32768 to 32767 

32 bits: -2147483648 to 2147483647 
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Type Device name Number of devices Range 

Constant*2 

Hexadecimal system 16# 
16 bits: 16#0–16#FFFF 

32 bits: 16#0–16#FFFFFFFF 

Single-precision 

floating-point number 
F 32 bits: ±1.17549435-38 to ±3.40282347+ 38 

String*3 String “$” 1–31 characters 

*1: Constants are indicated by K in the device lists in Chapter 5 and Chapter 6 in the AS Series Programming 

Manual. An example when “K50” appears in the AS Series Programming Manual, enter only the number 50 in 

ISPSoft. 

*2: Floating-point numbers are indicated by F/DF in the device lists in Chapter 5 and Chapter 6 in the AS Series 

Programming Manual, but they are represented by decimal points in ISPSoft. For example, for the floating-point 

number F500, enter 500.0 in ISPSoft.  

*3: Strings are indicated by “$” in Chapter 5 and Chapter 6 in the AS Series Programming Manual, but they are 

represented by quotes (“ ”) in ISPSoft. For example, for the string 1234, enter “1234”in ISPSoft. 

*4: This is used for editing in ISPSoft only.  

5.1.2 Basic Structure of I/O Storages 

Device Function 
Access by 

bits 

Access by 

words 

Modify by 

ISPSoft 
Force the bit ON/OFF

X Input relay OK OK OK OK 

Y Output relay OK OK OK OK 

M Auxiliary relay OK - OK - 

SM 
Special auxiliary 

relay 
OK - OK - 

S stepping relay OK - OK - 

T Timer OK OK OK - 

C Counter OK OK OK - 

HC 32-bit counter OK OK OK - 

D Data register OK OK OK OK 

SR Special data register - OK OK - 

FR File register - OK*1 - - 

E Index register - OK OK - 

*1: Use an instruction for writing to an FR.   
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5.1.3 Relation Between the PLC Action and the Device Type 

Device type 

PLC action 

Non-latched area Latched area 

Device Y Other devices File register Other devices 

Power: OFF→ON Cleared Cleared Retained Retained 

Restore to defaults Cleared Cleared Cleared Cleared 

STOP 

↓ 

RUN*1 

This clears the  

non-latched area 

state. 

Cleared Cleared Retained Retained 

This retains the 

non-latched area 

state. 

Retained Retained Retained Retained 

RUN 

↓ 

STOP*1 

This clears the  

device Y state. 
Cleared Retained Retained Retained 

This retains the 

device Y state. 
Retained Retained Retained Retained 

SM204 is ON.This clears all 

non-latched areas. 
Cleared Cleared Retained Retained 

SM205 is ON.This clears all 

latched areas. 
Retained Retained Retained Cleared 

*1: For state setups, see HWCONFIG in ISPSoft. The PLC STOP->RUN default is “clear the non-latched area 

state”. The PLC RUN->STOP default is “clear the state of device Y”.  

 

5.1.4 Latched Areas in the Device Range 

Device Function Device range Latched area 

X Input relay X0–X63 All devices are non-latched. 

Y Output relay Y0–Y63 All devices are non-latched. 

M*1 Auxiliary relay M0–M8191 The default range is M6000–M8191. 

SM Special auxiliary relay SM0–SM2047 

Some devices are latched and cannot be 

changed. 

Refer to the list of special auxiliary relays for 

more information. 

S*1 Stepping relay S0–S1023 The default range is S512–S1023 

T Timer  T0–T511 All devices are non-latched. 
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Device Function Device range Latched area 

C*1 Counter C0–C511 The default range is C448–C511 

HC*1 32-bit counter HC0–HC255 The default range is HC128–HC255 

D*1 Data register 
D0–D29999 The default range is D20000–D29999 

W0–W29999 Use this for editing in ISPSoft only. 

FR File register FR0–FR65535 All devices are latched. 

SR Special data register SR0–SR2047 

Some are latched and cannot be changed. Refer 

to the list of special data registers for more 

information. 

E Index register 
E0–E9 All devices are non-latched. 

E10–E14 Use this for editing in ISPSoft only. 

*1: For the latched area setups, see HWCONFIG in ISPSoft. Setting the latched area means the other areas 

show as non-latched areas. The range of latched areas cannot exceed the device range. For example, if 

you set the M600–M7000 as latched areas, M0–M5999 and M7001–M8191 become non-latched areas. 

5.2. Device Functions 

Procedure for processing the program in the PLC: 

Input terminal X

Device memory

Processin g th e prog ram

D
evice m

em
ory

Regenerating the output s ignal
and sending it to the output terminal

 

Regenerating the input signal 

Device memory

 Regenerating the input signal 

1. Before executing the program, the external input signal 

state is read into the memory for the input signal.  

2. When the program is executed, the state in the 

memory location for the input signal does not change 

even if the input signal changes from ON to OFF or 

from OFF to ON. The input signal is not refreshed until 

the next scan begins. 

 Processing the program 

After the input signal is refreshed, the instructions in the 

program are executed in order from the start address of the 

program. The results are stored in the device memories.  

 Regenerating the state of the output  

After the instruction END is executed, the device memory 

state in the device memory is sent to the specified output 

terminal. 
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5.2.1 Values and Constants 

Name Description 

Bit A bit is the basic unit in the binary system. Its state is either 1 or 0. 

Nibble 
A nibble is composed of four consecutive bits (for example b3–b0). Nibbles can 

represent 0–9 in the decimal system or 0–F in the hexadecimal system. 

Byte 
A byte is composed of two consecutive nibbles (i.e. 8 bits, b7–b0). Bytes can 

represent 00–FF in the hexadecimal system. 

Word 
A word is composed of two consecutive bytes (i.e. 16 bits, b15–b0). Words can 

represent 0000–FFFF in the hexadecimal system. 

Double word 

A double word is composed of two consecutive words (i.e. 32 bits, b31–b0). 

Double words can represent 00000000–FFFFFFFF in the hexadecimal 

system. 

 
The relation among bits, nibbles, bytes, words, and double words in the binary system is shown below. 

b31b30 b29 b28 b27b26 b25 b24b23 b22 b21 b20b19 b18 b17 b16 b15 b14 b13 b12b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

NB0NB1NB2NB3NB4NB5NB6NB7

BY3 BY2 BY1 BY0

W1

DW

W0

Double word

Word

Byte

N ibble

Bit
 

The PLC uses four types of values to execute the operation according to different control purposes. The 
following illustrates the values of these functions.: 

1. Binary number (BIN) 

The PLC uses the binary system to operate the values. 

2. Decimal number (DEC) 

The PLC uses decimal numbers for; 

 The setting value of a timer (T) or the setting value of a counter (C/HC); for example, TMR C0 50 
(constant K). 

 The device number; for example, M10 and T30 (device number) 

 The number before or after the decimal point; for example, X0.0, Y0.11, and D10.0 (device 
number). 

 The constant K: used as the operand in an applied instruction. For example, MOV 123 D0 
(constant K). 
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3. Binary-coded decimal (BCD) 

A decimal value is represented by a nibble or four bits, so that sixteen consecutive bits represent a 
four-digit decimal value.  

4. Hexadecimal number (HEX) 

The PLC uses hexadecimal numbers for;  

 the constant 16#: used as the operand in an applied instruction; for example, MOV 16#1A2B D0 
(hexadecimal constant). 

 

The following table shows the corresponding values. 

Binary Number 

(BIN) 

Decimal Number 

(DEC) 

Binary Code Decimal 

(BCD) 

Hexadecimal Number 

(HEX) 

PLC internal execution 
Constant K,  

Device number 
BCD related instruction 

Instant 16#,  

Device number 

0000 0 0000 0 

0001 1 0001 1 

0010 2 0010 2 

0011 3 0011 3 

0100 4 0100 4 

0101 5 0101 5 

0110 6 0110 6 

0111 7 0111 7 

1000 8 1000 8 

1001 9 1001 9 

1010 10 - A 

1011 11 - B 

1100 12 - C 

1101 13 - D 

1110 14 - E 

1111 15 - F 

10000 16 0001 0000 10 

10001 17 0001 0001 11 
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5.2.2 Floating-point Numbers 

The floating-point numbers are represented by decimal points in ISPSoft. For example, the floating-point 
number of 500 is 500.0.  Refer to Section 2.2.2 in the AS Series Programming Manual for more information. 

5.2.2.1 Single-precision Floating-point Numbers 

Floating-point numbers are represented by the 32-bit register. The representation adopts the IEEE754 
standard, and the format is as follows.  

S Exponent Mantissa

8-bit 23-bi t

b31 b0

Sign b it
0: Positive
1: Negative  

Equation:   127;.121   BMBES

 

The single-precision floating-point numbers range from ±2-126 to ±2+128, and correspond to the range from 
±1.1755×10-38 to ±3.4028×10+38. 

The AS series PLC uses two consecutive registers to form a 32-bit floating-point number. Take (D1, D0) for 
example. 

S E7 E6 E5 E1 E0 A22 A21 A20 A6 A5 A4 A3 A2 A1 A0

b0b1b2b3b4b5b6b20b21b22b23b24b28b29b30b31

2 2 2 2 2 2 2 2 2 2 2 2 22 2

D1(b15~b0) D0(b15~b0)

Exp on en t ( 8 b its) Ma nt issa (2 3b its)

Ma nt issa sign b it (0 : Po sit ive; 1: Ne ga tive)
W hen b 0~b3 1 a re zeros, the con te nt is zero .

T he pos it ion w here the d eci mal point  is  hid den

 

Example 1: 

23 is represented by a single-precision floating-point number. 

Step 1: Convert 23 into the binary number, i.e. 23.0=10111. 

Step 2: Normalize the binary number, i.e. 10111=1.0111 ×24 (0111 is the mantissa, and 4 is the exponent.).  

Step 3: Get the value of the exponent. 

∵ E-B=4→E-127=4 ∴ E=131=100000112 

Step 4: Combine the sign bit, the exponent, and the mantissa to form the floating-point number. 

0 10000011 011100000000000000000002=41B8000016 
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Example 2: 

-23 is represented by a single-precision floating-point number. 

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point 
number, except that the sign bit is 1.  

1 10000011 011100000000000000000002=C1B8000016 

 

5.2.2.2 Decimal Floating-point Numbers 

-23 is represented by a single-precision floating-point number. 

Converting -23.0 into the floating-point number uses the same steps as converting 23.0 into the floating-point 
number, except that the sign bit is 1.  

1 10000011 011100000000000000000002=C1B8000016 

 

5.2.2.2 Decimal Floating-point Numbers 

 Single-precision floating-point numbers and double-precision floating-point numbers can be converted 

into decimal floating-point numbers so people can read them. However, the PLC uses single-precision 

floating-point numbers and double-precision floating-point numbers internally. 

 A 32-bit decimal floating-point number is represented by two consecutive registers. The constant is 

stored in the register whose number is smaller while the exponent is stored in the register whose number 

is bigger. Take (D1, D0) for example. 

10Decimal f loating-po in t number=[Constant        ]*D0
[Exponent      ]D1

 

Base number D0=±1,000 to ±9,999 

Exponent D1=-41–+35  

The base number 100 does not exist in D0 because 100 is represented by 1,000×10-1. 32-bit decimal 

floating-point numbers range from ±1175×10-41 to ±402×10+35. 
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5.2.3 Strings 

The PLC can process strings composed of ASCII codes (*1). A complete string begins with a start character 
and ends with an ending character (NULL code). Strings can be a maximum of 31 characters, and the ending 
character 16#00 is added automatically in ISPSoft.  

1. No string (NULL code) is moved. 

 

D0=0 (NULL) 

 

2. The string has an even number of characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 

 

3. The string has an odd number if characters. 

 

D0 16#62 (b) 16#61 (a) 

D1 16#64 (d) 16#63 (b) 

D2 0 (NULL) 16#65 (e) 
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*1: ASCII code chart 

Hex 0 1 2 3 4 5 6 7 8 9 A B C D E F 

ASCII                 

Hex 10 11 12 13 14 15 16 17 18 19 1A 1B 1C 1D 1E 1F 

ASCII                 

Hex 20 21 22 23 24 25 26 27 28 29 2A 2B 2C 2D 2E 2F 

ASCII SP ! " # $ % & ' （ ） * + ， - . / 

Hex 30 31 32 33 34 35 36 37 38 39 3A 3B 3C 3D 3E 3F 

ASCII 0 1 2 3 4 5 6 7 8 9 ： ; < = > ? 

Hex 40 41 42 43 44 45 46 47 48 49 4A 4B 4C 4D 4E 4F 

ASCII @ A B C D E F G H I J K L M N O 

Hex 50 51 52 53 54 55 56 57 58 59 5A 5B 5C 5D 5E 5F 

ASCII P Q R S T U V W X Y Z      

Hex 60 61 62 63 64 65 66 67 68 69 6A 6B 6C 6D 6E 6F 

ASCII ` a b c d e f g h i j k l M n o 

Hex 70 71 72 73 74 75 76 77 78 79 7A 7B 7C 7D 7E 7F 

ASCII p q r s t u v w x y z { | } ~  

Note:  represents an invisible character. Please do not use it. 

 

5.2.4 Input Relays (X) 

 Input function  

The input is connected to the input device (external devices such as button switches, rotary switches, and 

number switches), and PLC reads the input signal. You can use input contact A or contact B several times 

in the program, and the ON/OFF input state varies with the ON/OFF input device state. 

 Input number (the decimal number): 

For the PLC, the input numbers start from X0.0. The number of inputs varies with the number of inputs on 

the digital input/output modules. The inputs are numbered according to the order in which the digital 

input/output modules are connected to the CPU module. The maximum number of inputs for the PLC is 

8192, and the input number range is between X0.0 and X511.15. 

 Input type 

Inputs are classified into two types. 

1. Regenerated inputs: PLC reads the state of a regenerated input before the program is executed.  For 

example, LD X0.0. 
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2. Direct input: The state of a direct input is read by the PLC during the execution of the instructions. For 

example, LD DX0.0. 

 

5.2.5 Output Relays (Y) 

 Output function 

The output sends the ON/OFF signal to drive the load connected to the output, such as an external signal 
lamp, a digital display, or an electromagnetic valve. There are four types of outputs: relays, transistors 
(NPN and PNP), and TRIACs (thyristors). You can use the output contact A or contact B several times in 
the program. Use output Y only once in the program; otherwise, according the PLC’s program-scanning 
principle, the state of the output depends on the circuit connected to the last output Y in the program.  

 Output number (the decimal number) 

For the PLC, the output numbers start from Y0.0. The number of outputs varies with the number of outputs 
on the digital input/output modules. The outputs are numbered according to the order in which the digital 
input/output modules are connected to the PLC. The maximum number of outputs on the PLC is 1024, and 
the range is between Y0.0 and Y63.15. 

An output that is not used as an output device can be used as a general device.  

 Output types  

Outputs are classified into two types. 

1. Regenerated output: The state of a regenerated output is not written until the program executes the 
instruction END according to the states of the outputs. For example, OUT Y0.0. 

2. Direct output: The state of a direct output is written by the PLC during the execution of the instructions 
according to the states of the outputs. For example, OUT DY0.0. 

 

5.2.6 Auxiliary Relays (M) 

The auxiliary relay has contact A and contact B. It can be used several times in the program. You can combine 

the control loops with the auxiliary relay, but you cannot drive the external load with the auxiliary relay. You can 

use the auxiliary relays in either of two ways. 

1. For general use: In general use, if an electrical power interruption occurs when the PLC is running, 

the auxiliary relay is reset to OFF. When the power is restored, the auxiliary relay 

remains OFF. 

2. For latched use: In latched use, if an electrical power interruption occurs when the PLC is running, 

the state of the auxiliary relay states for latched use is retained. When the power 

supply is restored, the state remains the same as before the power interruption. 
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5.2.7 Special Auxiliary Relays (SM) 

Every special auxiliary relay has its own specific function. Refer to section 2.2.7 in the AS Series Programming 

Manual for more information. 

5.2.8 Stepping Relays (S) 

You can easily see the stepping relay in industrial automation to set the procedure. It is the most basic device in 

sequential function chart (SFC) programming. Refer to the ISPSoft User Manual for more information on using 

sequential function charts. 

There are 2048 stepping relays, (S0–S2047). Every stepping relay is like an output relay in that it has an output 

coil, contact A, and contact B. You can use it several times in the program, but the relay cannot directly drive 

the external load. You can use the stepping relay as a general auxiliary relay when it is not used in a sequential 

function chart. 

5.2.9 Timers (T) 

 100 millisecond timer: The timer specified by the instruction TMR takes 100 milliseconds as the timing unit. 

 1 millisecond timer: The timer specified by the instruction TMRH takes 1 millisecond as the timing unit. 

 The accumulative timers are ST0–ST511. If you want to use the device-monitoring function, these timers   

can monitor T0–T511. 

 If you use the same timer repeatedly in a program, including in different instructions TMR and TMRH, the 

timer setting value is the one that the timer matches first. 

 If you use the same timer repeatedly in a program, the timer is OFF when one of the conditional contacts is 

OFF. 

 If you use the same timer in a program as the timer for a subroutine’s exclusive use and an accumulative 

timer in the program, it is OFF when one of the conditional contacts is OFF. 

 When the timer is switched from ON to OFF and the conditional contact is ON, the timer is reset and 

counts again. 

 When the instruction TMR is executed, the specified timer coil is ON and the timer begins to count. When  

the value of the timer matches the timer setting value (value of the timer ≧ setting value), the contact state 

is ON. 
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A. General-purpose timer 

When the instruction TMR is executed, the general-purpose timer begins to count. When the value of the 

timer matches the timer setting value, the output coil is ON. 

 When X0.0=ON and the timer takes 100 ms as the timing unit, the output coil T0 is ON when the 

value of the timer = setting value100.  

 When X0.0=OFF or the power is off, the value of the timer is 0 and the output coil T0 is OFF.  

 

X0.0

T0(PV)

Y0.0

SV:K100

10  sec

 

B. Accumulative timer 

When the instruction TMR is executed, the accumulative timer begins to count. When the value of the 

timer matches the timer setting value, the output coil is ON. As long as you add the letter S in front of the 

letter T, the timer becomes an accumulative timer. When the conditional contact is OFF, the value of the 

accumulative timer is not reset. When the conditional contact is ON, the timer counts from the current 

value. 

 When X0.0=ON and the timer T250 takes 100 ms as the timing unit, the output coil T250 is ON 

when the value of the timer = timer setting value100.  

 When X0.0=OFF or the power is off, the timer T250 stops counting, and the value of the timer stays 

the same. When X0.0=ON, the value of the timer is accumulating value When the accumulated 

value = timer setting value 100, the output coil T250 is ON.  
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X0.0

T2

Y0.0

SV: K100

T1+T2=10 sec

T250(PV)

T1

 

C. Timer used in the function block 

Use the T412–T511 timers for the function block or the interrupt. 

When the instruction TMR or END is executed, the timer used in the functional block begins to count. 

When the value of the timer matches the timer setting value, the output coil is ON. 

If you use the general-purpose timer is used in the function block or the interrupt, and the functional or 
interrupt is not executed, the timer cannot count correctly. 

 

5.2.10 16-bit Counters 

 Characteristics of the 16-bit counter 

Item 16-bit counter 

Type General type 

Number C0–C511 

Direction Counting up 

Setting value 0–32,767 

Specificying the counter setting value
The setting value can be either the constant or the value in the data 

register. 

Change of the current value 
The counter stops counting when the value of the counter matches 

the setting value. 



AS Ser ies Operat ion Manual  

5-16 

_5 

Item 16-bit counter 

Output contact 
The contact is ON when the value of the counter matches the setting 

value. 

Reset 
When the instruction RST is executed, the current value is cleared to 

zero, and the contact is reset to OFF. 

Action of the contact After the scan completes, the contact acts. 

 Counter function 

Each time the input switches from OFF to ON, the value of the counter is the same as the output coil. Use 

either the decimal constant or the value in the data register as the counter setting value. 

 16-bit counter: 

1. Setting range: 0–32,767. The setting values 0 and 1 both mean the same thing in that the output contact is 

ON when the counter counts for the first time. 

2. For the general-purpose counter, the current value of the counter is cleared when there is a power 

interruption. If the counter is latching, the current value of the counter and the state of the contact before 

the power interruption are retained. The latched counter counts from the current value when the power 

supply is restored. 

3. If you use the instruction MOV or ISPSoft to transmit a value bigger than the counter setting value to the 

current value register C0, the contact of the counter C0 is ON and the current value becomes the same as 

the counter setting value next time X0.1 switches from OFF to ON. 

4. Use either the constant or the value in the data register as the counter setting value. 

5. The counter setting value can be a positive or negative value. If the counter counts up from 32,767, the 

next value is 0. 

Example:  
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1. When X0.0=ON, the instruction RST will be executed and the current value of C0 will be reset to zero and 

the output contact of the counter C0 will be FF. 

2. When X0.1 is from OFF to ON, the value of the counter increases by one increment.   

3. When the value of the counter C0 reached the setting value 5, the contact of the counter C0 will be ON (the 

current value of C0 = the setting value = 5). After that the trigger from X0.1 will not be accepted by C0 and 

the current value of C0 will stay at the value 5.   

X0.0

X0.1

Y0.0,C0 

C0 ( PV)

0
1

2
3

4
5

(SV)

0

 

 

5.2.11 32-bit Counters (HC) 

 Characteristics of the 32-bit counter 

Item 32-bit counter 

Type Up/down counter Up counter High-speed counter 

Number HC0–HC63 HC64–HC199 HC200–HC255 

Direction Counting up/down Counting up Counting up/down 

Setting value -2,147,483,648 to +2,147,483,647 

Specification of the 

setting value 

The setting value can be either the constant or the value occupying two data 

registers (32-bit). 

Change of the current 

value 

The counter keeps counting even after the value of the counter matches the setting 

value. 

Output contact 

The contact is ON when the value of the addition counter matches the setting value.

The contact is reset to OFF when the value of the subtraction counter matches the 

setting value. 

Reset 
When the RST instruction is executed, the current value is cleared to zero, and the 

contact is reset to OFF. 
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Item 32-bit counter 

Action of the contact After the DCNT instruction scan is complete, the contact activates. 

 32-bit general-purpose addition/subtraction counter 

1. Setting range: -2,147,483,648 to 2,147,483,647 

2. The switch between the 32-bit general-purpose addition counters and the 32-bit general-purpose 

subtraction counters depends on the states of the special auxiliary relays SM621–SM684. For example, 

the counter HC0 is the addition counter when SM621 is OFF, but HC0 is the subtraction counter when 

SM621 is ON. Use either the constant or the value in the data registers as the setting value for the counter, 

and the setting value can be a positive or a negative number. If you use the value in the data registers as 

the setting value of the counter, the setting value occupies two consecutive registers. 

3. For the general-purpose counter, the current value of the counter is cleared when there is a power 

interruption. If the counter is latched, the current value of the counter and the state of the contact before 

the power interruption are retained. The latched counter counts from the current value when the power 

supply is restored. 

4. If the counter counts up from 2,147,483,647, the next current value is -2,147,483,648. If the counter counts 

down from -2,147,483,648, the next current value is 2,147,483,647. 

 32-bit high speed addition/subtraction counter 

Refer to the DCNT instruction description (API 1004) in the AS Series Programming Manual for more details. 

Example:  
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1. X10.0 drives SM621 to determine counting direction (up/down) of HC0. 

2. When X11.0 goes from OFF to ON, RST instruction executes, the PV in HC0 is  cleared to 0, and its 

contact is OFF.  

3. When X12.0 goes from OFF to ON, PV of HC0 counts up (plus 1) or down (minus 1). 

4. When PV in HC0 changes from -6 to -5, the contact HC0 goes from OFF to ON. When PV in HC0 changes 

from -5 to -6, the contact HC0 goes from ON to OFF. 

5. If you use the MOV instruction in ISPSoft to designate a value bigger than SV to the PV register of HC0, 

then the next time the X12.0 goes from OFF to ON, the contact HC0 is ON and PV of HC0 equals SV. 

X10.0

X11.0

X12.0

 When t he output c ontact w as O N 

Y0.0,
HC0 Contacts

HC0 
( )PV

Accumulatively
increasing Progressive ly

decreasing

0
1

2
3

4
5

4
3

2
1

0
-1

-2
-3

-4
-5

-6
-7

-8

0

-7
-6

-5
-4

-3

Accumulatively
increasing

 

 

5.2.12 Data Registers (D) 

The data register stores 16-bit data. The highest bit represents either a positive sign or a negative sign, and the 

values that you can store in the data registers are between -32,768 to +32,767. Two 16-bit registers can be 

combined into a 32-bit register, that is, (D+1, D) in which the register whose number is smaller represents the 

lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the values that you can 

store in the data registers are between -2,147,483,648 to +2,147,483,647. Four 16-bit registers can be 

combined into a 64-bit register; that is, (D+3, D+2, D+1, D) in which the register whose number is smaller 

represents the lower 16 bits. The highest bit represents either a positive sign or a negative sign, and the values 

which can be stored in the data registers are between -9,223,372,036,854,776 to +9,223,372,036,854,775,807. 

You can also use the data registers to refresh the values in the control registers in the modules other than 

digital I/O modules. Refer to the ISPSoft User Manual for more information about refreshing the values in the 

control registers. 
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The registers can be classified into two types according to their properties. 

1. General-purpose register: when the PLC begins to run or is disconnected, the value in the register  clears 

to zero. To retain the data when the PLC begins to RUN, refer to the ISPSoft User Manual for more 

information. Notice that the value still clears to zero when the PLC is disconnected. 

2. Latched register: if the PLC is disconnected, the data in the latched register is not cleared. In other words, 

the value before the disconnection is still retained. To clear the data in the latched area, use the RST or 

ZRST instruction.  

 

5.2.13 Special Data Registers (SR) 

Every special data register has its definition and specific function. Refer to section 2.2.14 in the AS Series 

Programming Manual for more information. 

 

5.2.14 Index Register (E) 

The index register is a 16-bit data register. Like the general register, you can read data from it and write data 

into it. However, it is mainly used as the index register. The index registers range from E0–E9. Refer to section 

4.4 in the AS Series Programming Manual for more information about using index registers. 

 

5.2.15 File Registers (FR) 

The AS Series PLC provides you with file registers for storing larger numbers of parameters. You can edit, 

upload, and download the system parameters with ISPSoft. You can read the values in a file register can be 

read while operating the PLC. Refer to the MEMW instruction (API 2303) in the AS Series Programming 

Manual for more information about how to write to a file register.  
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6.1 Quick Start 

This chapter provides a simple example showing you how to create a traditional ladder diagram in ISPSoft.  

Because you may not be familiar with IEC 61131-3 and may not understand the functions provided by ISPSoft, 

the chapter does not introduce programming concepts related to IEC 61131-3.  For example, the chapter does 

not include POUs, function blocks, variables, and so on.  

6.1.1 Example 

When the equipment in this example operates, the parts on the conveyor move from left to right. If a sensor 

senses that a part is under an injector, the PLC sends a trigger signal to the injector, and the injector injects the 

glue. The injection length is set externally and is not controlled by the PLC program . However, the PLC 

program must be able to turn the trigger signal OFF so that the trigger signal can be sent next time. There are 

two injectors above the conveyor, and the two injectors inject glue in the same way. 

There is a sensor at the left side of the conveyor. When a part passes the sensor, the sensor value increases 

by one increment. When the sensor value is 100, the internal completion flag is set to ON. The flag state can be 

used by other procedures later. However, this example does not introduce the use of flag states. 

 

 

6.1.2 Hardware 

In this example, the AS series CPU module used is the AS332T-A. 

Type ID Description 

Digital input X0.0 START button 

Digital input X0.1 STOP button 

Digital input X0.2 In position sensor 1 

Digital input X0.3 In position sensor 2 

Digital input X0.4 Counting sensor 
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Type ID Description 

Digital output Y0.0 Conveyer 

Digital output Y0.1 Trigger signal for injector 1 

Digital output Y0.2 Trigger signal for injector 2 

 

6.1.3 Program 

(1) When the START button (X0.0) switches from OFF to ON, the internal operation flag is set to ON, and the 

conveyor (Y0.0) starts. When the STOP button (X0.1) switches from OFF to ON, an error occurs (the error 

flag is ON), the operation flag is reset to OFF, and the conveyor stops. 

(2) When the in position sensor 1 (X0.2) is ON, the trigger signal for injector 1 (Y0.1) is set to ON. When the in 

position sensor 1 is OFF, the trigger signal for injector 1 is reset to OFF. 

(3) When the in position sensor 2 (X0.3) is ON, the trigger signal for injector 2 (Y0.2) is set to ON. When the in 

position sensor 2 is OFF, the trigger signal for injector 2 is reset to OFF. 

(4) When the counting sensor (X0.4) switches from OFF to ON, the sensor value increases by one increment. 

If the sensor value is larger than or equal to 100, the internal completion flag is set to ON. 
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6.2 Procedure for Creating a Project in ISPSoft 

This section shows you the procedure for creating a project in ISPSoft. You can adjust the procedure according 

to your needs. 

 

 

 Hardware configuration 

You set the parameters such as a range of latched devices and a port number in a PLC. You configure the 

modules with an AS300 Series CPU module, and set the parameters in these modules. 

 Network configuration 

If a system uses a network architecture, or devices need to exchange data, use the network configuration 

tool NWCONFIG in ISPSoft to configure a network and exchange data with COM as well as Ethernet.  

 Programming 

After you write a program in ISPSoft, compile the program. If the compiling is unsuccessful, messages in 

the Compile Message page show where the errors occur. 

 Testing and debugging 

Download the compiled program, the hardware configuration, and the network configuration to a PLC. You 

can then test and debug the program online with the functions provided by ISPSoft. 

Because the example introduced in this chapter does not discuss a network configuration, you only perform the 

following procedure.  
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6.4 Hardware Configuration 

After you double-click HWCONFIG in the project management area, the HWCONFIG window appears. 

 

 
6.4.1 Configuring a Module 

In the HWCONFIG window, the default setting is with a CPU module. Refer to Chapter 8 for more information.   

6.4.2 Setting the Parameters 

After you double-click the CPU module or the extension module, the Device Setting dialog box appears with 
the module information.  
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6.5 Creating a Program 

The following sections show you how to create a traditional ladder diagram in ISPSoft. The sections include 

creating a POU, editing a traditional diagram, and compiling a program. 

6.5.1 Adding a Ladder Diagram 

(1) Right-click Programs in the project management area, point to POU (program organization unit), and then 
click New…. 

 

(2) In the Create Program dialog box, type a program name in the POU Name box, select Ladder Diagram 

(LD) in the Language section, and keep the other default values. Click OK after the setting is complete. A 

new program organization unit (POU) appears under Programs in the project management area.  

 

 



(3) After you ad

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

After the pr

describes t

Icon 

 

 

 

 

 

 

 

 

 

 

dd the POU, a

rogram editing

he functions. 

Keybo

Sh

Sh

Sh

Sh

Sh

Sh

Typing

a program edit

g window open

oard shortcut

hift+Ctrl+C 

None 

hift+Ctrl+A 

hift+Ctrl+B 

hift+Ctrl+P 

hift+Ctrl+N 

Ctrl+I 

hift+Ctrl+I 

ESC 

 an instruction

L

Pr

ting window a

ns, the corresp

t 

Displa

Displa

Activa

Adds 

delete

Goes 

Goes 

Puts a

Put a 

Selec

n Insert

Loc al symbol ta

rogram edit ing

ppears in the 

ponding toolba

ay/hides the c

aying/hides th

ates/deactivate

a bookmark to

es a bookmark

to the previou

to the next bo

a network abo

network unde

cts an item 

ts a contact 

able

g area

Chapter  

main working 

ar appears in t

Function

omments on t

e commands o

es the selecte

o the selected

k from the sele

us bookmarke

ookmarked po

ove the selecte

er the selected

6 Wr i t ing 

 area. 

the window. T

n 

the networks 

on the device

ed network 

d network sele

ected network

ed position 

osition 

ed network 

d network 

a Program

6-9

The list below 

 

s 

ected or 

k 

 

 

6__



_6 

AS Ser ies 

6-10 

Icon

 

 

 

 

*. Refer t

 
6.5.2 Ba

(1) Click 

cursor ch

Decide w

you wan

In this ex

red fram

 

Operat ion 

n Key

 Typ

 Typ

 Typ

 Typ

 Typ

 

o Section 6.5.3

asic Editi

 on the tool

hanges to a co

where to inser

nt to edit. The s

xample, you d

me and click the

Manual  

yboard shortc

ing an instruct

ing an instruct

ing an instruct

ing an instruct

ing an instruct

Shift+Ctrl+U 

3 for more info

ing ─ Crea

lbar, and then 

ontact when th

rt a contact. If 

system autom

do not need to 

e left mouse b

 

cut 

tion Ins

tion Ins

tion Se

tion 
Ins

(NP

tion 
Se

(NP

Ins

rmation about 

ating a C

move the mo

he mouse curs

you edit a lad

matically arrang

decide where

button. 

serts a coil 

serts a compa

elects a type of

serts a block lo

P/PN/INV/FB

elects a type of

P/PN/INV/FB

serts an instru

typing an inst

ontact an

ouse cursor to 

rsor is moved t

der diagram, 

ges an inserte

e to insert the 

 

Func

rison contact

f comparison 

ogic instruction

B_NP/FB_PN)

f block logic in

B_NP/FB_PN)

ction or a func

truction. 

nd a Coil 

the red frame

to the left, righ

the mouse cu

ed object; you 

contact. Place

tion 

contact 

n 

 

nstruction 

 

ction block 

e in Network 1

ht, or bottom o

rsor must be n

cannot move 

e the mouse c

. The mouse 

of the red fram

near a position

the object. 

cursor near the

 

me. 

n 

e 



(2

(3

) Click  

The items o

Trigger. In 

) Click the lin

the red fram

Decide whe

In this exam

frame and c

on the toolba

on the list are 

this example,

ne at the right 

me. The mous

ere to insert th

mple, you do n

click the left m

r, or press Esc

Normally Op

 click Rising-

side of the co

e cursor chan

he coil. 

not need to de

mouse button.

c on the keybo

pen, Normally

-edge Trigger

ontact, click 

ges to a coil w

ecide where to

oard. After you

y Close, Risin

r. 

 on the too

when the mous

o insert the coi

Chapter  

u double-click 

ng-edge Trigg

olbar, and then

se cursor is ab

l. Place the m

6 Wr i t ing 

k the contact, a

ger, and Fallin

n move the mo

bove or under 

mouse cursor n

a Program

6-11

a list appears.

ng-edge 

 

ouse cursor to

the red frame

near the red 

 

 

 

6_

 

o 

e. 

_



_6 

AS Ser ies 

6-12 

(4) Click 

items on

(5) Click ??

jump to t

to compl

coil. 

 

Operat ion 

 on the tool

n the list are O

? above the c

the next box in

lete the editing

Manual  

lbar, or press 

Out, Set, and R

contact, type a

n the network.

g. In this exam

Esc on the key

Reset. In this e

a device addre

 After you type

mple, type X0.0

yboard. After y

example, click

 
 

ess in the box,

e a device add

0 in the box fo

 

you double-cli

k Set. 

 and then pre

dress in the bo

or the contact, 

ick the coil, a l

ss Enter on th

ox, press Esc 

and type M0 i

list appears. T

 

he keyboard to

on the keyboa

in the box for 

 

The 

o 

ard 

the 



Ad

Af

ed

bo

ke

If y

Th

mo

inf

 
6

Cl

se

Cr

(1

dditional rem

fter you click a

dit the next box

oxes. After you

eyboard to exit

you have decl

he symbols on

ouse or the up

formation abo

.5.3 Ba

ick  on th

elected networ

reate a contac

) Click the lin

mark 

a network and 

x in the netwo

u finish the ed

t editing. 

lared symbols

n the drop-dow

p/down key on

ut symbols. 

asic Editin

he toolbar to s

rk. In this exam

ct and a coil by

ne in Network 

press Enter o

rk. Press Tab 

iting, press En

s, click  in 

wn list are the 

n the keyboard

ng ─ Inse

select a netwo

mple, Network

y clicking 

2. 

on the keyboa

on the keyboa

nter on the key

a box, or pres

symbols that 

d. Refer to Ch

erting a N

ork. Click 

k 2 is under Ne

 and  o

rd, you can ed

ard to select th

yboard to jum

ss Page Down

you can assig

apter 6 in the 

Network a

 on the toolba

etwork 1. 

n the toolbar o

Chapter  

dit a box. Pres

he next networ

p to the next b

n on the keybo

gn to the objec

ISPSoft User 

and Typin

ar to place ano

or by typing in

6 Wr i t ing 

ss Enter on the

rk. Use the ke

box. Press Es

oard when you

ct. Select a sym

r Manual for m

ng an Inst

other network

nstructions. 

a Program

6-13

e keyboard to 

eyboard to edit

c on the 

u edit the box.

mbol with the 

more 

 

truction 

k above the 

 

 

 

 

6_

t 

. 

_



_6 

AS Ser ies 

6-14 

(2) Type the

a box wh

click OK

(3) Type the

 

Additional re

You create a 

typed are not

 To Insert a

Operat ion 

e IL instruction

hich you can e

K at the right si

e IL instruction

emark 

contact and a

t case-sensitiv

a normally-ope

Manual  

 “LD M0”. This

edit appears. A

ide of the box

n “OUT Y0.0”, 

a coil by typing

ve. 

en contact (con

s instruction is

After you finish

. 

and write the 

g simple instru

ntact A), type 

s not case-sen

h typing the IL

 
program show

 

uctions. Refer 

“A <device ad

 

 

nsitive. As soo

L instruction, p

wn below. 

to the descrip

ddress>” 

n as you type 

press Enter on

ption below. Th

 

the IL instruct

n the keyboard

 

 

he instructions

tion,  

d or 

s 



 

 

6

Be

cu











To

als

de

ne

fra

 

To insert a no

To insert an o

.5.4 Bas

efore you sele

ursor appears 

 Select the n

 Select the in

 Select the n

 Select the o

 Select the b

o select a grou

so select the g

evice, and then

etwork, and the

ame. 

ormally-closed

output coil (OU

sic Editin

ect an object in

as a small arr

etwork 

nput contact 

etwork 

output coil 

block 

up of devices, 

group of devic

n pressing Ctr

e devices mus

 contact (cont

UT), type “O <d

ng ─ Sele

n a network, p

row, click the o

click a device

ces by clicking

rl+B on the key

st be adjacent

tact B), type “B

device addres

ecting a 

ress Esc on th

object in the n

e and drag it to

g the first devic

yboard. You m

t to one anoth

B <device add

ss>” 

 Network

he keyboard, o

etwork. The b

o draw a frame

ce, pressing C

must draw a fra

er. Input and o

Chapter  

dress>” 

k and Op

or click  o

basic selection

e around the g

Ctrl+B on the k

ame around d

output devices

6 Wr i t ing 

 

 

peration 

on the toolbar

n shows below

group of devic

keyboard, click

devices that ar

s cannot be in

a Program

6-15

r. After the 

w. 

es. You can 

king the last 

re in the same

n the same 

 

 

6_

e 

_



AS Ser ies Operat ion Manual  

6-16 

_6 

 

To select several networks, press and hold the Ctrl key on the keyboard and click the networks. You can also 

select a range of networks by pressing and holding Shift on the keyboard, clicking the first network within the 

range, and then clicking the last network within the range. 

 

Right-click an object after selecting it to show the context menu. 

Item Function 

Undo 
Undo the last action. 

You can undo up to 20 previous actions. 

Redo You can redo an action that has been undone. 

Cut Cut a device, block, or network. 

Copy Copy a device, block, or network. 

Paste Paste an object that has been copied or cut into the present position. 

Paste right 
Paste an object at the right side of the selected position. 

The object is connected in series to the selected position. 

Paste under 
Paste an object under the selected position. 

The object is connected in parallel to the selected position. 

Delete Delete a device, block, or network. 

Activate/Inactivate 

Network 

Activate or deactivate the selected network. 

The deactivated network is ignored when you compile the program. 
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*1. The program above saves in the folder …\ISPSoft x.xx\Project\Example\Gluing_System_C. 

*2. Refer to Chapter 8 in the ISPSoft User Manual for more information about creating a ladder diagram. 

 
 
6.5.10 Checking and Compiling a Program 

After you write a program, check the syntax of the programming language or compile the program. The syntax 

and structure in the present window are checked after you run the Check function. The system checks the 

entire project after you run the Compile function. If the system does not find any errors in the project, it 

automatically generates execution code. After you successfully compile the program, the mother line at the left 

side of the ladder diagram becomes black. 

 



_6 

AS Ser ies 

6-24 

 Check 

From th

 Compile

From th

 

After you com

the project, th

system autom

function after

 

Operat ion 

he Compile m

e 

he Compile m

mplete the che

he Compile M

matically show

r you correct t

Manual  

menu, click Ch

menu, click Co

eck, the Comp

Message wind

ws you where t

he error. 

 

heck, or 

ompile, or 

pile Message

ow shows the

the error occu

on the toolba

 on the toolb

 page shows t

e related mess

urs. You can ru

ar. 

bar. 

the check resu

sage. After you

un the Check

ult. If there are

u click the mes

function or the

 

 

 

e any errors in

ssage, the 

e Compile 

n 



6

6

Be

In 

IS

Op

Yo
2.4

(1

(2

(3

(4

6.6 Test

.6.1 Cre

efore you dow

this example,

PSoft User M

peration Manu

ou can skip th
4 in the ISPS

) Install the m

that the wir

) Connect the

module is in

number is a

) Make sure 

If the icon r

shortcut on

COMMGR)

) Double-clic

in the COM

ting and

eating a C

wnload a progra

, connect ISPS

anual for more

ual for more in

his section if 
oft User Man

modules on the

ring is correct, 

e CPU module

nstalled on the

assigned to De

that COMMG

representing C

 the Start me

). 

ck the icon rep

MMGR window

d Debug

Connectio

am and param

Soft to the CP

e information 

nformation abo

you have co
ual. 

e main backpl

and then pow

e to the comp

e computer, D

elta PLC. Ref

R is started an

COMMGR is n

nu (Start > Pr

resenting COM

w to create a d

gging a 

on 

meters to a PL

PU module AS3

about connec

out wiring. 

onnected ISPS

lane to match 

wer on the CP

uter with a US

Delta PLC app

fer to Appendi

nd the icon re

not displayed o

rograms > De

MMGR on the

river. 

Program

LC or monitor t

332T-A with a

cting ISPSoft to

Soft to a PLC

the hardware 

U module. 

SB cable. If the

pears in the De

x A for more in

presenting CO

on the system

elta Industria

e system tray t

Chapter  

m 

them online, c

USB cable. R

o a PLC in oth

C successfully

configuration 

e USB driver f

evice Manage

nformation abo

OMMGR is dis

tray, start CO

l Automation

o open the CO

6 Wr i t ing 

connect ISPSo

Refer to Sectio

her ways. Refe

y as describe

 in HWCONFI

for the AS ser

er window, an

out installing a

splayed on the

OMMGR by cli

n > Communic

OMMGR wind

a Program

6-25

oft to the PLC.

on 2.4 in the 

er to the AS 

ed in Section 

IG. Make sure

ies CPU 

d a port 

a USB driver.

e system tray. 

cking the 

cation > 

 

ow. Click Add

 

 

 

6_

. 

e 

d 

_



_6 

AS Ser ies 

6-26 

(5) Set the p

 Type

 Sele

 Sele

PLC

 Sele

of A

(6) After you
OK appe

(7) Click the

Tools m

driver yo

informat

Operat ion 

parameters in 

e a driver nam

ect USB (Virtu

ect a communi

 and its comm

ect the number

Auto-retry box

u finish the se
ears in the Sta

e driver you cr

menu, click Com

ou created in t

ion displays in

Manual  

the Driver Pr

e in the Drive

ual COM) in th

cation port in 

munication por

r of times to re

x, and select a 

tup, USB_Driv
atus column.  

reated in the C

mmunication

he Driver list,

n the ISPSoft s

roperties dialo

er Name box.

he Type list in 

the COM Por

rt display in the

etry the sendin

retry interval 

ver appears in

COMMGR win

n Settings…. I

 select 0 in th

status bar. 

og box, and th

the Connecti

rt list. If the firs

e COM Port li

ng of a comma

in the Time In

n the COMMG

dow, and then

In the Commu

e Station Add

hen click OK.

 

on Setup sec

st two steps a

ist. 

and if a conne

nterval of Aut

GR window. W

n click Start. S

unication Set

dress list, and

ction. 

re complete, t

ection error oc

to-retry box. 

hen the conne

 

Start ISPSoft, a

tting dialog bo

d then click OK

the connected

ccurs in the Tim

ection is norm

and then on th

ox, select the 

K. The driver 

 

me 

al, 

he 



Chapter  6 Wr i t ing a Program 

6-27 

6_

 

 

 

 

 

 

 

 

 

 

 

(8) On the PLC menu, click System Information. ISPSoft retrieves related information from the PLC. If the 

computer communicates with the CPU module normally, the related information retrieved from the PLC 

displays in the System Information dialog box. 

 

 

6.6.2 Downloading a Program and Parameters 

If ISPSoft is correctly connected to a PLC, you can download the parameters and program in the project to the 

PLC. First, start ISPSoft and open the project you created in the previous sections. In this example, you 

download two types of parameters to the CPU module: hardware configuration and the program itself. 



AS Ser ies Operat ion Manual  

6-28 

_6 

 Downloading the hardware configuration 

(1) Double-click HWCONFIG in the project management area to open the HWCONFIG window. 

 

(2) The hardware configuration displays in the window. Before you download the hardware configuration 

to the CPU module, make sure the actual hardware configuration is the same as the hardware 

configuration in the window. 

(3) On the Options menu, click Download, or  on the toolbar. The Transfer Items dialog box 

appears. Click OK to download the hardware configuration to the CPU module. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) After you successfully download the hardware configuration to the CPU module, the BUS FAULT LED 

indicator on the CPU module is OFF. Close the HWCONFIG window. If the BUS FAULT LED indicator 

on the CPU module is still ON or blinking, the CPU module is in an abnormal state. Make sure the 

actual hardware configuration is the same as the hardware configuration in the HWCONFIG window, 

and refer to the operation manual for more information about eliminating the error. Refer to Chapter 8 

for more information about HWCONFIG. 
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 Method 2 

Right-click Device Monitoring Table in the project management area, and click New. 

 

Type a table name in the Add Monitor Table dialog box, and then click OK. An item appears under Device 

Monitor Table in the project management area. Double-click the item to open the monitoring table. You can 

create several monitoring tables in the project, and the monitoring tables are saved with the project. 

 

 

After you double-click the item, a item monitoring window appears. You can add items to be monitored to the 

window. To add an item to the window, double-click the blank space in the monitoring table, type a device name, 

type a start address, and the number of devices to be monitored in the Device Monitor Input dialog box. You 

can add up to 100 items to a monitoring table. 
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Press Insert on the keyboard to switch between inserting and replacing an item in the monitoring table. The 

selected mode displays in the status bar in ISPSoft. 

If you select insert mode, the new item is added above the selected item in the monitoring table. If you select 

replacement mode, the new item overwrites the selected item in the monitoring table. 

 

To hide certain columns in the monitoring table, right-click the monitoring table, point to Set the Fields, and 
clear certain items. After you clear an item, the corresponding column disappears.

 

The following describes the columns in the monitoring table. 

Column Description 

Source Source of a symbol 

Identifier Identifier of a symbol 

Device name Name of a monitored device  

Status State of a monitored bit device or a contact (ON or OFF). 

 



_6 

AS Ser ies 

6-36 

Colum

Data type 

Value (16 

Value (32 

Float 

Radix 

Comment 

 

After you cre

Right-click an

context menu

item in this co

You can text 

section. Refe

program. 

 

Operat ion 

mn 

Dat

bits) In o

bits) In o

In o

Sele

Dis

ate the monito

n item in the m

u in the progra

ontext menu. 

and debug the

er to Chapter 1

Manual  

ta type of a m

online mode, 

online mode, 

online mode, 

ect a format 

play the com

oring table, yo

monitoring tabl

am editing win

e program you

17 in the ISPS

 

monitored sy

displays a 1

displays a 3

displays a 3

to represent

mments on a 

ou can monitor

le in online mo

ndow. You can

u created in th

Soft User Manu

Descrip

mbol. 

6-bit value.

32-bit value.

32-bit floating

t a value. 

device or on

r the items in t

ode to display

n change the it

is chapter thro

ual for more in

ption 

g-point numb

n a symbol. 

the monitoring

y a context me

tem state or th

ough the moni

nformation abo

ber. 

g table in onlin

nu which is th

he item value b

toring table yo

out testing and

ne mode. 

he same as the

by clicking an 

 

ou created in t

d debugging a

e 

this 

a 



Chapter  6 Wr i t ing a Program 

6-37 

6_

6.7 Setting a Real-time Clock 

After you connect an AS Series CPU module to a computer, you can set the real-time clock in the CPU module 

through ISPSoft. 

(1) On the Tools menu, click Set RTC. 

 

 

(2) Select Computer, and then click Synchronize to complete setting the real time clock. 
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7.1 Overview of Memory Cards 

The AS Series CPU modules support standard MicroSD cards that meet the specifications in this chapter. This 

chapter describes the specifications and usage for the MicroSD cards supported by the AS series CPU 

modules. 

7.1.1 Appearances of Memory Cards 

SD cards are classified into three types according to size: SD cards, MiniSD cards, and MicroSD cards. AS 

Series CPU modules support MicroSD cards. 

 

7.1.2 Memory Card Specifications  

SD cards are also classified into three types according to capacity: SD cards, SDHC cards, and SDXC cards. 

The AS Series currently only supports a maximum of 32GB in FAT32 format. SD card families are shown in the 

table below. The Micro SDHC in the SDHC column indicates the specifications supported by the AS Series. Be 

sure to purchase products that meet these specifications. 

 SD card families  

Type SD SDHC SDXC 

Capacity 32 MB~2 GB 4 GB~32 GB 32 GB~2 TB 

File 

system 
FAT16/FAT32 FAT32 exFAT (FAT64) 

Size SD SDHC Mini SDHC Micro SDHC SDXC Micro SDXC 

Speed 

class 

rating 

N/A 

CLASS 2 (Min. 2 MB/Sec.) 

CLASS 4 (Min. 4 MB/Sec.) 

CLASS 6 (Min. 6 MB/Sec.) 

CLASS 10 (Min. 10 MB/Sec.) 

CLASS 2 (Min. 2 MB/Sec.) 

CLASS 4 (Min. 4 MB/Sec.) 

CLASS 6 (Min. 6 MB/Sec.) 

CLASS 10 (Min. 10 MB/Sec.) 
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7.2 Before using a Memory Card 

7.2.1 Formatting a Memory Card 

You may need to format a new SDHC memory card with the FAT32 file system before you use it for the first 

time.  You cannot use an unformatted SDHC memory card in an AS Series CPU module. 

The following example introduces the most common way to format an SDHC card: formatting an SDHC card 

through a card reader. Also carefully read the documents provided by the SDHC card manufacturer. 

 

(1) Insert the SDHC card into a card reader. The operating system detects a new storage device. 

(2) Right-click the new storage device, and then click Format. 

(3) You must format the memory card with the FAT32 file system. Do not change any other default settings. 

Click Quick Format, and then click Start. 

(4) After you click OK in the warning window, the SDHC card formats. 

 

7.3 Installing and Removing a Memory Card 

7.3.1 Memory Card Slot in a CPU Module 

The memory card slot is on the front side of the AS Series PLC.  

 
Memory Card Slot

 

 

When you format a memory card, you also delete all the data in the memory card. Verify whether you 
need to back up the data in a memory card before you format the memory card. 
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7.3.2 Installing a Memory Card 

Insert a memory card into the CPU module memory card slot and push it in until it clicks. Be sure the memory 

card is fixed firmly in the slot; if the memory card is loose, it is not installed correctly. The memory card can only 

be inserted in one direction. Do not force the memory card or you may damage the CPU module. The correct 

way to insert the memory card is shown below. 

 

 

 
 
 

 

 

 

 
 
 

  

     

7.3.3 Removing a Memory Card 

You can remove a memory card by pushing it in. The card then springs from the slot. 

 

 
 
 

 

 

 

 
 
 

 
 

 

7.4 Memory Card Contents  

7.4.1 Initializing a Memory Card 

When you insert an SDHC card into a CPU module that is powered on, the system initializes the SDHC card, 

and creates a default folder named according to the model of the CPU module. 

When the system initializes an SDHC card, it automatically adds any missing folders to the directory structure. 

However, if the initialization of a SDHC card fails, you cannot initialize the SDHC card again until you reformat 

it.  

When you initialize a memory card, the SYSTEM LED indicator blinks. 
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7.4.2 Folder Structure in a Memory Card 

The image below shows the default folder group created by an AS System. The folder name is AS300. Several 

subfolders are contained inside the AS300 folder. Related files created by you and the AS system are stored in 

the subfolders. 

 

Folder Description 

Firmware Stores firmware files (.mot) 

Log Stores Log files (.log) 

SysDup Stores backup files (.dup) 

UserProg Stores device memory files (.txt, .dmd, .csv) 

DevMem, Setup Reserved for the system use 

 

PLC CARD SD Card Root 
AS300 Firmware

Log 

SysDup 

DevMem

Setup 

UserProg 
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7.5 Introduction to the CARD Utility 

The AS Series CPU modules include SDHC slots, and you can back up and restore module data with a 

memory card. ISPSoft includes the CARD Utility for the AS Series CPU modules. With this utility, you can back 

up and restore data in an AS Series CPU module or backup and restore an ISPSoft project. The backup can 

include the program code, parameter settings, hardware configuration, and network configuration, as well as 

the values in the devices in an AS series CPU module. Refer to Section 7.7.1 in the Operation Manual for more 

information about the specifications and usage of SDHC cards with AS Series CPU modules. 

 
The list below describes the functions supported by the CARD Utility, including a flowchart. 

 If you export data from an AS Series CPU module as a backup file (*.dup), you can save the exported data 

in the memory card in the module or in a folder on the computer. You can also decide whether to back up the 

values in the devices in the AS Series CPU module. 

 If you export an ISPSoft project for an AS Series CPU module as a backup file (*.dup), you can only save the 

exported ISPSoft project in a folder in the computer. You can see data such as register editing (*.dvl), device 

status editing (*.dvb), file register editing (*.wft) for the AS Series as values in the device and back them up. 

You can put a memory card with the backup file into the AS series CPU module. You can copy a backup file 

(*.dup) saved on the computer into the AS series CPU module connected to the computer, or restore the 

backup file to an ISPSoft project. If you choose to restore the backup file to an ISPSoft project, the system 

automatically skips the values in the devices and the hardware configuration in the backup file.  

 If you restore the backup file (*.dup) from the PC to an ISPSoft project for an AS Series CPU module, you 

can also restore data such as register editing (*.dvl), device status editing (*.dvb), and file register editing 

(*.wft) for the AS Series.  
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7.6 Backing Up a Project 

If the backup source or backup destination is an AS Series CPU module or memory card, make sure that 

ISPSoft is connected to the AS Series CPU module. During backup, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After the backup is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information. 

(1) Double-click CARD Utility in the project management area to open the CARD Utility wizard. 

(2) Select the Backup (To DUP File) option button in the CARD Utility wizard and then click Next. 

 

(3) Select a backup source, and then click Next. 

a. If you select the CPU (Need Connection), the backup file is stored in the memory card.  
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b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click 

 and select an isp file in the Open dialog box. If the program in the isp file selected is not compiled, a 

message appears when you back up the isp file. Open the isp file with ISPSoft, compile the program in the 

isp file, and then save the isp file. After the program in the isp file is compiled, you can back up the isp file. 

 

 

(4) After you select CPU (Need Connection) / ISP Project (Compiled and saved), click Next,  

a. If you select the CPU (Need Connection), a prompted window appears. And you need to decide 

whether to back up the values in devices on the AS Series CPU module that is connected to ISPSoft. 

 

b. If you select the ISP Project (Compiled and saved), the backup file is stored in your computer. Click  

and select an isp file in the Open dialog box and then decide the file path where you’d like to store the backup 

file in your computer and then define its file name.  
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(5) Select a backup destination. If the backup source is an ISPSoft project, the backup destination must be a 

computer. 

a. If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file path is Root directory of the memory card\AS300\SysDup\AUTOEXEC.dup. 

 

b. If you select PC (DUP File), click , select a folder in the Save in list in the Save As dialog box, and 

type a filename in the File name box. When you select the backup source for the ISPSoft Project, set 

the PLC password. You can set the password to be the same as the Project password, set a new PLC 

password, or not set a PLC password. If you do not set a password for the Project, the PLC password 

is also not set. When you select Setting new PLC password, the wizard looks like the following 

image. And you can set new PLC password and number of the attempt times.  
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(6) After that you can see the summary. Make sure that the summary in the CARD Utility wizard is 

consistent with the data backup you want to perform, and then click Execute.  

 

(7) The AS Series CPU module still performs the data backup even if you click Cancel. You can turn off the 

AS Series CPU module to stop the data backup; however, the backup file produced is not a complete 

backup file, and you must delete the backup file from the memory card. 

If you select Memory Card (PLC Side), the filename of the backup file is AUTOEXEC.dup, and the 

backup file path is Root directory of the memory card\AS300\SysDup\AUTOEXEC.dup. If there is an 

old backup file in the memory card, the Warning message appears. Click Replace, Archive, or Cancel in 

the Warning message. 

 

If the backed up data is protected by passwords, these passwords are also backed up. 

Data backup Description 

CPU module Memory card 
The backed up data includes the PLC ID and the PLC password set 

in the CPU module. 

ISPSoft project Computer 
The backed up data includes the program ID and the project 

password set in the ISPSoft project. 
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(8) After you perform the data backup, click Home or Close in the CARD Utility wizard. 

 

 

7.7 Restoring a Project 

If the restoration source or restoration destination is an AS Series CPU module or memory card, make sure that 

ISPSoft is connected to the AS Series CPU module. During restoration, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF. Refer to Section 2.4 in the ISPSoft User Manual for more information. 

(1) Double-click CARD Utility in the project management area to open the CARD Utility wizard. 

(2) Select Restore (From DUP File) in the CARD Utility wizard and then click Next.  
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(3) Select a restoration source, click  and then select a backup file to be restored. 

 

a. If you select Memory Card (PLC side) (Need Connection), the backup files in the memory card 

display in a window after you click . Double-click a backup file in the window to choose it. 

b. If you select PC side (Need Connection), the backup files in the PC display in a window after you 

click . Double-click a backup file in the window to choose it. 
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(4) Select a restoration destination, and then click Next.  

a. To put the selected backup file into the AS Series CPU module, select CPU (Need Connection). If the 

restoration source is the CPU (Need Connection), the restoration destination must be the AS Series 

CPU module. 

b. If you select ISP Project, click , and then specify a filename and a path. If the path specified point 

to a file that already exists, the file is overwritten when you restore the data. 

 

(5) Make sure that the summary in the CARD Utility wizard is consistent with the data restoration you want 

to perform and then click Execute. 

 

If you click Cancel in the process of restoring data to the AS Series CPU module, the data is not 

completely restored. The AS Series CPU module still performs the data restoration even if you click 
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Cancel in the process of restoring a backup file in the memory card. You can turn off the AS Series CPU 

module to stop the data restoration from being performed. To prevent the AS Series CPU module from 

operating incorrectly, restore the AS Series CPU module to the factory setting, or perform the data 

restoration again.  

The restoration source or restoration destination may contain a password and an ID. The following table 

describes the password and the ID process. 

Data restoration Description 

Memory cardCPU module 

a. The ID in the backup file must be the same as the ID in the CPU 

module; otherwise the data is not restored. 

b. If there is a PLC password in the CPU module, the password in the 

backup file must be the same as the PLC password in the CPU 

module. Otherwise the data is not restored. 

c. If there is no PLC password in the CPU module, and there is a 

password in the backup file, the system restores the data, and the 

password in the backup file becomes the PLC password in the 

CPU. 

Computer ISPSoft project 
The ID and the password in the backup file become the program ID 

and the project password in the ISPSoft project. 
 

(6) After you perform the data restoration, click Home or Close in the CARD Utility wizard. 
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7.8 Restoration Starts Once CPU is supplied with Power 

When the backup file in the memory card is consistent with the specific path and file name, the CPU can 

perform restoration once it is supplied with power. During restoration, the CPU LED and Error LED blinks 

alternatively and SM452 flag is ON. After restoration is done, the CPU LED and Error LED stops blinking and 

SM452 flag is OFF.  

 

Operation Steps: 

(1) Set up the backup file path and file name for the memory card backup file. The filename of the backup file 

is AUTOEXEC.dup and the root directory path of the memory card is \PLC 

CARD\AS300\SysDup\AS300_BACKUP.dup 

(2) Insert the memory card into the card slot when the CPU power is off.  

(3) When the CPU power is on, it automatically checks if the memory card data is consistent with the PLC data. 

If not, the restoration begins. The data check is specifically on the data in CPU programs and HWCONFIG 

parameters.     

(4) During the restoration, the CPU LED and Error LED blinks alternatively. Once the restoration is done, the 

blinking stops.  

 

7.9 CPU Error Log  

The system stores CPU error messages in the memory card whenever the quantity of the error messages 

reached to 20. You can also use special flag SM36 and special device SR36 to read the CPU error messages 

and state change logs. If there is error logs recorded in the memory card, the memory card keeps storing the 

error logs. You can change the file path to store other error logs or change the file name to store other error 

logs.   

Special Device Function Code Description 

SR36 

a. when the value is 0, it indicates there is no recording.  
b. when the value is 1234, it indicates the logs are stored in the memory card.  
c. when the value is 3456, it indicates the error logs and state change logs are stored in 

the memory card.  

 

Operation Steps to read CPU error logs and state change logs: 

Make sure the memory card is in the slot before reading the CPU error logs and state change logs.  

(1) Set SM36 to ON and the value in SR36 to 1234 or 3456 to read the CPU error logs and state change logs.  

(2) The root directory path of the memory card for error log is \PLC CARD\AS300\Log\Error.log 

(3) Use ISPSoft to read the error logs. ISPSoft Tools -> Review Error Log File -> Open Log File  
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8.1 Hardware Configuration Tool for AS Series Modules - 
HWCONFIG 

HWCONFIG is a built-in hardware configuration tool in ISPSoft. You can configure racks, set CPU and module 

parameters, download/upload parameters, detect a hardware configuration online, and make a diagnosis through 

HWCONFIG. 

You must download all parameters set in HWCONFIG to the CPU module for them to take effect.  

8.1.1 Introduction of the HWCONFIG Environment  

In ISPSoft, double-click HWCONFIG in the project management area to start HWCONFIG. 

 

 
 Product list: Available hardware is listed in the catalog.

 System configuration area: This is the main working area. You can configure and set the entire system in this 

area. 

 Information list: This shows information about the present system configuration.  
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The system configuration area displays the present system configuration. You  configure and set up the modules in 

this area. You can add extension modules to the right side of the AS Series CPU module. The CPU module also has 

function card slots for more versatile solutions. For the function card settings, go through the CPU module. Refer to 

Section 8.2 for function card configurations. When you modify the configuration in the system configuration area, the 

information in the information list updates. 

 
 
 
 
 
 
 
 
 
 
 
 

All available hardware is listed in the product list. After you click a section in the product list, it shows all devices 

belonging to that section. If you click a device, the specifications for the device appear under the product list. 

 

Delta Electronics provides you with specific configuration tools for some CPU modules. You can use tools such as 

Ethernet/IP or EtherCAT to set advanced parameters for network assignments for the modules. For advanced setup, 

right-click the CPU module in the system configuration area, click Communication Software, and then choose tools 

such as EIP Builder for Ethernet/IP configurations. You must save the configurations in HWCONFIG before opening 

the tools. Note that you cannot work in HWCONFIG while editing in the tools. Some tools require a separate 

installation, and the software shows a message if a tool needs to be installed.  

Function Cards

Extension Modules
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Refer to the manuals for the communication software tools for more information on setting up communications.  

 

8.1.2 Configuring a Module 

8.1.2.1 Adding a Module 

 Method 1 
Click a module from the product list and drag it to a vacant slot in the backplane in the system configuration area. The 

AS Series is not a backplane design, and you can place extension modules on the right side of the CPU module. You 

can only place the power module on the left side of the CPU module, and you can install only ONE power module.  

Position for Power Modules

Positions for 
Extension Modules

 

 
* When you drag a module from the product list to the system configuration area, you can only drop the module on a 

vacant slot. 
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 Method 2 

Double-click a vacant slot with a plus sign to display the Product List window. You can also right-click the vacant slot 

with a plus sign and then click Open to open the Product List window. 

 

Double-click a module to add it to the backplane from the Product List.  

 

 
 Method 3 

Double-click the empty space for the module on the Information List to show the Product List window.  
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In the Product List windows, double-click a module to add it.  

 

 
No matter which method you use to add a module, the configuration in the system configuration area and the 

information on the information list update when you add a module. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.1.2.2 Assigning I/O Addresses  

The AS Series does not support manually assigned addresses. Addresses are automatically assigned to an 

input/output module through HWCONFIG in ISPSoft.  You assign a start address to the first remote module installed 

on the right side of the I/O module slot (SCM module). The following I/O module is automatically assigned with the 

next address. For remote module configuration, refer to Section 8.2.3 for more details. 
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8.1.2.3 Editing a Comment 

You can add a comment about the hardware configuration by clicking the gray area at the top of the system 

configuration area. To start a new line of text at a specific point, press Shift+Enter on the keyboard. After you type the 

comment, press Enter. 

 

 

After you click the Comment cell for a module on the information list, press a key on the keyboard or click  to open 

the Device Settings dialog box. You can type a comment about the module in the Comment box. 
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8.1.2.4 Deleting a Module 

There are two ways to delete a module that has been configured. You cannot delete the CPU module. 

 Method 1 

(1) Click the module to delete from the system configuration area or information list. 

 

(2) On the Edit menu, click Delete, click  on the toolbar, or press Delete on the keyboard. 
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 Method 2 

(1) Right-click a module to delete from the system configuration area or information list, and then click Delete. 

   

 

8.1.2.5 Replacing a Module 

There are two ways to replace a module that has been added. You cannot replace the CPU module or power module. 

 Method 1 

(1) Right-click the module to be replaced in the system configuration area or on the information list.  

 

Or click the module to be replaced in the system configuration area or on the information list. On the Edit menu, click 

Replace.   
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(2) A Product List window appears. 

 

(3) Select the Replace All check box to replace multiple modules of the same type. Double-click the new module (the 

module that replace the existing module). A message appears: “The replaced module setting will be restored to 

the default values. Are you sure to continue?” Click Yes to replace the selected module. 
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 Method 2 

(1) Right-click the module you want to replace in the system configuration area or on the information list, and then 

click Replace. 

 

(2) A Product List window appears. 

(3) Select the Replace All check box to replace multiple modules of the same type. Double-click the new module (the 

module that replace the existing module). A message appears: “The replaced module setting will be restored to 

the default values. Are you sure to continue?” Click Yes to replace the selected module.  
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8.1.2.6 Copying/Pasting a Module 

There are two ways to copy a module. You cannot copy/paste the CPU module or the power supply module. 

 Method 1 

In the system configuration area or on the information list, right-click the module to copy, and then click Copy. 

 

 Method 2 

(1) In the system configuration area or on the information list, click the module to copy. 

 

(2) On the Edit menu, click Copy, or  on the toolbar. 

 

There are two ways to paste a module. 

 Method 1 

In the system configuration area or on the information list, right-click the slot where you want to paste the module, 

and then click Paste. 
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 Method 2 

(1) In the system configuration area or on the information list, click the slot where you want to paste the module. 

    

(2) On the Edit menu, click Paste, or click  on the toolbar. 

 

If the slot where you to paste a module already has a module, the pasted module is added in front of the slot where a 

module already exists. As the example shows below, adding the 06XA module in the position of the 04AD module 

moves the 06XA module in front of the 04AD module.  

 

8.1.2.7 Cutting/Pasting a Module 

There are two ways to cut a module. You cannot cut and paste the CPU module or the power supply module. 

 Method 1 

In the system configuration area or on the information list, right-click the module to cut, and then click Cut. 
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 Method 2 

(1) In the system configuration area or on the information list, click the module to cut. 

 

(2) On the Edit menu, click Cut, or click  on the toolbar. 

 

There are two ways to paste a module. 

 Method 1 

In the system configuration area or on the information list, right-click the  slot where you want to paste the module, 

and then click Paste. 

 

 Method 2 

(1) In the system configuration area or on the information list, click the slot where you want to paste the module. 

    

(2) On the Edit menu, click Paste, or click  on the toolbar. 
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If the slot where you want to paste the module already has a module, the pasted module is added in front of the slot 

where a module already exists. As the example show below, adding the 06XA module in the slot of the 04AD module 

pastes the 06XA module in front of the 04ADmodule.  

 

Additional remarks 

When you cut and paste a module, the parameters in the module are retained as follows. 

 Input/Output device range: The input/output devices assigned to the cut module are automatically assigned to 

the pasted module. 

8.1.2.8 Dragging a Module 

You can drag all modules in the system configuration area with the mouse, except the CPU module and the power 

supply module. When you drag a module from one position to another in the system configuration area, a red arrow 

appears along with the direction of your mouse cursor to show where the dragged module would be placed.  

 

 

* When you drag a module, the input/output devices assigned to the module, the comment about the module, the 

parameters in the module, the data registers assigned to the module, and the parameters in the intelligent module are all 

retained in the dragged module. 
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8.1.2.9 Show/Hide Device Name 

You can show or hide the module names in the system configuration area by clicking   on the tool bar.  

 

 

8.2 Setting the Parameters in an AS Series CPU Module 

8.2.1 Opening the PLC Parameter Setting Window 

After you double-click the CPU module in the system configuration area, the Device Setting dialog box appears. The 

parameters you can set vary with the models of the CPU modules. 

 Before you set the parameters in a CPU module, refer to the operation manual for the CPU module. To 

prevent damage to the system or personnel, check the effect of the parameters on the CPU module and 

the entire system. 

* You must download the set parameters to the CPU module before they take effect.  
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The parameters are classified into several types. Click the tabs at the top of the Device Setting dialog box and then 

click the setting options in the tree on the left.   

 

 

The setting parameters for the selected setting option appear on the right in the Device Setting dialog box. Click the 

option on the left, and then set the Value, Unit, Default, Minimum and Maximum for each parameter.  
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8.2.2 Setting the Basic CPU Parameters 

8.2.2.1 Options - System Information Page 

In the Device Setting dialog box, click the Options tab, and then click (expand) System Information to see the 

System Information, System Parameter, Device Range Setting, Input Point Filter Time, Position Control Para, and 

Daylight Saving Timing.  

 

System Information  

On the System Information page, you can edit two parameters: Name and Comment. You can enter up to 15 

characters in the Name section and up to 31 characters in the Comment section. You can use spaces and special 

characters in these two sections, but note that a Chinese character occupies two characters.  After you create an 

ISPSoft project, the default project name is the name of the CPU module, and the default name of the CPU module is 

attached to the model in the project management area. You can change the default name of the CPU module in the 

Name box later. 
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You can identify a device by means of device name. When several devices are connected on a network, you can 

check whether a device connected to the computer is the device you expect with the device name. If you want to 

download or upload the program, but the name of the CPU module is different from the name attached to the model in 

the project management area, the system reminds you to check the name of the CPU module and the name attached 

to the model in the project management area. 

System Parameter 

On the System Parameter page, you can set parameters by entering appropriate values or by selecting from a list. 

 

 
 Clear Non-latched area when Run  Stop 

This determines whether the states and values of the non-latched devices are cleared when the PLC changes 

from Run to Stop. 

 Disable: all the states and values in the non-latched devices stay the same. 

 Enable: all the states and values in the non-latched devices are cleared and restored to defaults. 

 

 Y keeps outputting when RUNStop 

This determines the states of the Y devices when the CPU module begins to run or stop.  

 Off: all Y devices are set to OFF. 

 Retain: the states of the Y devices stay the same. 

 

 I/O module CONFIG by Auto/Manual when Power On 

This determines whether the CPU module is automatically configured, or you configure the parameters in 

HWCONFIG.   

 Auto: the CPU module is automatically configured. 

 Manual: you configure the parameters in HWCONFIG. 



AS Ser ies Operat ion Manual   

 8-20

_8 

 Select Action when I/O Module parameter with manual CONFIG Different 

This determines which action is taken when the actual settings are not the same as the parameters that you 

manually set when the previous setting option is set to Manual.   

 Auto update: the CPU module is automatically configured. 

 Show error: the CPU module shows an error.  

 

 CPU module Stop when I/O Module No Response 

This determines how the CPU module and other modules react when a connected extension module is not 

responding. 

 Stop: the CPU module stops running and sends an error.

 Keep Run: the CPU module and I/O modules keep running.  

 

 CPU module Stop when I/O Module Occurred Error 

This determines how the CPU module reacts when a minor module error occurs.

 Stop: the CPU module stops running and sends an error.

 Keep Run: the CPU module keeps running and sends an error.  

 

 Setting delay time to detect I/O Module 

This sets the time to detect an I/O module after powering on the CPU module.  

 

 Assign X Input Point Control Run/Stop 

This assigns an input point to have the CPU module run or stop.

 Disable: run or stop the CPU module with the dip switch of the CPU module.

 Enable: run or stop the CPU module with the assigned input point, and the dip switch of the CPU module still 

controls the run stop state of the CPU module.   

 

 Select X Input Point 

If you select Enable in the previous option, you can select one input point to control the Run or Stop state of the 

CPU module from the dropdown list.  

 

 Constant Scan Cycle Time 

This sets the minimum scan cycle time.

 Disable: disables this function.

 Enable: when the actual scan cycle time is less than the setting time, the CPU module waits until the setting 

time is met, and then starts the next scan. When the actual scan time is longer than the setting time, 

the CPU module starts the next scan after the actual scan time completes.   
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 Input Constant Time 

If you selected Enable in the previous option, you set the scan cycle time here. If the actual scan time is less than 

the setting time, the CPU module waits to begin the next scan until the setting time is met. If the actual scan time 

is larger than the setting time, the CPU module ignores the setting time and operates according to the actual scan 

time. If you set the scan time longer than the watchdog timeout set, a watchdog timeout occurs when the CPU 

module operates.  

 

 Setting Watchdog Time 

This parameter sets a timeout during which the program is scanned. The CPU module sends an error if the 

program execution exceeds the watchdog time. 

 

 Show Battery Low Voltage Error 

This parameter sets whether to show an alarm when the lithium battery for the real-time clock has low voltage or 

is not installed in the AS300.

 Disable: disables this function.

 Enable: enables the alarm when the lithium battery has low voltage or is not installed. 

 

 Save Error History Info 

This specifies where to store the error log. 

 PLC: store error logs in the PLC. The PLC can store up to twenty error logs. If there are more than twenty 

error logs, the oldest error log is overwritten by the latest error log.  

 PLC & SD Card: when there are more than twenty error logs, the oldest error log is backed   

            up to the memory card before the oldest error log is overwritten in the PLC.  

 

 Select Action when 24Vdc Input Unstable 

 Continue running when power stable: when the power is unstable, the AS Series pauses, and after the 

 power stabilizes, the PLC continues running.   

 Into Error Status: when the power is unstable, the error LED blinks and the AS Series stops running.  

 

 Communication Module Refreshed Priority 

 Scan Time First: when there is an update, the AS Series automatically refreshes in batches to save scan           

time. 

 Synchronous Data First: when there is an update, the AS Series refreshes completely and automatically               

to ensure data integrity. When the quantity of the data large, the scan time can be affected.  

 

 COM Communication Error Record 

This parameter sets whether to enable the error record when there is an error at the COM port.



AS Ser ies Operat ion Manual   

 8-22

_8 

 Disable: disables this function.

 Enable: enables this function and starts recording COM errors in the error log.  



Select Action When 24 Vdc Input Unstable  

What to do when the 24 Vdc power is unstable  

Continue Running when power stable: waits till the power is stable and then PLC begins to run.  

Into Error Status: Stops and go to the error mode  



Communication Module Refreshed Priority  

Scan time first: only refresh the data that is different from the original ones to save scan time 

Synchronous Data first: scan and refresh all the data to ensure all data are synchronized. 

 

 I601 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1601 timer interrupt. This function is used together with Timer Interrupt 0. 

 

 I602 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1602 timer interrupt. This function is used together with Timer Interrupt 1. 

 

 I603 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1603 timer interrupt. This function is used together with Timer Interrupt 2. 

 

 I6014 Timer interrupt Setting Time Base  

Sets the interval for triggering the 1604 timer interrupt. This function is used together with Timer Interrupt 3. 

 
Device Range Setting  

The parameters on Device Range Setting table are shown in the following window. 
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Click  to open the parameter dialog box to set the start and end address. In the dialog box, click Default to restore 

the setting to the default values; click Clear to clear the set values; click OK to save the values and close the dialog 

box; click Cancel to discard the setting and close the dialog box.  

 

 

Input Point Filter Time  

On the Input Point Filter Time page, you can set the input point filter time for each input. If the duration of the received 

signal time is less than the filter time setting value, it is processed as noise and filtered out. Select an appropriate filter 

time according to your needs. 

 

 X Input Point Filter for CPU module 

 Default Setting: uses the default values in the input point filter.

 Manual Setting: uses the values you enter for the filter time for each X input point. 

 

 X0.0–X0.15 Input Point Filter Time 

 If you select Manual Setting for the previous parameter, you can set the filter time individually for X0.0–X0.15. 
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Position Control Parameter 
The parameters on Position Control Parameter table set to specify input points as the positive and 
negative limits of axis 1~ axis 6 channels. 12 limit points can be set at most. Axis No. 1~6 can also be set 
as Z phase triggers, home function finish points and clear output selects or positive/negative limited 
position.  

 

 Axis1(Y0.0/Y0.1) Positive/negative Limited Select~ Axis 6 (Y0.10/Y0.11) Positive/negative Limited 
Select: select the rising or falling edge trigger and X input point on the drop-down list. 

 Axis1 (Y0.0/Y0.1) Z Phase Trigger ~ Axis6 (Y0.10/Y0.11) Z Phase Trigger:   
  select the rising or falling edge trigger and X input point on the drop-down list. 
 Axis1 (Y0.0/Y0.1) Home Function Finish and Clear Output Select ~ Axis6 (Y0.10/Y0.11) Home Function 

Finish and Clear Output Select: select the rising or falling edge trigger and X input point on the 
drop-down list. 

Axis1 (Y0.0/Y0.1) Positive/negative Limited Position ~ Axis6 (Y0.10/Y0.11) Positive/negative Limited 
Position: set up the number of pulses as the positive or negative limited position in axis 1~6; setting 
range is -2147483647～2147483647.  

 

Daylight Saving Timing 

Enable or disable this function on the Daylight Saving Timing page. Set daylight saving time and the set the time zones 

for daylight saving and the system acts accordingly.    
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 Disable/Enable D.S.T Function 

Sets whether or not to use daylight saving time. 

 Start Date – Month 

Sets the month to start daylight saving 

 Start Date – Day 

Sets the day to start daylight saving 

 End Date – Month 

Sets the month to end daylight saving 

 Start Date – Day 

Sets the day to end daylight saving 

 Saving time 

Sets daylight saving time in minutes 

 

8.2.2.2 Options - COM1 & COM2 Port Setting 

The AS Series CPU module has two communication ports. There are two areas to set the parameters, one for each 

communication port.  

 

 Set a station address. You can identify a device on a network by the station address. The station address cannot 

be the same as the station address for another device on the same network. If the communication port functions 

as a slave, and there are other slaves, the station address of the communication port cannot be 0. Station address 

0 broadcasts to all slaves in a communication protocol. If a master specifies in a data packet that data must be 

sent to station address 0, the data is sent to all slaves. No matter what the station address of these slaves are, 

these slaves receive the data packet addressed to station address 0. 

 Set when the communication port runs. Select Stop --> Run, and communication works when the CPU module 

switches from Stop to Run. If you instead select Power-on, the communication starts working when you Power-on 

the module. 
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 Select a communication speed in the Baud Rate list , or select Custom and enter a new rate. 
 Set the communication parameters for the port.
 Set the Delay Time to Reply when the AS Series CPU module receives communication and how long it waits 

before responding to the remote modules. Received Data Timeout applies when the AS Series CPU module acts 

as a server to send out communications. The timeout is how long the module waits before the received data times 

out.    

8.2.2.3 Options - Ethernet Port Basic Setting 

Click Ethernet Port Basic Setting to see the setup page. Set the communication parameters for the Ethernet port in 

the CPU module on this page.  

 

Select Static in the Mode list to specify an IP address. Select Dynamic or BOOTP in the Mode list to assign an IP 

address from a DHCP/BOOTP server.  

 

8.2.2.4 Options - Ethernet Port Advanced Setting 

Click Ethernet Port Basic Setting to see the setup page. There are setups for IP Filter, NTP, Email, Socket, and RTU 

mapping.  
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IP Filter  

Devices whose IP addresses are listed in the table are allowed to communicate with the CPU module; the CPU 

module discards data packets sent from devices whose IP addresses are not in the table. Devices on a network are 

filtered. This setting ensures that objects communicating with the CPU module are known devices. You can set up to 8 

address ranges for allowed devices.  

 

NTP 

Click NTP to synchronize the real-time clock in the CPU module to an NTP server. Please refer to related documents 

or manuals for more information about NTP. 

Select the NTP Client Function Enable check box, and then set the related parameters. 

1

3

 

 Set the IP address of an NTP server. The CPU module corrects its internal time by connecting periodically to the 

server.

 Set a time interval for correcting the time in the CPU module. If the interval is thirty minutes, the CPU module 
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connects to the NTP server every thirty minutes.

 Select a time zone in the Time Zone list. 

Click Email to set the email-related functions. The system sends email to the set email address after you enable the 

email function. You can set up to four sets of conditions for sending email to up to four groups of email addresses. 

 

 

 Select Email Function Enable to enable the function.

 Set an IP address of the SMTP server. Set the COM port of SMTP server at the COM port and set the sender’s 

local email address. Type the Mail Subject to appear at the start of the subject of every email. 

 Select Account identification checkbox to enable the function to authenticate the connection with a user name 

and a password when logging into an SMTP server.

 Type the target email addresses. 

 

Click 1st Trigger Setting and type a trigger name in Trigger Name box and a minimum interval in Trigger Min Cycle. 

Then select a trigger condition in the Trigger Mode list. When the sending condition is met, the system sends an email 

every designated period of time. The system does not send the same email again.  
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You can set email trigger modes as follows. 

 CPU Error 

Trigger sending an email if an error occurs in the CPU module. Refer to the Operation manuals for more information 

about errors occurring in CPU modules. After you select CPU Error, select Fatal Error Only or All Errors in the list at 

the right side of the option. 

a) Fatal Error Only: Send an email if a fatal error occurs in the CPU module. 

b) All Errors: Send an email if an error occurs in the CPU module. 

 CPU (RUN<=>STOP) 

Trigger sending an email when the CPU module begins to run, or when the CPU module stops running. 

 Bit Status Change 

Trigger sending an email if the state of a bit device specified meets a set condition. For example, if X0.0 switches from 

OFF to ON, it triggers sending an email. To set a condition, click the   button in the following dialog box. 

 

 Device Name: Select a device type.

 Device Number & Bit: Type a device address; if the device type selected is X/Y, you must specify a bit 

number as well.

 State: Select Rising or Falling. 
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Register Value Change 

Trigger sending an email if the value in a device specified meets a set condition. For example, if the value in D0 is 

larger than 10. To set a condition, click the   button in the following dialog box.              

 

 

 

 

    

 Device Name: Users can select a device type in the Device Name drop-down list. 

 Device Number: Users can type a device address in the Device Number field. 

 State & Value: Users can set s condition of triggering the sending of an email here. 

 Periodic Timer 

The system periodically sends an email. How often the system sends an email depends on the Trigger Min Cycle 

interval in the Trigger Setting section. 

When you set any trigger mode, the user message and error log related parameters appear. 

 

Select the Trigger User Message Enable check box and then click the  to the right side of Trigger User 

Message. Type some content for the email text in the dialog box. 

If you select the Error Log Enable check box, the system automatically adds the error log to the email content.  

Trigger Attachment Mode determines whether to add an attachment to the email. Check the maximum size allowed 

for the email file before adding an attachment. Refer to the relevant email operation manuals for more information. If 

you select None, no attachment is inserted. 
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 File 

Allows you to select an error log or the system backup file from the memory card as the email attachment.  

 PLC Device 

The system automatically retrieves the device states or values listed in the table as the email attachment. After you 

select this option, click  in the following dialog box to open the Attachment dialog box. You can set a maximum of 

two groups of devices. For example, if the condition is met, the values in D0–D9 are sent as an attachment.  

 

Select the receiver’s target email address for the triggered email in the Trigger Receiving table. Set the specific email 

address in the Email section. 

Sockets 

You can set the parameters for sockets through which data is transmitted. You must use this function with specific 

applied instructions. Refer to the AS Series Programming Manual for more information, as sockets are not described 

here. Refer to the related documents or manuals for more information about sockets. In the Socket table, set COM 

port parameters for data transmission through Ethernet; however, you should use this function only with specific API 

instructions. For relevant details, refer to the AS Series Programming Manual.  
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The system for the AS Series module supports data transmission between the CPU module and other CPU modules 

or devices through a socket as well as through TCP and UDP protocols. You can set up four connections in each of the 

four groups. Select the Socket Function Enable checkbox and then select settings in the TCP and UDP setting 

pages. 

 

 

The parameters in the TCP Socket Setting are the same as the parameters in the UDP Socket Setting except that 

there is no Keep Alive Timer parameter in the UDP Socket Setting. 

 Remote IP: Sets a remote IP address. 

 Remote Port: Sets a communication port used by the remote device for this TCP connection. The port number   

            must be between 0–65535. 

 Local Port: Sets a communication port used by the local CPU module for this connection. The port number must be  

        between 0–65535. 

 Send Address: Sets an initial device in the CPU module where sent data is stored. 
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 Send Length: Sets the length of data sent by the local CPU module. The length must be between 0–500 words. 

 Receive Address: Sets an initial device in the CPU module where received data is stored. 

 Receive Length: Sets the length of data received by the local CPU module. The length must be between 0–500   

              words. 

 Keep Alive Timer: Sets a maximum time to keep the connection alive. If no data is transmitted, and the keep alive   

               period has elapsed, the CPU module automatically terminates the connection. 

The port number used by the local CPU module and the port number used by the remote device cannot be the same, 

and the devices where you store the sent data cannot overlap the devices where you store the received data. If the IP 

address of the remote device is 192.168.1.100, the port number used by the remote device is 65500, the port number 

used by the local CPU module is 65501, and the remote device and the local CPU module can transmit data through 

this TCP connection. 

If the local CPU module sends 10-word data to the remote device, the data is stored in D0–D9 before the data is sent. 

If the local CPU module receives 20-word data from the remote device, the data is stored in D100–D119.  

If the length of data received is larger than the setting value for the length, the first 20 words of data are stored in 

D100–D119, and the remainder of the data is discarded. Likewise, if the length of data received is less than the setting 

value for the length, the data is stored in the devices starting from D100, and the values in devices where no new data 

is stored are unchanged. 

If no data is transmitted, and 60 seconds have elapsed, the CPU module closes the socket and terminates the 

connection. 

In the RTU Mapping table, you can set a Delta RTU-EN01 slave in connection with an AS Series module. The remote 

device is controlled through Ethernet and you can connect up to 4 groups of RTU-EN01 in the network. Refer to the 

operation manual for setting and operation of RTU-EN01. 

 



AS Ser ies Operat ion Manual   

 8-34

_8 

Select RTU Mapping Enable checkbox to enable the function of connection between RTU module and AS series 

module. Set the update cycle in Cycle box and a timeout in Timeout box. It means a timeout when RTU does not give 

a reply within the timeout set. 

The data mapping between each group of RTU-EN01 and AS series module is set in the RTU Mapping section. 

RTU-EN01 and I/O module connected to it are set via DCISoft. For more information on DCISoft, refer to the operation 

manual. 

 

 Select RTU1 Enable to enable this RTU function. You can set each RTU individually.

 Set a station address and an IP address.

 Set the RX mapping address and RX mapping length to make the digital input points for the DI module 

connected to RTU and mapped to X/M devices, as well as the length for the AS Series module. Set the RY 

mapping address and length to set the digital output points for the DO module mapped to Y/M devices, as well 

as the length for the AS300 Series module.

 Set the RCR Read mapping address and RCR Read mapping length to make the analog input points for the AI 

module connected to RTU and mapped to D/SR devices, as well as the length for the AS300 Series module. Use 

the RCR Write mapping address and length to set the analog output points for the AO module mapped to D/SR 

devices, as well as the length for the AS300 Series module. 
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8.2.2.5 Options - Function Card 1 Setting 

Use the Function Card 1 Setting table to set the parameters for function card 1 in the AS300 Series CPU module.  

Install function card 1 by inserting it into the slot in the module. 

 

 Select Auto in Card1 Detect mode box to detect the actual card model and setting.  Select Manual to manually 

select the card in the Manual Select Card list and then configure the AS-F232/ F422/ F485/F2AD/F2DA function 

card.

 For setting the parameters in AS-F232/ F422/ F485 card, refer to the COM port setting in Section 3.5.2.2.

 At the bottom of the table, you can set F2AD to receive the signal of 0–10V or 4–20mA in F2AD Analog Input 

Mode list and set F2AD to send the signal of 0–10V or 4–20mA in F2DA Analog Output Mode box. Set the 

sampling interval for the F2AD and the average times in F2AD Sampling Time and Average Times. 

 

8.2.2.6 Options - Function Card 2 Setting 

Use the Function Card 2 Setting table to set parameters for the function card 2 in the AS Series CPU module.  

Install function card 2 by inserting it into the slot in the module. For function card 2, there is an additional option 

(AS-FCOPM) in Manual Select Card that does not exist for function card 1. If you select the AS-FCOPM card, set the 

parameters as shown below. 
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 Select AS Remote Control, Delta ASD-A2 Control, or CANopen DS301 in the AS-FCOPM working mode list. 

AS Remote Control connects the AS Series remote I/O. Delta ASD-A2 control is exclusively for Delta servo 

products. CANopen DS301 uses the DS301 standard protocol.

 When you select CANopen DS301, set the address of the station in the AS-FCOPM working mode.

 If you select Delta ASD-A2 Control in the AS-FCOPM working mode, you can set the remote I/O parameters. 

AS remote module No. sets the number of remote I/O modules, and each one connects an extension module. 

Refer to Section 3.5.3 for operation of the AS Series remote module. Select Run mode after detect remote 

module determines if the connected remote module works normally or if all remote modules stop running when 

the number of actual connected modules is inconsistent with the set number of modules. 

AS CPU keep or Stop when slave node disconnected determines whether to show only errors or to stop 

running and send an alarm when the remote I/O module is disconnected during operation. 

Remote Communication Timeout sets the timeout period if the remote I/O module does not reply. 

Auto Retry connection after Disconnected sets the number of times to retry the connection after a timeout 

occurs.

 Set the parameters Auto Retry connection after Disconnected and AS-FCOPM Bit Rate under the three 

AS-FCOPM working modes. 

 

8.2.3 Configuring AS - Series Remote Modules  

You can connect remote IO modules with the AS Series CPU module to prevent the need for wiring between a remote 

device and the controller.  Select Manual in the Card2 Detect Mode list and ASJ-FCOMPM in the Manual Select 

Card list in the Function Card 2 Setting table.  Then select AS Remote Control in the AS-FCOPM Working mode 

list and the number of AS remote modules.  

 

If you enter 2 in the AS Remote module No. box, two remote modules appear in the system configuration area after 

you click OK . 
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You can set the remote module in the system configuration area to add, delete, copy, and move an extension module, 

as shown in Section 8.1.2.  As with a general controller, you can click with the mouse, drag, or right-click then click 

context menu commands. You can configure all extension modules except network modules. 
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Double click a module to open the Device Setting dialog box for a remote module and the extension modules 

connected to it. 

 

Set the start of input device range for the remote module as follows. Click a remote module, then double-click Input 

Device Range in the Remote Module Group 1 table and then type the device No. in the dialog box. After you click 

OK, the input and output device range of the remote device and the extension modules connected to it are 

automatically configured.   
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The module arrangements may affect the input and output device range, and the device range may not be in order. To 

fix this, you can rearrange the input and output device ranges in an orderly sequence. On the File menu, click  Input / 

Output Device Rearrange to automatically arrange the device range sequence.   

 

 

8.3 Data Exchange  

8.3.1 Device Settings Dialog Box Descriptions  

In the Device Settings dialog box, after you click the Data Exchange-COM1, Data Exchange-COM2 or Data 

Exchange-Ethernet tab, you can set the parameters for the data exchange table for the communication port built into 

the AS Series module. 

The AS Series module can be a master and exchange data with remote slave devices through COM1 and COM2 

using the Modbus protocol, or through an Ethernet port using the Modbus TCP protocol. 
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 When you set the start Mode to Program Control, the program in the PLC determines whether to perform the set 

data exchange. PLC Run means that the set data exchange is performed automatically when PLC is in the RUN 

state. Always Enable means that the data exchange is performed constantly when the PLC is powered on.

 Add a new row in the data exchange table in area  by clicking Add. Move the selected data exchange row up or 

down by clicking Move Up and Move Down. Delete the selected data exchange row by clicking Delete. Copy the 

selected data exchange row by clicking Copy. You can then paste it back into the table as the last row.

 The following table explains the columns in the data exchange table. 

Name Description 

Item The number of the block for data exchange  

Enable 
Selects whether to enable the data exchange table when the data exchange is 

performed. 

Station Address/ 

IP Address 

The slave station address for the data exchange table. You can set one address for 

multiple data exchange tables. It is a station address under the COM1 and COM2 tabs, 

and IP under the Ethernet tab. 

Local Address The device address range used by the master in the data exchange table 

<< / >> 
「<<」: Input: the data block where the master reads from a slave 

「>>」: Output: the data block where the master writes to a slave 

Remote Address 

This is the device address range used by a slave in the data exchange table. 

The device range is in hexadecimal if the slave in the data exchange table is a 

user-defined Modbus Device. 

Quantity  
This is the size of the data exchange table, which is consistent with the result calculated 

from the device range. 
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8.3.1.1 Data Exchange - COM1 and Data Exchange - COM2 

On the Data Exchange-COM1 or Data Exchange-COM2 tab, double-click row in the data exchange table to set to 

open the Item dialog box as shown below. Select the Enable check box to enable the data exchange table in the 

mode mentioned above. Remote Address is the address of the target slave for data exchange. The Shortest Update 

Cycle is the period for data exchange of the data exchange table. The connection times out if the target device does 

not make any response within the time specified by Connection Timeout.  

Select Support Read/write synchronization (Function code 0x17) to have the master complete reading and writing 

in a single command to improve the efficiency of data exchange. This uses the specific Modbus function code. Make 

sure that all devices in data exchange support the Modbus function code for read and write synchronization. Otherwise, 

the attempt to read and write fails due to the failure to identify function codes after receiving the command from the 

master device. 

Remote Device Type is the model of a target slave including the Delta PLC and standard Modbus devices. 

 

 Read 

The AS Series module reads data from a remote device. 

Local Start Address: The device type and start address of the devices where the AS Series module stores data. 

Remote Start Address: The device type and start address of the remote device to be read. 
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Quantity: This is the input data length. 

 Write 

The AS Series module writes data to a remote device. 

Local Start Address: The device type and start address of the source data for the AS Series module. 

Remote Start Address: The device type and start address of the remote device where data is to be written. 

Quantity: The output data length. 

8.3.1.2 Data Exchange - Ethernet 

On the Data Exchange - Ethernet tab, double click a row in the data exchange table to set to open the Item dialog 

box as shown below. The settings are almost the same as those for Data Exchange - COM1 and Data Exchange - 

COM2, except that the target slave model option in Remote Device Type contains Delta PLC and standard Modbus 

TCP equipment, as well as the IP address for remote slaves. For other settings, refer to the descriptions of Data 

Exchange - COM1 and Data Exchange - COM2. 

 

Select the Apply to all check box on the right side of The Shortest Update Cycle and Connection Timeout and then 

click OK. Selecting the check box writes the settings for The Shortest Update Cycle and Connection Timeout to 

other data tables on the tab Data Exchange - Ethernet. You can also set the data exchange tables separately without 

selecting the Apply to all check box. 
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8.4 Setting Parameters in a Module 

8.4.1 Parameters in a Module 

You can set the parameters in every module configured in HWCONFIG. The functions and characteristics of every 

module depend on the parameter settings. To set the parameters in a module, double-click the module in the system 

configuration area to open the Device Setting dialog box. This dialog box may be different for each of the various 

devices. 

 

 

 

 

 

 

 

 

 

 

 

The parameters are set according to the functions supported by the module. Before you set the parameters, 

refer to the Operation Manual for more information. To prevent damage to the system or personnel, check the 

effect of the parameters on the module and the entire system. There are two tabs Device Setting dialog box: the 

Device Information tab and the Normal Exchange Area tab. Click the Device Information tab to display the module 

information, appearance, and present DDF document version.  

The number of parameters that you can set in the module and the range of setting values depend on the version of the 

DDF document. The firmware and hardware version of the CPU module also appear when all the modules are 

connected online. 
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Click the Normal Exchange Area tab to display the corresponding functions for the input/output devices assigned to 

the module. Select a parameter type at the left side of the dialog box, and then set the parameters in the table at the 

right side of the dialog box. The table formats for the parameter types are the same, but the contents of the tables are 

different. The number of parameters you set and the range of setting values depend on the firmware version of the 

module. 

 

The following shows the descriptions of the columns in the table. If a table cell is grayed out, you cannot edit the cell.  

Parameter name 

This column shows the parameter names or descriptions. 
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Value 

Set the initial parameter values in this column. When you download the parameters you set in HWCONFIG, the initial 

values (setting values) are written to the module. You may type initial values for some parameter types, or select initial 

values from a list for other parameter types in the Value column. Refer to the instructions for the module for more 

information about the range of values you can set, as well as the processing mechanism after you download the initial 

values. 

 

Unit, Default, Minimum and Maximum 

Refer to the unit, default, the minimum and maximum of the parameters in the following window. 

 

Click the Default button in the lower left corner of the Parameter Setting window to restore the default values of the 

parameters in the module. The software asks you to confirm that you want to reset the parameters to the default 

values. 

Yes No
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8.4.2 Exporting and Importing the Parameters in a Module 

You can save the parameters in the module as a CSV file. You can also import a previously exported file. 

 

 Exporting the parameters from a module 

Click Export in the Device Setting dialog box. In the Save As dialog box, select a folder in the Save in list, type a 

file name in File name, and click Save.

 Importing the parameters from a file 

Click Import File in the Device Setting dialog box. In the Save As dialog box, select a file to import, and click 

Open. Note that the windows for importing and exporting parameters may be different for different modules. 

Before importing the parameters, the system checks the file format and the module model. If the file format or the 

module model is not correct, the system stops the importing process. If the data registers specified in the original 

file that was exported have been used in the present configuration, the system specifies different data registers 

after the file is imported. 

 

8.4.3 Updating Parameters in a Module 

You can update the parameters in a module. Make sure the software is in the Online mode. Double click the module 

that you want to update. Click Update to update the parameters in the selected module. This function is limited to 

digital input I/O and analog I/O and network modules.  
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8.4.4 Setting Parameters in an SCM 

Delta Electronics, Inc. provides you with specific configuration tools for some CPU modules. You can open the tools 

such as CANopen network planning and SCM (Serial Communication Module) to set advanced parameters for 

network assignments for the modules. For advanced setups, in the system configuration area, right-click the CPU 

module, then click Communication Software, and then click SCMSoft. You must save the configurations in 

HWCONFIG before opening the tool. You cannot work in HWCONFIG while editing in the special configuration tools. 

Some tools require independent separate installation, and a message appears when the tool has not been installed.  

 

 

Refer to configuration tool manual for the steps to set up the communication software tools.  
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9.1 Introduction 
9.1.1 EtherNet/IP  

EtherNet/IP (“IP” stands for “Industrial Protocol”) is an industrial Ethernet network managed by ODVA, Inc. (formerly Open 
DeviceNet Vendors Association, Inc.), a global trade and standards development organization.  

EtherNet/IP works on a TCP/UDP/IP based Ethernet network and uses the most widely deployed collections of Ethernet 
standards to provide a broad range of applications in different industries that require high-speed and stability including 
Factory Automation (FA), Building Automation (BA), Process Automation (PA) and many more.  

Delta covers a full range of controller and drive products supported by EtherNet/IP, including Programmable Logic 
Controllers (PLC), inverters, Human Machine Interfaces (HMI) and so on. Refer to Section 9.9 for a full product list that 
support EtherNet/IP. In addition, you can also use EDS files to connect to other brands of EtherNet/IP devices. You can 
run Delta EtherNet/IP software (EIP Builder) through the ISPSoft software. Download the ISPSoft software at:    

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&d
ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US 

9.1.2 Definitions of Common Network Terms  

Term Definition 

ODVA Open DeviceNet Vendor Association for EtherNet/IP  

EIP 
EtherNet/IP, an industrial Ethernet network, provides interoperability for system providers. IP 

stands for Industrial Protocol. The term “EIP” (EtherNet/IP) is used in this manual.  

I/O Connection Use the I/O connection to connect to EtherNet/IP and to exchange data cyclically.  

Explicit Message 
Connect to EtherNet/IP and to exchange data non-cyclically. Data is exchanged piece by 

piece through instructions.  

RPI 
Requested Packet Interval, through the I/O connection to connect to EtherNet/IP to 

exchange data at regular time intervals.  

ACD Address Conflict Detection to detect IP address duplications. 

Produced/Consumed 

TAG (P/C TAG) 

 You use TAGs for assigning and referencing memory locations for Rockwell PLCs, the 

same as registers for Delta PLCs.  

 Produced tag: A tag that a controller makes available for other controllers. Multiple 

controllers can simultaneously consume (receive) the data. A produced tag sends its 

data to consumed tags (consumers) without using logic. 

 Consumed tag: A tag that receives the data of a produced tag. The data type of the 

consumed tag and the produced tag must match (including any array dimensions).  

 The data is transferred over Ethernet/IP. For example, PLC-A needs data from PLC-B, 

so PLC-B sends the data to PLC-A. Therefore, PLC-B is the producer and PLC-A is 

the consumer. 

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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EDS 

Electronic Data Sheets: EDS files are simple text files used by EtherNet/IP network 

configuration tools to help you identify EtherNet/IP products and easily commission them on 

a network.  

Data Mapping Exchanging data between devices  

EIP Scanner The master station is called an EIP Scanner in EtherNet/IP. 

EIP Adapter The slave station is called an EIP Adapter in EtherNet/IP. 

DLR 

Device Level Ring (DLR) provides fault-tolerant network design for daisy-chain and linear 

topology. The DLR protocol provides high network availability in a ring topology. It was 

intended primarily for implementation in EtherNet/IP end-devices that have two Ethernet 

ports and embedded switch technology, providing fast network fault detection and 

reconfiguration to support the most demanding control applications.  

Modbus TCP This is a Modbus variant used for communications over TCP/IP networks. 

 

9.1.3 Ethernet Features  

9.1.3.1 Delta EIP Architecture 

This typical Delta EIP architecture includes an EIP Scanner and Adapters; data mapping is achieved between devices 

through an I/O connection and explicit messaging. The AS Series supports single port Ethernet; thus you can install and 

configure devices with embedded switch technology over EtherNet/IP. 

 

 



AS Ser ies Operat ion Manual  

 

9-6 

_9 

9.1.3.2 EIP Features 

 Flexibility 

- Flexible topology: EIP devices may include single port Ethernet as well as dual port Ethernet, and provide 
applicable networks such as linear topology, ring topology and ring topology for faster expansion and easier 
management.  

- EtherNet/IP works on a TCP/UDP/IP based Ethernet network, uses most widely deployed collections of 
Ethernet standards, and supports Wi-fi connection. Even personnel with no IT background can build the 
network easily.  

- Applicable networks include linear topology, ring topology, star topology, Ethernet, EtherNet/IP, one or more 
LANs, etc. You can set configuration through USB or an interface. 

 Simplicity 

- With a connector: Delta provides a full range of products, including human machine interfaces (HMI), 
programmable logic controllers (PLC), and inverter drives for application in an industrial operation. You can 
build a network simply through an RJ-45 connector, saving costs on cables and other connecting tools.   

- Single network: in place of the 3-tier industrial architecture, single network architecture provides 100MB/bits 
high-speed cyclical and non-cyclical data mapping functions, ensuring complete network diagnosis and 
effectively shortening debugging time.    

- Graphical user interface software: the EIP Builder uses a graphical user interface designed for intuitive 
operation. 

 Integration 

- Data mapping: the EIP Builder provides a consistent setting interface, allowing you to reduce the time to learn 
and set up configurations. 

- Listed device parameters: the EIP Builder presents the device parameters in a list. Instead of looking them up 
in the user manual, you can quickly check on the parameters in the list.  

- EDS file: you can connect to Delta and other brands of EtherNet/IP products with EDS files.   

 

9.2 Installation 

9.2.1  EtherNet/IP Device 

A Delta EtherNet/IP (EIP) device allows you to build a linear topology, ring topology, and star topology networks. A Delta 

EIP device includes the EIP Builder software, EIP Scanner, EIP Adapter, EIP Tap, and an Ethernet switch. EIP Scanners 

and EIP Adapters can be further divided into single port and dual port devices. The AS Series are single port devices. 

Refer to Section 9.2.2.1 for the single port setup and refer to Section 9.2.2.3 for the software installation.  

9.2.2  Network Cable Installation 

Each EtherNet/IP device is connected to an Ethernet switch with a CAT 5e cable. Please use Delta standard cables and 

the DVS series industrial switches. Refer to the Delta PLC/HMI Cable Selection Guide for more information.  
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9.2.2.1. Single Port Device  

You can use a single port device to build up either a linear or a star network topology. An Ethernet switch and an Ethernet 

tab are required to create a star topology or a ring topology. 

Linear Topology 

 Linear Topology 1 

 

 
 

 Linear Topology 2 

 

 
 

Star Topology 

 

 

9.2.2.2. Dual Port Device 

You can use a dual port device to build a linear, a star or a ring network topology. A DLR function is required to create a 

ring topology. Refer to Section 9.9.2 for DLR supported series.  

Linear Topology 
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Star Topology 

 

 
 

Ring Topology 

A DLR function is required to create a ring topology. Refer to Section 9.9.2 for AS series that support DLR. 

 
 

When a switch is needed for the particular topology, the switch should support the DLR function. If not, the connection 

might fail.  
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9.2.2.3 EIP Builder Software 

Linear and star topology 

Install the EIP Builder software on your PC to monitor and configure the EIP devices. You can also connect an EIP device 

to your PCs directly, or use a switch to connect to the PCs.  

 
Ring topology 
Install the EIP Builder on your PC to monitor and configure the EIP devices. Be sure to save a network connection for your 

PC to connect to the EIP device.  

 
Alternatively, you can use an EIP tap to connect your PC so that the ring topology stays intact.  
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9.3 Specifications 

9.3.1 Ethernet Specification 

Communication Protocols EtherNet/IP Scanner / Adapter、MODBUS TCP 

Protocols  BOOTP、DHCP、SMTP、NTP、Socket、HTTP 

Communication Speed 10/100 Mbps Auto-Detection 

Communication Interface RJ-45 with Auto MDI/MDIX 

Numbers of the Ethernet Communication Port 1 

 

Item Specification 

AS300 AS200 

MODBUS TCP 
Master 32 16 

Slave 32 16 

Socket  

(communication port) 

TCP 4 2 

UDP 4 2 

SMTP (for emailing) 4 2 

 

9.3.2 EtherNet/IP Specification 

Item AS300 Series AS200 Series Remarks 

Communication Protocol 
MODBUS TCP, EtherNet/IP, SMTP, 

HTTP 

Protocols can 

be used 

simultaneously 

MODBUS 

TCP 

Server connection number 32 16  

Client connection number 32 16  

RTU Mapping 4 4  

Socket 
TCP connection number 4 2  

UDP connection number 4 2  

SMTP Email number 4 2  

EtherNet/IP 

Type Scanner, Adapter  

Topology Star  

CIP Network 

I/O 

Connection 

CIP 

connection 

number 

32 

(Clients+Servers) 

16 

(Clients+Servers) 

I/O 

connections 

shared 
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Item AS300 Series AS200 Series Remarks 

TCP 

connection 

number 

16 

(Clients+Servers) 

8 

(Clients+Servers) 

I/O 

connections 

shared 

Requested 

Packet 

Interval (RPI) 

5 ms–1000 ms Default: 20 ms 

Max. 

Transmission 

Speed 

 

3000 pps 
 

Max. Data 

Length/per 

transmission 

500 bytes   

CIP Network 

Explicit 

Message 

Class 3 

(Connected 

Type) 

Total 32 

(Servers), 

including the 

ones from the 

UCMM type 

Total 16 

(Servers), 

including the 

ones from the 

UCMM type 

I/O 

connections 

shared 

UCMM  

(Non- 

Connected 

Type) 

Total 32 (Clients 

+ Servers) , 

including the 

ones from the 

Class 3 

Total 16 (Clients 

+ Servers) , 

including the 

ones from the 

Class 3 

I/O 

connections 

shared 

CIP Objects 

Identity, Message Router, Assembly, 

Connection Manager, Port, TCP/IP 

interface, Ethernet link, Vendor 

specific 

 

CIP Network 

Produced 

TAG 

Max. CIP 

connection 

number 

32 16 

I/O 

connections 

shared 

Max. Data 

Length 

500 bytes (IO Connection) 

400 bytes (Explicit Message) 
 

Requested 

Packet 

Interval (RPI) 

5 ms–1000 ms  
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Item AS300 Series AS200 Series Remarks 

CIP Network 

Consumed 

TAG 

Max. CIP 

Connection 

Number 

32 16 

I/O 

connections 

shared 

Max. Data 

Length 

500 bytes (IO Connection) 

400 bytes (Explicit Message) 
 

Requested 

Packet 

Interval (RPI) 

5 ms–1000 ms  

 
AS00SCM (RTU) + AS-FEN02 

connection number 
15 8 AS Remote 

9.3.3 EtherNet Communication Port 

9.3.3.1 Communication Port Pin Assignment 

Delta EtherNet/IP devices use CAT5e industrial Ethernet cables and can be connected via RJ-45 communication port.  

Pin Signal Description Pin Signal Description 

 

1 Tx+ Transmit plus 5 -- N/C 

2 Tx- Transmit negative 6 Rx- Receive negative 

3 Rx+ Receive plus 7 -- N/C 

4 -- N/C 8 -- N/C 

 

9.3.3.2 Communication LED Indicator 

LED Indicator LED Status Description 

LINK Green 

ON 
 Communication port is connected. 

 Connected to Ethernet 

OFF 
 Communication port is not connected. 

 Not Connected to Ethernet 

ACK Yellow 

Blinking 
 Packets transmitting/receiving 

 Packets transmitting/receiving over Ethernet 

OFF 
 No packets transmitting/receiving 

 No packets transmitting/receiving over Ethernet 

Note: The LED indicator is at the RJ45 connection.  
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9.4 EIP Builder  

The Delta EtherNet/IP software, EIP Builder, is embedded in ISPSoft. You run it from the ISPSoft software (version 3.0 

and above). Download the ISPSoft software at:   

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&d

ownloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US  

9.4.1 Run the EIP Builder   

You can call EIP Builder from Delta EIP Scanner’s HWCONFIG in ISPSoft. You can also call it independently to set up 

parameters for the Adapter. The Delta EIP Scanner is equipped with the EtherNet/IP communication PLC and the 

EtherNet/IP module. Refer to Section 9.9.3 for a list of Delta EIP Scanner products supported by EIP Builder. 

9.4.1.1 Run the EIP Builder via an EIP Scanner  

 Steps to run EIP Builder 

Run EIP Builder from an EIP Scanner product. When using a Delta EIP Scanner, you set up an EIP module through 

HWCONFIG in ISPSoft.  

Open
ISPSoft V3 0.

Create
ISPSoft Project

Open
HWCONFIG

Download
H WCON FIG

Create
EIP Module

Y EIP 
P LC

Open
EIP Builder

Start

N 

 

1. Open ISPSoft V3.0: click the Start menu and go to Programs > Delta Industrial Automation > PLC > ISPSoft 

3.00 > ISPSoft 3.00. 

 
2. Create a new project: on the File menu, click New to display the Create a New Project dialog box. 

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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3. Select a PLC: in the Create a New Project dialog box, select a PLC product that is supported by EIP builder.  

 
 

4. Open HWCONFIG: double-click HWCONFIG in the Project window.  
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5. Save and download the settings from HWCONFIG：on the File menu click Save to save the settings and then 

click the download button  on the toolbar to download the file to PLC. You must save the configuration in 

HWCONFIG before opening the other communication tools. While working in the communication tools, you 

cannot work in HWCONFIG. 

 

6. Open EIP Builder: right-click the CPU module in the system configuration area point to Communication 

Software and then click EIP Builder. 

 

9.4.2 Set up the IP Address 

This section provides an overview of how to set up IP address for AS Series modules. Set up the IP address before 

configuring the EIP related parameters or data mapping settings.  

 

9.4.2.1 IP Address Types 

The AS Series supports 3 types of IP addressing, BOOTP, DHCP and static IP address.  

Type of IP Address Definition 

BOOTP 

Uses the TCP/IP Bootstrap Protocol (BOOTP) to set up the IP address, netmask and 

gateway. A BOOTP server may require some configuration. The BOOTP protocol is designed 

for a network in which each host has a permanent network connection. 

DHCP 
Uses the Dynamic Host Configuration Protocol (DHCP) to automatically obtain IP address, 

netmask, gateway, main computer name and the WINS server.  

Static IP You manually set the IP address, netmask and gateway.  
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9.4.2.2 Set the IP Address (Static IP) 

 Steps to set the IP address  

When using an EIP product with a static IP address, set up the IP address in HWCONFIG in ISPSoft. The following 

example uses the AS Series.  

Create
ProjectISPSoft 

Open
HWCONFIG

Set up 
IP Address

Create
EIP M odule

Y EI P
PLC

N 

Download
HWCONFIG

 
 
Refer to Section 9.4.1.1 for how to set up an EIP module in HWCONFIG.  

1. Configure the network parameters 

 Double-click the AS Series module in HWCONFIG to open the Device Setting dialog box. 

 On the Options tab, set the IP address on the Ethernet Port Basic Settings page, and then click OK.   

 
 
 



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-17 

9_

2. Save and download the settings from HWCONFIG: on the File menu click Save to save the settings and then 

on the Options menu, click Download or click the Download button on the toolbar. 

 

9.4.2.3 Set the IP Address (BOOTP/DHCP) 

 Steps to set the IP address 

When using an EIP product with a BOOTP/DHCP IP address, users can set up the IP address through the IP 

Manager in the EIP Builder.   

Create
AddressMAC Set up IP

Same I assign P 
mode after each 
power-on 

Reset I assign P 
mode after each 
power-on 

Y Disable
BOOTP

N 

Open
EIP Bui lder

Open
 IP M anager

Descriptions for the IP Manager:  

1
2
3

4

7

6

8
9

10

5
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 Item Definition 

 Stop the Server 
Stops the BOOTP/DHCP server; the IP manager does not request an IP 

addresses from the BOOTP/DHCP server. 

 Network Settings 
Opens a dialog box to set up the subnet mask, gateway, primary DNS, secondary 

DNS, and domain name.  

 Clear List Clears the contents of the list. 

 New Adds a new IP/MAC address.  

 Delete Deletes the selected item from the list. 

 Import Imports the IP/MAC address list; the file format is .CSV. 

 Export Exports the IP/MAC address list; the file format is .CSV. 

 Enable BOOTP Enables the BOOTP to assign an IP address for the selected item.  

 Enable DHCP Enables the DHCP to assign an IP address to the selected item. 

 Disable BOOTP/DHCP 
Disables the BOOTP/DHCP on the device; the device does not request an IP 

addresses from the server.  

 

 Steps to set the IP address:  

1. MAC address: find the MAC address on the EIP device. The MAC address uniquely identifies the device.  

 

2. Open the IP Manager 

 In EIP Builder on the Tool menu, click IP Manager. 
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 The IP Manager can be the BOOTP/DHCP Server, receiving IP address requests from devices. The IP  

     Manager window is shown below. 

 
 

3. Set up the IP address 

 Double-click the listed MAC address for your device to open the Input Data dialog box.  

 
 

 Enter the IP address and click OK. 
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4. Disable DHCP/BOOTP 

Click the device in the Mapping Table that you want to disable, then click Disable DHCP/BOOTP. The selected 

device does not send DHCP/BOOTP requests. To change the IP address receiving mode, refer to Section 9.4.2.4 for 

more information.   

 
 Notes 

 Enable BOOTP: when the IP address receiving mode is BOOTP (BOOTP is enabled), the IP address is 

assigned, and the device sends out BOOTP requests for IP addresses during each power-on. 

 Enable DHCP: when the IP address receiving mode is DHCP (DHCP is enabled), the IP address is assigned, 

and the device sends out DHCP requests for IP addresses during each power-on. 

 Disable DHCP/BOOTP: when BOOTP is disabled, the device does not send out any DHCP/BOOTP requests 

for IP addresses during each power-on.  

9.4.2.4 Re-enable BOOTP/DHCP  

To enable the DHCP or BOOTP function again, use the device software to make the change. Using the AS Series as an 

example: from the Start menu, start ISPSoft, then HWCONFIG, and then IP Manager. In IP Manager sets the IP address 

to the receiving mode.  

Open 
HWCONFIG

Set up
parameters

Set up IP
receiving mode

Open
EIP Builder

Download
HWCONFIG

Open
IP Manager
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 Steps to set device parameters  

1. Refer to Section 9.4.1.1 for how to start HWCONFIG. 

2. Set the parameters: enable the IP address receiving mode to BOOTP/DHCP.  

◆ Double-click the device to open the Device Setting dialog box.  

◆ Make changes to the items, such as IP address receiving modes and click OK to confirm the settings. 

 
3. Download the settings from HWCONFIG 

◆ Refer to Section 9.4.1.1 for more information. 

4. Open EIP Builder. 

◆ Refer to Section 9.4.1.1 for more information. 

5. Open the IP Manager 

◆ Refer to Section 9.4.2.2 for more information. 

6. Open the IP setup page 

◆ Refer to Section 9.4.2.2 for more information. 
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9.4.3 Network  

EIP Builder provides a graphical user interface, and you can see the devices and their EtherNet/IP connections in the 

Network View. This section provides an overview of how to add your devices to the network connections. 

 

Add Device
(Scan Network)

Create Network
(Set u p Connection)

Set up Device
Settings

IP Manager
(Set up IP)

Add Devices
(Manually)

EIP Builder

 
 

Descriptions of the EIP Builder Window 

1

3

4

2

  

 Item Definition 

 Toolbar Toolbar buttons 

 Network View Displays the connected devices and their connection status 

 Configuration Area Displays the configurations and allows you to set the parameters 

 Product List Displays the available devices that can be connected to EtherNet/IP  
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 Toolbar buttons 

 
 

Icon Name Definition  

 
New Creates a new EIP Builder project 

 
Open Opens an existing project 

 
Save Saves the project 

 
Help Opens the help file 

 
Cut Cuts the selected item 

 
Copy 

Copies the selected item 

 
Paste 

Pastes the selected item 

 
Delete 

Deletes the selected item 

 
Scan Network Scans the network for device availability  

 
Check Checks if the project is planed properly 

 
On-line Mode Switches to on-line mode 

 
Uploader Uploads from a device 

 
Downloader Downloads to a device 

 
Setup Button 

Opens the communication setting; set up the path connecting the PC to the EIP 

Scanner.  
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 Network View 

1

2

3

4

 
 Name Definition  

 Station Name Name of the station 

 Device Name Name of the device 

 Ethernet COM Port 
Displays the number of devices with Ethernet communication ports.  

The last digit of the IP address is shown on the COM port. 

 Network_0 
Displays the connection status; devices on the same line indicate they are in the same 

network. 

 
 Configuration Area 
Refer to Section 9.4.3.3 for more information. 

 
 Product List 

1

2

 
 

 Name Definition  

 Search Bar 
Type the module name you want to find; if no match is found, that means there is no EDS 

file in the system matching the module name. 

 Product List 
Categorizes the devices according to the EtherNet/IP definition; devices from third 

parties are in the Others folder. 

  



 

9.4.3.
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9.4.3.3 Set EIP parameters 

Click the tabs in the Information window to view and edit the EIP Parameter and the EDS Parameter.   

 
 

 Information Tab 

This tab contains the Module Name, Version, Rack, Slot, Slot, IP address, Mask, Network and Data Exchange 

Setting.  

 
 
 EIP Parameter Tab 

This tab contains parameter information from the EDS file. When offline, you can check only the connection 

parameters for setting up the EDS filtering rules.  

 Disable Keying: Disable key checking the product information versions.  

 Compatible Keying: Check if the product information and its master version match and check the 

minor version for compatibility. 

 Exact Match: Check if the product information, and both the master version and minor version match. 
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When the device is connected, you can click the Upload button to upload the related parameters from the device.  

AS332T

 
 

 Name Definition  

① Module Status 

 Identification: displays information regarding Vendor, Product 

Type, Product Name, Revision, etc. 

 Status: displays connection status, including Major Fault, Minor 

Fault, Internal State, Configuration Status, and Module Identity. 

② IP Setting 

 Port1: indicates port 1 of the device, for editing IP Address, 

Subnet Mask, Gateway Address, and Host Name.   

Note: when there is a Port2, that means there are 2 Ethernet 

communication ports. 

③ Connection 
 EDS parameters filtering rules include Disable Keying, 

Compatible Keying, and Exact Match. 

④ Port Status 
 Displays Link Status, Speed, Duplex, Negotiation Status and 

Hardware Fault.  

 DLR  Displays the DLR information 
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AS332T

 

AS332T
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 EDS Parameter Tab: this is not supported for the AS Series modules; the software closes itself when this Tab 

is selected.  

9.4.4 Data Mapping 

When the connection between devices is established, you can use data mapping to exchange data between devices. This 

section provides an overview of how to create a data mapping table.  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View

 
 
Descriptions for the Data Mapping: 

1

2 3 4 76 8 95 10  
 

 Name Definition  

 Connection Count 

Data mapping connection count; each row represents one 

independent EtherNet/IP connection. The number of connections 

cannot exceed the maximum number of connections for the Scanner. 

For the AS Series, the maximum number of connections 32. 

 Enable Enable and disable data mapping for the connection. 

 TAG 

Use TAG to perform data mapping with adapters. 

After selecting this check box,  

 The directional arrow points left of () (READ only) 

 Registers cannot be used in this row. 



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-33 

9_

 Name Definition  

 The length format is defined by the data format in the Global 

Symbols; you cannot change the length format here. 

 You must create a Consumed TAG in the Global Symbols in 

ISPSoft before using this function.  

 IP Address 

The IP address of the Adapter to connect to. After the data mapping 

connection is established, the system loads the connected device’s IP 

address. You can also select the device’s IP address from the list to 

add and edit the connection.  

 Adapter Name 

Once you select the IP address, its name is displayed but cannot be 

modified here. Refer to Section 9.4.3  for more information on  

how to change the device name.     

 

CPU Address Start address of the data mapping’s register. 

Scanner’s register address + 

address offset (Ethernet/IP modules) 

Actual represented register = starting register address + address 

offset; you can set the starting register address in the HWCONFIG 

setup page.  

Select the TAG check box.  Select the Consumed TAG name from the list. 

 

Adapter Address/Parameter Target adapter’s register address / parameters 

Select the TAG check box.  
Input the name of the Produced TAG for other connected EIP devices. 

The default name is the same as the name shown in . 

 I/O Mapping Table 

Set up the IN/OUT parameters. When there is no I/O representative 

table presented for the Adapter, the parameters cannot be opened, for 

example in some PLCs. 

 Length  
Set the data mapping length; unit: byte, the maximum is 500 bytes. 

You cannot change the length format here when using TAG. 

 Property Set the advanced data mapping parameters. 

 

 I/O Mapping Table 

Delta EIP devices provide an I/O mapping table. You can use the table to edit the parameters if needed.   

 Name Definition  

 Connection 
Select the connection from the list. Different connections may have 

different mapping parameters.  

 In Input mapping parameters. The No. column shows the maximum 
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 Name Definition  

number of mapping parameters to input. Double-click the Name 

column to open the mapping table to edit the parameters.  

 Out 

Output mapping parameters. The No. column states the maximum 

number of mapping parameters to output. Double-click the Name 

column to open the mapping table to edit. 

 Name 
The parameter name; double-click the Name column to open the 

mapping table to edit the parameters. 

 Value 

Values; after editing and downloading, the scanner stores the values. 

When the connection is established, the values are written to the 

Adapter. 

 

 
 

 Property 

1

2

3

4
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 Name Definition  

 Requested Packet Interval (RPI) Time interval to request packets through the I/O connection, unit: ms 

 Multicast Communication mode setup: Multicast or Point-to-Point 

 Timeout Sets the timeout according to the RPI or a multiple of RPI (RPI*X). 

 Trigger Mode 

Cyclic: renews data cyclically  

Change of State: renews data once there is any change 

Application: renews data according to the product setup   

 Steps to set up and download parameters 

1. Create a data mapping table (※):  

 Right-click the COM port on the Ethernet Scanner, and then click Data Mapping to open the Data Mapping 

Table.  

 
The system creates a Data Mapping Tab, shown for Network_0.  

Network_0 Data Mapping Tab

Network_0 Data Mapping Table
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2. Set the Data Mapping Parameters  

 Type the parameters in the data mapping table. See below for examples 

a) Reading D500–D599 from the Adapter with the IP address 192.168.1.2 to the D10000–D10099 in the 

Scanner. 

b) Writing D20200–D20299 from the Scanner to D100–D199 in the Adapter with the IP address 192.168.1.1

 

 Use TAG function in data mapping 

a) Create a General Device in the Network View as shown below and then set the IP address to be used as  

          a Produced TAG. For adding a device, please refer to Section 9.4.3. 

 

b) Start or switch to the data mapping page. 
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b) In the Property Setting dialog box, enter the data mapping parameters. 

Set the Requested Packet Interval (RPI) to refresh the data between the Scanner and Adapter 

periodically; for example, every 20ms.   

 
3. Download 

 Click the Downloader button on the tool bar to open the Project Downloader window. 

 

 Select the Scanner communication port in EIP Builder; every communication port can download a data 

mapping table.  

 

9.4.5 Diagnosis 

EIP Builder can provide diagnostic information on the connection and data mapping status. For the connection status, 

refer to the Adapter connection status and indicator in the Network View tab; and for data mapping status and error codes, 

refer to Network_0 in the data mapping tab.    
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 Steps to view network status 

 Network View (Connection Status) 

a) Click the Network View tab to check the device status from the indicators: for example RUN / STOP and 

Error indicators for the PLC.   

 
 

The dotted line and the warning sign indicate a connection error, as shown below. 

 
 

 Network_0 (Data Mapping):  

a) Click the On-line Mode button on the toolbar. 

 

  

Status 

Network View 
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b) Click the Network _0 tab to check the data mapping status and the error codes for Network_0. For error 

code definitions, refer to Section 9.6.2.    

Connec tion Stat us

 

 
 

9.5 Programming  

9.5.1 Explicit Message 

All connections in EtherNet/IP can be divided into explicit messaging connections and implicit (or I/O) messaging 

connections. Explicit messaging uses TCP/IP and request/response communications or client/server connections, 

requiring that the instruction include the memory location of the data to be sent to the client. Implicit messaging uses 

UDP/IP, in which a server sends information from predefined memory locations to a client at a given interval, using a 

requested packet interval (RPI) parameter to specify the interval. For details on using implicit messages, please refer to 

Section 9.4.4. This section provides an overview of how the AS Series uses explicit messaging instructions.   

When the AS Series acts a Scanner, you can use the EIPRW instruction (API 2208) to read and write Objects. When EIP 

Builder uses Objects as parameters, each Object includes various parameters. For details on the EIPRW instruction, 

please refer to the AS Programming Manual. For details on Objects that are supported by the AS Series, please refer to 

Section 9.8.  

9.5.2 TAG  

EtherNet/IP can use TAGs to exchange data. A Delta PLC can use Global Symbols to define a TAG, and then Delta HMI 

and third party devices can use the TAG. There are 2 types of EIP TAGs, Produced TAGs and Consumed TAGs.  

1. Produced TAG: a PLC makes Produced tags that send data to Consumed tags in other EIP Scanners for data 

mapping with other EIP devices.  

Connection Status 

Error Codes 
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2. Consumed TAG: EIP Scanners make Consumed tags to receive data from Produced tags for data mapping with other 

EIP devices.  

You can use tags to connect to other EIP devices. Before connecting a Consumed TAG, please check the IP address 

of the device to be connected and the Produced TAG name. One device can have more than one Produced TAG and 

Consumed TAG. See the following example.  

Other EIP devices

Produced TAG

Consumed TAG

Produced TAG 1

Consumed TAG 1

Produced TAG

Consumed TAG

Produced TAG 2

Consumed TAG 2

 

9.5.2.1 Produced TAG 

Creating a Produced TAG 

1. In ISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Produced Tag). 
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2. Double-click EtherNet/IP Table (Produced TAG) to create a Produced TAG. 

 

3. Right click in the EtherNet/IP Table (Produced Tag) window and then click Add a Symbol to open the Add Symbol 

dialog box.   

 

4. Enter the required information in the table to create the Produced TAG.  

 

 

After the settings are complete, download the TAG to the PLC. Other EIP devices can access the Produced TAG with their 

Consumed TAG. For information on creating a Consumed TAG, refer to the EIP device manual.  

9.5.2.2 Consumed TAG 

Creating a Consumed TAG 

1. In ISPSoft, in the Project tree, expand Global Symbols to see EtherNet/IP Table (Consumed Tag). 
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2. Double-click EtherNet/IP Table (Consumed TAG) to create a Consumed TAG. 

 

3. Right click in the EtherNet/IP Table (Consumed Tag) window and then click Add a Symbol.   
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4. In the Add Symbol dialog box, enter the required information in the table to create a consumed tag.  

 

5. You can use tags in the data mapping. Refer to Section 9.4.4 for more information. 

 Descriptions for the Add Symbol dialog box 

1 2 3 4 5

 
Number Name Description 

 Identifier Create Tags for a PLC; up to 40 characters. 

 Address 
Correspond to registers or bytes in a PLC; you can use a data register or M bit 

device.  

 Type 
Supports data types such as BOOL, WORD, DWORD, INT, DINT, REAL, and 

ARRAY (one-dimensional array linear array, up to 512 bytes).  

 Initial Value Not supported  

 Comment Description for the TAG; up to 128 characters.  

 

9.6 Troubleshooting  

This section provides an overview of error codes and troubleshooting for the AS Series.  

9.6.1 Error Code Classification 

There are two types of error code categories for the AS Series: Configuration Errors, and Application Errors. These error 

codes are defined by the ODVA for EtherNet/IP errors. Refer to the following table for AS Series error codes. 

Error Code Classification 

Description 1st Phase 2nd Phase 

Category Item 

Configuration error EDS files mismatched 
Mismatched EDS files lead to I/O connection 

※failure.    
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Data exchange setup error 
Data exchange setup error lead to I/O 

※connection failure.  

Application error Ethernet/IP error ※EtherNet/IP communication failure  

※ Only the last 2 bytes of the error code are shown; for example, only 011C appears for the error code H’1101011C.  

 

9.6.2 Error Codes & How to fix them 

9.6.2.1 Configuration Errors 

Category Error Code Description How to fix them 

EDS Files 

Mismatched 

H’1101011C  

The Transport Class field 

values of the Transport Class 

and Trigger in the EDS file 

are mismatched.  

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010114 

The Vender ID or the Product 

Code in the EDS file is 

mismatched. 

1. Check if the product information and the EDS 

file match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010115 

The device type parameters 

in the EDS file are 

mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010116 
The revision parameters in 

the EDS file are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’1101011E 

 

The direction parameters in 

the EDS file are mismatched. 

 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’1101011F 

The fixed / variable output 

flag in the EDS file is 

mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010120 
The fixed / variable input flag 

in the EDS file is 
1. Check if the product information and the EDS file 
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Category Error Code Description How to fix them 

mismatched. match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010121 
The output priority in the EDS 

file is mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010122 
The input priority in the EDS 

file is mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010123 

The output connection type 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010124 

The input connection type 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010125 

The redundant ownership 

output parameters in the EDS 

file are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010126 

The configuration size 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010129 

The configuration path 

parameters in the EDS file 

are mismatched. 

1. Check if the product information and the EDS file 

match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

H’11010132 The EDS file does not 1. Check if the product information and the EDS file 
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Category Error Code Description How to fix them 

support Null forward open. match.  

2. Reload the EDS file. 

3. Ask the vendor of the device for the EDS file. 

Data 

Exchange 

Setup Error 

H’12010100 I/O connections duplicated 

1. Check if the system has created the I/O 

connections. 

2. Change the connection type to Listen Only. 

H’12010106 Ownership conflict  

1. Check the scanner owner. 

2. Reconfigure the invalid scanner. 

3. Change the connection to multicast. 

H’12010110 
Target for connection not 

configured  

1. Check the I/O connection status. 

2. Activate the I/O connections again. 

H’12010111 Adapter RPI not supported  Check the RPI for the adapter.  

H’12010113 Out of connections 

1. Check if the number of connections exceeds the 

limit. 

2. Reduce the number of the product connections.  

H'12010119 Non-Listen only not opened 

1. Check if the system has created the I/O 

connections. 

2. Check the scanner I/O connection status. 

H’12010127 
Invalid originator to target 

Size  

Check the module number and the product setup file 

to see if they match.  

H’12010128 
Invalid target to originator 

Size 
Check the output size in the connection parameters. 

H’1201012D 
Consumed TAG does not 

exist. 

Check if the parameters in the Consumed tag are set 

correctly.  

H’1201012E 
Produced TAG does not 

exist. 

Check if the parameters in the Produced tag are set 

correctly. 

H’12010204 Unconnected request timeout 

No response from the adapter; check if the power 

and the network connection for the adapter are 

working properly.  

H’12010302 
Network bandwidth NOT 

available for data 

1. Check the I/O connection limit between the 

scanner and the adapter. 

2.  Increase the RPI value or reduce the number of 
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Category Error Code Description How to fix them 

connections.  

H’12010315 
Invalid segment in connection 

path 

Check the module number and the product setup file 

to see if they match.  

 

9.6.2.2 Application Error 

Category Error Code Description How to fix them 

EtherNet/ 

IP Error 
H’00010203 I/O connection timeout  

1. Check the network connection status. 

2. Check if the module is working properly. 

3. Increase the RPI value. 

 

9.7 Studio 5000 Software Operation 

This section provides an overview using Ethernet/IP to connect to a Delta Ethernet/IP Adapter with third party software. 

For this example we use the Rockwell Automation software Studio 5000.  

9.7.1 Architecture 

The Rockwell Automation (RA) EIP Scanner uses Ethernet to connect to a Delta Adapter. The PC connects to the RA 

Scanner through Ethernet or USB. 

 
※ Rockwell Software Studio 5000, ControlLogix, RSLogix are registered trademarks of Rockwell Automation, Inc.  

 Operation Steps:  

Download Data ExchangeData Exchange
Set up

Data Exchange
Table

Network View
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9.7.2 Create a New Project 

 Open Studio 5000 and under Create, click New Project. 

 

 
 

 Select a PLC and select the chassis. This example uses a 1756-L71. 

 
  

New Project

Select PLC 



AS Ser ies Operat ion Manual  

 

9-50 

_9 

 Click Finish to create the new project. 

 
 

 After creating the project, Studio 5000 displays the Controller Organizer and workspace.  

 
 

9.7.3 Create a Scanner 

Next, add the 1756-EN2TR Ethernet/IP module, and then connect to the Ethernet/IP devices through the Ethernet/IP 

module.  

 

 

Select a backplane 
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9.7.3.1 Create a New Ethernet/IP Module 

 Right-click 1756 Backplane 1756-A7 and then click New Module.  

 
 

 Type 1756-EN2TR in the filter field, click the 1756-EN2TR module, and then click Create. 
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 Type the Name, IP address and other required information, and then click OK to add the EtherNet/IP module.  

 
 

 The new 1756-EN2TR module appears in the Controller Organizer tree.  
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9.7.4 Connect to a Delta Adapter 

This section provides an overview of connecting to a Delta Ethernet/IP Adapter with the Rockwell Automation software 

Studio 5000. 

 

9.7.4.1 Import an EDS File 

 In Studio 5000, on the Tools menu, click EDS Hardware Installation Tool.  

 

 

 Select Register an EDS file(s) and click Next. 
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 Select Register a single file and click Browse to find the EDS file to import.  

 
 

 Follow the instructions in the wizard and then click Finish to complete importing the EDS file.  
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9.7.4.2 Create an Adapter 

 In Studio 5000, in the Controller Organizer under 1756-EN2TR, right-click Ethernet and then click New Module.  

 
 

 Type the module number of the imported Delta EDS file in the filter field, click the Delta module, and then click 

Create. 
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 Verify that the product name and IP address are the same as the information shown in the Module Definition 

section.  

 
 

 Click Change if you need to make a change to the module definition.  
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※ In general, there is no need to change the parameters from the imported EDS files which can usually be used 

without modification.  

 In the New Module dialog box, click the Connection tab to modify the Requested Packet Interval and Input Type 

settings. The RPI uses the I/O connection to a Scanner to exchange data at regular intervals, and the units are 

micro-seconds. For Input Type select either Unicast or Multicast. The Input Type selections may vary for different 

products.  
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 Click OK to create the adapter. The new Delta Adapter appears in the Controller Organizer tree.  

 

 
 

9.7.5 Download 

The next step is to download the project to the PLC and go online.  

 
 In Studio 5000, on the Communications menu, click Who Active. To establish a connection, select the Scanner 

connected to the PC, and then on the Communications menu click Download.  
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 After the connection is successfully established, the I/O status shows green by I/O OK.  

 
 

9.7.6 Data Mapping 

In the Controller Organizer, you can map data, including Configuration, Input and Output parameters. When you create a 

device I/O Configuration, the tags are added automatically.  

 Click Program TAGs to display the Tags window. 
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 Tags are listed in the Name column. Tag names begin with a product name and end with C or I1 or O1, separated 

from the name by a colon (:), for example CMCEIP01:C, CMCEIP01:I1, and CMCEIP01:O1. 

 
 

 Tag name：C indicates the tag contains information from the Adapter EDS file, including Input and Output 

parameters. You can edit these parameters in Studio 5000.  

 Tag name：I1 indicates that the mapping starts from TAG：I1[0], and is mapped to the first parameters of the Adapter 

output. The length is the output length provided by the Adapter.  

 Tag name: O1, indicates that the mapping starts from TAG：O1[0], and is mapped to the first parameters of the 

Adapter Input. The length is the input length provided by the Adapter. 

 

Tag:I1[0]

Tag:I1

Tag:I1[1]

Tag:I1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Output

Tag:O1[0]

Tag:O1

Tag:O1[1]

Tag:O1[31]

Parameter_0

Parameter_1

Parameter_31

Adapter
Input

Delta Adapter
VFD-C2000

RA EIP Scanner
1756-L71+1756-EN2TR EtherNet/IP

..
.

...

... ..
.
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9.8 CIP Object 

9.8.1 Object List 

CIP requires objects (groups of related data and behaviors associated with this data) to describe a device, how it functions, 

communicates, and to define its unique identity. Objects can be further defined by Class (a set of objects representing the 

same type of system), Instance (a copy of an object), and Attribute (data values). An object’s instance and class have 

attributes, providing services and implementing behaviors. Instance 0 contains the basic information for every object, that 

is: version and length. Instance 1–N contains parameters for creating connections. You can get product parameters from 

the supported service code through objects.  

 
The supported EtherNet/IP objects are listed in the following table. Refer to Section 9.8.2 for the data type definitions. 

Refer to Section 9.8.3 for object contents. Refer to Section 9.5 for object reading and writing.  

Object Name Function Class ID 

Identity Object Provides identification of general information about the device.  1 (H’01) 

Message Router Object 

Provides a messaging connection point through which a client 

can address a service to any object class or instance residing in 

the physical device. 

2 (H’02) 

Assembly Object 

Binds attributes of multiple objects, which allows data to or from 

each object to be sent or received over a single connection and 

can be used to bind input data or output data.  

4 (H’04) 

Connection Manager 

Object 

Provides connection and connectionless communications, 

including establishing connections across multiple subnets. 
6 (H’06) 

Port Object 
Describes the communication interfaces that are present on the 

device and visible to CIP, including USB, Ethernet/IP and more. 
244 (H’F4) 

TCP/IP Interface Object Provides the mechanism to configure a device’s TCP/IP network 245 (H’F5) 
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Object Name Function Class ID 

interface; examples of configurable items include the device’s IP 

Address, Network Mask, and Gateway Address. 

Ethernet Link Object 
Maintains link-specific counters and status information for an 

IEEE 802.3 communications interface.  
246 (H’F6) 

X Register Bit/Word Register 848（H’350） 

Y Register Bit/Word Register 849（H’351） 

D Register Bit/Word Register 850（H’352） 

M Register Bit Register 851（H’353） 

S Register Bit Register 852（H’354） 

T Register Bit/Word Register 853（H’355） 

C Register Bit/Word Register 854（H’356） 

HC Register Bit/Word Register 855（H’357） 

SM Register Bit Register 856（H’358） 

SR Register Word Register 857（H’359） 

 

9.8.2 Data Type 

This section provides an overview of the data types supported by objects.  

Data Type Description 

BOOL False(H’00) or True(H’01) 

SIGNED 

INTEGER 

SINT(1 byte), INT(2 bytes), DINT(4 bytes), LINT(8 bytes) 

Number 1st 2nd 3rd 4th 5th 6th 7th 8th 

SINT 0LSB        

INT 0LSB 1LSB       

DINT 0LSB 1LSB 2LSB 3LSB     

LINT 0LSB 1LSB 2LSB 3LSB 4LSB 5LSB 6LSB 7LSB 

 

Example: DINT value = H’12345678 

Number 1st 2nd 3rd 4th 

DINT 78 56 34 12 
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Data Type Description 

UNSIGNED 

INTEGER 

USINT(1 byte), UINT(2 bytes), UDINT(4 bytes), ULINT(8 bytes) 

Ex: UDINT value = H’AABBCCDD 

Number 1st 2nd 3rd 4th 

UDINT DD CC BB AA 
 

STRING 

ASCII CODES, 1 or 2 bytes/words 

STRING: 2 bytes character count + 1 byte character  

 Contents (Char count) Contents (String contents) 

STRING 04 00 4D 69 6C 6C 

 

STRING2: 2 bytes character count + 2 byte character 

 Contents (Char count) Contents (String contents) 

STRING2 04 00 4D 00 69 00 6C 00 6C 00 

 

SHORT_STRING: 1 bytes character count + 1 byte character 

 Contents (Char count) Contents (String contents) 

STRING 04 4D 69 6C 6C 
 

Fixed LENGTH 

BIT STRING 

BYTE (1 byte), WORD (2 bytes), DWORD (4 bytes), LWORD (8 bytes) 

  1st 2nd 3rd 4th 5th 6th 7th 8th 

Byte 7…0        

WORD 7…0 15…8       

DWORD 7…0 15…8 23…16 31…24     

LWORD 7…0 15…8 23…16 31…24 39…32 47…40 55…48 63…56 
 

STRINGI 

A single string consists of multiple language representation 

Name Data Type Meaning 

Number USINT 
The number of internationalized character 

strings 

Strings 
Array of: 

Struct of: 

Array of individual internationalized character 

strings 

LanguageChar1 USINT 
The first ASCII character of the ISO 639-2/T 

language 
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Data Type Description 

LanguageChar2 USINT 
The second ASCII character of the ISO 639-2/T 

language 

LanguageChar3 USINT 
The third ASCII character of the ISO 639-2/T 

language 

CharStringStruct USINT 

The structure of the character string, limited to 

the Elementary Data type value 0xD0 

(STRING), 0xD5 (STRING2), 0xD9 (STRINGN) 

and 0xDA (SHORT_STRING) 

CharSet UINT 

The character set which the character string is 

based on which comes from IANA MIB Printer 

Code (RFC 1759). 

International String 
Defined in 

CharStringStruct 

An array of 8-bit octet elements which is the 

actual international character string 

ISO 639-2/T language: 

Language First Character Second Character Third Character 

English e n G 

French f r e 

Spanish s p a 

Italian i t a 
 

STRUCT 

STRUCT of: Composed of any data types. 

Ex.: STRUCT of { BOOL, UINT, DINT } = { TRUE, H’1234, H’56789ABC } 

 1st 2nd 3rd 4th 5th 6th 7th 

Byte 01 34 12 BC 9A 78 56 
 

ARRAY 

Array of: Composed of one data type. 

Ex.: ARRAY of UINTs = { 1，2，3 } 

Number 1st 2nd 3rd 4th 5th 6th 

Array 01 00 02 00 03 00 
 

EPATH 

A path that consists of multiple segments and references the class, instance and attribute of 

another object. 

Example：Identity Object, Instance attribute 5 = “ 20 01 24 01 30 05 “ 
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9.8.3 Identity Object (Class ID: 01 Hex) 

This object stores identity information that consists of the Vendor ID, Device Type, Product Code and Major Revision for 

your device. 

 Service Code 

Service 

code 
Service Name 

Attribute 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’05 Reset X V Resets the drive to the start-up state. 

H’0E Get_Attribute_Single V V Read one attribute 

 Class 

 Class ID: H’01 

 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’1 Revision of this object  

H’02 Max Instance Get UINT H’1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’1 

Number of object instances currently 

created at this class level of the 

device 

 

 When Instance = 0, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Vendor ID Get UINT H’31F Delta Electronics, Inc. 

H’02 Device Type Get UINT H’0C Communication Adapter 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’03 Product Code Get UINT H’4000 Product Code 

H’04 

Revision 

Get 

STRUCT -- Revision of this device: Major / Minor 

Major Revision USINT H’01 Major Revision Range: H’01–H’7F 

Minor Revision USINT H’01 Minor Revision Range: H’01–H’FF 

H’05 Status Get WORD H’00 Status, refer to the following ※1 table 

H’06 Serial Number Get UDINT H’abcd 
The last 4 characters of the MAC 

address, ab:cd 

H’07 Product Name Get STRING “AS300T” 
The maximum length of a product 

name is 32 characters. 

   
 

※1 Status Description (H’05) 

Bit (s) Name Description 

0 Owned 

Does the device has an owner connection?. 

0: No 

1: Yes 

1 Reserved 0，Always OFF 

2 Configured 

Is the device configured? 

0: No 

1: Yes 

3 Reserved 0，Always OFF 

4-7 Extended Device Status 

0: Self-testing 

1: Firmware update 

2: At least one faulted I/O connection 

3: No I/O connections established 

4: Non-volatile configuration error 

5: Major fault 

6: At least one I/O connection in run mode 

7: At least one I/O connection established, all in idle 

mode. 

8-15: Reserved 
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Bit (s) Name Description 

8 Minor Recoverable Fault 
0: No minor recoverable fault detected 

1: Minor recoverable fault detected 

9 Minor Unrecoverable Fault 
0: No minor unrecoverable fault detected 

1: Minor unrecoverable fault detected 

10 Major Recoverable Fault 
0: No major recoverable fault detected 

1: Major recoverable fault detected 

11 Major Unrecoverable Fault 
0: No major unrecoverable fault detected 

1: Major unrecoverable fault detected 

 

9.8.4 Message Router Object (Class ID: 02 Hex) 

This object provides a messaging connection point through which a client may address a service to any object class or 

instance residing in the physical device. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

 Class 

 Class ID: H’02 

 Instance 

 H’00: Class Attribute 

 H’01: Instance Attribute 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’01 Revision of this object 

 

 When Instance = 0, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’02 Number Available Get UINT H’0 
The maximum number of 

connections 
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Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’03 Number Active Get UINT H’0 
The number of connected 

connections 

 

9.8.5 Assembly Object (Class ID: 04 Hex) 

This object binds attributes of multiple objects, which allows data to or from each object to be sent or received over a 

single connection and can be used to bind input data or output data.  

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V V Read a single attribute 

H’10 Set_Attribute_Single X V Edit a single attribute 

 Class 

 Class ID：H’04 

 

 Instance 

 H’00：Class Attribute 

 H’64：I/O Connection Output 1 

 H’65：I/O Connection Input 1 

 H’66：I/O Connection Output 2 

 H’67：I/O Connection Input 2 

 H’72：I/O Connection Output 8 

 H’73：I/O Connection Input 8 

 H’74-H’7A Reserved 

 H’80：Configuration 1 

 H’81：Configuration 2 

 H’87：Configuration 8 



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-69 

9_

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’C7 
The maximum number of 

instances 

 

 When Instance = 64–87, the Instance Attributes are listed below. 

I/O Message Connection 

Connection No. Function Instance Attribute Length 

Connection 1 

Input 0x65 100 words 

Output 0x64 100 words 

Configuration 0x80 8 words 

Connection 2 

Input 0x67 100 words 

Output 0x66 100 words 

Configuration 0x81 8 words 

Connection 3 

Input 0x69 100 words 

Output 0x68 100 words 

Configuration 0x82 8 words 

Connection 4 

Input 0x6B 100 words 

Output 0x6A 100 words 

Configuration 0x83 8 words 

Connection 5 

Input 0x6D 100 words 

Output 0x6C 100 words 

Configuration 0x84 8 words 

Connection 6 

Input 0x6F 100 words 

Output 0x6E 100 words 

Configuration 0x85 8 words 

Connection 7 

Input 0x71 100 words 

Output 0x70 100 words 

Configuration 0x86 8 words 
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Input 0x73 100 words 

Output 0x72 100 words 

Configuration 0x87 8 words 

 

9.8.6 Connection Manager Object (Class ID: 06 Hex) 

Use this object for connection and connectionless communications, including establishing connections across multiple 

subnets. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’0E Get_Attribute_Single V X Read a single attribute 

H’4E Forward_Close X V Close a connection 

H’54 Forward_Open X V 
Open a connection; the maximum 

data size is 511 bytes.   

 Class 

 Class ID：H’06 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance  Get UINT 1 
Maximum instance number of this 

object 
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 When Instance = 1, the Instance Attributes are listed below. 

Attribute Name 
Access 

Rule 
Data Type Values Description 

H’01 Open Requests Get UINT H’0 
Number of Forward Open service 

requests received.  

H’02 Open Format Rejects Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

bad format. 

H’03 
Open Resources 

Rejects 
Get UINT H’0 

Number of Forward Open service 

requests that were rejected due to 

lack of resources. 

H’04 Open Other Rejects Get STRUCT H’0 

Number of Forward Open service 

requests that were rejected for 

reasons other than bad format or 

lack of resources. 

H’05 Close Requests Get WORD H’0 
Number of Forward Close service 

requests received. 

H’06 Close Format Rejects Get UDINT H’0 

Number of Forward Close service 

requests that were rejected due to 

bad format. 

H’07 Close Other Rejects Get STRING H’0 

Number of Forward Close service 

requests that were rejected for 

reasons other than bad format. 

H’08 Connection Timeouts Get UINT H’0 

Total number of connection timeouts 

that have occurred in connections 

controlled by this Connection 

Manager. 
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9.8.7 Port Object (Class ID: F4 Hex) 

This section describes the communication interfaces that are present on the device and visible to CIP, including USB, 

EtherNet/IP and more. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V 
Returns a predefined listing of this 

objects’ attributes 

H’0E Set_Attribute_Single V V 
Returns the contents of the 

specified attribute. 

 

 Class 

 Class ID：H’F4 

 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT 1 Revision of this object 

H’02 Max Instance Get UINT 1 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT 1 

Number of object instances currently 

created at this class level of the 

device 

H’08 Entry Port Get UINT 1 Communication port for EtherNet/IP 

H’09 Port Instance Info Get 
ARRAY of 

STRUCT of 
-- 

Port Instance information: Port Type 

+ Port Number 
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Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

Port Type UINT H’04 
EtherNet/IP, refer to the following 

※1 

Port Number UINT H’01 Identifies each communication port 

 

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Port Type Get UINT H’04 
EtherNet/IP, refer to the following 

※1 

H’02 Port Number Get UINT H’01 Identifies each communication port 

H’03 

Link Object 

Get 

STRUCT of -- 
Identifies Object attached to this 

port. Path length + Link Path 

Path Length UINT -- Path length 

Link Path EPATH -- Path segment 

H’04 Port Name Get 
SHORT_ 

STRING 
EIP1 Name of the communication port 

H’07 
Port Number and 

Node Address 
Get EPATH 01 01 

Communication port number and 

node number of this device on port. 

 

※1 Communication Port Type 

Communication Port Type Description 

1 Self-defined 

2 ControlNet 

3 ControlNet Redundant 

4 EtherNet/IP 

5 DeviceNet 

201 Modbus/TCP 

203 SERCOS III 
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9.8.8 TCP/IP Interface Object (Class ID: F5 Hex) 

This object provides the mechanism to configure a device’s TCP/IP network interface. Examples of configurable items 

include the device’s IP Address, Network Mask, and Gateway Address. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attribute_Single V V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

 

 Class 

 Class ID = H’F5 

 Instance 

 H’00：Class Attribute 

 H’01：Instance Attribute 

 H’N: Instance #N Attribute, number of IP addresses that the device supported 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’2 Revision of this object 

H’02 Max Instance Get UINT H’2 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’2 

Number of object instances currently 

created at this class level of the 

device 

 

 

 

 

 

 

 



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-75 

9_

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Status Get DWORD H’2 
IP status, refer to the following  

※1 

H’02 
Configuration 

Capability 
Get DWORD H’15 

Configuration capability, refer to 

the following ※2 

H’03 
Configuration 

Control 
Get/Set DWORD H’0 

Configuration Control, refer to the 

following ※3 

H’04 

Physical Link 

Object： 

Get 

STRUCT of -- Path to physical link object 

Path Size UINT H’0 Size of Path 

Path EPATH -- 
Logical segments identifying the 

physical link object 

H’05 

Interface 

Configuration： 

Get/Set 

STRUCT of -- 
TCP/IP network interface 

configuration. 

IP Address UDINT H’C0A80005 
The device’s IP address; 

192.168.1.5 

Network Mask UDINT H’FFFFFF00 
The device’s network mask:  

255.255.255.0 

Gateway Address UDINT H’C0A80001 
Default gateway address: 

192.168.0.1 

Name Server UDINT 0 Primary name server 

Name Server 2 UDINT 0 Secondary name server 

Domain Name STRING 00 00 Default domain name 

H’06 Host Name Get/Set STRING AS300T Device name 

 

※1 Interface Status 

Status Description 

0 The Interface Configuration attribute has not been configured. 

1 
The Interface Configuration attribute contains valid configuration obtained from BOOTP, DHCP or 

non-volatile memory. 

2 The Interface Configuration attribute contains valid configuration obtained from hardware. 
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※2 Interface Capability Flags 

Bit Description 

0 BOOTP Client 

1 DNS Client 

2 DHCP Client 

3 DHCP-DNS Update 

4 Configuration Settable 

5 Hardware Configurable 

6 Interface Configuration Change Requires Reset 

 

※3 Interface Configuration Control 

Status Description 

0 
The device uses the interface configuration values previously stored (for example, in non-volatile 

memory or through hardware switches). 

1 The device obtains its interface configuration values through BOOTP. 

2 The device obtains its interface configuration values through DHCP on start-up. 

 

9.8.9 Ethernet Link Object (Class ID: F6 Hex) 

This object maintains link-specific counters and status information for an IEEE 802.3 communications interface. 

 Service Code 

Service 

Code 
Service Name 

Support 
Description 

Class Attribute Instance Attribute 

H’01 Get_Attributes_All X V Read all attributes 

H’0E Get_Attributes_Single V V Read one attribute 

 

 Class 

 Class ID: H’F6 

 

 Instance 

 H’00: Class Attribute 
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 H’01: Instance Attribute 

 H’N: Instance #N Attribute, the number of the Ethernet port 

 

 When Instance = 0, the Class Attributes are listed below.  

Class 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Revision Get UINT H’03 Revision of this object 

H’02 Max Instance Get UINT H’021 
Maximum instance number of this 

object 

H’03 Number of Instance Get UINT H’01 
Number of object instances currently 

created at this class level of the device 

 

 

 When Instance = 1, the Instance Attributes are listed below. 

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’01 Interface Speed Get DWORD H’64 

Interface speed currently in use  

10(H’0A), 100(H’64), 1000(H’3E8) 

Mbps 

H’02 Interface Flags Get DWORD H’F 
Ethernet port status, refer to the 

following ※1 

H’03 Physical Address Get 
ARRAY of 

6 USINTs 

By 

Product 
MAC address 

H’0A 

Interface Label 

Get 

SHORT_S

TRING 
NA 

Define the name of the Ethernet port  

For example: for port 1, the definition 

of the name in string is 01 31. 

Length USINT NA 
The maximum length of the name is 

16 words. 

Interface name 
SHORT_S

TRING 
NA 

Use ASCII characters to name the 

Ethernet port name. 
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※1 Interface Flag Table 

 

9.8.10 X Register (Class ID: 350 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’32 Read_Parameter X V Read Parameter 

 

 Class 

 Class ID：H’350 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

Bit (s) Name Description 

0 Link Status 
0 indicates an inactive link 

1 indicates an active link 

1 Half/Full Duplex 
0 indicates half duplex 

1 indicates full duplex 

2-4 Negotiation Status 

0：Auto-negotiation in progress 

1：Auto-negotiation and speed detection failed 

2：Auto negotiation failed but detected speed 

3：Successfully negotiated speed and duplex 

4：Auto-negotiation not attempted. Forced speed and duplex. 

5 Manual Setting Requires Reset Set to zero 

6 Local Hardware Fault 
0: the interface detects no local hardware fault 

1: a local hardware fault is detected 

7-31 Reserved 0 
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 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 X0.0 Get BOOL H’00 X0.0 bit register 

H’01 X0.1 Get BOOL H’00 X0.1 bit register 

H’02-H’03FE X0.2-X63.14 Get BOOL H’00 X0.2 -X63.14 bit register 

H’3FF X63.15 Get BOOL H’00 X63.15 bit register 

 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 X0 Get INT H’00 X0 word register 

H’01 X1 Get INT H’00 X1 word register 

H’02-H’3E X2-X62 Get INT H’00 X2-X62 word register 

H’3F X63 Get INT H’00 X63 word register 

 

9.8.11 Y Register (Class ID: 351 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’351 

 

 Instance 

 H’01：Instance Attribute, Bit Register 
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 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 Y0.0 Set BOOL H’00 Y0.0 bit register 

H’01 Y0.1 Set BOOL H’00 Y0.1 bit register 

H’02-H’03FE Y0.2-Y63.14 Set BOOL H’00 Y0.2-Y63.14 bit register 

H’3FF Y63.15 Set BOOL H’00 Y63.15 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 Y0 Set INT H’00 Y0 word register 

H’01 Y1 Set INT H’00 Y1 word register 

H’02-H’3E Y2-Y62 Set INT H’00 Y2-Y62 word register 

H’3F Y63 Set INT H’00 Y63 word register 

 

9.8.12 D Register (Class ID: 352 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’352 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 
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 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 D0.0 Set INT H’00 D0.0 bit register 

H’01 D0.1 Set INT H’00 D0.1 bit register 

H’02-H’752FE D0.2-D29999.14 Set INT H’00 D0.2-D29999.14 bit register 

H’752FF D29999.15 Set INT H’00 D29999.15 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 D0 Set INT H’00 D0 word register 

H’01 D1 Set INT H’00 D1 word register 

H’02-H’752E D2-D29998 Set INT H’00 D2-D29998 word register 

H’752F D29999 Set INT H’00 D29999 word register 

 

9.8.13 M Register (Class ID: 353 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’353 

 

 Instance 

 H’01：Instance Attribute, Bit Register 
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 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 M0 Set BOOL H’00 M0 bit register 

H’01 M1 Set BOOL H’00 M1 bit register 

H’02-H’1FFE M2-M8190 Set BOOL H’00 M2-M8190 bit register 

H’1FFF M8191 Set BOOL H’00 M8191 bit register 

 

9.8.14 S Register (Class ID: 354 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’354 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 S0 Set BOOL H’00 S0 bit register 

H’01 S1 Set BOOL H’00 S1 bit register 

H’02-H’7FE S2-S2046 Set BOOL H’00 S2-S2046 bit register 

H’7FF S2047 Set BOOL H’00 S2047 bit register 
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9.8.15 T Register (Class ID: 355 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’355 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 T0 Set BOOL H’00 T0 bit register 

H’01 T1 Set BOOL H’00 T1 bit register 

H’02-H’1FE T2-T510 Set BOOL H’00 T2-T510 bit register 

H’1FF T511 Set BOOL H’00 T511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 T0 Set INT H’00 T0 word register 

H’01 T1 Set INT H’00 T1 word register 

H’02-H’1FE T2-T510 Set INT H’00 T2-T510 word register 

H’1FF T511 Set INT H’00 T511 word register 
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9.8.16 C Register (Class ID: 356 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’356 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 C0 Set BOOL H’00 C0 bit register 

H’01 C1 Set BOOL H’00 C1 bit register 

H’02-H’1FE C2-C510 Set BOOL H’00 C2-C510 bit register 

H’1FF C511 Set BOOL H’00 C511 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 C0 Set INT H’00 C0 word register 

H’01 C1 Set INT H’00 C1 word register 

H’02-H’1FE C2-C510 Set INT H’00 C2-C510 word register 

H’1FF C511 Set INT H’00 C511 word register 
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9.8.17 HC Register (Class ID: 357 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’357 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 H’02：Instance Attribute, Word Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 HC0 Set BOOL H’00 HC0 bit register 

H’01 HC1 Set BOOL H’00 HC1 bit register 

H’02-H’FE HC2-HC254 Set BOOL H’00 HC2-HC254 bit register 

H’FF HC255 Set BOOL H’00 HC255 bit register 

 When Instance = 2, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 HC0 Set DINT H’00 HC0 word register 

H’01 HC1 Set DINT H’00 HC1 word register 

H’02-H’FE HC2-HC254 Set DINT H’00 HC2-HC254 word register 

H’FF HC255 Set DINT H’00 HC255 word register 
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9.8.18 SM Register (Class ID: 358 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’358 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 SM0 Set BOOL H’00 SM0 bit register 

H’01 SM1 Set BOOL H’00 SM1 bit register 

H’02-H’FFE SM2-SM4094 Set BOOL H’00 SM2-SM4094 bit register 

H’FFF SM4095 Set BOOL H’00 SM4095 bit register 
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9.8.19 SR Register (Class ID: 359 Hex) 

 Service Code 

Service Code Service Name 

Support 

Description 
Class Attribute 

Instance 

Attribute 

H’0E Get_Attribute_Single X V Read one attribute 

H’10 Set_Attribute_Single X V Write one attribute 

H’32 Read_Parameter X V Read Parameter 

H’33 Write_Parameter X V Write Parameter 

 

 Class 

 Class ID：H’359 

 

 Instance 

 H’01：Instance Attribute, Bit Register 

 When Instance = 1, the Instance Attributes are listed below.  

Instance 

Attribute 
Name 

Access 

Rule 
Data Type Values Description 

H’00 SR0 Set INT H’00 SR0 word register 

H’01 SR1 Set INT H’00 SR1 word register 

H’02-H’7FE SR2-SR2046 Set INT H’00 SR2-SR2046 word register 

H’7FF SR2047 Set INT H’00 SR2047 word register 
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9.9 Delta EIP Product List 

9.9.1 Delta EIP Products 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

AH10EMC-5A V1.00 

AS300 Series V1.00 

AS200 Series V1.00 

Small PLC DVP-ES2-E Series V1.00 

Inverter 
VFD-MS300 Series (CMM-EIP01 Communication Card) V3.60 

VFD-C2000 Series (CMC-EIP01 Communication Card) V1.06 

 

9.9.2 Delta EIP Products, DLR (Device Level Ring) supported  

Positioning Product Firmware Version 

Mid-range 

PLC 

AH10EN-5A V2.00 

AHRTU-ETHN-5A V1.00 

 

9.9.3 Delta EIP Products, Scanner supported 

Positioning Product Firmware Version 

Mid-range 

PLC 

AHCPU511-EN, AHCPU521-EN, AHCPU531-EN V2.00 

AH10EN-5A V2.00 

Small PLC AS Series V1.00 
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9.10 Operation and Monitor on the Web 

Users can input the IP address of the AS CPU series to connect to the device. The web page consists of three parts, 

Login/Logout, Menu and Context after the module connection is made.  

(1) Login / Logout 

(2) Menu 

(3) Context 

 

 

9.10.1 Menu 

The Menu section provides items such as Information and Data Monitor for setup.  

Item  Description Subtitle 

Information 
Provide the information of 

AHRTU-ETHN 
Device information 

Data Monitor Data monitor setup Data monitor setup 

 

9.10.2 Information 

 Device information 

The following page introduces basic product information. The page can be opened even if you have not 

logged in. The page cannot be revised. 
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9.10.3 Data Monitor 

 Data monitor setup page 

Here provides 4 device monitoring page. Up to 30 items can be monitored on each page. 

(1) Add a new table: define the table name and then modify the default update cycle according to your requirement. After 

that press Save Table List button, a Save Successful window will show up. And the table will be added on the 

monitoring page.  
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(2) Add a new device to be monitored: select a table you’d like to edit and then click Edit, and the table to be edited will 

appear in the lower part of the page.

 

(3) Edit the device to be monitored: after editing is done, scroll the page down to see the Save table button. Click the 

Save table button and once the setup is done, a Save Successful window will show up.  

Column Description 

MODBUS 6 digit The Modbus address of the device to be monitored (6 digits) 

Radix 
Supported display format: Signal Decimal, Unsignal Decimal, Hexadecimal, Octal and 

Binary. 

Point How many digits to show after the decimal point 

Read only Set the monitoring to Read only 

Description User-defined 
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 Monitor table page 

Display the data to be monitored; green means the status is updated successfully and yellow means it is still in operation.  

Column Description 

Update Cycle Update the default cycle; unit: second; default is 1 second. 

“-“ Button Press this button to decrease the value in the update cycle by 1; the minimum value is 1. 

“+” Button Press this button to increase the value in the update cycle by 1; the maximum value is 60. 

Device The Modbus address of the device to be monitored (6 digits) 

Value 
Supported display format: Signal Decimal, Unsignal Decimal, Hexadecimal, Octal and 

Binary. 

Description User-defined 

 

 

 

 



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-93 

9_

Browsers supported are listed below: 

Manufacturer Browser Version 

Microsoft Internet Explorer V7.0 and later versions 

Google Chrome V14 and later versions 

Mozilla Firefox V17 and later versions 

 

9.11 Delta EIP Product Application (with OMRON Products) 

9.11.1 Architecture 

Delta EtherNet/IP Scanner connects to OMRON EtherNet/IP Adapter through Ethernet communication. PC connects to 

Delta EtherNet/IP Scanner through Ethernet communication or USB connection.  

Software versions for AS300 and OMRON NJ501-1300: 

 AS300 CPU  

ISPSoft: V3.02.25 

COMMGR: V1.06.05 

HWCONFIG: V3.02.20 

EIP Builder: V1.03.01 

 

 OMRON NJ501-1300: 
Sysmac Studio : V1.15 
Network Configurator : V3.59c 

 

 

 

 

 Operation Steps:  

Download Connect ion 
Status

Data Mapping
Set up

EtherNet /IP
Set upNetwork Set up
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9.11.2 TAG Connection 

EtherNet/IP can use TAGs to exchange data. Here AS300 CPU acts as Master and OMRON NJ501-1300 as a Producer 

TAG to establish an EtherNet/IP communication.  

 

 Create Produced TAG 

1. Start the OMRON software Sysmac Studio. Select Connect to Device. Configure the parameters and then click 

Connect.  

 
 

2. After the connection is successfully established, click Tools on the menu bar. And then select EtherNet/IP 

Connection Settings to access the EtherNet/IP connection settings. 

3. Right-click the cell of the Node Address you’d like to edit its EtherNet/IP settings and then select Edit to open the 

EtherNet/IP communication setting window.   

4. Double-click Global Variables under Programming - Data in the Multiview Explorer. Right-click in the global 

variable table and select Create New from the menu. 
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5. Right-click in the global variable table and select Create New from the menu. 

※Click Controller on the menu bar and change the Project to Disconnected before creating a new global  
 

6. Set the Network Publish to Output. 
And then with this attribute, you can access a variable from external devices through CIP communications or a 
tag data link. For tag data links, this can be a variable for data output (from the local Controller to another 
Controller). 

 
 

7. Select the tab of Built-in EtherNet/IP Connection Settings and select the Tag Set from the left. Right-click in 
the editing area and select Create New Tag Set from the menu and then name the tag set as ToAS .   

 
 

8. Right-click on the created Tag Set and select Create New Tag from the menu.  
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9. The tag is added in the created tag set.  

 
 

10. Click Controller and then Synchronize…from the menu bar to synchronize the setting with OMRON Scanner. 

 
 

11. Create Tag sets in Network Configurator. Open Network Configurator and select Option-> Select Interface-> 
Ethernet I/F. 
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12. Select Network -> Connect 

 
 

13. Select Interface and click OK to confirm the setting.  

 
 

 
 

14. The blue light indicates the connection is working normally. 
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15. Drag OMRON NJ501-1300 from the EtherNet/IP Hardware section to the network view. 

 
 

16. Right-click OMRON NJ501-130 (the scanner) and select Parameter -> Edit from the menu.  
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17. Click Edit Tags on the Tag Sets tab and click New on the Out-Produce tab to create a new tag with the same 
name and length as the one from the “output” tag set in Sysmac .  

 
 

18. The new tag is created as shown below.  
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19. After setting, click Network -> Download.  

 
 

20. After downloading, the Network Configurator dialog box is displayed.  
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 Create a Consumed TAG 
1. Start ISPSoft and click Tools -> Communication Settings and select a driver with Ethernet communication.  

※ Before setting the communication, make sure COMMGR is working normally and save the driver settings.  

 
 

 
 

2. Click Global Symbols to expand the tree node and see the options. Double-click EtherNet/IP Table (Consumed 
Tag) from the Project section on the left. Right-click the blank area and select Add a Symbol.  
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3. Set the data type to ARRAY[200] OF WORD and then click OK to confirm the setting.  
※ Data size should be the same as the Produced Tag data size

 
 
A symbol is added, as the image shown below. 

 
 

4. Go to PLC-> Transfer -> Download to download the parameters to the Scanner. 
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5. Double-click HWCONFIG from the Project section on the left to start HWCONFIG.  

 
 
6. Right-click the PLC and select Communication Software - > EIP Builder to start EIP Builder. 

 
 
7. Click Tool-> DDF(EDS) Manager to import the EDS File.  
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8. Drag and drop the device from the Product List on the right to add have it added in the Network View.  
※ You can select the device and click the Information tab to edit its IP address. 

 
 

9. Drag and drop the red spare to have the Ethernet communication port connected to the network. 

 

  



Chapter  9 Ethernet  Spec i f icat ion and Operat ion 

 

9-105 

9_

10. Right-click the CPU’s communication port and select Data Mapping to create a data mapping table.  

 
 
11. Make sure the data below CPU Address/TAG and Adapter/TAG is correct.  
※ CPU Address/TAG: Consumed TAG 
   Adapter /TAG: Produced TAG, created by Producer 
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12. Click Operate-> Downloader to download the parameters to the Scanner. 

 
 

 
 Connection Check 

1. Click  to have the project in On-line Mode and see if the network lines are solid ones.  
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2. The solid network lines indicate the data mapping is being monitored successfully.  

 
 
 Data Mapping 
1. Start Sysmac Studio and make sure the project is in Online Mode. Go to View -> Watch Tab Page on the menu bar. 

Click Watch Tab Page to monitor.  

 
 

2. Select Watch (Table) 1 and input a name for the tag.  
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3. Modify the values according to the display format. Make sure the value in the Online Value column is the same as 
the value in the Modify column.  

 
 
4. Start ISPSoft, and select Device Monitor Table -> New to create a new device monitor table.  

 
 

5. Double click the blank area in the Monitor Table and then select the Identifier tab. Set up the Object (variable name) 
and the Name (source) and then click OK to confirm the setting.  
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6. After setting up, switch to Online Mode.  

 
 

7. Make sure the values in Consumed Tag are the same as the ones in Produced Tag.  
 

9.11.3 IO Connection 
 Set up an IO Connection from a slave station 
1. Create two variables and set the rule of one variable as input and set the rule of the other variable as output. Set 

the data type and length as Array[0..99] of word. 

 
 

2. Go to Tools -> Export Global Variables -> Network Configurator on the menu bar.  
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3. Start Network Configurator and then add and edit NJ501-1300 from the Ethernet Hardware List on the left. 
Select Parameter -> Edit and click To/From File -> Export to File on lower right corner of the Tag Sets page. 
 

 
 

4. After the file is imported, make sure the input and output variables are imported in In-Consume and Out-Produce 
sections.   
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5. Click the variable in In-Consume section and select Edit. 
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6. Click Advanced button in the Edit Tag Set window and set the Instance ID to Manual and then input the Instance ID 
you’d like to use for IDs in In-Consume section.  

 
 

7. Use the same method to set the Instance ID manually for IDs in In-Consume section as you have set for IDs in 
Out-Produce section. 

 
 

8. When the settings for Instance ID are done, click OK to confirm the settings on Edit Device Parameter.  
9.  
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10. Click Network -> Download to download the parameters to the slaves.   

 
 

 Set up an IO Connection from a Master station 
1. Start EIP Builder and drag and drop a General Device into the Network View area and set up network connection.  

 
 

 
2. Click slave icon and set up its IP address and then configure the parameters in the EIP Parameter tab.  
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3. Set up the slave IO connection:  
1) Master Output Instance ID = Slave Input (In-Consume) Instance ID 
2) Master Input Instance ID = Slave Output (Out-Produce）Instance ID 

※ Refer to slave’s operation manual for more information on Instance IDs.  
 

4. Set up the connection and start data mapping. 
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5. Download the EIP parameters to the master.  

 
 

 Connection status 
1. After the parameters are downloaded, change the project to Online Mode. And make sure the monitoring on 

the network and the data mapping table is normal.  
Network View 
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Data mapping status 

 
 
 Data Mapping 
1. Start ISPSoft and create a new Monitor Table. Add devices that correspond to the master in the table.  

 
 

 
2. Change the project to Online Mode and start to monitor the data mapping.  
Monitoring from the master 

5555
7CB6

00005555
00007CB6

0.000
0.000
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Monitor from the slave 

 
 

Master_Address Slave_Address 

D0  
ToAS_IO 

（Instance ID=110） 

D500  
FromAS_IO 

（Instance ID=100） 
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MEMO 
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10.1 Introduction to CANopen 
1. Because of its simple wiring, immediate and stable communication, strong debugging ability, and low 

cost, the CANopen network is widely used in fields such as industrial automation, the automotive industry, 
the medical equipment industry, and the building trades. 

2. The AS300 Series PLC is compatible with CANopen when using the AS-FCOPM function card for the 
CAN port, and can work in master mode or slave mode. The CAN port conforms to the basic 
communication protocol CANopen DS301 

3. This chapter explains the functions of CANopen. In master mode, CANopen can support up to 64 slaves. 

4. CANopen Builder is the CANopen network configuration software for the AS Series. You set the 
CANopen station address and the communication rate with this software. ISPSoft is the programming 
software for the AS Series. 

5. This chapter mainly focuses on the CANopen functions. Refer to Section 10.3 for more information. 

 

10.1.1 CANopen Function Descriptions 

The CAN port has the following functions when acting as a master. 

1. It supports the standard CANopen protocol DS301 V4.02. 

2. It supports the NMT (network management object) service. 

 It supports NMT state control. 

Use NMT state control to control the state of a slave in the CANopen network. 

 It supports NMT error control. 

Use NMT error control detect the disconnection of a slave. The NMT error control is classified into 
two types; Heartbeat and Node Guarding. The AS Series PLC does not support Node Guarding. 

3. It supports the PDO (process data object) service. 

 Use PDO messaging to transmit immediate input and output data. 

 It supports up to 256 RxPDO and 1894 bytes.  

 It supports up to 256 TxPDO and 1894 bytes. 

 It supports synchronous and asynchronous modes for the PDO transmission type. 

4. It supports the SDO (Service Data Object) service. 

 Use SDO to read, write, or configure the slave parameters.  

 It supports standard SDO transmission mode.  

 It supports automatic SDO functions. You can write up to 20 pieces of data to a slave.  

 It supports using the SDO service in a PLC ladder diagram to read the data from a slave or write 
the data to a slave. 

5. It supports the reading emergencies from a slave service. 

 Use this service to read an error or an alarm from a slave. 

 You can store up to 5 emergencies in a slave. 
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 You can read emergencies from a slave through a PLC ladder diagram. 

6. It supports the SYNC object (synchronous object) service. 

7. Several devices can operate synchronously through the synchronous object service. 

8. The supported CANopen communication rates are: 20K, 50K, 125K, 250K, 500K, and 1Mbps. 

The supported mapping data types are: 

Storage Data type 
8-bit SINT USINT BYTE 
16-bit INT UINT WORD 

32-bit DINT UDINT REAL DWORD 

64-bit LINT ULINT LREAL LWORD 

 

The CAN port has the following functions when acting as a slave. 

 It supports the standard CANopen protocol DS301 V4.02. 

 It supports the NMT (network management object) service. 

 It supports the NMT state control. 

The state of the AS series in the CANopen network is controlled by a master. 

 It supports the NMT error control. 

The AS Series supports Heartbeat but not Node Guarding. 

 It supports the PDO (process data object) service. 

 The PDO message transmits the immediate input data and output data. 

 It supports up to 8 TxPDO and 8 RxPDO. 

 The PDO transmission type: synchronous mode and asynchronous mode 

 It supports the emergency service. 

If an error or an alarm occurs in the AS series, the master is notified through the emergency service. 

 

10.1.2 The Input/Output Mapping Areas 

The following table lists the CANopen DS301 specifications for the AS series PLC.  

Type Item Description 

Master 
Maximum slave nodes Up to 64 nodes 
Maximum transfer size of 
a PDO (Read + Write) 

Up to 2000 Bytes (including some system configurations) 

Slave 
Maximum transfer size of 
a PDO (Read + Write) 

Up to 8 PDOs; each PDO with up to 8 bytes can be transferred 
at a time 
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The output mapping areas are D25000-D25999, and the input mapping areas are D24000-D24999, as the 
following table shows. 

Device in the PLC Mapping area Mapping length 

D25000–D25031 
SDO request information, NMT service information, and 
Emergency request information 

64 bytes 

D24000–D24031 SDO reply information, and Emergency reply information 64 bytes 

D25032–D25978 RxPDO mapping area 1894 bytes 
D24032–D24978 TxPDO mapping area 1894 bytes 

 

If an AS Series functions as a slave, the output mapping areas are D25032–25063, and the input mapping 
areas are D24032–24063 as the following table shows. 

Device in the PLC Mapping area Mapping length 
D6032–D6063 RxPDO mapping area 64 bytes 
D6282–D6313 TxPDO mapping area 64 bytes 

 
 

10.2 Installation and Network Topology 
This section introduces the physical dimensions of AS-FCOPM function card, the HWCONFIG settings, the 
CAN interface, the CANopen network framework, and the maximum communication distance. 

 

10.2.1 The Dimensions of AS-FCOPM 

61
.3

37

59
.3

23.9
 

Unit: mm 
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10.2.2 AS-FCOPM on AS300 PLC 

 
Note: the AS-FCOPM card can only be installed in the Card 2 slot in the AS series 
 

10.2.3 Configure the AS-FCOPM with HWCONFIG  

Before using the AS-FCOPM card in an AS series PLC, use HWCONFIG in ISPSoft to configure the 
AS-FCOPM card.   

1. You can only install the AS-FCOPM in the card 2 slot as marked in red below. Double click the function 
card 2 slot to go to the Device Setting dialog box.  

 
 

2. Select Manual for Card 2 Detect mode and select AS-FCOPM Card for Manual Select Card.  
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3. Select the working mode, node ID and the bit rate for AS-FCOPM. 

* Working mode: CANopen DS301 

* Node ID: 1 

* Bit rate: 125k bps (the default, or you can select your own bit rate) 

 
 
4. When finished, click the Download button on the toolbar to download the settings to the PLC.  

 
 

10.2.4 The CAN Interface and Network Topology 
10.2.4.1 Definitions of the CAN Signal and Data Types 
The CAN signal is a differential signal. The voltage of the signal is the voltage difference between CAN+ and 
CAN-. The CAN+ and CAN- voltages take SG as a reference point. The CAN network can be in one of two 
states. One state is a dominant level, and is indicated by the logical “0”. The other state is a recessive level, 
and is indicated by the logical “1”. The CAN signal level shows below. 

 

Dominant Recessive 
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The following picture shows the data frame format. The CAN nodes transmit the CAN messages to the 
network from left to right. 

 
 

10.2.4.2 The CAN Network Endpoint and the Topology Structure 
In order to make the CAN communication more stable, the two endpoints of the CAN network are connected 
to 120 ohm terminal resistors. The topology structure of the CAN network appears below. 

 
 

10.2.4.3 The Topology Structure of the CANopen Network 

 
1) Use standard Delta cables when wiring the CANopen network. These cables are the thick cable 

UC-DN01Z-01A, the thin cable UC-DN01Z-02A, and the thin cable UC-DN01Z-02A. Separate the 
communication cables from any power cables to avoid interference. 

2) Connect the CAN+ (white) and CAN- (blue), which are at the endpoints of the network, to 120 ohm 
resistors. The AS-FCOPM card is equipped with a 120 ohm resistor switch; you can enable the resistor 
with the switch. Purchase the standard Delta terminal resistor for use with the other devices and the RJ45 
connecter.  
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3) Note the limitation on the length of the CANopen network. The transmission distance of the CANopen 
network depends on the transmission rate of the CANopen network. The following table shows the 
relation between the transmission rate and the maximum communication distance. 

Transmission rate 
(bit/seconds) 20K 50K 125K 250K 500K 1M 

Maximum 
communication distance 
(meters) 

2500 1000 500 250 100 25 

 

4) The list below shows the Delta network products for the CANopen network. 

Product Model Function 

 

 

AS332T-A 
AS332P-A 
AS324MT-A 

The AS300 series PLC can function as the 
CANopen master or slave when you install an 
AS-FCOPM function card. The AS-FCOPM is 
equipped with a 120 ohm resistor controlled 
by a switch. 

 

DVP32ES200RC 
DVP32ES200TC 

The DVP-ES2-C series PLC has a built-in 
CAN interface. It can function as the 
CANopen master or slave. 

 

DVPCOPM-SL 

DVPCOPM-SL is a module connected to the 
left side of an S series PLC. It can function as 
the CANopen master or slave. The PLCs that 
you can connect to the DVPCOPM-SL are the 
DVP-28SV, DVP-28SV2, DVP-SX2, 
DVP-SA2, and DVP-EH2-L. 

 

IFD9503 

The IFD9503 gateway converts CANopen to 
Modbus, and connects a device (with an 
RS-232 or RS-485 interface) that conforms to 
the standard Modbus protocol to a CANopen 
network.  You can connect up to 15 devices. 

 

DVPCP02-H2 

The CANopen slave module is connected to 
the right side of an EH2 series PLC. It can 
connect the EH2 series PLC to a CANopen 
network. 
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Product Model Function 

 
IFD6503 

This analyzes CANopen network data, and 
has ports both ends for a CAN interface and a 
USB interface. Use it to monitor CAN network 
data, or allow CAN nodes to transmit the 
data. The product is used with the Netview 
Builder software. 

 

ASD-A2-xxxx-M 
servo driver 

This servo driver has a built-in CANopen 
interface. It controls positioning, speed, and 
torque. 

 

VFD-C2000/CP2000/C200 
series AC motor drives 

This AC motor drive has a built-in CANopen 
function, and controls  positioning, speed, 
and torque. For the C2000/CP2000 series AC 
motor drives, you must purchase a 
CMC-COP01 to provide the CAN interface. 
Only the C200 series AC motor drive has the 
built-in CANopen interface. 

 

VFD-EC series AC motor 
drive 

The EC series AC motor drive has a built-in 
CANopen interface. It controls speed and 
torque. 

 

TAP-CN01 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with a 
switch. 

 

TAP-CN02 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with a 
switch. 
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Product Model Function 

 

TAP-CN03 
This CANopen network topology distribution 
box has a 120 ohm resistor enabled with 
switch. 

 

UC-CMC003-01A 
UC-CMC005-01A 
UC-CMC010-01A 
UC-CMC015-01A 
UC-CMC020-01A 
UC-CMC030-01A 
UC-CMC050-01A 
UC-CMC100-01A 
UC-CMC200-01A 

These CANopen sub cables have RJ45 
connectors at both ends.  
UC-CMC003-01A: 0.3 meters 
UC-CMC005-01A: 0.5 meters 
UC-CMC010-01A: 1 meter 
UC-CMC015-01A: 1.5 meters 
UC-CMC020-01A: 2 meters 
UC-CMC030-01A: 3 meters 
UC-CMC050-01A: 5 meters 
UC-CMC100-01A: 10 meters 
UC-CMC200-01A: 20 meters 

 

UC-DN01Z-01A 
UC-DN01Z-02A 

CANopen network cable 
UC-DN01Z-01A: CANopen main cable 
UC-DN01Z-02A: CANopen sub cable 

 

TAP-TR01 
This 120 ohm resistor has an RJ45 
connector. 

 

10.3 The CANopen Protocol 

10.3.1 Introduction to the CANopen Protocol 

The CAN (controller area network) fieldbus only defines the physical layer and the data link layer of a network. 
See the ISO11898 standard for information. The CAN fieldbus does not define the application layer. In 
practice, the hardware contains the physical layer and the data link layer. The CAN fieldbus itself is not 
complete, and needs a superior protocol to define the use of 11/29-bit identifier and 8-byte data. 

The CANopen protocol is the superior protocol based on the CAN fieldbus. It is one of the protocols defined 
and maintained by CiA (CAN-in-Automation) and was developed on the basis of the CAL (CAN application 
layer) protocol, using a subset of the CAL communication and service protocols. 

The CANopen protocol contains the application layer and the communication profile (CiA DS301). It also 
contains a framework for programmable devices (CiA 302), recommendations for cables and connectors (CiA 
303-1), and SI units and prefix representations (CiA 303-2). 

In the OSI model, the relation between the CAN standard and the CANopen protocol is described in the 
following diagram. 
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1. The object dictionary 

CANopen uses an object-based method to define a standard device. Every device is represented by a 
set of objects and can be visited by the network. The diagram below illustrates the CANopen device 
model. The object dictionary is the interface between the communication program and the superior 
application program. 

The core concept of CANopen is the device object dictionary (OD). It is an orderly set of objects. Every 
object has a 16-bit index for addressing and also defines an 8-bit subindex. Every node in the CANopen 
network has an object dictionary that includes the parameters that describe the device and the network 
behavior. The object dictionary of a node is also described in the electronic data sheet (EDS) for the 
device. 

 

Device profile CiA Device profile CiA Device profile CiA  

OSI seventh layer  

Application layer 
Communication profile CiA DS-301 

CAN controller CAN 2.0A 

ISO 11898 + -
+ -

CAN network 

OSI second layer  

Data link layer 

OSI first layer  
Physical layer 
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10.3.2 The CANopen Communication Object 

The CANopen communication protocol contains the following communication objects. 

1. PDO (process data object) 

 The PDO provides the direct channel for the device application object, and transmits the real-time data. 
It has high priority. Every byte in the PDO CAN message data list transmits data, and the message 
usage rate is high. 

 There are two kinds of uses for PDOs; data transmission and data reception. They are distinguished 
by Transmit-PDOs (TxPDOs) and Receive-PDOs (RxPDOs). Devices supporting TxPDOs are called 
PDO producers, and devices that receive PDOs are called PDO consumers. 

 The PDO is described by the “producer/consumer mode”. The data transmits from one producer to one 
or many consumers. The data that can be transmitted is limited to between 1-byte and 8-byte data. 
After the producer transmits the data, the consumer does not need to reply to the data. Every node in 
the network detects the transmitted data and decides whether to process the received data . 

 Every PDO is described by two objects in the object dictionary: the PDO communication parameters 
and the PDO mapping parameters 

PDO communication parameters: the COB-ID used by PDO, the transmission type, the prohibition 
time, and the counter cycle 

PDO mapping parameters: the object list in an object dictionary. These objects are mapped into the 
PDO, including the data length (in bits). To explain the contents of the 
PDO, the producer and the consumer both have to understand the 
mapping.  

The PDO transmission modes: synchronous and asynchronous  

Synchronous mode: synchronous periodic and synchronous non-periodic  

Asynchronous: The producer transmits the PDO when the data changes, or after a trigger.  

The following table lists supported transmission modes. 

 

Type PDO transmission  
 Periodic Non-periodic Synchronous Asynchronous RTR 

0  X X   
1 – 240 X  X   

254    X  
255    X  

Mode 0: The PDO information is transmitted only when the PDO data changes and the synchronous 
signal is received. 

Modes 1–240: One piece of PDO information is transmitted every 1–240 synchronous signals. 

Mode 254: The trigger is defined the manufacturer. The definition in the PLC is the same as mode 
255. 

Mode 255: The PDO is transmitted when the data changes, or it is transmitted after a trigger. 

All the data in the PDO has to be mapped from the object dictionary. The following diagram shows an 
example of PDO mapping. 
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The following table shows the data format for RxPDO and TxPDO. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

Object 
identifier 

Data 

2. SDO (service data object) 

 The SDO builds the client/server relation between two CANopen devices. The client device can read 
the data from the object dictionary on the server device and write the data into the object dictionary on 
the server device. The SDO visit mode is “client/server” mode. The mode which is visited is the SDO 
server. Every CANopen device has at least one service data object that provides the visit channel for 
the object dictionary of the device. SDO can read all the objects in the object dictionary, and write all 
objects into the object dictionary.  

 The SDO message contains the index and subindex information used to position the objects in the 
object dictionary, and the composite data structure can easily be passed by the SDO visit. After the 
SDO client sends the reading/writing request, the SDO server replies. The client and the server can 
stop SDO transmission. The requested message and the reply message are separated by different 
COB-IDs. 

 The SDO can transmit the data in any length. If the data length is more than 4 bytes, the data must be 
transmitted by segment. The last segment of the data contains an end flag. 

 The following table shows the structures of the SDO requested message and reply message. 

The format of the requested message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
600（hex）

+Node-ID 
Requested 

code 
Object index Object 

subindex 
Requested data 

LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

 

 

PDO_1  

Application object C zzh zzzzh 

Application object B yyh yyyyh 

 

Application object A xxh xxxxh 

Object dictionary 

xxxxh 

zzzzh 

yyyyh 

8 xxh 3 

16 zzh 2 

8 yyh 1 

3 0 

PDO_1 mapping 

Application object A Application object C  Application object B
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The definition of the requested code in the requested message: 

Request code (hex) Description 
23 Writing 4-byte data 
2B Writing 2-byte data 
2F Writing 1-byte data 
40 Reading data 
80 Stopping the current SDO function 

The format of the reply message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
580（hex） 

+Node-ID 
Reply 
code 

Object index Object 
subindex 

Reply data 
LSB MSB bit7-0 bit15-8 bit23-16 bit31-24 

The definition of the reply code in the reply message: 

Reply code (hex) Description 
43 Reading 4-byte data 
4B Reading 2-byte data 
4F Reading 1-byte data 
60 Writing 1/2/4-byte data 
80 Stopping the current SDO function 

 

3. NMT (network management object) 

The CANopen network management conforms to the master/slave mode. Only one NMT master exists in 
the CANopen network, and all other nodes are considered to be slaves. NMT includes three services: 
module control, error control, and boot-up services. 

 Module control services 

The master node in the CANopen network controls the slave by sending commands. The slave 
receives and executes the command, and does not need to reply. All CANopen nodes have internal 
NMT states. The slave node has four states: initialization, pre-operational, operational, and stop 
states. The following diagram illustrates the device states. 
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(1) After power is supplied, the device automatically enters the initialization state. 

(2) After the initialization is complete, the device automatically enters the pre-operational state. 

(3)(6) The remote node starts. 

(4)(7) The device enters the pre-operational state. 

(5)(8) The remote node stops. 

(9)(10)(11) The application layer resets. 

(12)(13)(14) The communication resets. 

(15) After the initializing is complete, the device automatically enters the reset application state. 

(16) After the reset application state is complete, the device automatically enters the reset 
communication state. 

The following table shows the relation between the communication object and the state. You can only 
execute the communication object service in the correct state. For example, you can only execute 
SDO in the operational state and pre-operational states. 

 Initialization Pre-operational Operational Stopped 
PDO   X  
SDO  X X  
SYNC  X X  
Time Stamp  X X  
EMCY  X X  
Boot-up X    
NMT  X X X 

 

 

Initializing 

Reset application  

Reset communication  

Pre-operational 

Operational  

Stopped 

(1)

(15)

(16)

(2) 

(3) (4)
(7)

(5)

(6)
(8) (9)

(10) 

(11) 

(12) 

(13) 

(14) 

Initialization 
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The control message format for the node state: 

COB-ID Byte 0 Byte 1 

0 Command specifier (CS) 
Slave address  
(0: Broadcast) 

 

The command specifiers: 

Command specifier 
(hex) Function 

01 Start the remote node 
02 Stop the remote node 
80 Enter the pre-operational state 
81 Reset the application layer 
82 Reset the communication 

 Error control services 

The error control service detects the disconnection of a network node. The error control services are 
classified into two types: Heartbeat and Node Guarding. The AS Series PLC only supports Heartbeat. 
For example, the master can detect the disconnection of the slave only after the slave enables the 
Heartbeat service. 

The following illustrates the Heartbeat principle. The Heartbeat producer transmits the Heartbeat 
message according to the set Heartbeat producing time. One or many Heartbeat consumers detect the 
message transmitted by the Heartbeat producer. If the consumer does not receive the message 
transmitted by the producer within the timeout period, there is a problem in the CANopen 
communication or the producer is disconnected.  

 

Request 

Receiving 

Receiving 

 
Request 

Heartbeat consumer Heartbeat producer 

Heartbeat 
producing 
time Heartbeat 

timeout 
period 

Heartbeat event 

Heartbeat 
timeout 
period 

Receiving 
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 Boot-up services 

After the slave completes the initialization and enters the pre-operational state, it transmits the 
Boot-up message. 

1. Other predefined CANopen communication objects (SYNC and EMCY) 

 SYNC Object (Synchronous object) 

The synchronous object is the message that the master node periodically broadcasts on the CANopen 
network. This object recognizes the network clock signal. Every device decides whether to use the 
event use synchronous communication with other network devices depending on its configuration. For 
example, when controlling a driving device, the devices do not act immediately after they receive the 
command sent by the master. They do act when they receive the synchronous message. This makes 
multiple devices act synchronously. 

The format of the SYNC message: 

COB-ID 
80 (hex) 

 Emergency object 

The emergency object is used by a CANopen device to indicate an internal error. When an emergency 
error occurs in the device, the device sends the emergency message (including the emergency error 
code), and the device enters an error state. After the error is eliminated, the device sends another 
emergency message with emergency error code 0, and the device enters the normal state. 

The format of the emergency message: 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7

80 (hex) 
+Node-ID

Emergency error 
code Error 

register 
Factory-defined error code 

LSB MSB 

Note: The value in the error register is mapped to index 1001 (hex) in the object dictionary. If the value is 
0, no error occurred. If the value is 1, a normal error occurred. If the value is H’80, an internal error 
occurred in the device.  

10.3.3 The Predefined Connection Set 

In order to decrease the configuration workload of the network, CANopen defines a default identifier. In the 
predefined connection set, the structure of the 11-bit identifier is as follows. 

 

Function code Node ID 
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The following tables list the objects that are supported and the COB-IDs that are assigned to the objects. 

 

1. The broadcast object in the predefined connection setting 

Object Function code COB-ID Index of the 
communication parameter

NMT 0000 0 - 
SYNC 0001 128 (80h) 1005h, 1006h, 1007h 

Time stamp 0010 256 (100h) 1012h, 1013h 
 

2. The corresponding object in the predefined connection set 

Object Function code COB-ID Index of the 
communication parameter

Emergency 0001 129 (81h)–255 (FFh) 1014h, 1015h 
PDO1 (TX) 0011 385 (181h)–511 (1FFh) 1800h 
PDO1 (RX) 0100 513 (201h)–639 (27Fh) 1400h 
PDO2 (TX) 0101 641 (281h)–767 (2FFh) 1801h 
PDO2 (RX) 0110 769 (301h)–895 (37Fh) 1401h 
PDO3 (TX) 0111 879 (381h)–1023 (3FFh) 1802h 
PDO3 (RX) 1000 1025 (401h)–1151 (47Fh) 1402h 
PDO4 (TX) 1001 1153 (481h)–1279 (4FFh) 1803h 
PDO4 (RX) 1010 1281 (501h)–1407 (57Fh) 1403h 
SDO (TX) 1011 1409 (581h)–1535 (5FFh) 1200h 
SDO (RX) 1100 1537 (601h)–1663 (67Fh) 1200h 

NMT Error Control 1110 1793 (701h)–1919 (77Fh) 1016h, 1017h 
 

10.4 Sending SDO, NMT and Reading Emergency Message 
through the Ladder Diagram 
You can edit the request message mapping area to affect the transmission of SDO, NMT and Emergency 
messages. The following table shows the corresponding relations between the request message mapping 
area, response message mapping area, and PLC device. 

PLC device Mapping area Mapping length 

D25000-D25031 SDO request message, NMT service message and 
Emergency request message 

64 bytes 

D24000-D24031 SDO response message and Emergency response message 64 bytes 
 

The CANopen master can only send one SDO, NMT, or Emergency request message to the same device at a 
time. Clear the request message mapping area to zero when sending SDO, NMT, or Emergency request 
message through the WPL program. 
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10.4.1 Data Structure of SDO Request Message  
Sending SDO through the ladder diagram reads or writes the slave parameter. 

1. The data format of the SDO request message: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message Header

ReqID Command (Fixed to 01) 

D25001 Reserved Size 

D25002 Type Node ID 

D25003 

Message Data 

High byte of main index Low byte of main index 

D25004 Reserved Sub-index 

D25005 Datum 1 Datum 0 

D25006 Datum 3 Datum 2 

D25007 - D25031 Reserved 

 ReqID: the request ID. Whenever an SDO request message is sent out, the message is given a ReqID 
for CANopen master to identify. When reading/writing another SDO message, the original ID number 
must be changed. In other words, reading/writing SDO is triggered by changing of the value of “ReqID”. 
The ReqID range is between 00–FF (Hex). 

 Size: the length of the message data. The counting starts from D6253 with a byte as the unit. When 
reading, it is fixed to four and when writing, it is four plus the byte number of data types of index and 
subindex and the maximum value is eight. But when writing, if the data type of the index and subindex 
is word, the data length is six. The data length is file if the data type is byte. 

 Node ID: the node address for the target equipment on a CANopen network. 

 Type: 01 indicates the read access; 02 indicates the write access. 

The following table shows the data format of the SDO response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message Header

ResID Status code 
D24001 Reserved Size 

D24002 Type Node ID 

D24003 

Message Data 

High byte of main index Low byte of main index 

D24004 Reserved Sub-index 

D24005 Datum 1 Datum 0 

D24006 Datum 3 Datum 2 

D24007~D24031 Reserved 

 Status code: 

The following table lists the status code values in the response message. 

Status code Explanation 
0 No data transmission request 
1 SDO message transmission succeeds. 
2 SDO message is being transmitted. 
3 Error: SDO transmission time-out 
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Status code Explanation 
4 Error: Illegal command code 
5 Error: the length of the transmitted data is illegal. 
6 Error: the length of the response data is illegal. 
7 Error: Equipment to be sent messages is busy. 
8 Error: Illegal type 
9 Error: Incorrect node address 

0A Error message (See the error code for SDO response message) 
0B-FF Reserved 

 ResID: the same as the request ID in the request message. 

 Size: the length of the message data, maximum of 20 bytes. The unit is bytes. When writing, the 
maximum is four; the data length is decided by the data type of index and subindex when reading. 

 Node ID:  the node address of the target equipment on CANopen network. 

 Type: in the SDO response message, 43 (Hex) refers to reading four bytes of data; 4B (Hex) refers to 
reading two bytes of data; 4F (Hex) refers to reading one byte of data; 60 (Hex) refers to writing 1/2/4 
byte(s) of data; 80 (Hex) refers to stopping SDO command. 

Example 1: write 010203E8 (hex) to (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 

D25000 
Message 
Header 

ReqID=01 Command =01 
D25001 Reserved =0 Size =8 
D25002 Type =02 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=03 Datum 0=E8 
D25006 Datum 3=01 Datum 2=02 

 Response data: 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
Header 

ResID =01 Command =01 
D24001 Reserved =0 Size =4 
D24002 Type =60 Node ID =03 
D24003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D24004 Reserved =0 Subindex =0 
D24005 Datum 1=00 Datum 0=00 
D24006 Datum 3=00 Datum 2=00 
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Example 2: read the value of (Index_subindex) 212D_0 in slave of No. 3 through SDO; the data type of 
(Index_subindex) 212D_0 is double words (32 bits). 

 Request data:  

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
Header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =4 
D25002 Type =01 Node ID =03 
D25003 

Message 
data 

Main index high byte =21 Main index low byte =2D 
D25004 Reserved =0 Subindex =0 
D25005 Datum 1=0 Datum 0=0 
D25006 Datum 3=0 Datum 2=0 

 

10.4.2 Data Structure of NMT Message 

Use the NMT service to manage the CANopen network such as start, operation, reset of nodes, etc. 

The following table shows the data format of the NMT request message. 

PLC device 
Request message 

 High byte Low byte 

D25000 
Message 
Header 

ReqID Command (Fixed to 01) 

D25001 Reserved Size (Fixed to 04) 

D25002 Type (Fixed to 03) Node ID 

D25003 Message 
data 

Reserved NMT service code 

D25004 Reserved Node ID 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an NMT request message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another NMT request message is sent out, the original ID 
number must be changed. In other words, change the value of ReqID. The ReqID range is between 
00–FF (Hex) to trigger sending the NMA request message. 

 Node ID: the node address for the target equipment on the CANopen network (0: Broadcast). 

 NMT service code: 

NMT service code (Hex) Function 
01 Start remote node 
02 Stop remote node 
80 Enter the pre-operational state 
81 Reset application 
82 Reset communication 
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The following table shows the data format of the NMT Response message. 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Reserved 
D24002 Reserved Node ID 

 When status code is 1, the NMT operation has succeeded. When status code is not equal to1, the 
NMT operation has failed and you should verify that the data in NMT request message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 

Example 1: Stop slave of No. 3 through NMT 

 Request data: 

PLC device 
Request message 

 High byte(Hex) Low byte(Hex) 
D25000 

Message 
header 

ReqID =01 Command =01 
D25001 Reserved =0 Size =04 
D25002 Type =03 Node ID =03 
D25003 Message 

data 
Reserved NMT service code =02 

D25004 Reserved Node ID =03 

 Response data: 

 

10.4.3 Data Structure of EMERGENCY Request Message 

The Emergency request message communicates the slave error and alarm information. 

The following table shows the data format of the Emergency request message. 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID Command (Fixed to 1) 
D25001 Reserved Size (Fixed to 0) 
D25002 Type (Fixed to 04) Node ID 

D25003~D25031 
Message 

data 
Reserved 

 Command: Fixed to 01. 

 ReqID: the request ID. Whenever an Emergency message is sent, the message is given a ReqID for 
the CANopen master to identify. Before another Emergency request message is sent out, the original 
ID number must be changed. In other words,  change the value of ReqID. The ReqID range is 
between 00–FF (Hex) to trigger the sending the Emergency request message. 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Reserved =0 
D24002 Reserved =0 Node ID =03 
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 Node ID: the node address of the target equipment on CANopen network. 

 

The following table shows data format of the Emergency response message. 

PLC device 
Response message 

 High byte(Hex) Low byte(Hex) 
D24000 

Message 
header 

ResID Status code 
D24001 Reserved Size Fixed to 2A 
D24002 Type (Fixed to 04) Node ID 
D24003 

Message 
data 

Total number of data Number of data stored 
D24004 Datum 1 Datum 0 
D24005 Datum 3 Datum 2 
D24006 Datum 5 Datum 4 
D24007 Datum 7 Datum 6 

D24008-D24011 Emergency2 
D24012-D24015 Emergency3 
D24016-D24019 Emergency4 
D24020-D24023 Emergency5 
D24024-D24031 Reserved 

 Command: Fixed to 01(Hex). 

 When status code is 1, reading the Emergency message has succeeded. When status code is not 
equal to1, reading the Emergency message has failed and you should verify that the data in the 
Emergency message is correct. 

 Node ID: the node address for the target equipment on the CANopen network. 

 Total number of data: the total number of Emergency messages CANopen master receives from the 
slave. 

 Number of data stored: the latest number of Emergency messages CANopen master receives from the 
slave (5 messages at most). 

 An Emergency 1 consists of the data in D6004-D6007  and every Emergency message consists of 8 
bytes of data. 

The following table shows the data format of Emergency messages on the CAN bus. Datum 0–datum 
7 in Emergency response message correspond to byte 0–byte 7 respectively. 

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
80（hex） 

+Node-ID 
Emergency error 

code 
Error storage 

register 
Vendor custom error code 

Example 1: read the Emergency message from the slave No.2, and the Emergency messages the slave 
sends out successively.  

COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 
82（hex） 43 54 20 14 0 0 0 0 

 
COB-ID Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7 

82（hex） 42 54 20 15 0 0 0 0 
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 Request data: 

PLC device 
Request message 

 High byte Low byte 
D25000 

Message 
header 

ReqID=01 Command =01 
D25001 Reserved Size =0 
D25002 Type =04 Node ID =03 

 

 Emergency response data 

PLC device 
Response message 

 High byte Low byte 
D24000 

Message 
header 

ResID=01 Status code =01 
D24001 Reserved =0 Size =2A (Hex) 
D24002 Type =04 Node ID =03 
D24003 

Message 
data 

Total number of data =1 Number of data stored =1 
D24004 Datum 1=54 Datum 0=42 
D24005 Datum 3=20 Datum 2=14 
D24006 Datum 5=0 Datum 4=0 
D24007 Datum 7=0 Datum 6=0 

 

10.4.4 Example of Sending SDO through the Ladder Diagram 

1. Control Requirement: 

Read the value of P0-09 from the servo through SDO. 

2. Hardware Connection: 

 

3. The Corresponding Relation between Slave Parameter and Index/Subindex 

The index_subindex corresponding to P0-09 in servo is 2009_0. In the CANopen Builder network 
configuration software, right click the servo icon, and then click Parameter Edit. In the Parameter Edit 
dialog box, you can see the index_subindex corresponding to the servo parameter.  

For more details on how to operate the network configuration interface, refer to Section 11.1.1 in the 
CANopen Builder software help file 
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4. The Structure of the Request Message Devices: 

PLC device 
Content 

(Hex) 
Explanation 

High byte(Hex) Low byte(Hex) 

SDO 
request 

message 
mapping 

area 

D25000 0101 ReqID = 01 Command = 01  
D25001 0004 Reserved Size = 04  
D25002 0102 Type = 01 Node ID = 03 
D25003 2009 Index high byte = 20  Index low byte = 09  
D25004 0000 Reserved Subindex = 00  

 

5. Editing the Ladder Diagram in ISPSoft 

 

 

 

When M2=ON, after reading succeeds, the program stores the data from the target device in 
D24000–D24005. The value of D24005: 100（hex）is the value read from P0-09. 
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6. The Structure of the Response Message Devices: 

 

10.5 Troubleshooting 

10.5.1 CANopen Network Node State Display 

1. In the AS300 Series PLC, while you enable the CANopen function, it uses SR825–893 as the special 
registers as shown in the following table. 

Special register Function 

SR825 Displays the state of AS300 series PLC. 

SR830–SR893 Displays the state of 64 nodes in the network 

SR826  Flag for the state of the slave 1–16 

SR827 Flag for the state of the slave 17–32 

SR828 Flag for the state of the slave 33–48 

SR289 Flag for the state of the slave 49–64 

SR821 Version of CANopen DS301 

SR822 Displays the CANopen baud rate (unit: 1kpps) 
 

2. As a master, the AS300 series PLC supports a maximum of 64 slaves ranging from node 1 to node 64. 
You can use SR826–829 to monitor the state of the nodes in the network. The 16 bits in SR826 
correspond to 16 slaves and their corresponding relations are shown in the following table.  

Bit b7 b6 b5 b4 b3 b2 b1 b0 
Node Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 
Bit b15 b14 b13 b12 b11 b10 b9 b8 

Node Node16 Node15 Node14 Node13 Node12 Node11 Node10 Node 9 

When the node in the master node list is normal, the corresponding bit is OFF; when the node in the 
master node list is abnormal (for example, initializing fails or the slave is offline for some reason), the 
corresponding bit is ON. 

 

3. The error code of every node is displayed through the corresponding special register (SR830–893) and 
the relations between special register and corresponding node (1–16) is shown in the following table. 

Special 
register 

SR830 SR831 SR832 SR833 SR834 SR835 SR836 SR837 

Node Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7 Node 8 

PLC device 
Content 

(Hex) 
Explanation 

High byte(Hex) Low byte(Hex) 

SDO 
response 
message 
mapping 

area 

D24000 0101 ResID = 01 Status code = 01  
D24001 0006 Reserved Size = 08 
D24002 4303 Type = 43  Node ID = 03  
D24003 2009 Main index high byte = 20 Index low byte = 09  
D24004 0004 Reserved Subindex = 00 
D24005 0100  Datum 1= 01 Datum 0= 00  
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Special 
register 

SR830 SR831 SR832 SR833 SR834 SR835 SR836 SR837 

Special 
register 

SR838 SR839 SR840 SR841 SR842 SR843 SR844 SR845 

Node Node 9 Node10 Node11 Node12 Node13 Node14 Node15 Node16 

 

4. Codes displayed in SR830–893 when the AS300 Series PLC is the master:  

Code Indication How to correct 

E0 
AS300 Series PLC master module 
receives the emergency message 
sent from slave. 

Read the relevant message with the PLC program 

E1 
PDO data length returned from the 
slave is not consistent with the 
length set in the node list. 

Set the PDO data length of the slave and 
re-download. 

E2 PDO of slave is not received. Check and ensure the setting is correct. 
E3 Downloading auto SDO fails. Check and ensure auto SDO is correct. 

E4 
Configuration of PDO parameter 
fails. 

Ensure that the PDO parameter setting is legal. 

E5 Error in key parameter setting. 
Ensure that the connected slave device is 
consistent with the configured slave in the 
software. 

E6 
The slave does not exist in the 
network Ensure that the power supply of slave is normal 

and slave is correctly connected to the network. 
E7 Slave error control is timed-out. 

E8 
The node IDs of master and slave 
repeat. 

Set the node ID of the master and slave again and 
ensure their node IDs are unique. 

 

5. Codes displayed in SR825 when the AS300 Series PLC is the master: 

Code Indication How to correct 

F1 
Slave has not been added to node 
list of CANopen Builder software 

Add slave into the node list and then re-download 
the configuration data. 

F2 
The data are being downloaded to 
AS300 Series PLC 

Wait to finish downloading the configuration data. 

F3 AS300 Series PLC is in error status Download parameter configuration again. 

F4 Bus-OFF is detected. 
Check that the CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

F5 
AS300 Series PLC setting error 
such as incorrect node address 

The node address in the AS300 Series PLC should 
be between: 1–127. 

F8 
Internal error; the error is detected in 
the internal memory 

If the same error occurs after cycling the power, 
replace it with a new AS300 PLC. 

FB 
The sending buffer in the AS300 
Series PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot. 

FC 
The receiving buffer in the AS300 
Series PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot. 

 

 



AS Series Operat ion Manual   

 10-28

_10 

6. Codes displayed in SR825 when the AS300 Series PLC is the slave:  
 

Code Indication How to correct

A0 
AS300 series PLC is being 
initialized. 

-- 

A1 
AS300 series PLC is 
pre-operational. 

Check that the CANopen bus cable is properly 
connected

A3 
The data are being downloaded to 
AS300 series PLC 

Wait to finish downloading the configured data. 

B0 Heartbeat message time-out 
Check that the CANopen bus cable is properly 
connected.

B1 
PDO data length returned from the 
slave is not consistent with the 
length set in the node list. 

Reset the PDO data length in the slave and 
download the new setting to the AS300 Series 
PLC.

F4 BUS-OFF state is detected. 
Check that CANopen bus cables are properly 
connected and ensure that all the node devices run 
at the same baud rate before you reboot. 

FB 
The sending buffer in the AS300 
Series PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot.

FC 
The receiving buffer in the AS300 
Series PLC is full. 

Check that the CANopen bus cable is properly 
connected and then reboot.

 

10.6 Application Example 
The AS300 Series PLC can control Delta A2 servo rotation, and monitor the actual rotation speed of the motor 
in real time. It does this by mapping the relevant servo drive parameters to the corresponding PDO, and reads 
or writes the relevant servo drive parameters through the CAN bus. 

1. Connectting the Hardware 

 

 

Note: 

 Use a standard communication cable such as UC-DN01Z-01A / UC-DN01Z-02A / UC-CMC010-01A. 
and connect the terminal resistors (Delta standard terminal resistor TAP-TR01) to both ends of the 
network when you construct the network. 

 M of ASD-A2-xxxx-M refers to the model code and currently only the M-model servo supports 
CANopen communication. 

2. Setting Servo Parameters: 

 Set servo parameters as shown in the following table. 
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Parameter Setting Explanation 
3-00 03 Node ID of the A2 servo is 2 
3-01 400 CAN communication rate is 1Mbps. 
1-01 04 Speed mode 
0-17 07 Drive displays the motor rotation speed (r/min) 
2-10 101 Set DI1 as the signal for Servo On 
2-12 114 Set DI3 as the signal _SPD0 for speed selection  
2-13 115 Set DI4 as the signal _SPD1 for speed selection 

 
3. Setting the CANopen Baud Rate and Node ID of AS300 Series PLC  

The AS300 Series PLC uses the default setting values: Node ID: 1 and baud rate: 1Mbps. 

You set the CANopen Node ID and baud rate for the AS300 series PLC in the CANopen Builder software, 
as shown in the following steps. 

A. Right click the AS300 Series PLC icon in HWCONFIG, then click Communication Software, and 
then click CANopen Builder.  

 

 

B. Click the Online  button on the Toolbar to enter on-line mode.  
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C. Click the Scan Network  button on the Toolbar to scan the network. 

 

 

D. On the Network menu, click Master parameter to display the Master Configuration dialog box.  

 

 

 

 

Item Explanation Default 

Node ID 
Node ID of AS300 series PLC on the CANopen 
network 

1 

Baud rate CANopen communication rate 1M bit/second 
Work mode CANopen master/slave mode Master 
Cycle period Cycle time for sending one SYNC message 50ms 

Master heartbeat time 
Interval time for sending the master heartbeat 
message 

200ms 
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Configure the CANopen communication stations and rates in HWCONFIG.  

E. After you complete the previous steps, click the Download  button on the Toolbar to download 
the parameters to the PLC.   

 

Note: you must reboot the AS300 Series PLC to enable the downloaded parameters.  

 

4. Scanning the Network: 

On the Network menu, click Online or click the  button to scan for the master and slaves on the 
CANopen network. The master and slave found by the scan appear in CANopen Builder. For more 
information, refer to Section 11.1.1 in the CANopen Builder software help file. 

 

5. Configurating Nodes: 

Double click the slave icon in CANopen Builder to display the Node configuration dialog box.  

 Error Control Protocol 

Sets the error control protocol for the master to monitor if the slave is offline. 

 Auto SDO Configuration 

Perform one write action to the slave parameter with SDO.  The write action is finished when the 
slave enters the operational state from the pre-operational state. You can configure up to 20 SDOs by 
clicking Auto SDO configuration. 
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 PDO Mapping and Properties 

Sets the mapping parameter and transmission type for the PDO. 

For more details on the function of these buttons, refer to Section 11.1.1 in the CANopen Builder 
software help file.  

 

 PDO Mapping:  

RxPDO1: mapping parameter P1-09; transmission type 255. 

RxPDO2: mapping parameter P3-06, P4-07; transmission type 255. 

TxPDO1: mapping parameter P0-09; transmission type 1. 

 

 

 PDO transmission type : 

PDOs can be classified into RxPDO or TxPDO. RxPDO data are sent from master to slave and 
TxPDO data are sent from slave to master. 

The PDO transmission types can be synchronous or asynchronous. In synchronous transmission, the 
master sends out the SYNC message in a fixed cycle. You set the length of the cycle in the Master 
Properties dialog box (default is 50ms). In asynchronous transmission, the message is sent out when 
the PDO mapping parameter changes. 
The following table describes the PDO Transmission types. 
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Transmission Type Description Remark 

0 

RxPDO 

When any change in the mapped data happens, 
RxPDO data is sent out immediately. The data 
the slave receives is valid only when receiving 
the next SYNCH message. RxPDO data is not 
sent out if there is no change in the data. SYNCH 

non-cycle 
 

TxPDO 

When any change in the mapped data happens 
and the slave receives the SYNC message, the 
data are sent out immediately. The TxPDO data 
are valid immediately after master receives them. 
TxPDO data is not sent out if there is no change 
in the data. 

N 
（N:1–240） 

RxPDO 

After N messages are sent out, and regardless of 
whether the mapped data changes, the data that 
the slave receives is valid only when receiving 
the next SYNCH message. 

SYNCH 
cycle 

 
TxPDO 

After N messages are sent out and regardless of 
whether the mapped data is changed, the data 
that the master receives is valid at once. 

254 

RxPDO 

The mapped data is sent out immediately when it 
changes and is valid when the slaves receives it. 
RxPDO data is not sent out if there is no change 
in the data. 

ASYNCH 

TxPDO 

The slave sends out the data once every one 
Event timer time.  After that, the TxPDO data is 
not allowed to be sent out within an inhibit timer 
time. 
When the Event timer and Inhibit timer are both 
equal to 0, the slave sends TxPDO data to the 
master immediately when the data changes, and 
the data that master receives is immediately 
valid. 

255 Same as Type254 

Note: 

 Synchronous transmission type can fulfill multi-axis motion at the same time. 

 If you monitor a real-time changing parameter such as the actual rotation speed of the motor, set 
the TxPDO to the synchronous transmission type; otherwise the frequent change in the slave data 
can block the CANopen network. 

  

After you finish setting the above parameters, double click the master device to display the Node List Setting 
dialog box. Select ASDA-A2 Drive, and click > to move the A2 drive to the right-side list, and then download 
the configured data. 
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The mapping relation between master and slave: 

AS300 Series PLC master register Data transmission on CANopen 
bus A2 device 

D25032 
 Low word of P1-09 of 

servo 

D25033 
High word of P1-09 of 
servo 

D25034 P3-06 of servo 

D25037 P4-07 of servo 

D24032 
 Low word of P0-09 of 

servo 

D24033 
High word of P0-09 of 
servo 

 

6. Program control: D25032 is given the value 256 in ISPSoft; that is, the speed command is set as 
256r/min in the following diagram. 
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7. Program explanation 

When the AS300 Series PLC runs for the first time, set the parameter P3-06 for servo drive to F. 

 When M0 switches from OFF to ON, the instruction writes 256 to D25032 and then writes the value to  
the servo parameter P1-09 through RxPDO1. 

 When M1 switches from OFF to ON, change P4-07 to 5. DI1 and DI3 are ON. DI1 means the SERVO is 
ON and DI3 calls the speed specified by parameter P1-09 for servo rotation. 

 When M1 switches from ON to OFF, the speed command becomes 0 and the motor stops running. 

 
 

10.7 Object Dictionary 
The following table lists the communication objects in the object dictionary. 

Index Subindex Object name Data type Attribute 
Default 
value 

H’1000 H’00 Device type Unsigned 32 bits R 0x00000000 
H’1001 H’00 Error register Unsigned 8 bits R 0 
H’1005 H’00 COB-ID SYNC Unsigned 32 bits RW 0x00000080 

H’1008 H’00 Manufacturer device name Vis-String R 
AS300 

Series PLC 

H’1014 H’00 COB-ID EMCY Unsigned 32 bits R 
0x80 + 

Node-ID 

H’1016 

-- Consumer heartbeat time    

H’00 Number of valid subindex Unsigned 8 bits R 1 

H’01 Consumer heartbeat time Unsigned 32 bits RW 0 

H’1017 H’00 Producer heartbeat time Unsigned 16 bits RW 0 

H’1018 

-- Identity Object    

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 Vendor-ID Unsigned 32 bits R 0x000001DD
H’02 Product code Unsigned 32 bits R 0x00000055 
H’03 Revision number Unsigned 32 bits R 0x00010002 

H’1400 

-- 
RxPDO1 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO1 Unsigned 32 bits RW 
0x00000200+

Node-ID 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1401 
-- 

RxPDO2 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’01 COB-ID of RxPDO2 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’03 Inhibit time Unsigned 16 bits RW 0 

H’1402 

-- 
RxPDO3 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO3 Unsigned 32 bits RW 0x80000000 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’1402 H’03 Inhibit time Unsigned 16 bits RW 0 

H’1403 

-- 
RxPDO4 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO4 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1404 

-- 
RxPDO5 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO5 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1405 

-- 
RxPDO6 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO6 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1406 

-- 
RxPDO7 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO7 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’03 Inhibit time Unsigned 16 bits RW 0 

H’1407 -- 
RxPDO8 communication 
parameter 

   



Chapter  10 CANopen Function and Operat ion 

 10-37

10 

Index Subindex Object name Data type Attribute 
Default 
value 

H’00 Number of valid subindex Unsigned 8 bits R 3 

H’01 COB-ID of RxPDO8 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 0 

H’1600 -- RxPDO1 mapping parameter    

H’1600 

H’00 Number of valid subindex Unsigned 8 bits RW 4 

H’01 The first mapped object Unsigned 32 bits RW 0x20000110 

H’01 The second mapped object Unsigned 32 bits RW 0x20000210 

H’02 The third mapped object Unsigned 32 bits RW 0x20000310 

H’03 The fourth mapped object Unsigned 32 bits RW 0x20000410 

H’1601 

-- RxPDO2 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1602 

-- RxPDO3 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1603 

-- RxPDO4 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1604 -- RxPDO5 mapping parameter    
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Index Subindex Object name Data type Attribute 
Default 
value 

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’1604 

H’01 The first mapped object Unsigned 32 bits RW 0 
H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1605 

-- RxPDO6 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1606 

-- RxPDO7 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1607 

-- RxPDO8 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’01 The second mapped object Unsigned 32 bits RW 0 

H’02 The third mapped object Unsigned 32 bits RW 0 

H’03 The fourth mapped object Unsigned 32 bits RW 0 

H’1800 

-- 
TxPDO1 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO1 Unsigned 32 bits RW 
0x00000180+

Node-ID 
H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 

H’1800 H’05 Timer Unsigned 16 bits RW 100 

H’1801 

-- 
TxPDO2 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO2 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’1802 

-- 
TxPDO3 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO3 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1803 

-- 
TxPDO4 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO4 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1804 

-- 
TxPDO5 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO5 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1805 

-- 
TxPDO6 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO6 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 

H’1805 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1806 

-- 
TxPDO7 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO7 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 

H’1807 

-- 
TxPDO8 communication 
parameter 

   

H’00 Number of valid subindex Unsigned 8 bits R 5 

H’01 COB-ID of TxPDO8 Unsigned 32 bits RW 0x80000000 

H’02 Transmission mode Unsigned 8 bits RW 0xFF 
H’03 Inhibit time Unsigned 16 bits RW 50 
H’05 Timer Unsigned 16 bits RW 100 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’1A00 

-- TxPDO1 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 4 

H’01 The first mapped object Unsigned 32 bits RW 0x20010110 

H’02 The second mapped object Unsigned 32 bits RW 0x20010210 

H’03 The third mapped object Unsigned 32 bits RW 0x20010310 

H’04 The fourth mapped object Unsigned 32 bits RW 0x20010410 

H’1A01 

-- TxPDO2 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A02 

-- TxPDO3 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’1A02 
H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A03 

-- TxPDO4 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’1A04 

-- TxPDO5 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A05 

-- TxPDO6 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A06 
-- TxPDO7 mapping parameter    

H’00 Number of valid subindex Unsigned 8 bits RW 0 
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Index Subindex Object name Data type Attribute 
Default 
value 

H’01 The first mapped object Unsigned 32 bits RW 0 

H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 

H’1A07 -- TxPDO8 mapping parameter    

H’1A07 

H’00 Number of valid subindex Unsigned 8 bits RW 0 
H’01 The first mapped object Unsigned 32 bits RW 0 
H’02 The second mapped object Unsigned 32 bits RW 0 

H’03 The third mapped object Unsigned 32 bits RW 0 

H’04 The fourth mapped object Unsigned 32 bits RW 0 
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11.1 CPU Module Operations  

11.1.1 Procedure 

The following diagram describes the operation of the CPU module. 

 

The CPU module is supplied with power. 

The system enables the initialization.  
 The non-latched memory is initialized. 
 The downloaded program is checked. 
 The parameters in the CPU module are checked. 
 The parameters in the module table are checked. 
 The module table in the CPU module is compared 

with the actual I/O configuration. 
 The I/O setting is downloaded to the I/O module. 
 If the memory card is installed, whether to execute 

the system copy procedure or not is checked. 

Diagnosis processing: 
 The memory card and other setting are checked. 
 The I/O bus is checked. 
 The system parameter is checked. 

The data sent to the I/O module is refreshed. 
 The data sent to the digital I/O module is refreshed. 
 The data sent to the analog I/O module is refreshed. 
 The data sent to other modules are refreshed. 

Program execution:  
 The user program is executed. 
 The interrupt subroutine is executed. 

The data sent from the I/O module is refreshed. 
 The data sent from the digital I/O module is 

refreshed. 
 The data sent from the analog I/O module is 

refreshed. 
 The data sent from other modules are refreshed. 

Communication service: 
 The communication through the CPU module 
 The communication through other I/O modules 
 The internal communication between the CPU 

module and the I/O module 
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11.1.2 I/O Refreshing and Communication Service 

 Refreshing I/O  

The CPU module reads external I/O data periodically or outputs data to an external I/O. Refreshing the 

I/O includes the following.  

 Refreshing data in a digital I/O module 

 Refreshing data in an analog I/O module 

 Refreshing data in a network module 

All I/O refreshing executes in the same loop. The data in an input device refreshes before a program 

executes, and the data in an output device refreshes after the program executes. 

Unit Maximum data exchange Data exchange area 

Digital I/O module 
Depends on the number of input/output 

channels in the unit. 
Input relay/Output relay 

Analog I/O module 
Depends on the number of input/output 

channels in the unit. 
Data register 

Network module Depends on the unit. Data register 

 

 Communication service 

Communication service is the unscheduled communication service for a network module. It includes the 

communication requests sent from external equipment to a CPU module, and the communication requests 

sent from the CPU module to the external equipment. 

 

11.2 CPU Module Operating Modes  

11.2.1 Operating Modes 

There are two operating modes. They can be used to control a user program and all tasks. 

STOP mode: A program is not executed under this mode. Users can download a module table, initialize CPU 

configuration and other setting, download a program, check a program, and force a bit ON/OFF. 

RUN mode: A program is executed under this mode. Users can not download a module table, and initialize 

CPU configuration and other setting. 
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11.2.2 Status and Operation under Different Operating Modes 

The following table lists the status and operation states for RUN and STOP modes. 

 Basic operation 

CPU 

mode 
Program 

I/O 

refreshing 
External output 

Program memory 

Non-latched 

area 

Latched 

area 

STOP 

The execution 

of the program 

stops.  

I/O refreshing 

executes. 

OFF. If you set the I/O 

module so that the final 

state of the external output 

on the I/O module is 

retained, the final state of 

the external output on the 

I/O module is retained. 

The data in the program 

memories is retained. 

RUN 
The program  

executes. 

I/O refreshing  

executes. 

The program controls the 

external output. 

The program controls the 

program memories. 

 

 Relationship between the operating modes and tasks 

Mode Loop task Interrupt task 

STOP Execution of a loop tasks stops. 
Execution of an interrupt task 

stops. 

RUN 

 The tasks that have not been executed are in the 

HALT state. 

 If a task is active, or the instruction TKON is 

executed, the task executes. 

 If a task is not active, or the instruction TKOFF  

executes, the task does not execute. 

If the condition of the interrupt is 

met, the interrupt task executes. 

 

 Relationship between changing modes and the program memory 

Change of the mode Non-latched area Latched area 

STOP→RUN 
Data is cleared or retained depending 

on your setting. 
The data is retained. 

RUN→STOP The data is retained. The data is retained. 
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12.1  Troubleshooting 
12.1.1 Basic troubleshooting steps 
This chapter includes the possible errors the can occur during operation, their causes, and corrective actions.  

(1) Check the following: 

 The PLC should be operated in a safe environment (consider environmental, electronic, and vibration safeties). 

 Connect power supply correctly to the PLC. 

 Secure the module, terminal, and cable installations.  

 All LED indicators show correctly. 

 Set all switches correctly. 

(2) Check the following operational functions: 

 Switch the RUN/STOP state 

 Check the settings for the AS Series to RUN/STOP 

 Check and eliminate errors from external devices  

 Use the System Log function in ISPSoft to check system operation and logs 

(3) Identify possible causes: 

 AS Series or external device 

 CPU or extension modules 

 Parameters or program settings 

 

12.1.2 Clear the Error States  
Use the following methods to clear the error states. If the error source is not corrected, the system continues to show 
errors.   

(1) Switch the CPU model state to STOP and then to RUN. 

(2) Turn off the CPU and turn it on again.  

(3) Use ISPSoft to clear the error logs.  

(4) Reset the CPU to the default settings and download the program again.  
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12.1.3 Troubleshooting SOP 
An error
occurred

Basic
troub leshoot in g

steps 
done

CPU module error 
or modules er ror

ERROR LED ON

ERROR L ED b linking 
normal ly 

(every 0 .5 sec.)

ERR OR LED bl ink ing
slowly (every 1 sec. , 

stop for 3 sec.)

Other LED blinking

Refer to sect ion 12 1 1 for. .
Basic troubleshooti ng steps

Yes

No

1. Refer to sec ti on 1 2.1.4 for the sys tem log
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.3 for troubleshoot ing for 
    I /O modules

Yes

No

No

Yes

No

Yes

Yes

No

Yes

Yes

No

CPU module
error

Mo dule
error

ERROR LED b l inking 
fast

(every 0 .2 sec.)

After going t hrough 
troubleshooting s teps,
the issues a re s til l not 

reso lved. 

No

The system runs normally.

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 12 1 4 for the sys tem log. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

1. Refer to sect ion 1 4 for the sys tem log 1 2. .
2. Refer to sec ti on 1 2.4 for error codes and 
    L ED indicators for CPU modules
3. Refer to sec ti on 1 2.2 for troubleshoot ing for 
    C PU modul es

If the p roblem per sis ts , please contact 
support.
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12.1.4 System Log 
If ISPSoft is connected to an AS Series, you can view actions and errors in the AS Series by clicking System Log on the 
PLC menu. The CPU can store up to 20 error log sets. After the 20 sets are stored, the 1st log is replaced with the 21st if 
there are new logs coming in, and the old logs are replaced with the new ones sequentially. When the memory card is 
installed in the CPU module, 20 sets of the old logs are backed up in the memory card and up to 1000 logs can be 
recorded. If the stored logs exceed 1000, the oldest 20 logs are replaced with the newest 20 logs in the memory card.  

(1) On the PLC menu, click System Log. 

 
(2) The System Log window appears. Click Clear Log to clear the error log in the window and the error log in the CPU 

module, and reset the CPU module. 

 
 

 Group No.: The number 1 indicates that the error occurred in the CPU module or the right-side module 1. The 
numbers 2–16 indicate the error occurred in the remote modules 1–15.   

 Module No.: The number 0 indicates that the error occurred in the CPU module or the remote module. The 
numbers 1–32 indicate the error occurred in the right-side module of the CPU module / remote module. 
The number 1 represents the closest module to the CPU module or the remote module. This number 
increases from the closest to the furthest from the CPU module or the remote module. Note: up to 
eight extension modules can be connected to the right-side of the remote module.   

 PLC/Module name: Model names of the CPU, remote, and extension modules.  
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 Error Code: Error codes in the error log. 

 Date & Time: The date and time the error occurred. The most recently occurring error is listed on the top.  

 The last column shows the descriptions for the error.  

 

12.2  Troubleshooting for CPU Modules 
Check the LED indicators and the error codes from the CPU module and refer to the following table for troubleshooting. V 
in the Log column indicates the error is recorded in the log. X in the Log column indicates the error is not recorded in the 
log. H in the Log column indicates whether or not you can set recording the error in the log in HWCONFIG.  

 

12.2.1 ERROR LED Indicators Are ON 
Error 
Code 
(16#) 

Description Solution  Flag Log

000A Scan timeout 
1. Check the setting of the watchdog timer in HWCONFIG.
2. Check whether the program causes a long scan time 

SM8 V 

 

12.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds 

Error 
Code 
(16#) 

Description Solution Flag Log

000C 
The program in the PLC is 
damaged. 

Download the program again. SM9 V 

0010 CPU memory is denied. Contact the factory. SM9 V 

002E 
CPU external memory access is 
denied. 

Contact the factory. SM9 V 

002F 
PLC programs are not consistent 
with the system logs. 

Download the program again. SM34 V 

0070 
The arrangement of the function 
cards is not consistent with the 
settings. 

Check whether the settings in HWCONFIG are consistent 
with the arrangement of the function cards. 

SM10 V 

0102 
The interrupt number exceeds the 
range. 

Check the program, compile the program again, and 
download the program again. 

SM5 X 

0202 
The MC instruction exceeds the 
range.  

Check the program, compile the program again, and 
download the program again. 

SM5 X 

0302 
The MCR instruction exceeds the 
range.  

Check the program, compile the program again, and 
download the program again. 

SM5 X 

0D03 
The operands used in DHSCS are 
not used properly. 

Check the program, compile the program again, and 
download the program again. 

SM5 X 

0E05 
The operands HCXXX used in 
DCNT are not used properly. 

Check the program, compile the program again, and 
download the program again. 

SM5 X 

1300 
- 

130F 

Errors occurred in the remote 
modules 

Refer to Section 12.3.4 for more information on the error 
codes for the remote modules. 

SM30 V 
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Error 
Code 
(16#) 

Description Solution Flag Log

1402 
The arrangement of the I/O modules 
is not consistent with the settings. 

Check whether the settings in HWCONFIG are consistent 
with the arrangement of the I/O modules. 

SM10 V 

140B 
More than four communication 
modules.  

Check the total number of communication modules 
(maximum is four). 

SM10 V 

140D More than 32 extension modules.  
Check the total number of extension modules (maximum 
is 32). 

SM10 V 

140E 
More than eight remote modules on 
the right side of the CPU module.  

Check the total number of remote modules on the right 
side of the CPU module (maximum is 8). 

SM30 V 

1600 
The extension module ID exceeds 
the range.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the error still occurs, contact the factory. 
SM10 V 

1601 
The extension module ID cannot be 
set.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the error still occurs, contact the factory. 
SM10 V 

1602 
The extension module ID is 
duplicated.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the error still occurs, contact the factory. 
SM10 V 

1603 
The extension module cannot be 
operated.  

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the error still occurs, contact the factory. 
SM10 V 

1604 
Extension module communication 
timeout 

1. Make sure the module is properly connected to the 
CPU module and turn the modules on again.  

2. If the error still occurs, contact the factory. 
SM10 V 

1605 Hardware failure Contact the factory. SM10 V 

1606 
Errors on the communication 
module function card 

Make sure the function card is properly connected to the 
CPU module and turn the modules on again. 

SM10 V 

1607 The external voltage is abnormal. 
Check whether the external 24 V power supply to the 
module is normal. 

SM10 V 

1608 
The Internal factory calibration or the 
CJC is abnormal. 

Contact the factory. SM10 V 

1609 
- 

160F 
Reserved (Error codes for the extension modules) 

200A Invalid instruction 
Check the program, compile the program again, and 
download the program again. 

SM5 V 

6010 
The number of MODBUS TCP 
connections exceeds the range.  

Check the number of superior devices (maximum is 32). 
SM

1092
V 

6011 
The number of EtherNet/IP 
connections exceeds the range. 

Check the number of connections (maximum is 16).  
SM

1093
V 

C000 
- 

CFFF 
The program syntax is incorrect. 

Save the PLC program and hand the file to the company 
or the technicians. 
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12.2.3 ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds 
This happens when the power supply 24 VDC of the CPU module is disconnected, or the power supply is not sufficient, 
not stable or abnormal.  

Error 
Code 
(16#) 

Description Solution Flag Log

002A The external voltage is abnormal. 
Check whether the external 24 V power supply to the 
module is normal. 

SM7 V 

 

12.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and 
Lighting up for 1 Second 

Error 
Code 
(16#) 

Description Solution Flag Log

1500 
 

Connection lost in the remote 
modules 

Check the network connection cable.  SM30 V 

1502 
- 

150F 

Errors occurred in the remote 
modules 

Refer to Section 12.3.4 for more information on the 
remote module error codes. 

SM30 V 

1800 
- 

180F 

Errors occurred in the extension 
modules 

Refer to Section 12.3 for more information on the 
extension module error codes. 

SM10 V 

1900 
- 

191C 

Heartbeat errors occurred in the 
slave for the Delta ASD-A2 control.

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
Note: The last 2 digits of the error code represent the ID 
number of the slave (convert hexadecimal to decimal). 

- V 

 

12.2.5 BAT. LOW LED Indicators Are ON 
This happens when there is no battery (CR1620) or the power is low. Turn this option off in the HWCONFIG > CPU > 
Device Setting > Show Battery Low Voltage Error CPU when you don’t need the RTC function to keep track of the current 
time (default is enabled).    

Error 
Code 
(16#) 

Description Solution Flag Log

0027 Battery Low Change battery or turn this option off  SM219 X 

 

12.2.6 BAT. LOW LED Indicators Blinking Every 0.5 Seconds 
This happens when RTC cannot keep track of the current time.  

Error 
Code 
(16#) 

Description Solution Flag Log

0026 
RTC cannot keep track of the 
current time 

Contact the factory. SM218 V 
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12.2.7 The LED RUN and ERROR Indicators are Blinking Simultaneously 
Every 0.5 Seconds 

This happens when the firmware of the CPU module is being upgraded. If this happens once the power is supplied to the 
CPU module, it means errors occurred during the previous firmware upgrade. Users need to upgrade the firmware again 
or contact your point of purchase.     

 

12.2.8 The RUN and LED Indicators are Blinking One After Another Every 
0.5 Seconds.  

This happens when the CPU module memory card is backing up, restoring, or saving.  

 

12.2.9 Other Errors (Without LED Indicators) 
Error 
Code 
(16#) 

Description Solution Flag Log

0011 The PLC ID is incorrect. Check the PLC ID. SM34 V 
0012 The PLC password is incorrect.  Check the PLC password. SM34 V 

002D 
The PLC maximum password attempts 
exceeded.  

Reset the CPU module or restore the CPU module 
to its factory settings. 

SM34 V 

0050 
The memories in the latched special 
auxiliary relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0051 
The latched special data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0052 
The memories in the latched auxiliary 
relays are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0054 The latched counters are abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, please contact the factory. 

SM6 V 

0055 
The latched 32-bit counters are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

0056 
The latched special auxiliary relay is 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6  V 

0059 
The latched data registers are 
abnormal. 

1. Reset the CPU module or restore the CPU 
module to its factory settings, and then download 
the program and the parameters again. 

2. If the error still occurs, contact the factory. 

SM6 V 

005D The CPU module does not detect a Check that the memory card is inserted correctly SM453 V 
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memory card. into the CPU module. 

005E 
The memory card is initialized 
incorrectly. 

Check whether the memory card is broken.  SM453 V 

0063 
An error occurs when data is written to 
the memory card. 

Check whether the file path is correct or whether 
the memory card is malfunctioning. 

SM453 V 

0064 
A file in the memory card cannot be 
read.  

Check whether the file path is correct, or whether 
the file is damaged. 

SM453 V 

1950 

The initialization of the Delta ASD-A2 
control has not yet been completed, the 
CANopen instructions cannot be 
executed. 

1. Check the CANopen connection cable.  
2. Check if the specific slave is working properly.  
3. If nothing is wrong, initialize the Delta ASD-A2 

again. 

- V 

2001 

Not using the FCOMP card or not in the 
right mode for the ASDA-A2 while using 
the CANopen communication 
instruction. 

Use the FCOMP card in the function card slot to 
check if the operation mode is correct.  

SM0 V 

2003 
The device used in the program 
exceeds the device range. 

Check the program, compile the program again, 
and download the program again. 

SM0 V 

200B 
The operand n or the other constant 
operands K/H exceed the range. 

Check the program, compile the program again, 
and download the program again. 

SM0 V 

200C The operands overlap. 
Check the program, compile the program again, 
and download the program again. 

SM0 V 

200D 
The binary to binary-coded decimal 
conversion is incorrect. 

Check the program, compile the program again, 
and download the program again. 

SM0 V 

200E The string does not end with 00.  
Check the program, compile the program again, 
and download the program again. 

SM0 V 

2012 Incorrect division operation 
Check the program, compile the program again, 
and download the program again. 

SM0 V 

2013 
The value exceeds the range of values 
that can be represented by the 
floating-point numbers. 

Check the program, compile the program again, 
and download the program again. 

SM0 V 

2014 
The task designated by the TKON or 
YKOFF instruction is incorrect or 
exceeds the range. 

Check the program, compile the program again, 
and download the program again. 
 

SM0 V 

2017 
The instruction BREAK is written outside 
of the FOR-NEXT loop. 

Check the program, compile the program again, 
and download the program again. 

SM0 V 

2027 
No such position planning table number 
or the format is incorrect.  

1. Check the program, compile the program again, 
and download the program again. 

2. Check the settings of the position planning table. 
SM0 V 

2028 
High speed output instruction is being 
executed. Only one instruction can be 
executed at a time.  

Refer to SR28 for the record of the axis number and 
rearrange the output control procedures. 

- V 

6004 The IP address filter is set incorrectly. 
Set the Ethernet parameter for the CPU module in 
HWCONFIG again. 

SM1108 X 

600D RJ45 port is not connected.  Check the connection. SM1100 X 

6012 
There are devices using the same IP 
address.  

1. Check if there are devices using the same IP 
address.  

2. Check if there is more than 1 DHCP or BOOTP 
server on the network.  

SM1101 V 

6100 The email connection is busy. 
Retry the email connection later. This error does not 
cause the PLC to stop running. Solve the problem 
by means of the related flag in the program. 

SM1113 X 
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6103 
The trigger attachment mode in the 
email is set incorrectly.  

Set up the trigger attachment mode in HWCONFIG 
> CPU Module > Device Setting > Options > 
Ethernet Port Advanced > Email > Trigger Setting > 
Trigger Attachment Mode.  

SM1113 X 

6104 
The attachment in the email does not 
exist. 

Check whether the attachment exists in the 
memory card. 

SM1113 X 

6105 
The attachment in the email is 
oversized. 

Check the size of the attachment. If the size is over 
2 MB, the file cannot be sent as an attachment. 

SM1113 X 

6106 
There is an SMTP server response 
timeout. 

Check for the correct address and set up the SMTP 
server in HWCONFIG > CPU Module > Device 
Setting > Options > Ethernet Port Advanced > 
Email again. 

SM1113 X 

6107 
There is an SMTP server response 
timeout. 

1. Check whether the status of the SMTP server is 
normal. 

2. Retry sending of the email later. This error does 
not cause the PLC to stop running. Solve the 
problem by means of the related flag in the 
program. 

SM1113 X 

6108 SMTP verification failed  
Check for the correct ID/Password and set up in 
HWCONFIG > CPU Module > Device Setting > 
Options > Ethernet Port Advanced > Email again. 

SM1113 X 

6200 
The remote communication IP address 
set in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6201 
The local communication port set in the 
TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6202 
The remote communication port set in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6203 
The device from which the data is sent 
in the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6206 
The device which receives the data in 
the TCP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 
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6208 
The data received through the TCP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > TCP 
Socket. 

- X 

6209 
The remote communication IP address 
set in the UDP socket function is illegal.

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620A 
The local communication port set in the 
UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620C 
The device from which the data is sent 
in the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

620F 
The device which receives the data in 
the UDP socket function is illegal. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6210 
The data received through the UDP 
socket exceeds the device range. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6212 
There is no response from the remote 
device after the timeout period. 

Make sure that the remote device is connected. - X 

6213 The data received exceeds the limit. 

1. Check the program and the related special data 
registers. 

2. Set the Ethernet parameter for the CPU module 
in HWCONFIG CPU Module > Device Setting > 
Options > Ethernet Port Advanced > UDP 
Socket. 

- X 

6214 
The remote device refuses the 
connection. 

Make sure the remote device operates normally. - X 

6215 The socket is not opened. 
Check whether operational sequence in the 
program is correct. 

- X 

6217 The socket is opened. 
Check whether operational sequence in the 
program is correct. 

- X 

6218 
The data has been sent through the 
socket. 

Check whether operational sequence in the 
program is correct. 

- X 

6219 The data has been received through the Check whether operational sequence in the - X 
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socket. program is correct. 

621A The socket is closed. 
Check whether operational sequence in the 
program is correct. 

- X 

7011 
The device communication function 
code in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7012 
The device communication address 
used in COM1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7013 
The device used in COM1 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7014 
The device length of the communication 
data in COM1 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7017 
The device checksum for the 
communication serial port of COM1 is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7021 
The device communication function 
code in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7022 
The device communication address 
used in COM2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7023 
The device used in COM2 exceeds the 
device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7024 
The device length of the communication 
data in COM2 exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7027 
The device checksum for the 
communication serial port of COM2 is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7031 
The device communication function 
code in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7032 
The device communication address 
used in the Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7033 
The device used in the Ethernet 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7034 
The device length of the communication 
data in the Ethernet exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7037 
The device checksum for the 
communication serial port of the 
Ethernet is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7041 
The device communication function 
code in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 
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7042 
The device communication address 
used in the USB is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7043 
The device used in the USB exceeds 
the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7044 
The device length of the communication 
data in the USB exceeds the limit. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7047 
The device checksum for the 
communication serial port of the USB is 
incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B1 
The device communication function 
code in function card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B2 
The device communication address 
used in function card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B3 
The device used in the function card 1 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B4 
The device length of the communication 
data in function card 1 exceeds the limit.

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70B7 
The device checksum for the 
communication serial port of function 
card 1 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C1 
The device communication function 
code in function card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C2 
The device communication address 
used in function card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C3 
The device used in function card 2 
exceeds the device range. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C4 
The device length of the communication 
data in function card 2 exceeds the limit.

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

70C7 
The device checksum for the 
communication serial port of function 
card 2 is incorrect. 

1. Check the communication setting in the master 
and the slave. 

2. Check the communication cable. 
- H 

7203 Invalid communication function code 

1. Refer to the function codes defined by the   
communication protocols. 

2. Check if the product firmware and the software 
used are the most updated versions.  

3. Make a note of the operation procedures and 
screenshots of the error windows and hand this 
note to the company or the technicians from the 
agents. 

- H 
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8105 
The contents of the program 
downloaded are incorrect. 
The program syntax is incorrect. 

1. Download the program and parameters again. 
2. Check the communication cable. 
3. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8106 

The contents of the program 
downloaded are incorrect. 
The length of the execution code 
exceeds the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8107 

The contents of the program 
downloaded are incorrect. 
The length of the source code exceeds 
the limit. 

1. Download the program and parameters again. 
2. Save all the projects and compress the projects  
  into one compressed file and then hand this file  
  to the company or the technicians from the  
  agents. 

- H 

8000 
- 

8FFF 

Errors occur between software and 
PLC. 

1. Check if the product firmware and the software 
used are the most updated versions.  

2. Make a note of the operation procedures and  
  screenshots of the error windows and hand this  
  note to the company or the technicians from the  
  agents. 

  

 
 

12.3  Troubleshooting for I/O Modules 
 Introduction to troubleshotting modules 

Digital I/O, analog I/O, temperature measurement, load cell, and network modules can be installed in an AS Series 
system. There are 2 types of error codes; error and warning. The CPU module and its modules stop operating when 
errors occur. The CPU modules and its modules do not stop operating when warnings are triggered.  

 

12.3.1 Troubleshooting for Analog Modules (AD/DA/XA) and 
Temperature Modules (RTD/TC) 

 
12.3.1.1 ERROR LED Indicators Are ON 
The following errors are specified as warnings. You can set up HWCONFIG to make them appear as errors when the 
following errors occur.  

Error 
Code Description Solution 

16#1605 Hardware failure Contact the factory. 
16#1607 The external voltage is abnormal. Check the power supply. 

16#1608 
The factory calibration or the CJC is 
abnormal. 

Contact the factory. 

 
 



 Chapter  12 Troubleshoot ing  

12-15 

12_

12.3.1.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
The following errors are specified as warnings to ensure that the CPU module can still run even when the warnings are 
triggered by its AIO modules. You can set up HWCONFIG to have the following first 4 error codes appear as errors when 
they occur.   

Error 
Code Description Solution 

16#1801 The external voltage is abnormal. Check the power supply. 
16#1802 Hardware failure Contact the factory. 
16#1804 The factory calibration is abnormal. Contact the factory. 
16#1807 The CJC is abnormal. Contact the factory. 

16#1808 
The signal received by channel 1 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 1 

16#1809 
The signal received by channel 2 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 2 

16#180A 
The signal received by channel 3 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 3 

16#180B 
The signal received by channel 4 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 4 

16#180C 
The signal received by channel 5 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 5 

16#180D 
The signal received by channel 6 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 6 

16#180E 
The signal received by channel 7 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 7 

16#180F 
The signal received by channel 8 exceeds 
the range of analog inputs (temperature). 

Check the signal received by channel 8 

 

12.3.2 Troubleshooting for the Load Cell Module AS02LC 
12.3.2.1 ERROR LED Indicators Are ON 
You can set up HWCONFIG to have the following appear as errors when they occur. 

Error 
Code Description Solution 

16#1605 Hardware failure (that is, the driver board) Contact the factory. 
16#1607 The external voltage is abnormal. Check the power supply. 

 
12.3.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
The following errors are specified as warnings to ensure the CPU module can still run even when the warnings are 
triggered by its AIO modules. You can set up HWCONFIG to have the following first 3 error codes appear as errors when 
they occur.   

Error 
Code Description Solution 

16#1801 The external voltage is abnormal. Check the power supply. 
16#1802 Hardware failure Contact the factory. 
16#1807 Diver board failure  Contact the factory. 

16#1808 
The signal received by channel 1 exceeds 
the range of analog inputs or the SEN 
voltage is abnormal.  

Check the signal received by channel 1 and the cable 
connections. 
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Error 
Code Description Solution 

16#1809 
The signal received by channel 1 exceeds 
the weight limit. 

Check the value input to channel 1 and the maximum 
weight setting. 

16#180A 
The factory calibration in channel 1 is 
incorrect. 

Check the weight calibration in channel 1.  

16#180B 
The signal received by channel 2 exceeds 
the range of analog inputs or the SEN 
voltage is abnormal. 

Check the signal received by channel 2 and the cable 
connections. 

16#180C 
The signal received by channel 2 exceeds 
the weight limit. 

Check the value input to channel 2 and the maximum 
weight setting. 

16#180D 
The factory calibration in channel 2 is 
incorrect. 

Check the weight calibration in channel 1. 

 

12.3.3 Troubleshooting for the Module AS00SCM as a Communication 
Module 

12.3.3.1 ERROR LED Indicator Are ON 
The following error codes identify possible errors when the AS00SCM module is installed on the right side of the CPU 
module and acts as a communication module.  

Error 
Code Description Solution 

16#1605 Hardware failure 
1. Check that the module is securely installed.  
2. Install a new AS00SCM or contact the factory. 

16#1606 The function card setting is incorrect.  

1. Check if the function card is securely installed.  
2. Install a new function card or contact the factory. 
3. Check if the setting in HWCONFIG is consistent with 

the function card setting. 
4. Install a new AS00SCM or contact the factory. 

 
12.3.3.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
The following error codes identify possible errors when the AS00SCM module is installed on the right side of the CPU 
module and acts as a communication module.  

Error 
Code Description Solution 

16#1802 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again. 

16#1803 Communication timeout 

1. Check whether the communication cable is properly 
connected. 

2. Check if the station number and the communication 
format are correctly set.  

3. Check if the connection with the function card is 
working correctly. 

16#1804 The UD Link setting is incorrect. 
1. Check the settings of the UD Link. 
2. Check the warning settings in the PLC. 

 
The following error codes can only be viewed with SCMSoft; when the following errors occur, they are not shown on the 
LED indicators and the system does not send the error messages to the CPU module.   
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Error 
Code Description Solution 

16#0107 
The settings in HWCONFIG and manual 
settings are not consistent with function card 
1.   

Check the settings in HWCONFIG and manual settings 
for function card 1.   

16#0108 
The settings in HWCONFIG and manual 
settings are not consistent for function card 
2. 

Check the settings in HWCONFIG and manual settings 
for function card 2. 

16#0201 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again.

16#0301 Function card 1 communication timeout 

1. Check if the station number and the communication 
format are correctly set.  

2. Check if the connection with the function card is 
working correctly.

16#0302 Function card 2 communication timeout 

1. Check if the station number and the communication 
format are correctly set.  

2. Check if the connection with the function card is 
working correctly. 

16#0400 Invalid UD Link Group ID for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0401 Invalid UD Link Group ID for function card 2 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0402 Invalid UD Link Command for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

16#0403 Invalid UD Link Command for function card 1 
1. Check the UD Link settings. 
2. Check the warning settings in the PLC. 

 

12.3.4 Troubleshooting for the Module AS00SCM as a Remote Module 
Errors from the remote modules are regarded as warnings for AS Series CPU modules. The LED indicator of the CPU 
module blinks and the CPU module can still operate. Use flag SM30 to manage error presentation in the remote modules.   

 

12.3.4.1 ERROR LED Indicators Are ON 
Error codes:   

Error 
Code Description Solution 

16#1301 Hardware failure 
1. Check if the module is securely installed.  
2. Change and install a new AS00SCM or contact the 

factory. 

16#1302 The function card setting is incorrect.  

1. Check if the function card is securely installed with 
the AS-FCOPM card.  

2. Change and install a new function card or contact the 
factory. 

3. Check if the setting in HWCONFIG is consistent with 
the function card setting.  

4. Install a new AS00SCM or contact the factory. 
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12.3.4.2 ERROR LED Indicators Blinking Every 0.5 Seconds 
Error codes:   

Error 
Code Description Solution 

16#1502 Incorrect parameters  Check the parameter in HWCONFIG. Download the 
parameter again. 

16#1503 Extension module communication timeout Make sure the module is properly connected to the CPU 
module and turn the modules on again. 

 
 
12.3.4.3 ERROR LED Indicators Blinking Every 0.2 Seconds 
This happens when the 24 VDC power supply for the remote module is not sufficient. Check the power supply. If the 
power supply is normal, remove the extension module from the CPU module and then check if the SCM remote module is 
out of order. Error codes: 

Error 
Code Description Solution 

16#1303 
24VDC power supply is not sufficient and 
then recovered from low-voltage for less 
than 10 ms. 

Check whether the 24 V power supply to the module is 
normal. 

 

12.3.5 Troubleshooting for AS01DNET Modules 

Refer to sections 12.4.6 and 12.4.7 for more details.  
 

12.4 Error Codes and LED Indicators for CPU Modules 
A. Columns 

a. Error code: If an error occurs in the system, an error code is generated. 

b. Description: The description of the error 

c. CPU status: If the error occurs, the CPU stops running, keeps running, or shows the status you defined for the 
error.

 Stop: The CPU stops running when the error occurs. 

 Continue: The CPU keeps running when the error occurs. 

d. LED indicator status: If the error occurs, the LED indicator is ON, OFF, or blinks. 

 ERROR: System error 

 Descriptions 

Module Type LED indicator Descriptions 

CPU Error LED 

There are five types of error indicator states for of the CPU module errors, including
LED indicator ON, OFF, blinking fast, blinking normally, and blinking slowly. When 
the LED indicator is ON, blinking fast/normally, clear the problems first in order to 
run the CPU module. When the LED indicator is blinking slowly, indicating a 
warning type of error codes, it does not require immediate action. Clear the 
problems when the module is powered off.  
 

Error type: 
ON: A serious error occurs in the module. 
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Module Type LED indicator Descriptions 

Blinking fast (every 0.2 seconds): unstable power supply or hardware  
Failure.  
Blinking normally (every 0.5 second): system program errors or system  
cannot run.  
 

Warning type:  
Blinking slowly (every one second and off for three seconds): a warning is    
triggered, but the system can still run.  
OFF: a warning is triggered, but the system can still run. You can modify the rules 

   of how a warning is triggered, or use the SM/SR to show the warnings. 

 

12.4.1 Error Codes and LED Indicators for CPU Modules 
Note: refer to Section 12.3 for the status descriptions of the Error LED indicators.  

Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

000A Scan timeout Stop V     

000C The program in the PLC is damaged. Stop   V   
0010 The access to the memory in the CPU is denied. Stop   V   
0011 The PLC ID is incorrect.  Continue     V 
0012 The PLC password is incorrect. Continue     V 

0026 
RTC cannot keep track of the current time (the 
battery LED is blinking.) 

Continue      

0027 Battery low (the battery LED is ON.) Continue      

002A 
24VDC power supply is not sufficient and then is 
recovered from low-voltage for less than 10 ms. 

Continue  V    

002D The PLC maximum password attempts exceeded. Continue     V 

002E 
The access to the external memory of the CPU is 
denied. 

Stop   V   

002F 
PLC programs are not consistent with the system 
logs. 

Stop   V   

0050 
The memories in the latched special auxiliary relays 
are abnormal. 

Continue     V 

0051 The latched special data registers are abnormal. Continue     V 

0052 
The memories in the latched auxiliary relays are 
abnormal. 

Continue     V 

0054 The latched counters are abnormal. Continue     V 
0055 The latched 32-bit counters are abnormal. Continue     V 
0056 The latched special auxiliary relay is abnormal. Continue     V 
0059 The latched data registers are abnormal. Continue     V 
005D The CPU module does not detect a memory card. Continue     V 
005E The memory card is initialized incorrectly. Continue     V 

0063 
An error occurs when data is written to the memory 
card. 

Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

0064 A file in the memory card cannot be read.  Continue     V 

0070 
The actual arrangement of the function cards is not 
consistent with the settings. 

Stop   V   

0102 The interrupt number exceeds the range. Stop   V   
0202 The MC instruction exceeds the range.  Stop   V   
0302 The MCR instruction exceeds the range.  Stop   V   

0D03 
The operands used in DHSCS are not used 
properly. 

Stop   V   

0E05 
The operands HCXXX used in DCNT are not used 
properly. 

Stop   V   

1300 
- 

130F 
Errors occurred in the remote modules Continue    V  

1402 
The arrangement of the I/O modules is not 
consistent with the settings. 

Stop   V   

140B 
Number of communication modules exceeds the 
limit of four.  

Stop   V   

140D 
Number of extension modules exceeds the limit of 
32.  

Stop   V   

140E 
Number of remote modules exceeds the limit of 
eight on the right side of the CPU module.  

Stop   V   

1500 Connection lost in the remote modules Continue    V  

1502 
- 

150F 
Errors occurred in the remote modules Continue    V  

1600 The ID of the extension module exceeds the range. Stop   V   
1601 The ID of the extension module cannot be set.  Stop   V   
1602 The ID of the extension module is duplicated.  Stop   V   
1603 The extension module cannot be operated.  Stop   V   
1604 Extension module communication timeout Stop   V   
1605 Hardware failure Stop   V   
1606 Errors on the communication module function card Stop   V   
1607 The external voltage is abnormal. Stop   V   

1608 
The Internal factory calibration or the CJC is 
abnormal. 

Stop   V   

1609 
- 

160F 
Reserved (Error codes for the extension modules) Stop    V   

1800 
- 

180F 
Errors occurred in the extension modules Continue    V  
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

1900 
- 

191C 

Heartbeat errors occurred in the slave of the Delta 
ASD-A2 control. 

Continue    V  

1950 
The initialization of the Delta ASD-A2 control has 
not yet been completed, the CANopen instructions 
cannot be executed. 

Continue     V 

2001 
Not using the FCOMP card or not in the right mode 
for the ASDA-A2 while using the CANopen 
communication instruction. 

Continue     V 

2003 
The device used in the program exceeds the device 
range. 

Continue     V 

200A Invalid instruction Stop   V   

200B 
The operand n or the other constant operands K/H
exceed the range. 

Continue     V 

200C The operands overlap. Continue     V 

200D 
The binary to binary-coded decimal conversion is 
incorrect. 

Continue     V 

200E The string does not end with 00.  Continue     V 
2012 Incorrect division operation Continue     V 

2013 
The value exceeds the range of values which can 
be represented by the floating-point numbers. 

Continue     V 

2014 
The task designated by the TKON or YKOFF 
instruction is incorrect, or exceeds the range. 

Continue     V 

2017 
The instruction BREAK is written outside of the 
FOR-NEXT loop. 

Continue     V 

2027 
No such position planning table number or the 
format is incorrect.  

Continue     V 

2028 
The high speed output instruction is being 
executed. Only one instruction can be executed at a 
time. 

Continue     V 

6004 The IP address filter is set incorrectly. Continue     V 
600D RJ45 port is not connected.  Continue     V 

6010 
The number of the MODBUS TCP connections 
exceeds the range.  

Continue   V   

6011 
The number of the EtherNet/IP connections 
exceeds the range. 

Continue   V   

6012 There are devices using the same IP address.  Continue     V 
6100 The email connection is busy. Continue     V 

6103 
The trigger attachment mode in the email is set 
incorrectly.  

Continue     V 

6104 The attachment in the email does not exist. Continue     V 
6105 The attachment in the email is too big. Continue     V 
6106 There is an SMTP server response timeout. Continue     V 
6107 There is an SMTP server response timeout. Continue     V 
6108 SMTP verification failed  Continue     V 



AS Ser ies Hardware Manual  

12-22 

_12 

Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

6200 
The remote communication IP address set in the 
TCP socket function is illegal. 

Continue     V 

6201 
The local communication port set in the TCP socket 
function is illegal. 

Continue     V 

6202 
The remote communication port set in the TCP 
socket function is illegal. 

Continue     V 

6203 
The device from which the data is sent in the TCP 
socket function is illegal. 

Continue     V 

6206 
The device that receives the data in the TCP socket 
function is illegal. 

Continue     V 

6208 
The data that is received through the TCP socket 
exceeds the device range. 

Continue     V 

6209 
The remote communication IP address set in the 
UDP socket function is illegal. 

Continue     V 

620A 
The local communication port set in the UDP socket 
function is illegal. 

Continue     V 

620C 
The device from which the data is sent in the UDP 
socket function is illegal. 

Continue     V 

620F 
The device that receives the data in the UDP socket 
function is illegal. 

Continue     V 

6210 
The data that is received through the UDP socket 
exceeds the device range. 

Continue     V 

6212 
There is no response from the remote device after 
the timeout period. 

Continue     V 

6213 The data received exceeds the limit. Continue     V 
6214 The remote device refuses the connection. Continue     V 
6215 The socket is not opened. Continue     V 
6217 The socket is opened. Continue     V 
6218 The data has been sent through the socket. Continue     V 
6219 The data has been received through the socket. Continue     V 
621A The socket is closed. Continue     V 

7011 
The device communication function code in COM1 
is incorrect. 

Continue     V 

7012 
The device communication address used in COM1 
is incorrect. 

Continue     V 

7013 
The device used in COM1 exceeds the device 
range. 

Continue     V 

7014 
The device length of the communication data in 
COM1 exceeds the limit. 

Continue     V 

7017 
The device checksum for the communication serial 
port of COM1 is incorrect. 

Continue     V 

7021 
The device communication function code in COM2
is incorrect. 

Continue     V 

7022 
The device communication address used in COM2
is incorrect. 

Continue     V 
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Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

7023 
The device used in COM2 exceeds the device 
range. 

Continue     V 

7024 
The device length of the communication data in 
COM2 exceeds the limit. 

Continue     V 

7027 
The device checksum for the communication serial 
port of COM2 is incorrect. 

Continue     V 

7031 
The device communication function code in 
Ethernet is incorrect. 

Continue     V 

7032 
The device communication address used in 
Ethernet is incorrect. 

Continue     V 

7033 
The device used in Ethernet exceeds the device 
range. 

Continue     V 

7034 
The device length of the communication data in
Ethernet exceeds the limit. 

Continue     V 

7037 
The device checksum for the communication serial 
port of Ethernet is incorrect. 

Continue     V 

7041 
The device communication function code in USB is 
incorrect. 

Continue     V 

7042 
The device communication address used in USB is 
incorrect. 

Continue     V 

7043 The device used in USB exceeds the device range. Continue     V 

7044 
The device length of the communication data in
USB exceeds the limit. 

Continue     V 

7047 
The device checksum for the communication serial 
port of USB is incorrect. 

Continue     V 

70B1 
The device communication function code in function 
card 1 is incorrect. 

Continue     V 

70B2 
The device communication address used in function 
card 1 is incorrect. 

Continue     V 

70B3 
The device used in function card 1 exceeds the 
device range. 

Continue     V 

70B4 
The device length of the communication data in 
function card 1 exceeds the limit. 

Continue     V 

70B7 
The device checksum for the communication serial 
port of function card 1 is incorrect. 

Continue     V 

70C1 
The device communication function code in function 
card 2 is incorrect. 

Continue     V 

70C2 
The device communication address used in function 
card 2 is incorrect. 

Continue     V 

70C3 
The device used in function card 2 exceeds the 
device range. 

Continue     V 

70C4 
The device length of the communication data in 
function card 2 exceeds the limit. 

Continue     V 

70C7 
The device checksum for the communication serial 
port of function card 2 is incorrect. 

Continue     V 

7203 Invalid communication function code Continue     V 



AS Ser ies Hardware Manual  

12-24 

_12 

Error 
code Description CPU 

status 

ERROR LED indicator status 

ON Blinking 
fast 

Blinking 
normally 

Blinking 
slowly 

OFF

8105 
The contents of the downloaded program are 
incorrect. 
The program syntax is incorrect. 

Continue     V 

8106 
The contents of the downloaded program are 
incorrect. 
The length of the execution code exceeds the limit.

Continue     V 

8107 
The contents of the downloaded program are 
incorrect. 
The length of the source code exceeds the limit. 

Continue     V 

8000 
- 

8FFF 
Errors occur between software and PLC. Continue     V 

 

12.4.2 Error Codes and LED Indicators for Analog/Temperature Modules 

Error code Description 

ERROR LED indicator status 

A  D /  
D  A /  
A D 

ERROR 

16#1605 Hardware failure OFF ON 
16#1607 The external voltage is abnormal. OFF ON 
16#1608 The factory calibration or the CJC is abnormal. OFF ON 

16#1801*1 The external voltage is abnormal. OFF Blinking 
16#1802*1 Hardware failure OFF Blinking 

16#1804*1 The factory calibration is abnormal. 
RUN: Blinking 
STOP: OFF 

Blinking 

16#1807*1 The CJC is abnormal. OFF Blinking 

16#1808 
The signal received by channel 1 exceeds the range of 
analog inputs (temperature). 

RUN: Blinking 
STOP: OFF 

Blinking 

16#1809 
The signal received by channel 2 exceeds the range of 
analog inputs (temperature). 

16#180A 
The signal received by channel 3 exceeds the range of 
analog inputs (temperature).  

16#180B 
The signal received by channel 4 exceeds the range of 
analog inputs (temperature).  

16#180C 
The signal received by channel 5 exceeds the range of 
analog inputs (temperature). 

16#180D 
The signal received by channel 6 exceeds the range of 
analog inputs (temperature). 

16#180E 
The signal received by channel 7 exceeds the range of 
analog inputs (temperature). 

16#180F 
The signal received by channel 8 exceeds the range of 
analog inputs (temperature). 

*1: The following errors are specified as warnings to ensure the CPU module can still run even when the warnings are 
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triggered by its AIO modules. You can set up HWCONFIG to have the following first 4 error codes appear as errors when 
they occur. 

 

12.4.3 Error Codes and LED Indicators for Load Cell Module AS02LC 

Error code Description 
ERROR LED indicator status 

A  D  ERROR 

16#1605 Hardware failure (the diver board included) OFF ON 
16#1607 The external voltage is abnormal. OFF ON 

16#1801*1 The external voltage is abnormal. OFF Blinking 

16#1802*1 Hardware failure OFF Blinking 

16#1807*1 Diver board failure  OFF Blinking 

16#1808 
The signal received by channel 1 exceeds the range of 
analog inputs or the SEN voltage is abnormal.  

RUN: Blinking 
STOP: OFF 

Blinking 

16#1809 The signal received by channel 1 exceeds the weight limit. 
16#180A The factory calibration in channel 1 is incorrect. 

16#180B 
The signal received by channel 2 exceeds the range of 
analog inputs or the SEN voltage is abnormal. 

16#180C The signal received by channel 2 exceeds the weight limit. 
16#180D The factory calibration in channel 2 is incorrect. 

*1: The following errors are specified as warnings to ensure the CPU module can still run even when the warnings are 
triggered by its AIO modules. You can set up HWCONFIG to have the following first 3 error codes appear as errors when 
they occur. 

12.4.4 Error Codes and LED Indicators for Module AS00SCM as a 
Communication Module 

Error Code Description 
ERROR LED indicator status 

ON Blinking 

16#1605 Hardware failure V  
16#1606 The setting of the function card is incorrect.  V  
16#1802 Incorrect parameters   V 
16#1803 Communication timeout  V 
16#1804 The setting of the UD Link is incorrect.  V 

 

12.4.5 Error Codes and LED Indicators for Module AS00SCM as a Remote 
Module 

Error Code Description 
ERROR LED indicator status 

ON Blinking Blinking 
fast 

16#1301 Hardware failure V   
16#1302 The setting of the function card is incorrect.  V   
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Error Code Description 
ERROR LED indicator status 

ON Blinking Blinking 
fast 

16#1303 
24 VDC power supply is not sufficient and then is recovered 
from a low-voltage less than 10ms situation. 

  V 

16#1502 Incorrect parameters   V  
16#1503 Extension module communication timeout  V  

 

12.4.6 Error Codes and LED Indicators for Module AS01DNET 
(Master/Slave Mode) 

Code Explanation Correction 

0~63 
Node address of AS01DNET-A (in 
normal operation)  

-- 

80 AS01DNET-A is in STOP status. Turn the PLC to RUN and start I/O data exchange 

F0 
The node ID of AS01DNET is the 
same as that of other node or 
exceeds the allowed range. 

1. Ensure that the node address of AS01DNET is unique.  
2. Re-power AS01DNET.  

F1 
No slave is configured in Scan 
List. 

Configure the scan list and then download the configuration to 
AS01DNET. 

F2 Too low voltage of the work power Check if the power supply for AS01DNET and the PLC is normal. 

F3 AS01DNET enters the test mode 
Switch the function switch IN1 from On to Off and re-power 
AS01DNET-A. 

F4 BUS-OFF 

1. Check if the network cable is normal and the shielded cable is 
grounded. 

2. Check if the baud rates of all nodes in the network are same. 
3. Check if the start and end of the network cable are both 

connected with a 121Ω terminal resistor. 
4. Re-power AS01DNET-A.  

F5 No network power  
1. Check if the network cable is normal.  
2. Ensure that the network power is normal.  

 F6 
Internal error; Flash or RAM 
check error  

If the error still exists after re-power, send AS01DNET-A back to the 
factory for repair. 

F8 
Error produced in factory 
manufacturing 

If the error still exists after re-power, send AS01DNET-A back to the 
factory for repair.  

F9 
Internal error; EEPROM access 
failure 

If the error still exists after re-power, send AS01DNET-A back to the 
factory for repair. 

FA Invalid configuration data 

1. Configure the network correctly and re-download it to 
AS01DNET-A. 

2. Check if the node address of one slave in the scan list is the 
same as that of AS01DNET-A. 

E0 
Identification parameters returned 
from the slave do not match the 
configuration data. 

1. Check if there is any change in node ID of the slave in the 
network. 

2. Check if some node device in the network is replaced. 
3. Re-configure the network. 

E1 
I/O Data size returned does not 
match that in the scan list.  

Re-configure I/O data size of the slave, download the configuration to 
AS01DNET-A and run the PLC.  
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Code Explanation Correction 

E2 

The slave device in the scan list 
does not exist or is offline when 
AS01DNET-A is in master mode.  

1. Check if there is a change in the node address of the slave. 
2. Check if the communication cable is disconnected or connected 

loosely. 
3. Check if the bus cable length exceeds the maximum transmission 

distance. If so, the system may not be stable. 

The I/O connection between the 
slave AS01DNET-A and the 
master is broken when 
AS01DNET-A is in slave mode.  

E3 
AS01DNET-A fails to transmit 
data. 

1. Make sure that the connection between AS01DNET-A and the 
network is normal. 

2. Check if the baud rate of AS01DNET-A is the same as that of 
other node in the network. 

E4 
Error detected in sequence of 
fragmented I/O data from the 
slave device. 

Check if the slave is operating normally. 

E5 
The slave device returns error 
when AS01DNET-A attempts to 
communicate with it. 

Check if the slave is operating normally.  

E6 
IO data size returned from the 
slave is bigger than that 
configured in Scan List.  

Check that the IO data size of the slave should be the same as that 
configured in Scan List.  

E7 
AS01DNET-A is checking MAC 
ID. 

If the code is displayed long, do the troubleshooting according to the 
following steps.  
1. Make sure that at least two nodes work normally in the network. 
2. Check if either end of the network is connected with the terminal 

resistor of 121Ω. 
3. Check if the baud rates of the node devices in the network are 

same. 
4. Check if the communication cable is normal so as to avoid that 

the cable is disconnected or connected loosely. 
5. Check if the bus cable length exceeds the maximum 

transmission distance. If so, the system may not be stable. 
6. Check if the shielded wire of the network cable is grounded. 
7. Re-power AS01DNET-A scanner module. 

 

12.4.7 Error Codes and LED Indicators for Module AS01DNET (RTU 
Mode) 

Code Indication How to deal with 

0~63 Node ID of the scanner module 
(When in RUN state)  No correction needed 

F0 The node ID is repeated or 
exceeds allowed range. 

1. Ensure that the node ID of AS01DNET (RTU) is unique in 
the DeviceNet network within the range of 0~63.  

2. Repower it on after changing the node ID. 

F1 
No I/O module is configured to 
AS01DNET (RTU) in the 
DeviceNet Builder software. 

Add I/O modules in AS01DNET (RTU) in the DeviceNet 
Builder software and download the configuration data to 
AS01DNET (RTU) after the configuration is finished. 

F2 The work voltage of AS01DNET 
(RTU) is too low.  

Check if the power supply for AS01DNET (RTU) works 
normally. 

F3 AS01DNET (RTU) enters the 
test mode.  Repower AS01DNET (RTU). 
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F4 AS01DNET (RTU) is the 
Bus-Off state. 

1. Check if the network communication cable is normal and 
the shielded cable is grounded.  

2. Ensure the baud rates of all network nodes are same.  
3. Check if the two ends of the network are both connected 

with a 120Ω terminal resistor. 
4. Repower the scanner module. 

F5 No network power supply for 
AS01DNET(RTU) 

1. Check if the network cable is normal. 
2. Check if the network power supply is normal. (The external 

24V DC network power supply is connected between red 
V+ and black V- of AS01DNET (RTU) .) 

F6 
Internal error; 
An error in the internal storage 
units of AS01DNET (RTU)  

Return the product to factory for repair if the error still exists 
after re-power on. 

F7 
Internal error; 
An error in the data exchange 
units of AS01DNET (RTU)  

Return the product to factory for repair if the error still exists 
after re-power on. 

F8 Manufacture error  Return the product to factory for repair if the error still exists 
after re-power on. 

F9 
Internal error; 
An error in the access of the 
Flash of AS01DNET (RTU) 

Return the product to factory for repair if the error still exists 
after re-power on.  

E4 Module error 

Check if an error occurs in the modules connected to the right 
side of AS01DNET (RTU);  
Check if the module exists;  
Check if current module matches that configured in the 
software; 
Check if the unconfigured module is added. 

E7 Repeated node ID detection 
 

If the code has emerged for a long time, please shoot troubles 
in the methods below. 
1. Ensure that there are at least two nodes working normally 

in the network. 
2. Check if the two ends of the network are both connected 

with a 121Ω terminal resistor. 
3. Ensure that the baud rates of all network nodes are same. 
4. Check if the network cable has a problem such as being 

disconnected and loosened. 
5. Check if the bus communication cable length exceeds 

maximum transmission distance. If the maximum 
transmission distance is exceeded, the stability of the 
system can not be ensured. 

6. Check if the shielded wire of the network communication 
cable is grounded. 

7. Turn on the power of AS01DNET (RTU) again. 

E9 
The number of I/O modules 
connected to AS01DNET (RTU) 
exceeds the maximum 8. 

Check if the number of I/O modules connected to AS01DNET 
(RTU) is more than 8.  

80 AS01DNET (RTU) is in STOP 
state.  

1. Check if the RUN/STOP switch of the PLC connected to 
the DeviceNet master is turned to RUN. 
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Code Indication How to deal with 

2. Check if the value of control word of AS01DNET (RTU) is 
1. For details, refer to section 10.5.4.3.4. 

83 
The AS01DNET (RTU) 
configuration in the software is 
being downloading. 

Wait until the download of AS01DNET (RTU) configuration 
data is completed.  
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A.1 Installing the USB Driver for an AS Series CPU module in 
Windows XP with SP3 

The instructions below show how to install the USB driver for an AS Series CPU module on Windows XP. To 

install the USB driver on another operating system, refer to the instructions in the operating system for 

information on installing new hardware. 

Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer. 

(1) Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on your 

computer with a USB cable. In the Found New Hardware Wizard, select No, not this time and then click 

Next. 

 

(2) The wizard displays the name of the detected USB device. Select Install from a list or specific location 

(Advanced) and then click Next. 
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(3) After you install ISPSoft version 3.00 or above, the driver for the AS CPU module is under the folder where 

you installed ISPSoft: ...\ISPSoft\drivers\Delta_PLC_USB_Driver\. 

Select Include this location in the search and enter the correct path, or click Browse to browse for the 

correct folder. Click Next to continue the installation. 
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(4) The system installs the driver. If the Hardware Installation message appears during the installation, click 

Continue Anyway. 

 

 

(5) Click Finish.  
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(6) Open the Windows Device Manager window. If the Delta PLC port for the USB device is under Ports 

(COM & LPT), the installation of the driver is successful, and Windows assigns a communication port 

number to the USB device. 

 

 

Additional remarks 

 If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver 

again. Follow the steps above, and install the driver again. After you install the driver, the communication 

port number that the operating system assigns to the USB device may have changed. 

 If Windows XP has not been updated to the version SP3 on the computer, an error message stating the 

missing files will appear during the installation. Resolve this issue with one of the following steps. 

(a) Cancel the installation, install Windows XP SP3 on the computer, and reinstall the driver according to 

the steps above. 

(b) Get the file needed, and specify the path where the file is stored for the missing file in the error 

message window. 

 



AS Ser ies Operat ion Manual  

A-6 

_ A 

A.2 Installing the USB Driver for an AS Series CPU module in 
Windows 7  

This section describes the steps to install the USB driver for an AS Series CPU module on Windows 7. To 

install the USB driver for an AS Series CPU module on another operating system, refer to the instructions in the 

operating system for information about installing new hardware.  

Before you install the USB driver, you must install ISPSoft version 3.00 or above on your computer. 

Supply power to the AS Series CPU module. Connect the AS Series CPU module to a USB port on the 

computer with a USB cable.  

(1) Windows detects the module. From the Windows Control Panel, open the Device Manager. The name of 

the USB device appears in the Device Manager window. Double-click the AS300.  
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(2) In the AS300 Properties dialog box, click Update Driver…..  

 

(3) Click Browse my computer for driver software.  
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(4) After you install ISPSoft version 3.00 or later, the driver for the AS Series CPU module is under the folder 

where you installed ISPSoft ...\ISPSoft\drivers\Delta_PLC_USB_Driver\. Enter the path to the driver, or 

click Browse to browse to the correct folder. 

Specify the correct path. If you installed the driver for the AS series CPU module to another location, 

specify the corresponding path. Click Next to continue the installation. 
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(5) Click OK. The system installs the driver. If the Windows Security window appears during the installation, 

click Install this driver software anyway. 

 

 

(6) When the installation completes, click Close. 
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(7) Open the Device Manager window again. If the name of the Delta USB device appears under Ports (COM 

& LPT), the installation of the driver is successful. The operating system assigns a communication port 

number to the USB device. 

 

 

Additional remarks 

 If you connect the PLC to a different USB port on the computer, the system may ask you to install the driver 

again. Install the driver again. After you install the driver, the communication port number that the operating 

system assigns to the USB device may have changed. 
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A.3 Installing the USB Driver for an AS Series CPU module in 
Windows 8 

Windows 8 driver signature enforcement provides a way to improve the security of the operating system by 

validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB 

driver does not include the driver signature, this section shows you how to disable driver signature enforcement 

in Windows 8 to successfully install the Delta PLC USB driver. Once you disable the driver signature 

enforcement setting, it returns to its original state after you restart Windows. 

Follow these steps to disable driver signature enforcement in Windows 8. 

1. Press the Windows button  【WIN】+【I】 on your keyboard to display the Settings window. Click 

Change PC settings. 

2. The PC settings window appears. Click General and then click Restart now under Advanced startup.  
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3. After the computer restarts, under Choose an option, click Troubleshoot.  Under Troubleshoot,  click 

Advanced options. 

 
 

4. On the Advanced options page, click Startup Settings, and then on the Startup Settings page, click 

Restart to restart the computer.  

 
 

5. Press the 7 or F7 key on your keyboard to choose Disable driver signature enforcement. Press Enter 

and the system directs you back to the Windows 8 operating system. Install the Delta PLC USB driver now 

by connecting the AS Series CPU module to your computer’s USB port. Refer to Section A2 for the steps 

to install the USB driver. 
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A.4 Installing the USB Driver for an AS Series CPU module in 
Windows 10 

Windows 10 driver signature enforcement provides a way to improve the security of the operating system by 

validating the integrity of a driver or system file each time it is loaded into memory. Because the Delta PLC USB 

driver does not include the driver signature, this section shows you how to disable driver signature enforcement 

in Windows 10 to successfully install the Delta PLC USB.  Once you disable the driver signature enforcement 

setting, it returns to its original state after restarting Windows. 

This section describes the steps to disable driver signature enforcement in Windows 10. 

1. Click the Windows Start button and then click Settings. 

2. In the Settings window, click Update & Security. 

A (Setting) B (Update & Security) 
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3. In the Settings window, click Recovery, and then click Restart now. 

C (Recovery) D (Restart now) 

 

4. After the computer restarts, under Choose an Option, click Troubleshoot, and then click Advanced 

options. 

 
 

5. On the Advanced options page, click Startup Settings. On the Startup Settings page click Restart to 

restart the computer.  
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6. On your keyboard, press 7 or F7 to choose Disable driver signature enforcement, and the system 

directs you to the Windows 10 operating system page. Install the Delta PLC USB driver.    

 

7. Install the USB driver for the AS Series CPU module by connecting the AS Series CPU module to your 

computer’s USB port. Refer to Section A2 for the steps to install the USB driver.  
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B.1 Device Addresses 

Standard Modbus device addresses: 

Device Type Format Device range 
Modbus address 

(Decimal number) 

AS300 Address  

(Hexadecimal number) 

X 
Bit DD.DD X0.0-X63.15 124577-125600 6000-63FF 

Word DD X0-X63 332769-332832 8000-803F 

Y 
Bit DD.DD Y0.0-Y63.15 040961-041984 A000-A3FF 

Word DD Y0-Y63 440961-441024 A000-A03F 

M Bit DDDD M0-M8191 000001-008192 0000-1FFF 

SM Bit DDDD SM0-SM4095 016385-020480 4000-4FFF 

SR Word DDDD SR0-SR2047 449153-451200 C000-C7FF 

D Word DDDDD D0-D29999 400001-430000 0000-752F 

S Bit DDDD S0-S2047 020481-022528 5000-57FF 

T 
Bit DDD T0-T511 057345-057856 E000-E1FF 

Word DDD T0-T511 457345-457856 E000-E1FF 

C 
Bit DDD C0-C511 061441-061952 F000-F1FF 

Word DDD C0-C511 461441-461952 F000-F1FF 

HC 
Bit DDD HC0-HC255 064513-064768 FC00-FCFF 

DWord DDD HC0-HC255 464513-464768 FC00-FCFF 

E Word DD E0-E9 465025-465039 FE00-FE09 

 


	AS Series Operation Manual
	Revision History
	Table of Contents
	Chapter 1 Product Introduction
	1.1 Overview
	1.1.1 Related Manuals
	1.1.2 Models Descriptions 

	1.2 Overview
	1.3 Characteristics

	Chapter 2 Specifications and System Configuration
	2.1 General Specifications
	2.2 CPU Module Specifications
	2.2.1 Functional specifications
	2.2.2 Electrical specifications
	2.2.3 Ethernet Specifications  
	2.2.4 CPU Module Profiles
	2.2.5 CPU Module Input/Output Terminals

	2.3 Digital Input/Output Module Specifications
	2.3.1 General Specifications
	2.3.2 Digital Input/Output Module Profiles
	2.3.3 Digital Input/Output Module Terminals

	2.4 Analog Input/Output Module Specifications 
	2.4.1 General Specifications
	2.4.2 Analog Input/Output Module Profiles
	2.4.3 Analog Input/Output Terminals
	2.4.4 Analog Input/Output Device Settings

	2.5 Temperature Measurement Modules Specifications
	2.5.1 General Specifications
	2.5.2 Temperature Measurement Module Profiles
	2.5.3 Temperature Measurement Module Dimensions
	2.5.4 Temperature Measurement Module Device Setting

	2.6 Positioning Module Specifications
	2.6.1 General Specifications
	2.6.2 Positioning Module Profiles
	2.6.3 Positioning Module Terminals 

	2.7 Network Module Specifications 
	2.7.1 General Specifications
	2.7.2 Network Module Profiles
	2.7.3 Network Module Device Setting

	2.8 Load Cell Module Specifications 
	2.8.1 General Specifications
	2.8.2 Load Cell Module Profiles
	2.8.3 Load Cell Module Dimensions
	2.8.4 Load Cell Module Device Setting

	2.9 Extension Card Specifications 
	2.9.1 General Specifications
	2.9.2 Extension Card Profiles
	2.9.3 Function Card Weights

	2.10 Power Supply Module Specifications 
	2.10.1 General Specifications
	2.10.2 Power Supply Module Profiles
	2.10.3 Power Supply Module Terminals


	Chapter 3 Installing Software
	3.1 Installing and Uninstalling ISPSoft
	3.1.1 Installing ISPSoft
	3.1.2 Uninstalling ISPSoft

	3.2 Installing and Uninstalling COMMGR
	3.2.1 Installing COMMGR
	3.2.2 Uninstalling COMMGR


	Chapter 4 Installing Hardware
	4.1 Installation
	4.1.1 Installing a Module
	4.1.2 Installing a Removable Terminal Block

	4.2 Wiring

	Chapter 5  Devices
	5.1 Introduction of Devices
	5.1.1 Device Table
	5.1.2 Basic Structure of I/O Storages
	5.1.3 Relation Between the PLC Action and the Device Type
	5.1.4 Latched Areas in the Device Range

	5.2. Device Functions
	5.2.1 Values and Constants
	5.2.2  Floating-point Numbers
	5.2.2.1 Single-precision Floating-point Numbers
	5.2.2.2 Decimal Floating-point Numbers
	5.2.2.2 Decimal Floating-point Numbers

	5.2.3  Strings
	5.2.4 Input Relays (X)
	5.2.5 Output Relays (Y)
	5.2.6 Auxiliary Relays (M)
	5.2.7 Special Auxiliary Relays (SM)
	5.2.8 Stepping Relays (S)
	5.2.9 Timers (T)
	5.2.10 16-bit Counters
	5.2.11 32-bit Counters (HC)
	5.2.12 Data Registers (D)
	5.2.13 Special Data Registers (SR)
	5.2.14 Index Register (E)
	5.2.15 File Registers (FR)


	Chapter 6 Writing a Program
	6.1 Quick Start
	6.1.1 Example
	6.1.2 Hardware
	6.1.3 Program

	6.2 Procedure for Creating a Project in ISPSoft
	6.3 Creating a Project
	6.4 Hardware Configuration
	6.4.1 Configuring a Module
	6.4.2 Setting the Parameters

	6.5 Creating a Program
	6.5.1 Adding a Ladder Diagram
	6.5.2 Basic Editing ─ Creating a Contact and a Coil
	6.5.3 Basic Editing ─ Inserting a Network and Typing an Instruction
	6.5.4 Basic Editing ─ Selecting a Network and Operation
	6.5.5 Basic Editing ─ Connecting a Contact in Parallel
	6.5.6 Basic Editing ─ Editing a Comment
	6.5.7 Basic Editing ─ Inserting an Applied Instruction
	6.5.8 Basic Editing ─ Creating a Comparison Contact and Typing a Constant
	6.5.9 Writing a Program
	6.5.10 Checking and Compiling a Program

	6.6 Testing and Debugging a Program
	6.6.1 Creating a Connection
	6.6.2 Downloading a Program and Parameters
	6.6.3 Connection Test

	6.7 Setting a Real-time Clock

	Chapter 7 Memory Card
	7.1 Overview of Memory Cards
	7.1.1 Appearances of Memory Cards
	7.1.2 Memory Card Specifications 

	7.2 Before using a Memory Card
	7.2.1 Formatting a Memory Card

	7.3 Installing and Removing a Memory Card
	7.3.1 Memory Card Slot in a CPU Module
	7.3.2 Installing a Memory Card
	7.3.3 Removing a Memory Card

	7.4 Memory Card Contents 
	7.4.1 Initializing a Memory Card
	7.4.2 Folder Structure in a Memory Card

	7.5 Introduction to the CARD Utility
	7.6 Backing Up a Project
	7.7 Restoring a Project
	7.8 Restoration Starts Once CPU is supplied with Power
	7.9 CPU Error Log 

	Chapter 8 Hardware Configuration and Data Exchange Setups
	8.1 Hardware Configuration Tool for AS Series Modules - HWCONFIG
	8.1.1 Introduction of the HWCONFIG Environment 
	8.1.2 Configuring a Module
	8.1.2.1 Adding a Module
	8.1.2.2 Assigning I/O Addresses 
	8.1.2.3 Editing a Comment
	8.1.2.4 Deleting a Module
	8.1.2.5 Replacing a Module
	8.1.2.6 Copying/Pasting a Module
	8.1.2.7 Cutting/Pasting a Module
	8.1.2.8 Dragging a Module
	8.1.2.9 Show/Hide Device Name


	8.2 Setting the Parameters in an AS Series CPU Module
	8.2.1 Opening the PLC Parameter Setting Window
	8.2.2 Setting the Basic CPU Parameters
	8.2.2.1 Options - System Information Page
	8.2.2.2 Options - COM1 & COM2 Port Setting
	8.2.2.3 Options - Ethernet Port Basic Setting
	8.2.2.4 Options - Ethernet Port Advanced Setting
	8.2.2.5 Options - Function Card 1 Setting
	8.2.2.6 Options - Function Card 2 Setting

	8.2.3 Configuring AS - Series Remote Modules 

	8.3 Data Exchange 
	8.3.1 Device Settings Dialog Box Descriptions 
	8.3.1.1 Data Exchange - COM1 and Data Exchange - COM2
	8.3.1.2 Data Exchange - Ethernet


	8.4 Setting Parameters in a Module
	8.4.1 Parameters in a Module
	8.4.2 Exporting and Importing the Parameters in a Module
	8.4.3 Updating Parameters in a Module
	8.4.4 Setting Parameters in an SCM


	Chapter 9. EtherNet Specification and Operation
	9.1 Introduction
	9.1.1 EtherNet/IP 
	9.1.2 Definitions of Common Network Terms 
	9.1.3 Ethernet Features 
	9.1.3.1 Delta EIP Architecture
	9.1.3.2 EIP Features


	9.2 Installation
	9.2.1  EtherNet/IP Device
	9.2.2  Network Cable Installation
	9.2.2.1 Single Port Device
	9.2.2.2 Dual Port Device
	9.2.2.3 EIP Builder Software


	9.3 Specifications
	9.3.1 Ethernet Specification
	9.3.2 EtherNet/IP Specification
	9.3.3 EtherNet Communication Port
	9.3.3.1 Communication Port Pin Assignment
	9.3.3.2 Communication LED Indicator


	9.4 EIP Builder 
	9.4.1 Run the EIP Builder  
	9.4.2 Set up the IP Address
	9.4.2.1 IP Address Type
	9.4.2.2 Set the IP Address (Static IP)
	9.4.2.3 Set the IP Address (BOOTP/DHCP)
	9.4.2.4 Re-enable BOOTP/DHCP

	9.4.3 Network 
	9.4.3.1 Scan Network
	9.4.3.2 Add devices (Manually)
	9.4.3.3 Set EIP Parameters

	9.4.4 Data Mapping
	9.4.5 Diagnosis

	9.5 Programming 
	9.5.1 Explicit Message
	9.5.2 TAG 
	9.5.2.1 Produced TAG
	9.5.2.2 Consumed TAG


	9.6 Troubleshooting 
	9.6.1 Error Code Classification
	9.6.2 Error Codes & How to fix them
	9.6.2.1 Configuration Errors
	9.6.2.2 Application Error


	9.7 Studio 5000 Software Operation
	9.7.1 Architecture
	9.7.2 Create a New Project
	9.7.3 Create a Scanner
	9.7.3.1 Create a New Ethernet/IP Module

	9.7.4 Connect to a Delta Adapter
	9.7.4.1 Import an EDS File
	9.7.4.2 Create an Adapter

	9.7.5 Download
	9.7.6 Data Mapping

	9.8 CIP Object
	9.8.1 Object List
	9.8.2 Data Type
	9.8.3 Identity Object (Class ID: 01 Hex)
	9.8.4 Message Router Object (Class ID: 02 Hex)
	9.8.5 Assembly Object (Class ID: 04 Hex)
	9.8.6 Connection Manager Object (Class ID: 06 Hex)
	9.8.7 Port Object (Class ID: F4 Hex)
	9.8.8 TCP/IP Interface Object (Class ID: F5 Hex)
	9.8.9 Ethernet Link Object (Class ID: F6 Hex)
	9.8.10 X Register (Class ID: 350 Hex)
	9.8.11 Y Register (Class ID: 351 Hex)
	9.8.12 D Register (Class ID: 352 Hex)
	9.8.13 M Register (Class ID: 353 Hex)
	9.8.14 S Register (Class ID: 354 Hex)
	9.8.15 T Register (Class ID: 355 Hex)
	9.8.16 C Register (Class ID: 356 Hex)
	9.8.17 HC Register (Class ID: 357 Hex)
	9.8.18 SM Register (Class ID: 358 Hex)
	9.8.19 SR Register (Class ID: 359 Hex)

	9.9 Delta EIP Product List
	9.9.1 Delta EIP Products
	9.9.2 Delta EIP Products, DLR (Device Level Ring) supported 
	9.9.3 Delta EIP Products, Scanner supported

	9.10 Operation and Monitor on the Web
	9.10.1 Menu
	9.10.2 Information
	9.10.3 Data Monitor

	9.11 Delta EIP Product Application (with OMRON Products)
	9.11.1 Architecture
	9.11.2 TAG Connection
	9.11.3 IO Connection


	Chapter 10 CANopen Function and Operation
	10.1 Introduction to CANopen
	10.1.1 CANopen Function Descriptions
	10.1.2 The Input/Output Mapping Areas

	10.2 Installation and Network Topology
	10.2.1 The Dimensions of AS-FCOPM
	10.2.2 AS-FCOPM on AS300 PLC
	10.2.3 Configure the AS-FCOPM with HWCONFIG
	10.2.4 The CAN Interface and Network Topology

	10.3 The CANopen Protocol
	10.3.1 Introduction to the CANopen Protocol
	10.3.2  The CANopen Communication Object
	10.3.3 The Predefined Connection Set

	10.4 Sending SDO, NMT and Reading Emergency Message through the Ladder Diagram
	10.4.1  Data Structure of SDO Request Message
	10.4.2 Data Structure of NMT Message
	10.4.3 Data Structure of EMERGENCY Request Message
	10.4.4 Example of Sending SDO through the Ladder Diagram

	10.5 Troubleshooting
	10.5.1 CANopen Network Node State Display

	10.6 Application Example
	10.7 Object Dictionary

	Chapter 11 CPU Module Operating Principles
	11.1 CPU Module Operations
	11.1.1 Procedure
	11.1.2 I/O Refreshing and Communication Service

	11.2 CPU Module Operating Modes
	11.2.1 Operating Modes
	11.2.2 Status and Operation under Different Operating Modes


	Chapter 12 Troubleshooting
	12.1  Troubleshooting
	12.1.1 Basic troubleshooting steps
	12.1.2 Clear the Error States
	12.1.3 Troubleshooting SOP
	12.1.4 System Log

	12.2  Troubleshooting for CPU Modules
	12.2.1 ERROR LED Indicators Are ON
	12.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds
	12.2.3  ERROR LED Indicators Blinking Rapidly Every 0.2 Seconds
	12.2.4 ERROR LED Indicators Slow Blinking Every 3 Seconds and Lighting up for 1 Second
	12.2.5 BAT. LOW LED Indicators Are ON
	12.2.6 BAT. LOW LED Indicators Blinking Every 0.5 Seconds
	12.2.7 The LED RUN and ERROR Indicators are Blinking Simultaneously Every 0.5 Seconds
	12.2.8 The RUN and LED Indicators are Blinking One After Another Every 0.5 Seconds.
	12.2.9 Other Errors (Without LED Indicators)

	12.3  Troubleshooting for I/O Modules
	12.3.1 Troubleshooting for Analog Modules (AD/DA/XA) and Temperature Modules (RTD/TC)
	12.3.1.1 ERROR LED Indicators Are ON
	12.3.1.2  ERROR LED Indicators Blinking Every 0.5 Seconds

	12.3.2 Troubleshooting for the Load Cell Module AS02LC
	12.3.2.1 ERROR LED Indicators Are ON
	12.3.2.2 ERROR LED Indicators Blinking Every 0.5 Seconds

	12.3.3 Troubleshooting for the Module AS00SCM as a Communication Module
	12.3.3.1 ERROR LED Indicator Are ON
	12.3.3.2 ERROR LED Indicators Blinking Every 0.5 Seconds

	12.3.4 Troubleshooting for the Module AS00SCM as a Remote Module
	12.3.4.1 ERROR LED Indicators Are ON
	12.3.4.2  ERROR LED Indicators Blinking Every 0.5 Seconds
	12.3.4.3 ERROR LED Indicators Blinking Every 0.2 Seconds

	12.3.5 Troubleshooting for AS01DNET Modules

	12.4 Error Codes and LED Indicators for CPU Modules
	12.4.1 Error Codes and LED Indicators for CPU Modules
	12.4.2 Error Codes and LED Indicators for Analog/Temperature Modules
	12.4.3 Error Codes and LED Indicators for Load Cell Module AS02LC
	12.4.4 Error Codes and LED Indicators for Module AS00SCM as a Communication Module
	12.4.5 Error Codes and LED Indicators for Module AS00SCM as a Remote Module
	12.4.6 Error Codes and LED Indicators for Module AS01DNET (Master/Slave Mode)
	12.4.7 Error Codes and LED Indicators for Module AS01DNET (RTU Mode)


	Appendix A Installing a USB Driver
	A.1 Installing the USB Driver for an AS Series CPU module in Windows XP with SP3
	A.2 Installing the USB Driver for an AS Series CPU module in Windows 7 
	A.3 Installing the USB Driver for an AS Series CPU module in Windows 8
	A.4 Installing the USB Driver for an AS Series CPU module in Windows 10

	Appendix B Device Addresses
	B.1 Device Addresses




